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Contact Information

Visit the Contact OLI Systems page at https://www.olisystems.com/contact to submit general inquiries,
contact Technical Support, or search for an address and phone number.

if you need to contact Support, an online request form is located at the OLI Systems Tech Support page at
https://www.olisystems.com/contact-tech-support. Other useful links and resources are:

*  OLI Systems Support Email: oli.support@olisystems.com

*  Product Downloads: http://downloads.olisystems.com/

*  OLI Systems YouTube Channel: https://www.youtube.com/OLISystems
*  OLI Systems Wiki page: http://wiki.olisystems.com/wiki/Main_Page

Disclaimer

This manual was produced using the OLI Studio / OLI Analyzer 10.0 build 1 (10.0.1). As time progresses, new
data and refinements to existing data sets can result in values that you obtain being slightly different than
what is presented in this manual. This is a natural progress and cannot be avoided. When large systematic
changes to the software occur, this manual will be updated.
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This manual will provide an introductory guide for new OLI Studio Software users. The OLI Studio is a software
suite containing several modules including, Stream Analyzer, ScaleChem and Corrosion Analyzer. A client’s
license determines which modules are enabled within the OLI Studio Software.

This introductory manual consists of one chapter showcasing the OLI Studio User Interface, and three main
chapters showcasing the three main modules of OLI Studio: Stream Analyzer, ScaleChem and Corrosion
Analyzer.

If you have not yet installed the software, please install it following the instructions given in Installation and
Security page in our Wikipage at: http://wiki.olisystems.com/wiki/Installation_and_security.

ch

chemistry

Stream Analyzer

Stream Analyzer is standalone software, and it is the main interface of the OLI Studio. Stream Analyzer is a
comprehensive thermodynamic tool that calculates speciation, phase equilibria, enthalpies, heat capacities and
densities in mixed-solvent, multicomponent systems. Capabilities and features of Stream Analyzer are:

e Three different thermodynamic frameworks:
o Aqueous (AQ) model
o Mixed Solvent Electrolyte (MSE) model
o Mixed Solvent Electrolyte and Soave-Redlich-Kwong (MSE-SRK) model

e Thermophysical properties: Stream Analyzer has thermophysical models to predict surface tension,
interfacial tension, viscosity, electrical conductivity, thermal conductivity, diffusivity, and osmotic pressure.

e Molecular and ionic inflows: Stream Analyzer accepts molecular inflows, typical of a process stream, and
ion inflows, typical of a sample water analysis.

S
ScaleChem

scale
ScaleChem is a simulation software tool that predicts scaling problems during oil and gas production.
ScaleChem simulates fluid production from the reservoir to the sales point, and computes the phase mass
balance, scale tendencies, and scale mass of production fluid at each location in the production line. Capabilities
and features of ScaleChem are:

e Brine, gas and oil analysis

e Scaling scenarios

o Compatibility testing of brines using the stream mixing function

e Phase equilibrium calculation used to perform four-phase reservoir saturation, from which as whole fluid
reservoir composition is determined

e Contour plots to study produced brine properties across a broad temperature and pressure range


http://wiki.olisystems.com/wiki/Installation_and_security

C
Corrosion Analyzer corrosion

Corrosion Analyzer is a module within the OLI Studio. A separate license enables this module. Corrosion
Analyzer is first-principles corrosion prediction tool. It is used to predict the corrosion rates of general corrosion,
propensity of alloys to undergo localized corrosion, depletion profiles of heat-treated alloys, and thermodynamic
stability of metals and alloys. It enables users to address the causes of aqueous corrosion by identifying its
mechanistic reasons. As a result, users take informed action on how to mitigate or eliminate this risk.

Corrosion Analyzer calculates corrosion by quantifying the bulk chemistry, transport phenomena, and surface
reactions through a thermophysical and electrochemical module.

e The thermophysical module calculates the aqueous solution speciation and obtains concentrations,
activities and transport properties of the reacting species.
e The electrochemical module simulates partial oxidation and reduction process on the metal surface.

The tool reproduces the active-to-passive transition and the effects of solution species on passivity.

Effects of temperatures, pressure, pH, concentration, and velocity on corrosion are also included. Capabilities
and features of Corrosion Analyzer are:

e Generation of Pourbaix (E vs pH) diagrams
e Calculation of general corrosion rates

e Localized corrosion susceptibility

e Heat treatment effect

e Generation of polarization curves plots



General View of the User Interface

In the OLI Studio Software, the OLI Studio Desktop User Interface provides the environment to create, analyze
and interpret the results of your application chemistry. In this manual, an overview of the different windows and
tools that you will be using within the software, as well as how to navigate the OL| Studio User Interface, will be

provided here.

Menu Bar ———

& 0Ll Studio - [Document1]
"1 File Edit Streams Calculations Chemistry Tools View Window Help

= Lancel | +———————— Status Bar

- & x

- 1

Description/
Definition
Pane

=1

=Em
Tooclbar — D= H 7 N2 W b |me s BE L o wE (G E
Mavigator » - x|y
Documentt +
¢ Streams Description  Object Map
Navigator
Pare Name: [Eieams Date: | 3/5/2019 [v
Desciiption
~
Actions Actions oo
Pane Actions
[#) Add Stream (@ Add Scale Contour
] Add Mixer ' Add Mixing Water
T Add Water Analysis 2 Add Facilities
%] Add EVS Calculation *3; Add HC Saturator v
& Add Brine Analysis = »
@& Add Oil Analysis
2 Add Gas Analysis
3 Add Saturator Stmmar)
|~ Add Scale Scenario
Plot Automatic Chemistry Model

Template ——
Manager

Calculation
Status
Output

Agueous (H+ ion) Databanks.

Plot Template Manager p . x Aqueous (H+ ion
Using K-fit Polynomials.
T-span: 25.0 - 225.0
*P-span: 1.0-201.0
* = differs from defaut

Save

Summary
Pane

Calculation + -

For Help, press F1

@B

The screenshot shown above is what you will see when you first start OLI Studio. . You can customize the
desktop to your own needs. The windows can be resized, moved, docked and detached.

Menu Bar

The Menu Bar gives access to the following options: File, Edit, Streams, Calculations, Chemistry, Tools, View,
Window and Help.

File: Gives access to functionality such as New, Open, Close, and Save a file

Edit: Cut, Copy, Paste, Delete and Clear calculation results

Stream: The Streams menu contains actions that can also be performed using the Actions Pane

Calculations: The calculation menu contains all the calculations found in the Actions Pane

Chemistry: Advanced changes to the chemistry can be made here.



Tools: Gives access to tools such as component search, names manager, units manager and other

customizations.

View: Gives the option to customize the view of the interface.

Window: Allows to arrange the different OLI Studio. documents in the window.

Help: Here you can have access to the Technical Support or any content that you may need related to

OLI Software.

Tool Bar

The Tool Bar gives quick access to different functions and sits below the Menu Bar. Tools within this bar can
be added, removed or repositioned. When a tool is selected (or turned ON) it is highlighted in light blue. When

deselected (or turned OFF) comes back to gray.

= T 11 vasSol?z Re ¥ me 315 8 4

They are laid out in the following order:

Quick access to File: D E’q H

Quick access to Edit:

Quick access to Help: 2 N2

Quick access to Chemistry: L1 Va So L2 Re & |me & IS 3 40 8

Quick access to Tools: dhEm 5 B Nz

Icons in the Chemistry section

In the quick access to Chemistry you find: Phases, Redox and Databanks.

Phases: Turns ON/OFF specific phases. Four different phases are available:

L1: Liquid 1 or water-rich phase

Va: Vapor phase

|4



So: Solid phase
L2: Usually organic rich phase, also referred to as Liquid 2 phase.
Redox: Denoted as Re. Turns ON/OFF Reduction/Oxidation (REDOX) reactions.

Databanks: Turn ON/OFF a specific thermodynamic databank. There are three thermodynamic databanks
available:

AQ: Aqueous databank
MSE: Mixed Solvent Electrolyte databank

MSE-SRK: Mixed Solvent Electrolyte and Soave-Redlich-Kwong databank

Icons in the Tools section
A description of each icon in the Tools section is given below:

Component search: % This tool helps you to look for a component using Formula, CAS number, or
via using the periodic table.

Names manager:

=
T
]
-

This tool shows you the name of components in different styles in tables

& and reports. The style options are: Display name, Formula or OLI Name.
Units manager: E? This tool allows you to select or change to preferred units for all

calculations.

Customize toolbars: i) This tool allows you to remove or add preferred tools to the Tool Bar. For
example, you can add or remove Chemistry from the Tool Bar.

General options: This tool allows you to adjust or change default software settings.

Calculation options: 4  This tools allows you to include or exclude different types of properties into
the calculations.
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Navigator Pane

The Navigator Pane (or tree level) contains the list of streams and calculations that are active within a file. This
view contains the icons and names of each action in a hierarchical tree. The Description/Definition pane
changes depending on the level that is highlighted. A plus sign next to an object in the stream level indicates
that that stream or object has sub-streams or branches. There are four levels: Global Stream Level, Stream
Level, Calculation Level, and Calculation Sublevel.

Global Stream Level: Provides the broadest view of the navigator objects. At this level the user can define
default units, default components name, and general preferred calculation options.

Stream Level: Chemistry options such as phase selection, REDOX reactions, and the thermodynamic
databanks can be selected as this level.

Calculation Level: Calculation types such as Single point calculations, Survey calculations, etc., are
subordinate to streams, and appear in this level. A more detailed explanation of calculation types can be found
in Chapter Il of this manual.

Calculation Sublevel: Some calculations, such as Survey calculations, have their own calculation sublevels.
They can be expanded or maximized using the small icon ( & or =) next to the calculation type.

Mavigator L
Documentt:1*

File name Documentd:2*

—— Document1:3*
%
S & Stream Stream Level
w4y SinglePoint

2. 4 Survey «— Calculation Level

----- £y Temperature=23.0°
----- £y Temperature=30.0
----- 4y Temperature=33.0°
----- £y Temperature=40.0
----- £y Temperature=45.0 °
----- £y Temperature=30.0°
----- £y Temperature=35.0°
----- £y Temperature=60.0 °
----- £y Temperature=65.0°

Global Stream Level

Calculation Sublevel

[aNaNaa NN aN S

Note: A star (*) next to the file name indicates that the file has not been saved.
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Actions Pane

This view contains selectable action icons. Each icon represents either a new stream input or new calculation.
Additional actions will appear depending on what kind of stream we are working with. You can change the view

of the actions pane by right clicking in the white area

Icons. In this case the List option was selected.

When located at the Global
Stream Level the following
action icons appear on the
Actions Pane.

If you select an action item that
belongs to Stream Analyzer, this
action item will be located at the
Stream Level, and only the
following action icons appear on
the Actions Pane.

If you select an action item that
belongs to ScaleChem, this
action item will be located at the
Stream Level, and only the
following action icons appear on
the Actions pane.

Plot Template Manager

The default location for the Plot Template Manager

Actions
Actions

& | Add Stream

) Add Mixer

Td Add Water Analysis

Add Brine Analysis
& Add Oil Analysis
%P Add Gas Analysis
@ Add Saturator
I—i Add Scale Scenario
Add Scale Contour
¢ Add Mixing Water
M Add Facilities
*3 Add HC Saturator

Actions
Actions

@Add Stream

[l Add Mixer

|£] Add Single Point
|| Add Survey

Add Chemical Diagram
|=] Add Stability Diagram

Add Corresion Rates

Actions
Actions

m Add Brine Analysis
& Add Oil Analysis
%5 Add Gas Analysis
@ Add Saturator

I—i Add Scale Scenario
Add Scale Contour
¢ Add Mixing Water
e Add Facilities

‘% Add HC Saturator

is in the lower left-hand corner of the main window.

The Plot Template Manager is a tool that allows the

user to create, save and use plot templates. This
tool allows a fast plotting and analysis of the users

results.

Plat Template Manager

. You can show the icons as a List, Small Icons or Large

These actions come with Stream
and Corrosion Analyzers

These actions come with
ScaleChem

[Default Plat]
target pH

Precipitation |

Save
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Description / Definition Pane

Users work most of the time on the Description / Definition area, which changes depending on which action

object is being used.

& OL Studio - [Document2*]

- a x
W7 File Edit Streams Calculations Chemistry Tools View Window Help - & x
s e Caneel ‘
DD“‘HHQE|§'ﬁt‘k‘?‘L1Va5nL2|mg|_g§g.ai|ME”Q«FE,g
Navigator g -x
Document1:1* ﬂ \
Document1:2* Description  Object Map
Documentd:3*
Documentz® Nane: [Stieams Date: | 3/8/2019 o
A_.‘
& Stream Description
. .4 SinglePoint -
L Mixer
¢ OLIStudio - [Document2*] - [m] X
Actions ~x 7 File it Streams Calculations emists ool View Window Hel - & x
T = 57 File Edit St Calcul Chemistry Tools View Window Help
Actions P ” CPA=ES - Cancel
\[&] Add Stream 7 Add Gas Analysis %3 = =
B ? n 4 IS g n Ty | G i
8l Add Mixer @ Add Saturator 5 DBHH{’Elé?V‘ L1V350L2|RB—|""EJR»<7M7| ME s G B
Td Add Water Analysis [ Add Scale Scenario LMY _{ Navigator B x| ?[ =
%] Add EVS Calculation [l Add Scale Contour Documenti:1*
W Add Brine Analysis ' Add Mixing Water Automati{_Document1:2* & Description ¥ Definition 3 Report
& Add Oil Analysis  #t; Add Facilities Aqueo| Document13®
< > Aay Document2 Variable Value Add Caleulaion  +
vsing B Stream Parameters
| Plot Template Manager L o-x Ts [ 48 Streams Special Conditions
e [ Stream Amount (mol) 56,5082
c=q| @ ream Temperature (°C) 25,0000 [Tty
4y SinglePoint
Pressure (atm) 1.00000
AL Miscer Summary
p— B Inflows {mol)
_ Hz0 555082 Unit Set: Metric (moles)
x p— . ] 1.00000
. e = Automatic Chemisiry Model
L = = differs from default. Aﬂ:\ﬁﬂus ("EH‘E'"_? Databanks:
queous (H+ ion)
£ Actions B %] Using K-fit Polynomials
2||Calculation Complete! Actions T-span: 25.0 - 225.0
3 &) Add Stream Add Corrosion Rates e
For Help, press F1 () Add Mixer Ao e
Add Single Point
& Add Survey
[B) Add Chemical Diagram
Add Stability Diagram
< >
[Plot Template Manager L - x|
Input
B Advanced Seach || Add as Stream Expart
ave
3 T-span: 25.0 - 225.0 -
D *P-span: 1.0 - 201.0
» = - differs fram default.
g
< [catculation Complete!
3 v
For Help, press F1 NUM |
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Summary Pane

The Summary Pane can be viewed in both the Description and Definition Tabs. The Summary Pane shows
inputs, calculation outputs, warnings, and has hyperlinks to the Units and Databank Managers. This window
varies with object.

¢ 0Ll Studio - [Document2*] — [m] X
"7 File Edit Streams Calculstions Chemistry Tools View Window Help - &%
[EA=ES o Cancel
D2l ?NK 11vasol2 Red me U o Mgn: GRS
Navigator B oex
A
Documentt:1*
Documentt:2* & Description [§3 Definition (B Report (3 File Viewer
Documentd:3*
Documentz* Name: [BinglePoint Date | 3/8/2018 |+
48 Streams
08 Steam Desciption ¢ OLl Studic - [Document2’] - O X
i..¢ SinglePoint
L&l Micer B File Edit Streams Calculstions Chemistry Tools View Window Help _ax
e Cancel
D™ BN 11vaSol2 Red me I o2 @ER: O EE
Navigator B oex
A
TR Feo Documentt:1*
r Descripti Definition ile Vi
Actions ; Documentt:2 & [&¥ @ Report I File Viewer
. Brenently Type of caleulation
Documentz® N Variable Value ~
S - = Stream Parameters Isathermal + | spess
42 Streams
. Stream Amount (mol) 56,5082
Unt Set letrc (mokes) £ Stream Tompersturs ('C) 25 0000 Cakculate @
.y SinglePoint
Automatic Chemistry Model K Mixer s arciainy 1.00000 Summary
A [ < Inflows (mol)
H20 555082 Unit Set: Metric (moles) ~
Plot Template Manager L ~x
T-span: 25.0-225.0 p=) 1.00000 Automatic Chemistry Mode!
“P-span: 1.0-201.0 Agqueous (H+ ion) Databanks:
*= differs from defaut: Aqueous (He ion)
Ixnfhermal Calciilation e g e % Using K-fit Polynomials
Save Actions T-span: 25.0 - 225.0
> *P-span: 1.0 - 201.0
= * = differs from default.
v T""a_;',;?fn“jfnzf'g Isoihermal Calculation
+ tfers from default. 25.0000°C 1.00000 atm
2 Phase Amounts.
2 N Aqueous  57.5082 mol
2 |calculation Completet Vapor 0.0 mol
3 Sold 0.0 mol
(s 2 s ] PlotTemplate Manager Goo . ‘Aqueous Phase Properties
pH 6.95746
lonic Strength  0.0173888 mol/mol
Inpt - Dutput Density 1.03589 giml
Vv
. Advanced Seach || AddasSteam | Expait Calc. elansed time: 0,030 sec:
ave .
= T-spam: 25.0- 225.0 ~
D “P-span: 1.0 - 201.0
B = = differs from default.
% |Calculation Complete!
: v
For Help, press F1 @ NUM

Calculation Status Output

The Calculation Status Output window shows progress, errors, warnings, temporary file locations, and other
data.

*||Starting Calculation ~
'||Calculating SinglePoint
&/|Unit Set: Metric [moles]
Automatic Chemistry Model
Ag H+ ion] Databanks:
Aqueous [H+ ion]
Using K-fit Polynomials
T-zspan: 25.0 - 225.0
*P-gpan: 1.0 - 201.0
= = = differs from default.
3
§||Trace enabled: Level=1 Filename="C:\Users\DIANA™1 MIL\AppD ata\Local\Temp\OLIB72a0\0LI2c2a2_SinglePoint. oue’
;% Calculation Complete! v
o
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Thermodynamic Frameworks and their Databases

You can access the databanks from the Menu Bar: Chemistry > Model Options... or via the quick access from
the Tool Bar.

There are three main thermodynamic frameworks in OLI Studio. . The user can pick the thermodynamic
framework that is more suitable for their chemistry. These are the AQ (Aqueous), the MSE (Mixed Solvent
Electrolyte), and the MSE-SRK (Mixed Solvent Electrolyte — Soave Redlich-Kwong) Thermodynamic
Frameworks. A more detail description of each framework is given below:

Aqueous (AQ) Thermodynamic Framework

The OLI Aqueous (AQ) thermodynamic framework, is a mature electrolyte activity coefficient model that predicts
the properties of solutions up to 30 molal ionic strength. Its accompanying database contains 6,000 species for
80+ elements (metals and non-metals) across multiple oxidation states.

This AQ framework is suitable for application involving electrolytes, gases and hydrocarbons dissolved in water.

The AQ framework utilizes the Bromley-Zemaitis activity model:

AlZ,Z_|NT (0.06+ 0.6B)|Z,Z_|\I

lo =— +BI+CI>+ DI
B¥: 1+ VI <1+ 15 1>2

1Z,Z_]

The model is capable of producing valid results in the following ranges:

Temperature -50-C to 300°C
Pressure 0 — 1500 bar
lonic Strength 0 — 30 molal

The AQ-framework selects the PUBLIC' database by default. Frequently there is more to the chemistry than
what is covered in the PUBLIC database. The following is a partial list of additional databases available in the
AQ framework:

Aqueous (H* ion) — Public Database and selected by default
Geochemical (AQ)

Ceramics (AQ)

Corrosion (AQ)

Low Temperature (AQ)

Alloys (AQ)

lon Exchange (AQ)

Surface Complexation Double Layer Model (AQ)

© N OAWON =

1 The PUBLIC database is the main OLI database, containing nearly 70 percent of the thermodynamic data available from OLI and 100
percent of the supporting information.
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Mixed Solvent Electrolyte (MSE) Thermodynamic Framework

A system’s thermodynamic properties are calculated from two sources; the first is from the Temperature and
Pressure dependent standard-state Gibbs energies (i.e., G_LO(T, P) of each species present. The second is from
the temperature, pressure and composition dependent excess Gibbs energy (i.e.,y;(m,T)) for each species
present. In the combined relationship, the partial molal Gibbs energy of the i*" species is, G, = G + RT Inm;y;,
where G? is the standard-state partial Gibbs energy and y; is the activity coefficient. This activity coefficient y;,
is computed using the MSE theory. A comprehensive explanation of the MSE theory is given in Wang et al. [7].

The MSE framework utilizes the MSE activity model which contains the extended Debye-Huckel term, that
accounts for long-range interactions, an UNIQUAC term that accounts for short-range interactions, and a
middle-range that includes the ionic interactions:

logy; = logy?® +logy{"® + logy{®

The model is capable of producing results for the following ranges:

Temperature -50°C — 10 90% Terit
Pressure 0 — 1500 bar
lonic Strength no limit

The MSE framework contains the following databanks:

MSE (HsO" ion) — Selected by default

Corrosion (MSE)

Geochemical (MSE)

Urea (MSE)

Surface Complexation Double Layer Model (MSE)

aprON =

Mixed Solvent Electrolyte with Soave-Redlich-Kwong Equation of State (MSE-
SRK) Thermodynamic Framework

The MSE-SRK model is based on the Mixed-Solvent Electrolyte (MSE) framework, which provides a very
accurate representation of electrolyte systems in both aqueous and mixed-solvent (e.g., glycol-containing)
environments. The MSE-SRK framework combines an equation of state for standard-state properties of
individual species, an excess Gibbs energy model to account for solution non-ideality in the aqueous electrolyte
phase, and the Soave-Redlich-Kwong equation of state (SRK EOS) to calculate the properties of the gas phase.
The MSE-SRK framework, however, provides a different treatment of the non-electrolyte-rich second liquid
phase for liquid-liquid equilibria. MSE-SRK assumes the second (usually organic-rich) liquid phase to be non-
ionic, and reproduces its properties using the SRK EOS. This allows the MSE-SRK framework to more easily
reproduce the critical behavior of nonelectrolyte systems.

In the MSE-SRK model, the electrolyte-containing (usually aqueous) liquid phase is represented by a
combination of the Helgeson-Kirkham-Flowers (HKF) equation of state for standard-state properties and the
MSE activity coefficient model for solution nonideality. Accordingly, the chemical potential of a species iin a
liquid (electrolyte) phase is calculated as:

ub = ufP¥(T,P) + RT Inx* (T, P,x) M
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where uiL'O'x(T, P) is the standard-state chemical potential from the HKF theory [9], [10], x; is the mole fraction,
and x;y;"" (T, P, x) is the activity coefficient from the MSE theory of Wang et al. [7], which accounts for long-
range electrostatic, specific ionic, and short-range intermolecular interactions.

The second liquid phase is assumed to be non-ionic and is modeled using the Soave-Redlich-Kwong equation
of state (SRK-EQS) [11]. The chemical potential in the non-ionic liquid phase is then calculated as:

uf = ui°(T) + RT lnw ()
where yf'O(T) is the chemical potential of pure component i in the ideal gas state, y; is the mole fraction,
¢;(T,P,y) is the fugacity coefficient from the SRK-EQS, P is the total pressure, and P° = 1 atm.

The properties of the gas phase are also obtained from the SRK equation according to Equation (2).
The MSE-SRK framework contains the following databanks:

MSE (H3O" ion) — Selected by default

MSE-SRK (HsO* ion) — Selected by default
Corrosion (MSE)

Geochemical (MSE)

Urea (MSE)

Surface Complexation Double Layer Model (MSE)

ook wh=
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Component Search

You can access the Component Search from the Menu Bar: Tools > Component Search... or via the quick

]

access from the Tool Bar |

Note: When using the Component Search tool will only show components in the database that you have
selected.

The Component Search option opens new window where you can search for the component of interest by
typing the component name or look up components using the Periodic Table option. In the periodic table option,
you have 3 search options:

o Any of selected: Will show elements that you have
e All of selected
e Only selected

Component Search - Databanks (MSE) ? x Component Search - Databanks (MSE) ? X
Look Up Component  Periodic Table Look Up Component  Periodic Table
BENZENE Molwt [78114418 Li |Be H EnN o|F[Ne
Benzene —— 10070 | Hydrogen -
Benzene, ethyl- CASNo |71-43-2 NaIMg = Al|Si|P|S|Cl|Ar
Benzene, riro- ,
Benzene-1.3dicabonylic acid Fomula [CBHE K |ca|sc| Ti VICrIMn Fe|Co| Ni|Cu|Zn |Ga|Ge|As|Se|Br|Kr
Phase Infomation Rb|Sr| Y | Zr NbIMo Tc|Ru|Rh|Pd|Ag|Cd|In |Sn|Sb|Te| I |Xe
Aqueous Cs|Ba|La|Hf TaIW Re|Os| Ir | Pt|Au]Hg| TI|Pb| Bi|Po| At |Rn
* = Match O or more characters Vapor
2 = match any single character Fr|Ra| Ac
Structure Synonyms Lanthanide Series |Ce | Pr [Nd|Pm|Sm|Eu |Gd| Th | Dy|Ho| Er [Tm|Yb | Lu
Armulene 2 Actinide Series | Th|Pa| U |Np|Pu|Am|Cm| Bk | Cf| Es |Fm|Md|No| Lr
Benzene
BENZENE C2H2 || Search Options
Benzene C14H10 O Any of selected
Benzene CEHE
Benzol C4H8 O &ll o selected
Benzole C10H22 ®
Benes Qonzz @® Only selected
CBHE C12H26
C6HE C13H28 {
Coal naphtha C14H30
Cyclohexatiene C15H32 v
Phene v =nst
63 species Add to Stream
Close Cancel Help Cancel Help

In any of the two options for component search, you can click on the Add to Stream button to add the
component in your chemistry.
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Names Manager

You can access the Names Manager from the Menu Bar: Tools > Names Manager... or via the quick access
HACL

from the Tool Bar BT

The Names Manager option opens new window where you can select the component name style. There are
three different styles:

o Display name: This is the name that is commonly displayed when a species is entered. This is the
default display. For example, Benzene, Cyclohexane, Sodium Chloride

e Formula: This is the chemical formula name. For example, C6H6, C6H12, NaCl

e OLI Name (TAG): This is the traditional name for the species stored internally in the OLI software. For
example: BENZENE, CYCLOHEXAN, NACL (Note: These names are usually for OLI internal use).

Additionally, you can select if you prefer the mineral name to appear after the solids. For example, NaCl (halite),
KCI (sylvite), etc.

Names Manager ? X
Name Style  Search Criteria  Names Dictionary

Component Name Style
() Display name
Use Names Dictionary
(® Formula
(O 0Ll Name [TAG)

Show mineral name after solids

The selected style will be uzed for displaying component
names in tables and lists.

Cancel Apply Help
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Units Manager

You can access the Units Manager from the Menu Bar: Tools > Units Manager... or via the quick access from
G+
the Tool Bar *F .

If you are changing units at the Global Stream Level, the Units Manager tool will open a new window where
you can change the default units for the whole document. You can also select the default units of the different
calculation objects.

| u
0=

At the Stream Level, the Units Manager tool will open a slightly different window and will change the units only

at the Stream Level and Calculation Level.

= % N2 e we WL e MdEmr G RE
Mavigator gax [
Document1® ] Default Units for Document | ? >
&
‘,‘ Streamns Default Units
B Stream
L SinglePoint I
Object Type All v
Default Units Brine
Contour
EVv3Standard
. Facilities
Metric Gas P Moles v 4
HCSaturator
Mixer
= = MixingWater
Actions 1 oil
Actions Customize.., | |2aturator
= . Scenario
&) Add Stream F=] Add EVS Calculatic Stream
(& Add Mixer & Add Brine Analysi: WaterAnalysis
Tl Add Water Analysis  # Add Oil Analysis Mote: Changes made to default units only apply to new objects. Existing
objects will not be modified.
<
Plot Template M ‘
ot Template Manager [l Cancel pary rop
[ ™ 1 1-Span: £3.U - ZZ0.U

| —
D & B X 11vasol2 Red me2l¥t s | #MEs: S B
Mavigator L - x ¢
Document1™® |
|4 Streams 8 Nacerintian &3 Definition & Danar
| Units Manager - Stream | ? K
o A eFaint Units Manager I
55
Metric ~ |Batch ~  |Moles - 4 =
110
55
Customize. . B
Actions L.
| Actions
‘&) Add Stream &) Add Survey
= £ OK Cancel Apply Help
&) Add Mixer |B) Add Chemical Diag [
4] Add Single Point @Add Stability Diagrar |

The default units are Metric, Batch and Moles, but you can change to any of the following default options:
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Scale Metric
Scale
Scale English

You can customize specific units, by clicking on the Customize... button. This will open a new window where
you can customize composition units, parameters units, and corrosion units. You can also select units for a
Batch system or a flowing system.

Edit Units - Stream 5 X ‘
(® Batch System () Flowing System
Composition |parameters  Corrosion
Variable Basis Units ]
Stream Amourit Moles mol
Inflows Moles mol
Output variables
Agqueous Composttion Moles mol
Vapor Composition Moles mol
Saolid Composition Moles mol
2ndd Liguid Composition Moles mol
Total Composition Moles mol
Basis options
Moles [mol |
Mass
Yolume
Concentration kg
Molar Concentration kg
. mg
:alssFFra’;uun (i100)
jole Fraction metric ton v
oK Cancel Help

Edit Units - Stream

Composition Parameters

Edit Units - Stream

Composition | Parameters | Corrosion

? X

(® Batch System (O Flowing System

? X

(®) Batch System () Flowing System

Variable Units
Angular Velocity cyclenin
Corrosion Rate mimsyr
Caorrosion Current Density Atsg-m
Length/Diameter cm
Potertial W (SHE)
Shear Stress Pa
Yolumetric Pipe Flow m3is
Welocity mis

Cancel Help

Variable | Units [~
Temperature |*C |
Pressure | atm |

[
Time: | hr
Alkalinty mg HCO3L
Density gt
Electrical Conductivity, molar m2ohm-mol |
Specific Electrical Conductivity pmhoscm |
Energy cal |
Energy, Molar | calimol |
Entropy | cali |
Entropy, Molar calimol K |
Fugacity atm
Heat Capacity calig K
lonic Strength (x-based) malinol
lanin Chrancdia (m hacad) el 1 .
Cancel Help
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Another option to access the Units Manager tool is by clicking on the units highlighted in blue. This is a
hyperlink to the Units Manager tool, and there you can make changes to the units.

e Stream Parameters
Stream Amount (mol) 56.5082
Temperature ("C}) 25.0000
Pressure (atm) 1.00000
T Inflows (maol)
H20 \ 35.5082
FeCl3 1.00000

Customize Toolbars

You can access the Customize Toolbars from the Menu Bar: Tools > Customize... or via the quick access

from the Tool Bar E . This will open a new window where you can disable or enable toolbars under Toolbars
tab.

Under the Commands tab, you can also add your preferred buttons in the tool bar. If you click on any of them,
it will give you a description of the actions the selected button will perform.

Customize *
Toolb C d |
Toolbars: Categories: Buttons
Standard Show Tooltips Mew. .. Standard [¢] el
[ | Full Screen Streams & Calcs: T T e
[*|Chemistry Model Options Cool Lock Beset ScaleChem pr| [pp] [cp] Fs O3
M [ Large Buttons Chemistry
Tools
Select a category, then click a button to see its description. Drag the button
to any toolbar
Description
Add an lsothermal calculation to the cument stream.
Tools
Cancel oK Cancel
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Calculation Options

You can access the Calculation Options from the Menu Bar: Tools > Options... or via the quick access from

R
the Tool Bar i . This will open a new window. Under the Calculation Options tab you can enable or disable
the following options:

1. General
a. Allows you to disable or enable
2. Diagnostics
a. Enable trace
3. Optional Properties
a. Diffusivities, electrical conductivity, heat capacity, activities, fugacities, and K-values, Gibbs
free energy, entropy, thermal conductivity, surface tension, interfacial tension, and pre-scaling
tendencies.

-\/'-Calculatinn Elptiu:um-" | Corvergence

#7 General Diagnostics =]

| ‘ Show status dialog [Enable trace ‘ |
| Verbose | ‘
. A

| " Optional Properties =,

| Diffusivities and Mobilities
[] Diffusivities Matrix

i Viscosity

Electrical Conductivity

|:| Heat Capacity

Activities, Fugacities, and K-Values
Gibbs Free Eneray

|:| Entropy

Thermal Conductivity
Surface Tension
Interfadal Tension

[ Pre-scaling Tendendes

Method
Estimated Rigorous
M A
Ok Cancel Apply Help '

23



Object Library

You can access the Object Library from the Menu Bar: View > Toolbars > Object Library.

This option will create a new window (to the right). You can find commonly used objects like standard sea water,

dry air, etc.

My Objects — save your own objects, such as a commonly used stream. You can drag an object and save it
here for your future use.

¢ OLl Studio - [Document1*] - O X
W7 File Edit Streams Calculations Chemistry Toolsindow Help - &8 %
DSHE| %8BS 2| Wlsu Pty CHE: G RIS
| Navigator g - x| £ View 5 ||Object Library g v x|
Document1* | My Objects
, Arrange lcons > = = -
8} streams Descr L Plot [El Report J File Viewer Standard Objects
: ine up lcons
E|0 Stream Survey by
4\ SinglePoint Full Screen i ~
-4 Survey S 2 fopEEie < Arabian Gulf  Basic
St Toolbars > I ~  Standard o] SeaWater...  Produc...
Tem w#  Status Bar ~  Chemistry Model Options
e -
s | ~  Tools @ @
e Inflows (mol) i Dry Air Extended
Hz0 Calculation Status Independently Produc...
NaCl +  Calculation Output Tagether
i ~  Actions @ @
Calculate S
+~  Plot Template Manager — @ | Muoist Air Pseudo
v  Navigator (30% hu... Components
: Object Library ‘Q @
| Actions g - x
8 Temperature survey:
Actions > Range  25.0t0 100.0°C Sea Water Seawater
Stepsize 5.0°C (Malecul..
No. steps 15 s s
No secondary survey selected
Unit Set: Metric (moles) Standard Water
Seawat... Analysis
Automatic Chemistry Model
Agueous (H+ ien) Databanks:
|Plot Template Manager L o x Agueous (H+ ion)
Using K-fit Pelynomials
T-span: 25.0 - 225.0
P-span: 1.0 - 1500.0
w Isothermal Calculation
= 25.0000 *C 1.00000 atm
Input 1 2 3 4 5 g e )
Calculation complete
Advanced Search Add as Stream Expart - v e amn
Save
,||Calculation Complete! &
v
@ NUM

Tip: If by accident we lose a tool bar, we can go to View > Toolbars >... and select the toolbar that is missing.
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For all calculations we will create one or more objects, referred to as a Streams, which are used to define a
particular chemistry, temperature and pressure.

There are five different types of calculations that can be carried out in OLI Studio : Stream Analyzer: Single
point, Survey (multiple point), Water Analysis, Mixer, and Chemical Diagram calculations. A brief definition of
each type of calculation is given below.

Point

Add
Chemical
Diagram

Add Stream is used to add a New Stream as a molecular input and define a specific
chemistry.

Single Point Calculations are used to find information (pH, volume, speciation, etc.)
at one specific equilibrium state.

Survey Calculations are useful for plotting changes in stream parameters against
temperature, pressure, or composition.

Water Analysis allows you to enter ionic inflows. i.e. allows you to enter anions and
cations.

Mixer Calculations are useful for mixing different streams. You will familiarize
yourselves with its four different mixing options, Single Point Mix, Multiplier, Ratio, and
Volume.

Chemical Diagram Calculations allows you to create a stability map for species
based on concentration and other parameters such as pH. A contour map is created
showing the user where some solids are stable and where others are not.

In these chapter several examples will be provided to cover all of these calculation types.
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Section 1. Single Point Calculations

Single point calculations are the simplest set of calculation in the software. There are 13 different single-point
calculation types, and a brief explanation of each single point calculation is provided below.

&) 0Ll Studic - [Document3*] — O x
B File Edit Streams Calculations Chemistry Tools View Window Help - 8 X
mﬁ% Idl= Cancel
D TM | 11vasolz Red miifs s | MEs GEF&D
Navigator g = x
Document3® | A
& Streams Description &¥ Definition [ Report (2 File Viewer
- Stream
A SinglePoint J Variable Value = Type of calculation
e Stream Parameters Specs...
Stream Amount (mol)y 55.5082 e lsothermal
Temperature ("C) 25.0000 )
Isenthalpic
Pressure (atm) 1.00000 d ]
- Inflows (mol) - Bubble Point ]
Hz0 555082 Dew Point
Vapor Amount
Vapor Fraction
Isochoric
Set pH
Precipitation Point
Composition Point
Actions L o~ x i .
Actions Reconcile Alkalinity
5 Autoclave
Custom
Flot Template Manager L o+ x
v
Input
Advanced Search Add as Stream Ex=port
Save
* ~
' ||Caleulation Failed!
& v
For Help, press F1 @ NUM
Isothermal The software computes solution properties based on a known composition, at a
constant temperature and pressure.
Isenthalpic A constant heat loss/gain is applied to the calculation and a temperature or pressure
can be adjusted to meet this new heat content.
Bubble Point The temperature or pressure is adjusted to reach a condition where a small amount of

vapor begins to appear.
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Dew Point The temperature or pressure is adjusted to reach a condition where a small amount of
aqueous liquid appears.

Vapor Amount The temperature or pressure is adjusted to produce a (user) specified amount of vapor.

Vapor Fraction The temperature or pressure is adjusted to produce a (user) specified amount of vapor
as a fraction of the total quantity.

Isochoric The temperature or pressure is adjusted to produce the (user) specified total volume.

Set pH The software adjusts the flowrate of a species to calculate the (user) specified pH of
the aqueous solution.

Precipitation Point  The software adjusts the flowrate of a species until a small amount of solid precipitates.

Composition Point  The composition point calculation is used to fix a species value. The software adjusts
the flowrate of a species until it reaches the (user) specified/fixed species value.

Reconcile Alkalinity The software reconciliates the alkalinity of a solution by adjusting a titrant, by default
the software uses CO:a.

Autoclave It is an isochoric (constant volume) calculation in which mass, pressure and
temperature are allowed to vary. This simulates a closed pressure vessel.?

Custom With the calculations stated so far, variables are predefined. For instance, we must
select either temperature or pressure as a variable in the dew point calculation. With
the Custom single point calculation, we can select from a wider variety of variables.

In this section, we will learn how to set up each one of these single point calculations, and will also introduce
how to use custom units, the names manager, modify the report, and other useful tips to get the most out of
your simulation results.

2 You may have to enable this calculation from Tools | Options | Enable Features Under Development
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1.1. Isothermal

The default and most basic single point calculation is the Isothermal calculation. The software computes
solution properties based on a known composition, pressure and temperature.

Example 1: Speciation and its importance for pH calculations

After completing this example, you will learn how to set up an Isothermal calculation and will also get a better
understanding of the importance of full speciation on the calculation of pH. Let’s calculate the pH of a 1 m FeCls
solutions at 25 °C and 1 atm.

Starting the Simulation

To start the software, double-click the OLI Studio icon on the desktop, which will take you to the OLI

o ; . OLI Studio
Studio interface where you can start creating your calculations. 45 -

1. Let’s create a new stream. Click on the Add Stream located in the Action Pane. When a stream is created
only H20O is present in the grid. Its cell is yellow because it cannot be removed, it is a permanent inflow.

2. For this example, we are going to use the AQ-Databank (The default databank)
Type FeClI3 in the white cell below H20 inflows grid, and press <Tab> or <Enter>

Enter the value 1.0 mol in the next cell.

& 0Ll Studio - [Document1*] - o X
B File Edit Streamns Calculations Chemistry Tools View Window Help - 8 x
= ﬁ Cancel e
D | X 14vasol2|Res |m s s | AE: SGEEeD
Mavigator L s x N
Document1* |
6:“ Streams Description (¥ Definition [ Repont
Lo Stream
J Variable Value ~ Add Calculation -
e Stream Parameters . .
Special Conditions

Stream Amount (mol) 56.5082

Temperature (°C) 25.0000 (SelEs @

Pressure (atm) 1.00000

Summary
= Inflows (mol)
Hz0 55.5082 Unit Set: Metric (moles)
FeCi3 1.00000
Automatic Chemistry Model
Agueous (H+ ion) Databanks:
Agueous (H+ion)
Using K-fit Polynomials

T-span: 25.0 - 225.0
*P-span: 1.0 - 201.0

Actions 5 * = differs from defautt.
o [E]Add Stream| [B) Add Stability Diagra
i X

Add Corresion Rate

Actions L o~ X

(4] Add Single Paint

&) Add Survey

Add Chemical Diagram
<

Plot Template Manager L - %

Input

Advanced Search Add az Stream Export
Save

x
>

For Help, press F1 @& MNUM
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Note: By default, the software populates the stream parameters table with 25°C, 1 atm, and 55.5082 moles of water. This amount of water
is 1 kg of water. All of OLI's internal agueous concentrations are based on the molal concentration scale. You will see this value frequently

throughout this manual. This effectively makes any component concentration a molal concentration.

Also, notice that the stream amount will be automatically calculated from the sum of the component inflows. To indicate that the summation

has occurred, the grid will highlight the stream amount cell in green.

5. Click the Description tab to change the name of the Stream. You can also change the name using the

<F2> key or by right-mouse click on the object and selecting rename.

6. Change the generic name Stream to pH of 1 m FeCI3

7. Add the following Description: Isothermal calculation - calculating the pH of FeCI3 1 molal solution

8. Go back to the Definition Tab

¢ 0Ll Studic - [Document1*] - X
B File Edit Streams Calculations Chemistry Tools View Window Help - 8 X
== ﬁ Cancel
== 2K | 1Mvasol2 Red mealE s s | MEs | SGEESD
Mavigator L o~ X N
Document1®
6:“ Streams Description Definition [ Report
. pHof 1 mFeCl3
Name: [pH of 1 m FeCld | Dae|4n22m3 [o
Description
Isothermal calculation - calculating the pH of FeCl3 1 molal sclution ~
Actions I v
Actions < >
[&] Add Stream 3] Add Stability Diagra
Add Mixer Add Corrosion Rate 5
(%) Add Single Point JIED
] Add suvey Unit Set: Metric (moles)
Add Chemical Diagram
< > Automatic Chemistry Model
Aqueous (H+ ion) Databanks:
Flot Template Manager Lo~ x Agueous (H+ ion)
Using K-fit Pelynomials
T-zpan: 25.0 - 225.0
*P-gpan: 1.0-201.0
* = differs from default.
Save
x
L3
&
For Help, press F1 @ MNUM
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Now, we are ready to perform a calculation

9. Go to the Add Calculation button
10. Select Single Point

Note: By default, the software selects the Isothermal type of calculation

¢ oLl Studio - [Document1*] - O X
®7 File Edit Streams Calculations Chemistry Tools View Window Help - 8 %
lor=~) ==
DEE| ¢ =028 hasitz Res meffems WEs S FE 0|
| Navigator g - x| o
Document1* |
6:“ Streams Description Definition [ Report
. pHof 1 mFeCl3 —
Variable | Value -
< Stream Parameters 5 Single Paint
Stream Amount (mol) 56.5082 3
Temperature (C) 25,0000 ey
Pressure (atm) 1.00000 Chemical Diagram
Summary
i LT R - Stability Diagram
H20 585082 Unit Set Corrosion Rates
FeCl3 1.00000
Automatic Chemistry Model
Agueous (H+ ion) Databanks:
Agueous (H+ion)
Using K-fit Polynomials
= T-span: 25.0 - 225.0
[Actions g o *p_span: 1.0 - 201.0
Actions 5 * = differs from defautt.
(&) Add Stream =) Add Stability Diagra
Add Mixer Add Corrosion Rate
(4] Add Single Point
] Add Survey
Add Chemical Diagram
< >
|Plot Template Manager L - x
v
Input
Advanced || Search Add az Stream
Save
x|
L3
&
For Help, press F1 @ NUM |
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1.

All the required variables have been entered, and the Calculate button has turned green. Click on the

Caleulate @ | button. You can also press the <F9> key to run the calculation.

Note: The calculation button has three colors depending upon the specifications:
Red - Insufficient specifications for a calculation
— Incomplete specifications but calculation can continue

Green — Completed specifications, the calculation is ready

¢ OLl Studio - [Document1*] - | X
W7 File Edit Streams Calculations Chemistry Tools View Window Help - 8 X
| EmneZE =l
DS HE & RB | 2R | Lvasi2 Res|meiffsms | sEs % e D
Mavigator L o~ X
| I
Document{* |
&% Streams Description Definition [ Report L File Viewer
o-#& pHof 1 mFeCl3 T [ calculati
. . : e of calculation
L.y SinglePoint Variable | Value ~ &
= Stream Parameters |zothermal - Specs...
Stream Amount (mol) 56.5082
Temperature (*C) 25.0000 Caloulate @@
Pressure (atm) 1.00000 Surnmary
= Inflows (mol)
H20 55.5082 Unit Set: Metric (moles)
F2ED 1.00000 Automatic Chemistry Model
d Agueous (H+ ion) Databanks:
Agueous (H+ ion)
Using K-fit Pelynomials
T-zpan: 25.0 - 225.0
| Actions L o x *Pgpan: 1.0 - 201.0
Actions N * = differs from default.
Isothermal Calculation
25.0000 *C 1.00000 atm
Calculation not done
|Plot Template Manager g - x
v
Input
Advanced Search Add az Stream Export
Save
x|
L3
&
For Help, press F1 @ NUM |
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12. Please save the file (File >Save as...) and type an appropriate name, for example Single Point

Calculations.

0Ll Studio - [Decument1*] — e
File Edit Streamns Calculations Chemistry Tools View Window Help - 8 X
I] Mew Ctrl+ M Cancel |
G -0 Go12 [Res me sl time MBS BB D
e Close
LY
Da Save Ctrl+S b
& Description Definition [ Report
im
(O Variable Value
B Ctrl+P = Stream Parameters Spesial Candiions
Print Previ Stream Amount (mel) 56.5082
rint Preview i
Temperature (*C) 25.0000 [ solids Only
Print Setup...
Pressure (atm) 1.00000 S:rﬁﬁqar}ﬁ Subform
Properties = Inflows (mol)
H20 55.5082 Unit Set: Metric (moles)
1 Barossa Scale Model-3.0ad FeCl3 100000
2 Barossa Scale Model-3.0ad Automatic Chemistry Model
q (H+ ion) Databanks:
3 Intertek Polarization.oad Agueous (H+i;n}
4 Intertek Polarization.oad Using K-fit Polynomials
E T-span: 25.0 - 225.0
|: Exit *P-gpan: 1.0 -201.0
Acl * = differs from default
[&] Add Stream =) Add Stability Diagra
Add Mixer Add Corrosion Rate
Add Single Point
] Add Survey
Add Chemical Diagram
£ >
|Plot Template Manager L o« x
Input
Advanced || Search Add &z Stream
Save
x|
L3
&
Save the active document with a new name @ NUM
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When the “Calculation is complete” a check mark appears on the calculation object & Now, let’s analyze

the results of the simulation.

¢ 0Ll Studio - [Single point calculation_Example_1.0ad)] — O e
B File Edit Streams Calculations Chemistry Tools View Window Help - 8 x
| RS - =l
D& | PR Uvasol2[Red|m s MBS G NE D
| Navigator g x| oy
Single point calculation_Example_1.0ad |
&% Streams Description Definition [ Report L File Viewer
5. & pHof 1m FeCl3 i
aép . R Variable | Value Tupe of calculation
L fye SinglePoint
= Stream Parameters |zothermal - Specs...
Stream Amount (mol) 56.5082
Temperature ("C} 25.0000 Calculate @ |
Pressure (atm) 1.00000 Surnmary
= Inflows (mol)
H20 55.5082 Unit Set: Metric (moles)
FeCl3 1.00000
¢ A i Chemistry Model
Agueous (H+ ion) Databanks:
Agueous (H+ ion)
Using K-fit Pelynomials
T-span: 25.0 - 225.0
| Actions L o x *Pgpan: 1.0 - 201.0
Actions A * = differs from default.
Isothermal Calculation
25.0000 *C 1.00000 atm
Phase Amounts
Agueous 594855 mol
Vapor 0.0 mol
Solid 0.0 mol
Agueous Phase Properties
|Plot Template Manager L - x pH 221505
lonic Strength  0.0997597 mol/mol
Density  1.11950 g/ml
Calc. elapsed time: 0.428 sec
Input  Output
Calculation complete
Advanced Search Add az Stream Export
Save
x| ~
'||Calculation Completel
3— L
For Help, press F1 @ NUM |

Anaylyzing the Results

The summary box displays a partial set of results including pH, density, and volume, as well as the total

calculation time.

The pH is calculated to be approximately 2.2
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Let’'s analyze the simulation results in more detail

13. Click on the Report Tab
14. Scroll down and find Species Output (True Species). You will find a list of the all the different species

present in the aqueous phase.

¢ 0Ll Studio - [Single point calculation_Example_1.0ad)] — O e
B File Edit Streams Calculations Chemistry Tools View Window Help - 8 x
=y =] = Vg L1 Va So L2 |[Re & |mse & M52 3 40 3 MEL S EE D
Mavigator L o~ X A
Single point calculation_Example_1.0ad |
6:“ Streams Description Defi (@ Report 2 File Viewer
=& pHof 1 mFeCl3
i & SinglePoint Jump to: | Species Output [True Species) ~ a Custarnize Expart
@ Species Qutput (True Species)
Row Fiker Agglled: Gny hon Zero Vales A
column FRer Appled: Onk Nom Zero Vales
Total Aqueous
maol maol
H20 55503 55.503|
CH 237833 297833
Fe+2 0583345 0.382345
FeCl2+1 5832183 5832183
Actions I
- H+1 5289423 5289423
Actions
FeOH+2 5275723 5275723
FeCh2 1207313 1207313
FeCI3 i 2250814 2250814
FeCl-1 6473268 6473268
Fe{OH}2+1 6358926 6358926
Fe2{OH)2+4 4785457 4785457
HCI 2837929 2837929
Plot Template Manager p o x Fe{OH)3 (Bernalite) 20703729 20703729
OH-1 505652=-13 9.05652=-13|
Fe{OH}4-1 11180318 1.11803=-18|
Total (by phase) 52,4888 55,4868
v
Save
x ~
'||Calculation Completel
3 v
For Help, press F1 @ MNUM

Why is the pH so low?

The aqueous iron species complexes the hydroxide ions. The water dissociation shifts in the direction to
replenish the hydroxide ions3.

This equilibrium is always present:

H,0 = H* + OH™

3 Le Chatelier’s principle. P.W.Atkins. Physical Chemistry. W.H. Freeman and Company, San Francisco (1982) p 269.
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Speciation Reactions
First iron (Ill) chloride dissociates:
FeCly; —» Fe®* +3CI
Then the Fe** interacts with water; hydrolysis reaction:
Fe** + H,0 —» FeOH?** + 2H*
Then another water molecule enters into the reaction:
FeOH?** + H,0 < Fe(OH),* + H*
These last two reactions take up the OH- from solution, and release H* into the solution

More speciation reactions occur, but the reactions above where shown as an illustration. The following is a list
of all the species that are formed in the aqueous phase:

Fe*s FeClo*! Fe(OH):° Ho00
FeCl*2 Fe(OH)z*" OH-" HClP
FeOH*2 H*+! FeCls Fez(OH)2*
cH FeCls? Fe(OH)s"

pH Calculation
The pH is calculating using the following formula:
pH = —log(my+yy+)

For the pH calculation the molality and the activity coefficient of the H* species is needed. To reveal the activity
coefficients calculated by software follow the steps below.
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15. Click on the Customize Button

16. Select Species Activity Coefficients
17. Click OK

17 Cancel Apply Help

6 oL o X
W7 File Edit Streams Calculations Chemistry Tools View Window Help = =
| EORER =
DM | (@R | Hwsiz[rRes | mifiies MEL GEEHD
| Navigator L oax| A
Single point calculation_Example_1.0ad ‘
4% Streams & Description & Definition @ Report CF File Viewer
=& pHof 1 mFeCi3
4 SinglePoint Jump to: | Species Dutput (True Species] ~ Export
Report Contents 7 X SpeciesQutput (True Specie:
Row FiRer Apgiss: Ony Nom Zerm Vakes ~
Category Report Contents gakmn FRerApelied: Gay Nan Zere Vakes
[=- Report Contents X
Calculation Surmary| 12 dd or remave a section, click the check box. A shaded box Total Aqueous.
s Il means that only part of the component wil be printed. To see what's — el
ream Inflas included in 2 component, click Details
- Speciation Summary ) H20 55502 55.502|
Siream Parameters Sections = pEp— 2o7aa3)
Tota.IfPhase Flows [ Calculation Summary ~ =) Py Py
- Gealing Tendencies ] Stream Inflaves
Species Dulpul ]S peciation Summary T FeC+1 88221823 58321823
- Malecular Dutput Stream Parameters H+1 5289423 5239423
- Element Balance Tatal/Phase Flows FeOH+2 527572e-2, 52757223
Species Activity Cogl Sealing Tendencies FeCh2 13079123 130731e-3
SDB_C\ES Fugacities FeCI3 (Molysite) 235081e-4, 22508 1e-4
- Partial Pressures e P aTazen
Spacies K-Values OH)2+1 8358928 6358928
Species Mobilities Fe(OH)2+
- Gpecies Self Diffusiv] Fe2[OH[2+4 478545 7] 47864527
Vapar Phase Diffusiy [[]Partial Fressures E HCI 253792e-9| 26279228
Gibbs Free Energy o []Species K'\"E_MES 1] Fe{OH)2 (Bernalite) 207037e-9| 20703729
- Gibbs Free Energy | |[]Species Mobilties OH-1 205652212 505852213
- Entropy [ 5pecies Self Diffusiviies
0t Do Pvits ot s v Fe(OH)4-1 1.118032-16)  1.11802=-1§)
Entrapy - Standard 5| E— y—" p—
- Reaction Kinetics
 Raciox Equations Up Down Select Al Clear Al v
Deescription
This section displays the tnue species activity coefficients.
~
6 of 22 Sections selected v
MNUM |
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18. Go to the Report and scroll down or use the Jump to option and select Species Activities/Fugacity

Coefficients.
¢ 0Ll Studio - [Single point calculation_Example_1.0ad)] — O e
B File Edit Streams Calculations Chemistry Tools View Window Help - 8 X
=y =] = Vg L1 Va So L2 |[Re & |mse & M52 3 40 3 MEL S EE D
Mavigator L o~ X A
Single point calculation_Example_1.0ad |
6:“ Streams Description Definition [E Report L2 File Viewer
=& pHof 1 mFeCl3
. 4 SinglePaint I Jurnp to: I Species Activity/Fugacity Coefficient: ~ @ |8, Customize Export
Stream P
Total and Phaze Flows [Amounts]
Specie| Scaling Tendencies A
ow Finer] SPEcies Dutput (True Species)
Fugacity
L L Coefficients
Species x-based m-based
CH1 0.82871 0.588807
FeCl3 - Aq 2.58304 23914
Fe2{OH)2+4 488808e-2 4540213
s 7 - x FeC2+1 0.458843 0.428208
Actions FeCl4-1 1.87281 174842
FeCH2 0.28571 025164
Fe+3 1.4323e-3 1.336838e-3
Fe{OH)2+1 0.701115 0.654184
Fe{OH)3 - 2q 2.56304 23914
Fe{OH}4-1 1.87281 174842
FeOH+2 0.28571 025164
H20 1.01807| 0.948897
Flot Template Manager L o x
HCI- Ag 2.58304 23914
|[H+1 1.2 115211
OH-1 1.87255| 174715
v
Save
x ~
'||Calculation Completel
3- L
For Help, press F1 @ MNUM

Thus, the pH is:
pH = —log(my+yy+)
pH = —10g[(5.28940 x 1073)(1.15211)]
pH = —10g[6.094 x 1073]
pH =2.2151

It is time to save your file (File >Save as...) or using the save icon in the tool bar. We save this example initially
as Single Point Calculations.
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Example 2: Calculating the pH of an acetic acid solution

In this example, we will explore an isothermal calculation and how to set up the right units before you start your
calculation. Let’s calculate the pH of a 10 wt% acetic acid solution. The temperature and pressure will be 75°C
and 1 atm, respectively.

Starting the Simulation

1

2
3.
4

Actions
o 8] Add Stream
TR Edd Micer

Add a new Stream

Click on the new Stream and press <F2> to change the name to Isothermal — acetic acid

Select the AQ thermodynamic Framework (selected by default)

Click on the Units Manager Icon, and the Units Manger window opens

{ OLlStudio - [Single point calculations.cad®]

OD=E| +
Mavigator Lo+ x
Single point calculations.oad*

B File Edit Streams Calculations Chemistry Tools View Window Hel

- & X

&% Streams
- |sothermal

- |sothermal
|sothermal - acetic acid

Actions Lo~ x

@) Add Stability Diagra
Add Corrosion Rate

[£] Add Single Paint

E) Add Survey
Add Chemical Diagram

£ >
Flot Template Manager L o+ X
Save

Cancel
o MEE R i
B K2 |11 vaSol2 Red me ¥ U 8 44 & & O
¢
Description Definition [ Report
J Variable Value Add Calculation -
= Stream Parameters . -
Special Conditions

Stream Amount (mol} 55.5082 5

Temperature (°C) 25.0000 L] Solids Only

Pressure (atm) 1.00000

Summary
= Inflows (maol)
H20 55.5082 Unit Set: Metric (moles)
Automatic Chemistry Model
Aguecus (H+ ion) Databanks:
Agueous (H+ion)
Using K-fit Polynomials
T-span: 25.0 - 225.0
*P_gpan: 1.0 -201.0
* = differs from default.
Input
Advanced Search Add az Stream Export

=

*||Calculation Complete!
i

For Help, press F1

@ NUM
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5. Click on the Customize Button

Units Manager - sothermal - acetic acid ? >
Units Manager
|Metric V| |Batch V| |M::4E5 V| III
O
| Ok | | Cancel | Apply Help

6. Let's change only the Inflows units. Click on the white box, select the drop-down arrow next to the unit,

and select Mass Fraction. Click OK, to exit the Units Manager and go back to the Definition tab.

Edit Units - |sothermal - acetic acid

T >

(®) Batch System () Flowing System

Composition  Parameters  Corrosion

Variable

| Baszis | Units ~

Inflow variables

Stream Amount

Inflows

Agueous Composition

Wapor Composition

Solid Composition

2nd Liguid Composition

Total Composition

Moles

Concentration mol

Molar Concentration =

Mags Fraction

Tfole Eraction —
mal

Basis options

Moles mol

Maszs g

Wolume L

Cencentration mgiL

Molar Concentration mol’L

Mass Fraction mass % ,
rrnla 0L

Mnala Frarstinn

Q ok | cCancel | Heb

Note: The default unit is mass%, however you can change

Mass Fraction

it to other to ppm (mass) or g/g.

Mrla Frastinn

ppm (Mass)
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We are now ready to enter the information to set up the single point calculation.

Go to the Add Calculation button and select Single Point. Select the default calculation type — Isothermal

Change the name to pH using the <F2> key or by right-mouse click on the object and selecting rename

1
2
3. Change the temperature to 75°C and pressure to 1 atm
4

Type Acetic Acid in the white cell below H20 inflows grid, and press <Tab> or <Enter>

Note: If the name Acetic Acid changed to the formula type i.e. CH3COOH, or the OLI TAG name, i.e. ACETACID, you can change

the name style to Display Name by clicking on the Names Manager icon B

5. Enter the value 10 mass% in the next cell.

Note: When using mass-fraction units, it is assumed that the amount of water will be the difference of the components entered. In

this case, the value field is highlighted in yellow to inform you that the value will be determined from the values of the other components.

6. Click on the Calculate button

¢ Ol Studic - [Single point calculations.oad*] - O *
B File Edit Streams Calculations Chemistry Tools View Window Help - 8 X
LD E TR L1vasol2 Red |medi3 s HAEFm: GEHFHD
Mavigator L o~ X A
Single point calculations.oad* |
&% Streams Description Definition [ Report L File Viewer
E-#& lsothermal .
Lo 0 lsathermal J Variable Value o Tuvpe of calculation
: lsothermal - acetic acid = Stream Parameters |sothermal A Specs...
LA pH Stream Amount (mol) 55,5082
Temperature ("C} 75.0000 Calculate 0(3
Pressure (atm) [ 1.00000 SuER
= Inflows (mass %)
Water 50.0000 | Unit Set: <Custom=
Aceti id 10.0000
ceticac Automatic Chemistry Model
Agueous (H+ ion) Databanks:
Agueous (H+ ion)
Using K-fit Pelynomials
= T-zpan: 25.0 - 225.0
Ac“f’”s B oo X *P_gpan: 1.0 - 201.0
Actions * = differs from default.
Isothermal Calculation
75.0000 *C 1.00000 atm
Calculation not done
Flot Template Manager L o x
Input
Advanced Search Add az Stream Export
Save
x ~
'||Calculation Completel
3- L
For Help, press F1 @ MNUM
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Anaylyzing the Results
After the calculation is complete, another way of analyzing the results is using the Output mini-tab.

1. Click on the Output mini-tab

2. Right-click on the gray area and select Sections

3. Select Additional Stream Parameters

~  Stream Parameters
~  Calculation Results

+~  Inflows

¢ oU Studio - [Single point calculations.oad®] Related Inflows
B File Edit Streams Calculations Chemistry Tools View Window Help Additional Stream Parameters - 8 X
== ﬁ Idle Cancel Phase Flow Properties
= ? N2 11 VaSo L2 Re & |me & U & 0 8 P Thermodynamic Properties
Navigator r oax A Pre-scaling Tendencies
Single point calculations.oad® | Pre-scaling Index
&% Streams Description Definition [ Report LI F Scaling Tendencies
E| ¢ Isothermal g Scaling Index
. iy |sothermal | Variable ! A
: : H Stream Parameters queous
=& |sothermal - acetic acid = FEE
. & pH [l Stream Amount (mol) Vapor
L Moles (True) - Aqueous (mol) Solid
Temperature (*C) Molecular Apparent - Aqueous
Pressure (atm) Totals
Infl %
i o ) Molecular Totals
Water
Acetic acid MBG Totals ¥
Activity Coefficients ¥
Fugacity Coefficients ¥
ACions 2o Fugacities - Vapor
Actions
K-Values >
Gibbs Free Energy
o=k nanercs Gibbs Free Energy Standard State (x-based)
Save default layout Entropy
Generate Model Entropy Standard State (x-based)
Mobilities
Flot Template Manager L o+ X pirierslialuss Self Diffusivities ¥ ol
iolimo
Sections > Partial Pressures
v
Calc. elapsed time: 0.029 zec
Olutput
Calculation complete
Advanced Search Add az Stream Export
Save
x ~
'||Calculation Complete!
3- L
For Help, press F1 @ MNUM

The Sections section offer more results such as Thermodynamic Properties, Scaling Tendencies, Equilibrium constants (K-
values), etc., that you can further explore.
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So, the calculated pH of this acetic acid solution is approximately 2.3.

Variable [ Value
T Stream Parameters
E| Stream Amount {mol) 555082
L Moles (True) - Aqueous (mel) 55.5133
Temperature (*C}) T5.0000
Pressure (atm} 1.00000
E Inflows (mass %)
Water 50.0000
Acetic acid 10.0000
= Additional Stream Parameters
Density - Agueous (g/'ml) 0.773204
Density - Total (o/ml} 0.773254
lonic Strength (m-based) - Aqueous (m 5.17899%e-3
lonic Strength (x-based) - Agueous (m 9.02834e-5
pH 232267
Standard Liquid Volume - Aqueous (L) 1.073638

Input  Output

Advanced Search

Add ag Stream

Export

Tupe of calculation

|zothermal - Specs..,

Calculate &8 |

Sunmmany

Unit Set: =Custem=

Autematic Chemistry Model

Agueous (H+ ion) Databanks:
Agueous (H+ ion)

Using K-fit Pelynomials
T-span: 25.0 - 225.0
*P-zpan: 1.0 - 201.0
* = differs from default.

Izothermal Calculation
75.0000 *C 1.00000 atm

Phase Amounts
Agqueous 107527 g
apor 0o0g
Solid 00g

queous Phase Properties
pH 2.32267
lenic Strength  9.02834e-5 molmol
Density  0.773254 g/ml

Calc. elapsed time; 0.029 sec

Calculation complete

It is time to save your file (File >Save as...) or using the save icon in the tool bar. You can save under the
same file that we created in Example 1 named as Single Point Calculations.
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1.2. Bubble Point

Liquid boils when its vapor pressure exceeds its confining pressure. Boiling occurs by adding heat (isobaric
boiling) or reducing confining pressure (isothermal boiling). Either way, the effect is the same: a vapor phase
forms. Stream Analyzer calculates this phenomenon using a calculation type called Bubble Point. Since the
OLI does not assume an air phase, the confining pressure acts like a plunger on a liquid’s surface. The pressure
the plunger exerts is the pressure specified in the software.

With the software, the temperature or pressure is adjusted such that a very small amount of vapor will form (i.e.
1x10-10 of the total stream amount in gmoles). This is another way of saying that the bubble point calculation is
a determination of the boiling point. Usually we determine the temperature at which a solution will boil. If the
pressure is set to 1 atm, then we calculate the Normal Boiling Point. If we set a constant temperature, then
we determine the bubble point pressure.

Example 3: Calculating the Bubble Point of a 1 M Acetone Solution

In this example, we are going to compute the bubble point of a 1 M Acetone solution, by changing the
temperature (isobaric) and then the pressure (isothermal). Additionally, you will learn how to change the Inflows
units from moles to moles/L (M).

Starting the Simulation

Use the inputs and parameters from the table below to create the stream’s composition. Certain inputs, such
as the name style, units, etc. will require further adjustments, and will be described as necessary.

Bubble Point Calculation

Calculation Settings Stream Composition and Conditions
Calculation Type Single Point Calculation | Stream Amount 1L
Calculation Sub-type Bubble Point Temperature 25°C
Stream Name Acetone Bubble Point Pressure 1 atm
Name Style Display Name Water Calculated
Unit Set Custom Acetone 1 mol/L
Framework MSE

Calculating the Bubble Point Temperature (Isobaric)

1. Add a new Stream

2. Click on the new Stream and press <F2> to change the name to Acetone Bubble Point
3. Select the MSE thermodynamic Framework

4. Click on the Names Manager Icon, and select the Display Name option, and click OK
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Mames Manager ? >

Mame Style  Search Criteia  Mames Dictionany

Component Mame Style

(®) Display name

Use Mames Dictionary

5. Click on the hyperlink mol next to Stream Amount

Variable | Value
= Stream Parameters
Stream Amount (mel 55.5082
Temperature (:C) 25,0000
Pre=sure (atm) 1.00000
= Inflows (mol)
Water 55.5082

6. This will open the Units Manager. Under Inflows, select the option of Molar Concentration. It will

automatically set the Stream amount as Volume in Liters. Then click OK.

Edit Units - Acetone Bubble point ? >
(®) Batch System () Flowing System
Composition  Parameters Corrosion
Variable | Basis | Units Py
Inflow variables
Stream Amount Volume L
Inflows - | mol’L
Output variMass
Agueous Composition Moles mol
‘apor Cemposition ' mol
Solid Composition mol
2nd Liguid Composition M?T;SFr?dinn mol
Tetal Compoesition mol
Basis options
Moles mol
Mass g
Volume L
Concentration mgfL
Melar Cencentration mol’L
Mass Fraction mass % -
Mnla Fractinn mnla 0L
| OK | | Cancel | | Help |

7. Type Acetone in the white cell below H20 inflows grid, and press <Tab> or hit <Enter>, and then enter

the value 1.0 mol/L in the next cell.

8. Go to the Add Calculation button and select Single Point calculation
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9. Select Bubble point as Type of Calculation.
10. Change the SinglePoint name to Bubble Point Temperature using the <F2> key
11. A new section appears in the grid, called Calculation Parameters. By default, the Temperature Bubble

Point calculation is selected. For this calculation leave the default calculation: Temperature

Note: In the drop-down arrow you have the option to select Bubble Point Temperature or Bubble Point Pressure.

Variable Value
= Stream Parameters
Stream Amount (L) 1.00000
] Temperature (*C) 25.0000
5] Pressure (atm) 1.00000
= Calculation Parameters
Calculate p -
= Inflows P
e Pressure
Acetone 1.00000

Note: There are also two dots to the left of the Temperature and Pressure rows. The yellow dot represents the “dependent”
variable. The temperature value, 25.000 is colored green. This value is now an initial guess, since the final value will be
computed. The brown dot adjacent to the Pressure variable indicates that this potentially dependent variable is “fixed”.

12. We are ready to perform the calculation. Click on the Calculate button or press the <F9> key.

13. Itis time to save your file (File >Save as...) or using the save icon in the tool bar. You can save under the
same file that we created before named as Single Point Calculations.
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Anaylyzing the Results

Review the Summary Box. The temperature at the bubble point is computed to be 87.11°C at 1 atm. Also notice
that the Vapor amount is ~ 5.074e-9 moles out of the total Aqueous amount of 50.74 moles. This is by design;
the software sets the amount of vapor at 1/10% the moles of the stream amount.

Unit Set; =Custom:=

Automatic Chemistry Model
MSE (H30+ ion) Databanks:
MSE (H30+ ion)
Using Helgeson Direct

Bubble Point Calculation
1.00000 atm
87 1143 °C

Phase Amounts
Agqueous  S0.7382 mol
Vapor 5.07382e-9 mol
Solid 0.0 mol

Agueocus Phase Properties
pH 6.23654
lonic Strength 1.04244e-8 mol'mol
Density  0.954131 g/ml

Calc. elapzed time: 0.725 zec

Calculation complete
Calculating the Bubble Point Pressure (Isothermal)
This next calculation computes the bubble point pressure for the same stream.
Select the Stream named Acetone Bubble point

Go to the Add Calculation button and select Single Point calculation

1

2

3. Select Bubble point as Type of Calculation.

4. Change the SinglePoint name to Bubble Point Pressure using the <F2> key
5

Change the Calculate-Temperature row to Calculate-Pressure

e Calculation Parameters

Calculate Pressure hd
e Inflows [moliL)

Water

Acetone 1.00000

6. Click on the Calculate button or press the <F9> key.

7. ltis time to save your file (File >Save as...) or using the save icon in the tool bar.
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Anaylyzing the Results

Review the Summary Box. The bubble point pressure is computed to be 0.0700550 at 25 °C. Also notice that
the Vapor amount is ~ 5.278e-9 moles out of the total Aqueous amount of 52.78 moles.

Unit Set; =Custom=

Automatic Chemistry Model
MSE (H30+ ion) Databanks:
WMSE (H30+ ion)
Uzing Helgezson Direct

Bubble Point Calculation
25.0000 *C
0.0700550 atm

asze Amounts

Agueous 527833 mol
apor 5.27833e-5 mol
Solid 0.0 mol

Agueous Phase Properties
pH 6.99771
lonic Strength  1.81453e-5 mol'mol

Density 0.990973 g'mil
Calc. elapsed time: 0.047 sec

Calculation complete
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1.3. Dew Point

The Dew Point is defined as the temperature at which a condensable component of a gas, for example water
vapor in the air, starts to condensate into liquid. OLI Studio: Stream Analyzer calculates this phenomenon using
a calculation type called Dew Point. With the software, the temperature or pressure is adjusted such that a very
small amount of liquid will form.

It is frequently useful to determine the temperature or pressure at which a gas will condense. If the pressure is
set constant, we calculate the dew point temperature; if the temperature is constant, then we determine the
dew point pressure.

Example 4: Calculating the Dew Point of a Simple Sour Natural Gas

In this example, we are going to compute the dew point of a simple sour natural gas, by changing the
temperature (isobaric) and then the pressure (isothermal).

Starting the Simulation

Use the inputs and parameters from the table below to create the stream’s composition. Certain inputs, such
as the name style, units, etc. will require further adjustments, and will be described as necessary.

Dew Point Calculation

Calculation Settings Stream Composition and Conditions
Calculation Type Single Point Calculation Stream Amount | Default — 55.5082 moles
Calculation Sub-type Dew Point Temperature 120 °C
Stream Name Sour Natural Gas Dew Point | Pressure 100 atm
Name Style Display Formula H20 Calculated
Unit Set Metric, Mole Fraction CO2 1 mole %
Framework MSE CHas 95 mole %
H2S 3 mole %

Calculating the Dew Point Temperature (Isobaric)

1. Add a new Stream

2. Click on the new Stream and press <F2> to change the name to Sour Natural Gas Dew Point
3. Select the MSE thermodynamic Framework
4

Click on the Names Manager Icon, and select the Formula option, and click OK

Mames Manager ? >

Mame Style  Search Criteria  Mames Dictionary

Compaonent Mame Style
() Digplay name
|Ise Mames Dictionary

(®) Formula
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5. Click on the Units Manager Icon, and select Metric, Batch, Mole Frac. This will change all inflows to

mole %.

Units Manager - Laden Gas Dew Point ? =

Units Manager

Metric w Batch  w Moles e L4
Males

Malar Conc,
Mass
Conc,

Customize...
Mass Frac.

Cancel Apply Help

6. Enter the composition of the gas given in the table above
7. Go to the Add Calculation button and select Single Point calculation
8. Select Dew point as Type of Calculation
9. Change the SinglePoint name to Dew Point Temperature using the <F2> key
10. Keep the Calculate-Temperature option
B Variable Value
e Stream Parameters
Stream Amount (mel) 55.5082
e} Temperature (*C}) 120.000
5] Pressure (atm} 100.000
e Calculation Parameters
Calculate Temperature
G Inflows [mole %)
H20 1.00000
co2 1.00000
CH4 85.0000
H2S 3.00000

11. We are ready to perform the calculation. Click on the Calculate button or press the <F9> key
12. Create a new SinglePoint and name it Dew Point Pressure. Repeat the steps above, and select the

Calculate-Pressure option
13. Itis time to save your file (File >Save as...) or using the save icon in the tool bar. You can save under the

same file that we created before named as Single Point Calculations.
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Anaylyzing the Results

Review the Summary Box. The calculated dew point temperature is 113.5°C. The calculated dew point pressure
is 129.8 atm.

Dew Point Dew Point
Temperature Pressure
Unit Set: Metric (mole fraction) Unit Set: Metric (mole fraction)
Automatic Chemistry Model Automatic Chemistry Model
MSE (H30+ ion}) Databanks: MSE (H30+ ion) Databanks:
MSE (H30+ ion) MSE (H30+ ien)
Using Helgeson Direct Using Helgeson Direct
Dew Point Calculation Dew Point Calculation
100.000 atm 120.000 °C
91.9154°C 472.561 atm
Phase Amounts Phase Amounts
Agueous 5.55082e-5 mol Agueous  1.00000e-8 mol
Vapor 55 5082 mol Vapor 55.5082 mol
Solid 0.0 mol Solid 0.0 mol
Agueous Phase Properties Agueous Phase Properties
pH 377521 pH 3.58375
lonic Strength  3.15475e-6 mol'mol lenic Strength  5.08513e-6 molmol
Density  0.950536 g/ml Density  0.953852 g/ml
Calc. elapsed time: 0.437 sec Calc. elapsed time: 0.043 sec
Calculation complete Calculation complete

Note: The software sets the amount of liquid to 1/10° of the stream amount for the dew point calculation.

You can study the composition of the acid gases such as CO2 and HzS dissolved in the Aqueous phase.
After you have calculated the Dew Point Pressure, click on the Report Tab. Scroll down or use the Jump to
option to go to the Species Output (True Species).

Jump ter | Species Dutput (True Species] ~ | @ Ek Customize Export
Species Output (True Species) A
Row Filter Applied: Onfy Non Zero Values
column Filter Applied: Onhy Non Zero Values

Total Liquid-1 Vapor
male % male % male %
CH4 95.0 0.346846 95.0
H2S 30 0.305546 30
coz 1.0 0.0428733 1.0
H20 1.0 99.3036 0.999998
H30+1 9.16104e-12 5.08513e-4
HS1 T.77131e12 4.31372e-4
HCO31 1.38954e-12 7.71308e-5
OHA 1.91059e-16 1.06054e-8
C03-2 6.99104e-19 3.88067e-11
52 5.6492e-20 3.13577e-12
Total (by phase) 100.0 100.0 100.0

The aqueous phase, also known as Liquid-1 in the MSE framework, is shown in the center column. The
dissolved CH4, H2S, and COz are 0.347, 0.305, and 0.043 mole % respectively.



1.4. Isochoric (constant volume)

The Isochoric calculation fixes the total system volume and adjusts the temperature or pressure. This can
be understood in a gas-phase from the basis of the Ideal Gas Law:

PV =nRT

If temperature is the free variable, then the above equation becomes T = %, meaning that for a given volume,
pressure, and gas moles, temperature can be obtained.

You will run a calculation, in which the system moles, temperature and volume are defined.
Example 5: Calculating the Total Pressure of a 10 L Vessel Containing Water and Air

In this example, you will add 1 kg water to a 10 L vessel and then fill the void (head space) with Air. The
temperature is 25 °C.

Starting the Simulation

Use the inputs and parameters from the table below to create the stream’s composition. Certain inputs, such
as the name style, units, etc. will require further adjustments, and will be described as necessary.

Autoclave Calculation

Calculation Settings Stream Composition and Conditions
Calculation Type Single Point Calculation Stream Amount Default — 55.5082
Calculation Sub-type Isochoric Ambient Temperature | 25 °C
Stream Name Isochoric H20 Calculated
Name Style Display Formula N2 77 moles
Unit Set Metric, Moles 02 21 moles
Framework AQ CO2 1 mol
Calculate Pressure Ar 0.04 moles
Vessel Volume 0L

Add a new Stream

Click on the new Stream and press <F2> to change the name to Isochoric
Select the AQ thermodynamic Framework

Click on the Names Manager Icon and select the Formula option

Click on the Units Manager Icon, and select Metric, Batch, Moles

Enter the gas composition in the table above

Go to the Add Calculation button and select Single Point calculation
Select Isochoric as Type of Calculation

Change the SinglePoint name to 10L Vessel using the <F2> key

=2 © © N o o bk 0w DN =

0. In the Calculation Parameters section set Total Volume to 10 L and Calculate Pressure. (To select

Pressure, click on the drop-down arrow).
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Variable Value
= Stream Parameters
Stream Amount (mol) 154 548
@ Temperature (*C) 25.0000
s} Pressure (atm} 1.00000
= Calculation Parameters
Total Volume (L) 10.0000
Calculate Pressure hi
= Inflows (mol)
H20 55.5082
N2 77.0000
02 21.0000
coz 1.00000
Ar 0.0400000

11. We are ready to perform the calculation. Click on the Calculate button or press the <F9> key
12. ltis time to save your file (File >Save as...) or using the save icon in the tool bar. You can save under the

same file that we created before named as Single Point Calculations.

Anaylyzing the Results

Review the Summary Box or Click on the Output-Minitab to see the Results.

Type of calculation

Variable [ Value A
- Stream Parameters | |zochoric - | | Specs... |
[=] Stream Amount (mel) 154.548
|— Moles (True) - Agueous (mol) 55,6901 Calculate & |
L Moles (True) - Vapor (mol) 838582 Summary
@ Temperature (*C) 25.0000
= Calculation Results (atm) Unit Set: Metric (moles) ~
P 305.676
O] Fressure | Automatic Chemistry Model
2 Inflows (mol) Agqueous (H+ ion) Databanks:
H20 55 5082 Agueous (H+ ion)
Using K-fit Polynomials
H2 770000 5 T-span: 25.0 - 225.0
o2 21.0000 *Pgpan: 1.0 -204.0
coz 1.00000 * = differs from default.
Ar 0.0400000 Isochoric Calculation
25.0000°C
305.678 atm
Phase Amounts
Agueous 555901 mol
apor 58.8582 mol
W Solid 0.0 mol
Input  Cutput Aqueous Phase Properties
pH 3.82308 v
lenic Strength  2.73534e-8 mel'mol
| Advanced || Search || Add az Stream || E spaort | Meanois 491,“.,“ -

About 305.7 atm of pressure are needed to compress the 154.55 moles of gas and liquid into a 10-L volume
vessel at 25 °C.
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Go to the Report tab and view the Total and Phase Flows (Amount) table.

Total and Phase Flows (Amounts)

column Filter Applied: Onhy Mon Zero Values

Total Aqueous Vapor
mal mal mal
Mole (True) 154 548 556901 93.8582
Mole {App) 154.548 55.6901 93.8582
! a a
Mass 387481 1006.11 286851
L L L
Volume 10.0001 0.994072 §.00558

The system is 10 L as defined (within the 1/108 tolerance). The water phase makes up slightly less than 1 L
and the balance is vapor. At this pressure, about 0.1527 moles of water evaporates, and contributes to the total

moles of vapor.
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1.5. Vapor Amount and Vapor Fraction

The vapor amount and vapor fraction calculations are identical in nature to the Bubble Point calculation,
except that instead of the software defining the vapor amount as 1x10-0 of the total stream amount, the user
defines the vapor size in either mole fraction units (vapor fraction) or mole units (vapor amount). To create a
specified amount of vapor (or vapor fraction) the software can adjust the temperature (or pressure).

Example 6: Evaporating a Brine

In this example, you will concentrate a brine via evaporation adjusting the temperature, until reaching a vapor
fraction amount of 95 mole %.

Starting the Simulation

Use the inputs and parameters from the table below to create the stream’s composition. Certain inputs, such
as the name style, units, etc. will require further adjustments, and will be described as necessary.

Vapor Fraction / Vapor Amount Point Calculation

Calculation Settings Stream Composition and Conditions
Calculation Type Single Point Calculation Stream Amount Default - 1 kg
Calculation Sub-type Vapor Fraction Temperature 25°C
Stream Name Brine Evaporation — Vapor Fraction | Pressure 1 atm
Name Style Display Formula H20 Calculated
Unit Set Metric, Mass Fraction NaCl 9 mass %
Framework MSE CaS0q4 1 mass %

Calculating the Vapor Fraction Temperature (Isobaric)

13. Add a new Stream

14. Click on the new Stream and press <F2> to change the name to Brine Evaporation — Vapor Fraction
15. Select the MSE thermodynamic Framework

16. Click on the Names Manager Icon and select the Formula option

17. Click on the Units Manager Icon, and select Metric, Batch, Mass Frac. This will change all inflows to
mass %.

Units Manager - Brine Evaporation - Vapor Fraction ? *

Units Manager

Metric w Batch Mass Frac, L4
Moles
Mole Frac.
Molar Conc.
Mass
f Conc.
Customize,..

Cancel Apply Help
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18. Enter the gas composition given in the table above.

19. Go to the Add Calculation button and select Single Point calculation

20. Select Vapor Fraction as Type of Calculation

21. Change the SinglePoint name to Vapor Fraction Temperature using the <F2> key

22. Enter 95 as the Vapor Fraction amount.
Note: The software will convert the 1 kg to mole units and will put 95% of this in the vapor phase.

23. Keep the Calculate-Temperature option

J Variable Value -~
= Stream Parameters
Stream Amount (kg) 1.00000
o Temperature ("C} 25.0000
@ Pressure (atm) 1.00000
= Calculation Parameters
Vapor Fraction (Vapor/nflow [mell) (mole %) §5.0000
e Inflows (mass %)
H20 50.0000
NaCl 9.00000
CasS04 1.00000

24. We are ready to perform the calculation. Click on the Calculate button or press the <F9> key
25. ltis time to save your file (File >Save as...) or using the save icon in the tool bar. You can save under the

same file that we created before named as Single Point Calculations.

Anaylyzing the Results

Review the Summary Box. The calculated temperature to put 95% (mole based) of the total stream amount in
the vapor phase is ~109°C, however the results in the summary box are given in mass. Let’s go to the Report.

Unit Set: Metric (mass fraction)

Automatic Chemistry Model
MSE (H30+ ion) Databanks:
MSE (H30+ ion)
Uzing Helgeson Direct

apor Fraction Calculation
1.00000 atm
108.805 *C

Phase Amounts
Agueous 00243143 kg
apor 0.882612 kg
Solid 0.0930728 kg

Agueous Phase Properties
pH 6.40682
lonic Strength  0.0990622 molmol
Density  1.16798 g/ml

Calc. elapsed time; 0.131 sec

Calculation complete
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1. Select the Report tab and scroll down to Total and Phase Flow (Amounts) Table.

Jump to: | Total and Phase Flows [Amounts) ~ @
Total and Phase Flows (Amounts}
column Filtter Applied: Onhy Non Zero Values
Total Liguid-1 Vapor Solid
mol mol maol mol
Maole (True) 51.6887 1.20091 48.9923 1.49547
Mole (App) 51.5708 1.08307 48.9923 1.49547
kg kg kg kg
Mass 0.999999 0.0243143 0.882612 0.0930728
L L L cm3
Volume 1518.82 0.0208174 1518.76 41.7748

The apparent moles (Mole (App)) are the molecular representation of the system. There is a total of 51.5708
moles in this system, and exactly 95% of this system is in the vapor phase with a total of 48.9923 moles.
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1.6. Set pH

The Set pH calculation is a useful tool in analyzing or designing a process. It allows you to create a solution
that conforms to a premeasured pH. Other applications include designing a system to meet an operational pH
or testing the impact of adding an acid or base to a system.

Example 7: Neutralizing Acetic Acid

In this example, you will compute the amount of base titrant required to neutralize a 1 molal acetic acid solution.
You will assume a neutral system at 7 pH and 25°C.

Starting the Simulation

Use the inputs and parameters from the table below to create the stream’s composition. Certain inputs, such
as the name style, units, etc. will require further adjustments, and will be described as necessary.

Set pH Calculation

Calculation Settings Stream Composition and Conditions
Calculation Type Single Point Calculation | Stream Amount Default
Calculation Sub-type Set pH Temperature 25°C
Stream Name Neutralizing Acid Pressure 1 atm
Name Style Display Formula H20 Calculated
Unit Set Metric, Moles CH3COOH 1 mol
Framework AQ

Setting the pH

Add a new Stream

Click on the new Stream and press <F2> to change the name to Neutralizing Acid
Select the AQ thermodynamic Framework

Click on the Names Manager Icon and select the Formula option

o M 0 Dnd =

Click on the Units Manager Icon, and select Metric, Batch, Moles (default units). Click OK.

Units Manager
Metric v Batch Moles v Lg
Customize...
oK Cancel App Help
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Enter 1 mol of CH3COOH as an inflow
Go to the Add Calculation button and select Single Point calculation
Select Set pH as Type of Calculation

© o N o

Change the SinglePoint name to Neutralizing acetic acid using the <F2> key

A new grid section named Calculation Parameters appears. In this grid the Target pH can be defined, as well
as the Acid and Basic titrants. The default titrants are HCl and NaOH (common) and so no additional
specifications are required except to set the pH.

| Variable _ Value
= Stream Parameters
- Stream Amount (mol) . 56.5082 |
Temperature (°C) 25.0000 |
Pressure (atm) - 1.00000 '
K" Calculation Parameters
. i Target pH - 0.0 |
Use Single Titrant ' No
pH Acid Titrant | HCL |
pH Base Titrant ' NAOH
3 Inflows (mol) _
H20 N 55.5082 |
CH3COOH B 1.00000 |}

Note: The default titrants can be changed by other acids or bases by adding the desired titrant as an inflow.
The titrants in the Set pH calculation can be also set using the Specs button.

Calculation Options ? X
Category %DH
Calculation Options Select an acid and base to adjust to meet the specified pH.

[JUse Single Titrant Hide Related Inflows
Acd Base

CH3COOH CH3COOH

H20 H20
T

The default acid and base are already set, so no additional work is required If a different acid/base is desired, then the New
Inflow button can be used to find additional components.
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10. Enter 7 as the Target pH amount

11. Use the default titrants:

HCL and NAOH

J Variable | Value
[< Stream Parameters
i Stream Amount (mol) 56.5082
[ Temperature (*C) 25.0000
Pressure (atm) : 1.00000
< Calculation Parameters
@| TargetpH [ 7.00000 |
Use Single Titrant | No e
pH Acid Titrant HCL
pH Base Titrant . NAOH
= Inflows (mol)
H20 " 55.5082
CH3COOH

1.00000

12. We are ready to perform the calculation. Click on the Calculate button or press the <F9> key

13. Itis time to save your file (File >Save as...) or using the save icon in the tool bar. You can save under the

same file that we created before named as Single Point Calculations.

Anaylyzing the Results

Review the Summary Box or Click on the Output-Minitab to see the Results. About 0.997 moles of NaOH is
needed to neutralize 1 mole of acetic acid.

Input

N Variable ] Value "
= Stream Parameters
Stream Amount (mol) 57.5053
Moles (True) - Aqueous (mol) 58.3044
Temperature (*C) 25.0000
Pressure (atm) 1.00000
7 Calculation Results (mol)
pH titrant added: NaOH i 0.997023
o Inflows (mol)
H20 55.5082
CH3COOH 1.00000
NaOH 0.997023
v

I'ype of calculation
Set pH

Calculate @ |

v | Specs..

Summary

Unit Set: Metric (moles)

Automatic Chemistry Model

Agueous (H+ ion) Databanks:
Agueous (H+ ion)

Using K-fit Polynomials
T-span: 25.0 - 225.0
*P-gpan: 1.0-201.0
* = differs from default.

Set pH Calculation
25.0000 °C
1.00000 atm
TargetpH 7.00000
Acid Titrant: HCI

Total. 0.0 mol
Base Titrant: NaOH
Total: 0.997023 mol
Added: 0.997023 mol

Phase Amounts
Agueous 58.3044 mol
Vapor 0.0 mol
Solid 0.0 mol
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1.7. Precipitation Point

The precipitation point calculation computes the amount of material held in solution at given conditions and
forces a very small amount of solid to exist. This calculation could be also called a solubility calculation.

Example 8: Determining the Solubility of Calcite (CaCOs)

Equilibrium based simulators suffer from a potential problem, that the most stable solid will tend to be included
over less stable (meta-stable) solids. Such is the case of calcium carbonate. Calcium Carbonate (CaCO:s3) is
found in nature in many forms. Two common forms are the more thermodynamically stable solids, Calcite and

the less stable form Aragonite.

In this example, we will compute the solubility of CaCOs as Calcite in a solution containing Ca*2, Mg*?, and CI-
as well as dissolved CO:..

Starting the Simulation

Use the inputs and parameters from the table below to create the stream’s composition. Certain inputs, such
as the name style, units, etc. will require further adjustments, and will be described as necessary.

Precipitation Point Calculation

Calculation Settings Stream Com_p_osnmn and
Conditions

Calculation Type Single Point Calculation Stream Amount | Default - 1 kg

Calculation Sub-type Precipitation Point Temperature 25°C

Stream Name Solubility of CaCO3 — Precipitation Point | Pressure 1 atm

Name Style Display Formula H20 Calculated

Unit Set Metric, Mass Fraction (ppm (mass)) CaCl2 10870 ppm (mass)

Framework AQ MgCI2 9325 ppm (mass)
Cc02 431 ppm (mass)
CaCO3 0 ppm(mass)

Calculating the Precipitation of Calcite (CaCO3)

Add a new Stream

Click on the new Stream and press <F2> to change the name to Solubility of CaCO3 — Precipitation Point
Select the AQ thermodynamic Framework

Click on the Names Manager Icon and select the Formula option

a Mo nd -

Click on the Units Manager Icon, and select Metric, Batch, Mass Frac. This will change all inflows to
mass%. However, you need to change the units to ppm (mass), to do this Click on the Customize
button.
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Units Manager - Sclubility of CaCO3 - Precipitation ... ? >

Units Manager

Metric w Batch Mass Frac, 4

=ty

Mole Frac.

Customize... Conc.
Mass

K Cancel Apply Help

6. This will open the Edit Units window. Change the units from mass% to ppm (mass).

Edit Units - Selubility of Ca

- Precipitation Point ? >
(®) Batch System () Flowing System

Composition  Parameters Corrosion

Variable | Basis | Units P
Inflow variables
Stream Amount Mass kg
Inflows Mass Fraction mass %
Qutput variables
Agueous Composition Mass Fraction mass %
apor Composition Mass Fraction mass %
Solid Composition Mass Fraction mass %
2nd Liguid Composition Mass Fraction mass %
Total Composition Mass Fraction mass %

Basis options

Moles

Mass

Volume
Concentration
Malar Concentration

| Mass Fraction
| Mala Frarctinn

N

Enter the stream composition given in the table above.
Go to the Add Calculation button and select Single Point calculation
9. Select Precipitation Point as Type of Calculation
10. Change the SinglePoint name to Calcite Precipitation using the <F2> key



At this point you may have noticed that the Calculate button is red, and that there is a red text in the Summary
Box with instruction that additional specs are needed. The specifications need to be defined in the Calculation
Parameters grid section.

Variable | Value = Type of calculation
= Stream Parameters {Precipitation Paint: vI Specs...
Stream Amount (kgy 1.00000
Temperature ("C) 25 0000 Calculate @@ |
Pressure (atm} 1.00000 Summarny
e Calculation Parameters
] Precipitant: =zelect= Unit Set: <Custom:=
Adjusted Inflow: <zelect=
. Automatic Chemistry Model
s Inflows (ppm (mass)) Aguecus (H+ ion) Databanks:
H20 9.79374e5 Agueous (H+ion)
Using K-fit Polynomials
e 10870.0 T-zpan: 25.0 - 225.0
MgClL2 9325.00 *P_gpan: 1.0 - 201.0
coz £31.000 ¥ * = differs from default.
cacos 0.0 Precipitation Paint Calculation
25.0000°C
1.00000 atm

Precipitate: Mot specified.
Adj. Inflow: Not specified.

Calculation not done

Please select a target solid.
Please select a variable to adjust.

L
IpLt
Advanced Search Add as Stream Ewport
11. Select the CaCO3 (Calcite) as the Precipitant
12. Select NaOH as the Adjusted Inflow
= Calculation Parameters
o Precipitant: CaCO3 (Calcite)
Adjusted Inflow:
= Inflows (ppi HZ0
CaCl2
H20
MgCIz
Cackz coz
Co2 431.000
CaC03 0.0

The Precipitant refers to the independent variable — in this calculation, the solid phase selected will
precipitate at amount of 1.0x10-° times the stream amount.

The Adjusted Variable is the variable to be changed by the software until the solid target amount is
achieved.
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Note: The precipitation point parameters can be also set using the Specs button.

o
| Y File Edit Streams Calculations Chemistry Tools View Window Help
= ﬁ Cancel
W= =] M| LLvasol2|Res w2 s H@E: G REEND
|| Navigator LI
Calculation Options ? X

Single point calculations.o

H Q’ pH Category Precipitation Paint
- & Acetone Bubble Poi C "

Type of calculation

- £y Bubble point ten .. Calculation Olptions Hide Related Inflows Mew Inflow Frecipitation Faint -
. recipitation Paint — »
£ Bubble peint pre Adjusted Variable

Sour Matural Gas De
.4y Dew Point Temp CalOH)2 (Portlandite] - 3l A Hz0 Calculate @
: Cal [Lime] - Sal Call2
- £y Dew Point Press Summar
& Brine Evaporation - :gg:gi:ég I;DQSQ t
‘?I Vba::lor F;acctlcog; MaCIZEHZ0 (Bischafite) Unit Set: <Customs=
& Solubility of CaCC MgCR - 5ol Automatic Chemistry Model
~#y Calcite Precipitat MgCIoH - Sal Agueous (H+ ion) Databanks:
MalOH)2 [Brucite] - Sol Agueous (H+ ion)
< kgl [Periclaze] - Sol Using K-fit Polynomials
Actions : aEEIE [Aragonite] - Sal ;I'};_s:;;r_‘ 21_._n0__22021_..n0
Actions = = > * = differs from defautt

Precipitation Point Calculation

Select the precipitant to precipitate and the adjusted varniable to adjust uriti 25.0000°C

the: solid forms. 1.00000 atm

Precipitate: CaC03 (Calcite)
Adj. Inflow: NaOH

Calculation not done

Flot Template Manager

Cancel Apply Help

Calcis - %

For Help, press F1 & MNUM

13. We are ready to perform the calculation. Click on the Calculate button or press the <F9> key

14. ltis time to save your file (File >Save as...) or using the save icon in the tool bar. You can save under the

same file that we created before named as Single Point Calculations.

Anaylyzing the Results

Review the Summary Box or Click on the Output-Minitab to see the Results.

The software calculated that the solubility of CaCOs as Calcite in the solution under study is around ~431.15

ppm (mass). The pH of this solution is ~5.97.
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You can also check the results in the Report Tab. Click the Customize button and Select Stream Inflows.

Variable Value
T Stream Parameters
[=] Stream Amount (ko) 1.00041
— Mass - Agueous (kg 1.00041
L Mass - Solid (ko) 5.46166e-8
Temperature (*C) 25.0000
Prez=ure (atm) 1.00000
= Calculation Results (ppm (mass))
Adjusted Inflow: CaCO3 | 413146
= Inflows (ppm (mass)) 1
H20 9.78970e5
Caciz 10865.5
MgCL2 932115
Co2 430.822
Caco3 413.145
IrnpLt
Advanced Search Add az Stream Export

Type of calculation

Precipitation Point - Specs...

Calculate &8 |

Surnmary

Unit Set: «Custom= ~

Automatic Chemistry Model

Agueous (H+ ion) Databanks:
Agueous (H+ ion)

Using K-fit Pelynomials
T-span: 25.0- 2250
*P-zpan: 1.0 -201.0

> * = differs from default.

Precipitation Point Calculation
25.0000 °C
1.00000 atm
Precipitate: CaC0O3 (Calcite)
Adj. Inflow: CaCO3
Total 413145 ppm (mass)

Phase Amounts
Agueous  1.00041 kg
Vapor 0.0 kg
Solid 5 46166e-8 kg

Agueous Phaze Properties

pH 5.96733
lonic Strength 00107 molmel W
Density  1.01414 g/ml

6 OLl Studio - [Single point calculations.cad®] — m] ®
W7 File Edit Streams Calculations Chemistry Tools View Window Help - 8 x
J N T = Ide Lancel
| Report Contents ? =
j Ee % EE D
E Category Report Contents
[=- Report Contents
F .. Calculation 5 To add or remowve a section, click the check box. A shaded box . .
Stacualmfr; ummat means that only part of the companent will be printed. To see what's eport Q File ¥iewer
S rea!'nt.n nsws included in a component, click Detailz. |
- Speciation Summar
SEeam F. ¥ Seciors | Expart
- Total/Phase Flows
- Scaling Tendencies A
- Species Output
. Molecular Output Stieam Parameters
.. Element B alance Total/Phase Flows
- Species Activiy Coe Scalir.wg Tendencies
- Species Fugacities Species Output
. Partial Pressures ] Malecular Dutput 1.00026 kg
- Species K alues Elemgnt Bah.ar?ce . 25.0000 C
- S pacies Maohilties []Species Activity Coefficients
- Species Sef Diffusiv] | [L] Spesies Fugacities 1.00000 atm
It - Wapar Phage Diffush, O F‘artla.\ Pressures
- Giibbs Free Energy o O Species K alues
A . Gibbs Free Energyo| | Species Mobilities Fo—
- Entropy [ Species Seif Diffusivities v n
- Entrapy - Standard 5 Tt o Dl Dl e e bl ol 0.0106874 malimol
- Rieaction Kinetics 0.599793 mol/k
- Riedog Equations Up Dawn Select Al Clear Al 9
13.7558 atm
1 D=sciplioy 34706 8 pmhofem
E This zection dizplays the stream inflows 0.0161381 m2iehm-mol
0.958261 cP
E of 22 Sections selected 1.07583
0.988618 L
< > L
4 0.986447 L
Eancel i A




Notice that the concentrations have changed slightly. This is to accommodate the additional 413.15 ppm CaCOs
needed to meet the calculation specifications.

Stream Inflows
Row Filter Applied: Onhy Mon Zero Values

Input Output
Species ppm (mass) ppm (mass)
H20 9.79374eb 9.78970e5
CaCl2 10870.0 10865.5
MgCl2 9325.00 932115
co2 431.000 430822
CaCO3 0.0 413146

Example 9: Determining the Solubility of Aragonite (CaCOs)

Calcite is the thermodynamically stable phase of calcium carbonate. Aragonite, calcite's orthorhombic
polymorph, is about 1.5 times more soluble than calcite4. At surface conditions, aragonite spontaneously turns
into calcite over geologic time, but at higher pressures aragonite, the denser of the two, is the preferred
structure.

In this example, we wish to determine the solubility of the less thermodynamically stable solid, Aragonite,
independently of the more stable solid Calcite. To do this, we need to modify the solid phases in the chemistry
model and add a new Databank.

Starting the Simulation

Calculating the Precipitation of Aragonite (CaCO3)

1. Under the Stream Solubility of CaCO3 — Precipitation Point, Add a Single Point calculation
2. Select Precipitation Point as Type of Calculation
3. Change the SinglePoint name to Aragonite Precipitation using the <F2> key
4. Select the CaCO3 (Calcite) as the Precipitant
5. Select NaOH as the Adjusted Inflow
= Calculation Parameters
@ Precipitant: CaCO3 (Aragonite)
Adjusted Inflow: CaC03 |

4 https://www.sciencedirect.com/topics/earth-and-planetary-sciences/calcite
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6. Click on Chemistry > Model Options

f_’) OLI Studio - [Single point calculations.oad®]
A7 File Edit Streams Calculationsm Tools  View Window Help
JJ mgg ‘Idle Pre-built Models »
O | | 7 M Templates »

| Navigator | Model Options...
Single point calculations.oad*

Select the Phases tab
Click on the “+” next to the Ca(+2) box to display all the calcium containing solids
Scroll down to find CaCO3 (Calcite) and uncheck this solid

10. Click OK continue.

Aragonite Precipitation Chemistry Model Options ? X

Databanks Redox | Phases | T/P Span

Include Phases Include Sclid Phases
[ Aqueous @-[F Al Solids ~
[ Vapor Cl+4)
A Solcs e {?}{OH}Z (Portlandite)
e | | v La ortlandite
[ISecondLigud | | § i CaC03 (Aragonite)
----- (WY CaC03 (Calcite)
lon Exchange Model . | {1 @ CaC12 (Hydrophilte)
® Margules | i i CaCl2 2H20 (Sirjarite)
Owison | CalCl2 4H20
----- CaCl2 6H20 (Antarcticite)
Kineties | i - CaCl2 Ca0 2H20
----- Call2 H20
[JEnable [ @ Ca0 (Lime)
[#--[w] Cl-1) w
= 1 e an

Calculste Scaling Tendencies for excluded solids

el | | oy | e

Note: The Include Solid Phases box lists the solids in the chemistry model. Unchecking these solids will mathematically
eliminate the solid from consideration. The Scaling Tendency, however, will still be calculated.

11. We are ready to perform the calculation. Click on the Calculate button or press the <F9> key
12. ltis time to save your file (File >Save as...) or using the save icon in the tool bar. You can save under the

same file that we created before named as Single Point Calculations.
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Anaylyzing the Results

Review the Summary Box or Click on the Output-Minitab to see the Results.

The software calculated that the solubility of CaCOs as Aragonite in the solution under study is around ~552.87
ppm (mass). The pH of this solution is ~6.21. You can see that the solubility of Aragonite is higher than the
solubility of Calcite (~431.15 ppm (mass)).

Type of calculation

| Precipitation Point v| | Specs... |

Calculate & |

Surmmary

Variable | Value
== Stream Parameters
[=] Stream Amount (kg) 1.00055
— Mass - Agueous (kg) 1.00055
L Mass - Solid (kg) L. 46166e-8
Temperature (*C) 25.0000
Pressure (atm) 1.00000
& Calculation Results (ppm (mass))
Adjusted Inflow: CaCO3 252873
s Inflows (ppm (mass))
H20 9 73833e5
CaCl2? 10864.0
MgClL2 9319.85
coz 430 762
CaCO3 552.873
= Solid {(ppm (mass))
CaCO3 (Aragonite) 1.00000e5
Input § Output
Advanced || Search || Add as Stream || E sport

Unit Set: <Custom:=

Automatic Chemistry Model
Agueous (H+ ion) Databanks:
Agueous (H+ ion})
Excluding 1 =olid phaze
Using K-fit Polynomials
T-zpan: 25.0-2250
*P-zpan: 1.0 - 201.0
* = differs from default.

Precipitation Point Calculation
25.0000 *C
1.00000 atm
Precipitate: CaCO3 (Aragonite)
Adj. Inflow: CaCO3
Total 552873 ppm (mass)

Phase Amounts
Agueous  1.00055 kg
Vapor 0.0 kg

Solid 5.465166e-3 kg
Aqueous Phase Properties
pH §.21344

lonic Strength 0.0T07E70 mol'mol
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Example 10: Determining the Solubility of Dolomite (CaMg(COs).)

The third carbonate mineral to mention is Dolomite, which is something like calcite with a very high
concentration of magnesium in it. Under some conditions there can be much more magnesium added in, and
when the amount of magnesium becomes roughly the same as the calcium, the resulting mineral is called
Dolomite with the following chemical formula: CaMg(COs)2. The formation of Dolomite is believed to appear in
geological time frames.

In the AQ Framework, the Public database does not include Dolomite. To add Dolomite into the Chemistry we
need to add the Geochemical Databank.

Starting the Simulation

Calculating the Precipitation of Dolomite (CaMg(CO3)2)
Under the Stream Solubility of CaCO3 — Precipitation Point, Add a Single Point calculation
Select Precipitation Point as Type of Calculation

1
2
3. Change the SinglePoint name to Dolomite Precipitation using the <F2> key
4. Click on Chemistry > Model Options

C) OLI Studic - [Single point calculations.oad®]

B File Edit Streams Calculatians Tools  View Window Help

e lde Pre-built Models »
0= R N Templates Sl ENE
Navigator [ Model Options...

Single point calculations.oad* '

5. Inthe Databanks Tab, select the Geochemical (AQ) Databank. You can double click or use the right arrow
to add the databank. Then Click OK.

Dolemite Precipitation Cheristry Model Options ? *
Databarks Redox Phases T/P Span
Databanks
Themodynamic Framework
Aqueous (H+ ion) ~
Available Selected
Comosion (AQ) ~ Geochemical (AQ)
Ceramics (AQ) Aqueous (H+ion)
Low Temperature (A3)
Aloys (AQ) =+ Ll
lon Exchange (AG)
Surface Complexation C
JMM Databank - +
TFS Natahank ¥
< > < >
Import Databank Databank search order is from top to bottom.
Use the Up and Down amows to change the
Unload Databank search order.
Cancel Apply Help
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10.
1.

12.
13.

Select the Phases tab

Click on the “+” next to the Ca(+2) box to display all the calcium containing solids
Scroll down to find CaCO3 (Calcite) and CaCO3 (Aragonite) and uncheck these solids
Click OK continue.

Dolomite Precipitation Chemistry Model Options ? *

Databarks Redox T/P Span

Include Phases Include Solid Phases
[+] Aquenus -3 Cai=2) -
Vapor | i P Ca{0OH)2 (Portlandite)

Solids
[]5econd Liquid

CaCo3 (Calcite)

Varop

al_l
----- CaClZ 2H20 (Sirjarte)

lon Exchange Madel | @ | CaC12 470
®Margues | | L. CaCl2 6H20 (Antarcticite)
OWilson | Calll2 Cal 2H20

----- Callz H20
Kineties | | e CaMg(C03)2 (Dis-dolomite)
ClEnable | CaMgiC03)2 (Dolomite)

..... CaMg(CO3)2 (Or-dolomite)
..... CaMg3{CO3)4 (Huntite)

Ly B

L

Calculate Scaling Tendencies for excluded solids

Cancel Apply Help

Note: The Include Solid Phases box lists the solids in the chemistry model. Unchecking these solids will mathematically
eliminate the solid from consideration. The Scaling Tendency, however, will still be calculated.

Select the CaMg(C03)2 (Dolomite) as the Precipitant
Select CaCO3 as the Adjusted Inflow
= Calculation Parameters
@ Precipitant: CaMgiCO3)2 (Dolomite)
Adjusted Inflow: CaCo3

We are ready to perform the calculation. Click on the Calculate button or press the <F9> key
It is time to save your file (File >Save as...) or using the save icon in the tool bar. You can save under the

same file that we created before named as Single Point Calculations.
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Anaylyzing the Results
Review the Summary Box or Click on the Output-Minitab to see the Results.

The software calculated that the solubility of Dolomite in the solution under study is around ~246.84 ppm
(mass). The pH of this solution is ~5.63.

So far, we know that the solubilities of Calcite, Aragonite, and Dolomite in a MgClz, CaClz and COz2 containing
solution were 413.15, 552.87 and, 246.84 ppm (mass) respectively.

Variable | Value - Type of calculation
= Stream Parameters Precipitation Foint = Specs...
[=] Stream Amount (kg) 1.00025
 Mass - Aqueous (ka) 1.00025 Calculate & |
- Mass - Solid (ko) 1.00626e-7 Summary
Temperature (*C) 25.0000
Pressure (atm) 1.00000 Unit Set: =Custom= ™
Calculation Result
e alculation Results (ppm {mass)) Automatic Chemistry Model
Adjusted Inflow: CaCO3 245,838 Agueous (H+ ion) Databanks:
e Inflows (ppm (mass)) Geochemical (A0Q)
Agueous (H+ ion)
et RS Excluding 2 solid phases
CaCl2 10867.3 Using K-fit Polynomials
MaCl2 9322 70 ¥ T-span: 25.0 - 225.0
*P-gpan: 1.0 - 201.0
Loz e * = differs from default.
filil il Precipitation Point Calculation
= Solid (ppm (mass)) 25.0000 °C
CaMg(C03)2 (Dolomite) 1.00000e6 1.00000 atm
Precipitate: CaMg(CO3)2 (Dolomite)
Adj. Inflow: CaCO3
Total 245838 ppm (mass)
Phase Amounts
Agueous 1.00025 kg
W Vapor 0.0 kg
Solid 1.00626e-T kg
Input | Output
hqueous Phase Properties )
Advanced Search Add as Stream Ewpart F'H = 5',‘,332%,5_ =

70



1.8.

Composition Point

The composition point calculation is used to fix a species value. This calculation is useful when for example
you want a target amount of a desired component or to fix an impurity or undesired component below a certain

\

alue.

Example 11: Targeting dissolved H.S in water below 0.001 m

In this example, you will use the composition point calculation to target the amount of molecular H2S dissolved

in water below 0.001 m.

Starting the Simulation

Use the inputs and parameters from the table below to create the stream’s composition. Certain inputs, such
as the name style, units, etc. will require further adjustments, and will be described as necessary.

Composition Point Calculation

Calculation Settings

Stream Composition and Conditions

Calculation Type

Single Point Calculation

Stream Amount

Default — 55.5082

Calculation Sub-type Composition Point Temperature 25°C
Stream Name Composition Point Pressure 1 atm
Name Style Display Formula H20 Calculated
Unit Set Metric, Moles H2S 0 moles
Framework AQ Target H2S-Aq value | 0.001 moles

Calculating the Vapor Fraction Temperature (Isobaric)

9.

S B e

Add a new Stream

Select the AQ thermodynamic Framework

Enter the composition of the gas given in the table above

Select Composition Point as Type of Calculation

Click on the new Stream and press <F2> to change the name to Composition Point

Click on the Names Manager Icon and select the Formula option

Click on the Units Manager Icon, and select Metric, Batch, Moles

Go to the Add Calculation button and select Single Point calculation

Change the SinglePoint name to H2S dissolved in water using the <F2> key

10. Set the Target Species to H2S-Aq (i.e. the molecular H2S dissolved in the Aqueous phase)
11. Set the Target H2S value to 0.001 moles
12. Set the Adjusted Inflow to H2S
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Variable Value
e Stream Parameters
Stream Amount {mol) 55.5082
Temperature (*C} 25.0000
Preszure (atm} 1.00000
= Calculation Parameters
Target Species: H25 - Ag
Target H2S Value: (mol) 1.00000e-3
Adjusted Inflow: H2S 1'
& Inflows (mol)
H20 55.5082
HZS 0.0

13. We are ready to perform the calculation. Click on the Calculate button or press the <F9> key

14. ltis time to save your file (File >Save as...) or using the save icon in the tool bar. You can save under the

same file that we created before named as Single Point Calculations.

Anaylyzing the Results

Review the Summary Box or Click on the Output-Minitab to see the results.

Variable [ Value ~
T Stream Parameters
Iﬂ Stream Amount (mol) 555093
L Moles (True) - Aqueous (mol) 555003
Temperature (*C) 25.0000
Pressure (atm} 1.00000
= Calculation Results (mol)
Adjusted Inflow: H2S 1.0101%e-3
T Inflows (maol)
H20 55.5082
H25 1.01019e-3
W
Imput
Advanced Search Add az Stream Ewport

Tupe of calculation

Caompozition Paoint Specs. .

Calculate 48 |

Surmnary

Unit Set: Metric (moles)

Automatic Chemistry Model

Aqueous (H+ ion) Databanks:
Agueous (H+ion)

U=ing K-fit Pelynomials
T-span: 25.0 - 2250
*P-gpan: 1.0 - 201.0
* = differs from default.

Composition Point Calculation
25.0000 °C
1.00000 atm
Target: H25
Fixed at 1.00000e-3 mol
Adj. Inflow: H2S
Total 1.01019e-3 mol

Phase Amounts
Agueous  55.5083 mol
Vapor 0.0 mol

Solid 0.0 mol
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According to the calculation, ~0.00101 moles of H2S were required to create a solution with 0.001 moles of

H2S-aq. The pH of this solution is ~5.0.

You can also go to the Report to see the distribution of species under the Species Output (True Species)

table.

Species Qutput (True Species)

Row Filter Applied: Onhy Mon Zero Values

column Fitter Applied: Onhy Non Zero Values

Total Aqueous

mal mal
H20 55.5082 55.5082
H2§ 1.0e-3 1.0e-3
H+1 1.01938e-5 1.01938e-5
HS1 1.01928e-5 1.01928e-5
OHA1 1.00348e-8 1.00348e-8
5.2 1.391e-13 1.391e-13
Total (by phase) 55.5093 55.5093

You can see that the molecular H2S is the value that was specified as a target. Notice that the concentration of
H* and HS- are nearly identical. This is because the following reactions:

H,S & H* + HS™

H* is slightly higher because a second reaction, the dissociation of water also contributes to the H* formation.

H,0 & H* + OH™
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1.9. Autoclave

An autoclave is a high pressure, high temperature hydrometallurgy unit with carefully controlled conditions.
From an OLI Software perspective, it is an isochoric (constant volume) calculation in which mass, pressure
and temperature are allowed to vary.

Autoclave calculations are widely used in the upstream oil and gas applications. When performing corrosion
testing, autoclave experiments are essential for simulating downstream conditions, i.e. conditions at high
temperatures and pressures. Additionally, it is important to evaluate the corrosivity of production fluids by
measuring solution properties, such as pH, and the concentration of aggressive species such as COz2, H2S, and
chlorides. An autoclave, however, has a constant volume, so it is imperative to know how much material (NaCl
solution, CO2 and H2S gases) is necessary to add at charging conditions (e.g. at room temperature) in order to
reach the desired final specifications, such as partial pressure of CO2 and H2S gases.

We will use the Autoclave calculation to calculate partial pressures, fugacities and the final composition of key
gases in the aqueous and vapor phases.

For the autoclave calculation 2 examples will be shown:

Using an Inert Gas

Calculating results at ambient conditions

Increasing the volume of the vessel and its implications

1
2
3. Increasing the final temperature and its implications
4

Increasing the final pressure and its implications

Using a Reactive Gas

1. Calculating results at final conditions

2. Using a Reactive Gas and a NaOH solution
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Example 12: Using an Inert Gas
1. Calculating Results at Ambient Conditions
In this example, you will add 1 kg water to a 2 L autoclave and then fill the void (head space) with N2. The

ambient temperature is 25 °C. The Nz is presumed to be the gas that remains in the autoclave headspace after
sparging (O2 removal) is completed.

The amount of N2 added is the combination of N2 vapor filling the headspace, and Nzthat dissolves in the water
(N2 aqueous). Since N2 has a low water solubility, this second amount is negligible. H20 also evaporates, so
the headspace will be a mixed gas, N2 and H20.

We can use the Ideal Gas Law to estimate the amount of N2 needed to fill the headspace:

PV =nRT
L —atm
latmXx 1L =nx0.082057— x 298.15 K
K — mol

n = 0.040874 moles

Although this estimate does not consider the H20 that is in the 1 L headspace or the amount of N2 dissolved in
water, it is still an easy approach to get a reasonable estimate.

You will review the results in greater detail here, because part of the goal of this first example it to show where
the important variables and properties are.

Starting the Simulation

Use the inputs and parameters from the table below to create the stream’s composition. Certain inputs, such
as the name style, units, etc. will require further adjustments, and will be described as necessary.

Autoclave Calculation

Calculation Settings Stream Composition and Conditions
Calculation Type Single Point Calculation Stream Amount Default — 55.5082
Calculation Sub-type Autoclave Ambient Temperature | 25 °C
Stream Name Autoclave Final Temperature 25°C
Name Style Display Formula Final Pressure 1 atm
Unit Set Metric, Moles Vessel Volume 2L
Framework MSE-SRK H20 Calculated
Results for Ambient conditions N2 0 moles

Add a new Stream

Click on the new Stream and press <F2> to change the name to Autoclave
Select the MSE-SRK thermodynamic Framework

Click on the Names Manager Icon and select the Formula option

Click on the Units Manager Icon, and select Metric, Batch, Moles

Enter the N2 as an inflow

N o o s~ DN =

Go to the Add Calculation button and select Single Point calculation



Select Autoclave as Type of Calculation

Change the SinglePoint name to Autoclave — Inert Gas using the <F2> key

Note: At this point you may have noticed that the Calculate button is red, and that there is a red text in the Summary Box with

instruction that additional specs are needed. The specifications need to be defined in the Calculation Parameters grid section.

10. Click on the Specs button.

Description Definition [5| Report L2 File Viewer

Variable | Value - Type of calculation
& Stream Parameters Autoclave V] Specs...
Stream Amount {mel) 55.5082

Ambient: Temperature (*C) 25.0000 Calculate & |

Ambient: Pressure (atm)

Surnrmary

= Calculation Parameters
Final Temperature (*C) 0.0 Unit Set. Metric (moles)

Final Pressure (atm)

Automatic Chemistry Model
Vessel Volume (L) 0.0 Agueous (H+ ion) Databanks:
Compute results at which condition Ambient Agueous (H+ion)

Using K-fit Pelynomials

- i i T-zpan: 25.0 - 225.0

H20 55.5082 *P_gpan: 1.0 - 201.0

M2 0.0 ¥ * = differs from default.

- Autoclave Calculation

Specifications:

Ambient Temperature  25.0000 °C
Final Temperature 0.0 °C

Final Pressure

Vessel Volume 0.0L

Calculation et done

“olume of vezssel is invalid.
Use the specs button to select up to 5
gazes to consider.

| npLt

Advanced Search Add az Stream Ewpart
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11. This will open the Calculation Options window to set up the target gas. Select N2-Vap and make sure to

select the specification type Partial Pressure (default). Click OK.

Calculation Options ? X

Category Autoclave
Autoclave
i Calculation Options

Target Gasles] [5 Max]

H20 -vap

Selected

Specification Type
(®) Partial Pressure(s)
() Mole Fractionfs] in Aqueous Phaze

Cancel Apply Help

12. Set the Final Temperature to 25°C, the Final Pressure to 1 atm and the Vessel Volume to 2 L

13. Set the compute results at Ambient Conditions

Variable Value

G Stream Parameters
Stream Amount (mol) 555082
Ambient: Temperature ("C) 25.0000
Ambient: Pregsure (atm)

== Calculation Parameters
Final Temperature (*C}) 25.0000
Final Pressure (atm) 1.00000
Vessel Volume (L) 200000

Partial Pressure: N2 (atm)

I Compute results at which condition [ Ambient |

At this point the system is defined as 1 kg H20 (55.5082 moles) at an ambient temperature of 25 °C. The partial

pressure of N2 will be calculated at a final temperature, 25 °C and pressure, 1 atm in a 2 L vessel.
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Note: The Autoclave calculation pathway

When performing an autoclave calculation, the software will perform two computations: First, at the final
conditions, and the second one at ambient (initial) conditions. It will compute the amount (in moles) of N2 needed
to create a 1 atm pressure at final conditions. It will then use this N2 to compute the pressure at ambient

conditions. The calculation pathway is showed in the image below.

Partial pressure (P;) is
computed at ambient
conditions

M- moles are
computed

Ambient

Final

P ambiznt = 7
Tamhbient= 25 C
Vr=2L
Mass of H-:0 =1kg

-

Prsna = 1atm
Tina= 25 C
Vr=2L
Mass of H-:0 =1kg

-——

14. We are ready to perform the calculation. Click on the Calculate button or press the <F9> key

15. Itis time to save your file (File >Save as...) or using the save icon in the tool bar. You can save under the

same file that we created before named as Single Point Calculations.

Anaylyzing the Results

Review the Summary Box or Click on the Output-Minitab to see the results.

H Variable

Value ~
= Stream Parameters (mol)
|_|:_| Stream Amount 55.5483
l— Moles (True) - Liquid-1 (mol) 55.5076
L Moles (True}) - Vapor (mel} 0.0407594
= Calculation Results
Ambient Temperature (“C) 25.0000
Ambient Pressure (atm) 1.00000
Final Temperature (*C} 25.0000
Final Pressure (atm) 1.00000
Vessel Volume (L} 2.00001
Partial Pressure: N2 (atm) 0.952642
Conditien that results were computed f Ambient
e Inflows (mol)
H20 55.5082
N2 0.0400796
W
Input
Advanced Search Add ag Stream Export

Type of calculation

Avtaclave - Specs..

Calculate &8

Summary

Unit Set: Metric (moles) N

Automatic Chemistry Model
MSE-SRK (H30+ ion) Databanks:
MSE-SRK (H30+ ion)
MSE (H30+ ion)
Second Liguid phase
Using Helgeson Direct

Autoclave Calculation
Results for ambient conditions:
Ambient Temperature  25.0000 °C
Ambient Pressure  1.00000 atm
Final Temperature  25.0000 °C
Final Pressure 1.00000 atm
VesselVolume 2.00000L
N2 0.958542 atm

Phase Amounts
Agqueous  55.5078 mol
Vapor 0.0407594 mol
Solid 0.0 mol
2nd Liguid 0.0 mol

Agqueous Phase Properties ")

pH 6.99756
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The calculated ambient pressure is 1 atm. It is identical to the final pressure, which is not surprising, since the
ambient and final temperatures were defined at the same value, and by design, the autoclave calculation uses
the identical inflows for ambient and final conditions.

The amount of N2 added is 0.0400796 moles, which produces a ~0.9686 atm partial pressure. The computed
Nz inflow compares to the Ideal Gas value of 0.040874 moles, a ~2% deviation.

Let's review the distribution of N2 in the liquid and vapor phase in the Report tab. Scroll down to the last table

named Element Distribution.

The last row is N (which is representing the molecular nitrogen). The distribution is 98.5% in the vapor phase
and 1.5% in the liquid phase. Also notice that around 0.0023% of the water has evaporated (see the H(+1) and

O(-2) rows).

Element Distribution

Total Total Liquid-1 Vapor

mol mole % % of Total % of Total
H(+1) 111.016 66.6346 99.9977 2.30264e-3
0{-2) 55.5082 333173 99.9977 2.30264e-3
N 0.080159 0.0481133 149278 98.5072

These results infer two effects:

1. As the final pressure (Pt) increases, additional N2 will dissolve in the water, shifting the fraction of nitrogen

to the liquid.

2. As the total autoclave volume (V) increases relative to the input liquid (which stays constant), additional

water will evaporate, shifting the water to the vapor. This case will be shown next.
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2. Increasing the Vessel Volume to 5 L

You are going to use the same case that you built up in the example above, with the only difference that you

will change the Vessel Volume.

1. Right click on the Autoclave — Inert Gas single point calculation and select copy

2. Selecting the stream named Autoclave, right click on it and select paste

3. Select the copied stream and name it Autoclave — Inert Gas Vessel Vol 5L

E & Autoclave

[ @W ‘ H

Arrange »

. Cut

C
Actions L
Actions Paste
Delete
Rename
Add As Stream

Clear Results

Plot Template Manager _ Clear Status

Calculation Options

ctions
Actions

&) Add Strea
) Add Mixe
A Add Singl
| Add Surve

<

Yot Template |

Arrange

Cut

Copy
Paste

2

Delete

Rename

Add As Stream
Clear Results

Clear Status

Calculation Options

E & Autoclave
- & Autoclave - Inert Gas
[ W Autoclave — Inert Gas Vessel Vol 5

Change the Vessel Volume to 5 L and Calculate <F9>

J Variable Value A
= Stream Parameters
Stream Amount (mel) 55.5082
Ambient: Temperature (*C) 25.0000
Ambient: Pressure (atm)
= Calculation Parameters
Final Temperature (*C) 25.0000
Final Pressure (atm) 1.00000
| VesselVolume (L) 5.00000 |
| Partial Pressure: N2 (atm} [
Compute resultz at which condition Anmbient ﬂ
e Inflows (mol)
H20 55.5082 *
N2 0.0

Type of calculation

Autoclave - Specs..

Calculate &8

Surannary

Unit Set: Metric (molez)

Automatic Chemistry Model
MSE-SRK (H30+ ion) Databanks:
MSE-SRK (H30+ ion)
MSE (H30+ ion)
Second Liquid phase
Using Helgeson Direct

Autoclave Calculation
Specifications:
Ambient Temperature 25,0000 °C
Final Temperature  25.0000 °C
Final Pressure 1.00000 atm
Vessel Volume 5.00000L
N2

Calculation not done

L

©

At this point the system is defined as 1 kg H20 (55.5082 moles) at an ambient temperature of 25 °C. The partial
pressure of N2 will be calculated at a final temperature, 25 °C and pressure, 1 atmin a 5 L vessel.

It is time to save your file (File >Save as...) or using the save icon in the tool bar.
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Anaylyzing the Results
Review the Summary Box or Click on the Output-Minitab to see the results.

Variable | Value - Twpe of calculation
= Stream Parameters (mol) Autoclawve - Specs...
[ Stream Amount 556671
| Moles (True} - Liguid-1 (mol) 55.5037 Calculate & |
L— Moles (True) - Wapor (mol) 0.1633599 Summarny
= Calculation Results
Ambient Temperature (*C) 25.0000 Unit Set: Metric (moles) ™
Ambient Pressure (atm) 1.00000 Automatic Chemistry Model
Final Tempsrature (*C} 25.0000 MSE-SRK (H30+ ion) Databanks:
Final Pressure (atm) 1.00000 MSE-::?E)I'C 'iH_E-D\+ ion}
Vessel Volume (L) 499998 5&':?: d'ﬂ; E; I;II'-IIR;SE.‘
Partial Prezsure: M2 [atm) 0.968642 Using Helgeson Direct
Condtion that resufts were computed f Ambient # Autoclave Calculation
— Inflows {mol) Resultz for ambient conditions:
H20 =z c0a2 Ambient Temperature  25.0000 *C

Ambient Pregsure  1.00000 atm
N2 0158874 Final Temperature 25.0000 *C

L Final Pressure 1.00000 atm
Vessel Volume 5.00000 L
W2 0.958542 atm

Phase Amounts
Agueous  55.5037 mol
Vapor 0.16335%9 mol
W Solid 0.0 mal
2nd Liguid 0.0 mol

Input | Output
Agueous Phase Properties ]

Adwvanced Search Add az Stream Ewpaort FH . E'?QTE.E,

The moles of liquid are now 55.5037. The reduction of 0.0039 moles (compared to the case of 2 L which was
55.5076 moles) is because this amount of H20 evaporated into the larger headspace. This phase distribution
is important to modeling the autoclave system properly, especially at elevated conditions as will be seen in the
next example.

The amount of N2 required to fill the 4-L headspace is 0.1589 moles; this amount is ~4-times greater than the
first case, which is expected for gas with a low water solubility.
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3. Increasing the Final Temperature

In this example, you will add 1 kg water to a 5 L autoclave and then fill the void (head space) with N2. The

ambient temperature is 25 °C, and the final conditions will be 1 atm and 100 °C.

The purpose of this example is to raise the H20 partial pressure relative to N2. In the 5 L case above, the N2
inflow is 0.1634 moles. As temperature increases, the H20 vapor pressure increases, and the amount of N2

required to fill the vapor void will decrease.

You are going to use the same case that you built up in the example above, with the only difference that you

will change the Final Temperature to 25 °C.

1. Copy the Autoclave — Inert Gas Vessel Vol 5L single point calculation and paste under the Autoclave

Stream.
Name it Autoclave — Inert Gas Tf=100C
Change the Final Temperature to 100°C and Calculate <F9>

- Variable Value

= Stream Parameters
Stream Amount (mol) 55.5082
Ambient: Temperature (°C) 25.0000
Ambient: Pressure (atm}

= Calculation Parameters
Final Temperature (*C) 100.000
Final Prezsure (atm) 500000
Veszel Volume (L) | 500000
Partial Pressure: N2 (atm)
Compute resultz at which condition Ambignt

& Inflows (mol)
H20 55.5082
M2 0.0

At this point the system is defined as 1 kg H20 (55.5082 moles) at an ambient temperature of 25 °C. The partial
pressure of N2 will be calculated at a final temperature, 100 °C and pressure, 50 atm in a 5 L vessel.

It is time to save your file (File >Save as...) or using the save icon in the tool bar.
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Anaylyzing the Results
Review the Summary Box or Click on the Output-Minitab to see the results.

J Variable Value
= Stream Parameters (mol)
|$| Stream Amount 55.5087
l— Moles (True) - Ligquid-1 {mol) 55.5031
L Moles (True) - Vapor (mol) 5.54762e-3
= Calculation Results
Ambient Temperature ("C) 25.0000
Ambient Pressure (atm) 0.0335414
Final Temperature (*C} 100.000
Final Pressure (atm} 1.00000
Vessel Volume (L) 500009
Partial Prezsure: N2 (atm) 2 67276e-3
Condtion that resufts were computed f Ambient
G Inflows (mol)
H20 55.5082
| ™2 | 4.38508=-4 |
|t
Advanced Search Add as Stream Ewpaort

Twpe of calculation

Autoclawve - Specs...

Calculate &8

Surnrmary

Unit Set: Metric (moles)

Automatic Chemistry Model
MSE-SRK (H30+ ion) Databanks:
MSE-SRK (H30+ ion)
MSE (H30+ ion)
Second Liguid phase
Using Helgeson Direct

Autoclave Calculation
Resultz for ambient conditions:
Ambient Temperature  25.0000 °C
Ambient Pregsure  0.0339414 atm
Final Temperature 100.000 °C
Final Pressure 1.00000 atm
Vessel Volume 5.00000 L
M2 287276e-3 atm

Phase Amounts
Agueous  55.5031 mol
Vapor 5.54752e-3 mol
Solid 0.0 mal
2nd Liguid 0.0 mol

Agueous Phase Properties
pH 6.90772

The amount of N2 added is very small (~0.0004 moles). This is to be expected, because the vapor pressure of
pure water at 100 °C is 1 atm. Therefore, a negligible amount of N2 is needed to raise the pressure. Notice also

that the calculated ambient pressure is 0.0339 atm. The vapor pressure of pure water at 25° C is 0.0313.

The results above imply that the autoclave will have a vacuum pressure at the ambient temperature, and when
heated to 100 °C will reach atmospheric pressure.

In autoclave testing, it is also of utmost importance to study and understand the partial pressures and fugacities
of key gases at the final conditions. You need to enable these properties to be shown in the Report.

Go to the Customize button and enable both the Species Fugacities and the Partial Pressures options, and

then click OK.
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o

B File Edit Streamns Calculations Chemistry Tools View Window Help
Report Contents ? X g | oA
M Category Report Contents
4 | = Report Contents
.. Calculation Summary, To add or remove a section, click the check box. A shaded box Report Q File Yiewer
= Stieam Inflows meansz that only part of the component will be printed. To see what's
included in a component, click Details. 5
- Speciation Summary i P ~ @ ag E=port
. Shream P. " Sections I
.. Total/Phase Flows [ Calculation Summary ~
- Scaling Tendencies O Strea!n !nflows ~
- Species Output [Speciation Summary
. Molecular Dutput Stream Parameters
. Element Ealance Total/Phase Flaws
- Species Activity Cog Scalir?g Tendencies
- Species Fugacities Species Output
.. Partial Pressures [IHalecular Output 617478 mol
- Species KValues Element Balance -
I - Species Mobilities |[]5pecies Activity Coefficients 25.0000 C
1 - Species Self Diffusiv] | ] Species Fugacities 38.0704 atm
M - apor Phase Diffusiy artial
- Gibbs Free Energy o 153 Rl
| . Gibbs Free Energy o [15pecies Mabiliies
[ - Entropy [1Species Self Diffusivities v 6.99144
. 1.834050-9 molimol
- - Reaction Kinetics
‘I—: . Redox Equations Up Drawn Select Al Clear Al 1.01846e-7 mollkg
I oo 78.4141
Description 543529 :
X atm
This section dizplays the vapor phase partial pressures.
0.0576240 umhofcm v
i 1.00360 L
7 of 22 Sections selected
= £ >
3 ~
1 Cancel Apply Help
= *F-span: T.U- 20T
g = = differs from default.
a
15
‘_g Calculation Complete!
5 v
For Help, press F1 @ MNUM

Notice that the Fugacity and Partial Pressure of N2 are nearly identical. This is expected since at low pressure
the fugacity approaches its partial pressure.

Species Fugacities

Partial Pressures

Row Filter Applied: Onfy Non Zero Valuss Row Filter Applied: Only Neon Zero Values

Species atm Species atm
Hz20 0.0312529 H20 0.0312686
M2 267376e-3 N2 2 67276e-3
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4. Increasing the Final Pressure

In this example, you will add 1 kg water to a 5 L autoclave and then fill the void (head space) with N2. The
ambient temperature is 25 °C, and the final conditions will be 100 atm and 100 °C.

You are going to use the same case that you built up in the example above, with the only difference that you
will change the Final Pressure to 100 atm.

1. Copy the Autoclave — Inert Gas Tf=100C single point calculation and paste under the Autoclave Stream.
2. Name it Autoclave — Inert Gas Pf=100 atm
3. Change the Final Pressure to 100 atm and Calculate <F9>

|

—

—

—

Variable
Stream Parameters

Stream Amount (mol)
Ambient: Temperature (°C)
Ambient; Pressure (atm)

Calculation Parameters
Final Temperature (*C})
Final Pressure (atm})
Vessel Volume (L)
Partial Pres=ure: N2 (atm)
Compute results at which condition

Inflows (mol)

H20
M2

Value

Ambient

35.5082
25.0000

100.000
100.000
5.00000

35.5082
0.0

At this point the system is defined as 1 kg H20 (55.5082 moles) at an initial temperature of 25 °C. The partial
pressure of N2 will be calculated at a final temperature of 100 °C and a final pressure of 100 atm in a 5 L vessel.

It is time to save your file (File >Save as...) or using the save icon in the tool bar.
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Anaylyzing the Results

Review the Summary Box or Click on the Output-Minitab to see the results.

Description Definition [ Report Ui File Viewer

J Variable
= Stream Parameters (mol)

Lf_l Stream Amount
[ Moles (True} - Liquid-1 (mol)
L Moles (True} - Vapor (mol)
= Calculation Results
Ambient Temperature (*C)
Ambient Pressure (atm)
Final Temperature (*C})
Final Prezsure (atm)
Weszsel Volume (L)

Partial Pressure: N2 (atm)

Condition that results were computed for
- Inflows (mol)
HZ20
N2
Input  Output
Advanced Search Add az Stream Export

Value

Ambient

25.0000
75.6205
100.000
100.000
5.00000
75.5829

55.5082
12.3169

Type of calculation

Autoclave - Specs...

Calculate &8

Summary

Unit Set: Metric (moles)

Automatic Chemistry Model
MSE-3RK (H30+ ion) Databanks:
MSE-SRK (H20+ ion)
MSE (H30+ ion)
Second Liguid phase
Using Helgeson Direct

Autoclave Calculation
Resultz for ambient conditions:
Ambient Temperature  25.0000 °C
Ambient Pressure 755205 atm
Final Temperature 100.000 *C
Final Pressure  100.000 atm
Vessel Volume 5.00000 L
N2 7T5.5829 atm

Phaze Amounts
Agueous  S5.5441 mol
Vapor 12,2810 mol
Solid 0.0 mol
2nd Liguid 0.0 mol

Agueous Phase Properties
pH 6098517
Innir: Strennth 1 B57NR:-9 mnl'mnl

The computed ambient pressure Pra is 75.6205 atm. Of this total, 75.5829 atm is N2 (Pn2=75.5829 atm) and
0.0376 atm is H20 (PH20=0.0376 atm). Thus, to create a 100 atm final pressure, the autoclave would need to

be charged with N2 at a regulator pressure of 75.6205 atm.

According to the calculation, the amount of N2 in the autoclave is 12.3169 moles. This amount of N2 plus the
55.5082 moles of H20 produces a final pressure of 100 atm in a 5 L autoclave at 100 °C.

Let's study the partial pressure and fugacity of N2 at these final conditions. Remember, you need to enable

these properties to be shown in the Report.

Go to the Customize button and enable both the Species Fugacities and the Partial Pressures options, and

then click OK.

For comparison purposes, the Species Fugacities and the Partial Pressures for 100 °C and 1 atm, and 100

°C and 100 atm are shown.
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Species Fugacities

Row Filter Applied: Onhy Mon Zero Values

Species Fugacities

Row Filter Applied: Onhy Mon Zero Values

Species atm Species atm
H20 0.0312529 H20 0.033019
N2 2 §7376e-3 N2 75.9152
Partial Pressures Partial Pressures
Row Filter Applied: Onfy Mon Zero Values Row Filter Applied: Only Mon Zero Values

Species atm Species atm
H20 0.0312686 H20 0.0376507
M2 267276e-3 M2 75.5820

Notice that at low pressures, the partial pressures and fugacities values of both H2O and Nz are nearly identical.
At the higher pressure, i.e. 100 atm, the partial pressures and fugacities of H20 and N2 start to differ.

The cause of this deviation is the non-ideal effects of high pressures on gas molecules as they are forced closer
together. At low pressures, gas molecules are too far apart to interact. As pressure increases, the average
distance between two molecules decrease, until at short range, intermolecular attractive forces begin to impact
the molecular properties. The impact of this effect is quantified in the fugacity term. Notice that fugacity and
partial pressure have the same units, atm.

Thus, when reviewing these two tables, the partial pressure can be seen as the idealized gas property at high
pressures (which does not take into account intermolecular forces). The fugacity is the real gas property at this

pressure. The non-ideal effect of pressure is therefore encapsulated in the following relationship:

Fugacity _f

¢= Partial Pressure E

Where,
@ is the fugacity coefficient

At low pressures, a gas molecule fugacity (f) approaches its partial pressure (p;), i.e. f > p;or¢e = 1.
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Example 13: Using and Reactive Gas

1. Calculating Results at Final Conditions

In this example, you will add 1 kg water to a 2 L autoclave and then fill the void (head space) with CO2. The
ambient temperature is 25 °C.

You will then modify the case further by adding NaOH so that additional CO2 dissolves in water to form

bicarbonate.

Starting the Simulation

Use the inputs and parameters from the table below to create the stream’s composition. Certain inputs, such
as the name style, units, etc. will require further adjustments, and will be described as necessary.

Autoclave Calculation

Calculation Settings

Stream Composition and Conditions

Calculation Type

Single Point Calculation

Stream Amount

Default — 55.5082

Calculation Sub-type Autoclave Ambient Temperature | 25 °C
Stream Name Autoclave Final Temperature 25°C
Name Style Display Formula Final Pressure 1 atm
Unit Set Metric, Moles Vessel Volume 2L
Framework MSE-SRK H20 Calculated
Results for Final Conditions CO2 0 moles
NaOH 0 moles

1. Add a new Stream

2. Click on the new Stream and press <F2> to change the name to Autoclave Reactive Gas

3. Select the MSE-SRK thermodynamic Framework

4. Click on the Names Manager Icon and select the Formula option

5. Click on the Units Manager Icon, and select Metric, Batch, Moles

6. Enter the CO2 and NaOH as inflows

7. Go to the Add Calculation button and select Single Point calculation

8. Select Autoclave as Type of Calculation

9. Change the SinglePoint name to Autoclave — CO2 using the <F2> key

10. Click on the Specs button. This will open the Calculation Options window to set up the target gas.

11. Select CO2 and make sure to select the specification type Partial Pressure (default). Click OK.
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0 OLl Studio - [Single point calculations.oad™] — O >
@7 File Edit Streams Calculations Chemistry Tools View Window Help = | =] e
o1 ==
DSHE| =02 2R vasoiz Res msiie ms | MEs % FeF a2 D
Mavigator L o~ X
Navgator : B
Sinala naint caleylati nadt
—= - : ? A .
3 Calculation Options ? X File Viewer
EEl = .
. Category Autoclave Value - Tupe of calculation
. Colou ": i Target Gas(es] (5 Max) | Autoclave v|I| Specs... I|
alculation Options 255082 L )
25,0000 Calculate @ |
ap
Summary
: 0.0 Unit Set: Metric (moles)
= A ic Chemistry Model
0.0 MSE-SRK (H30+ ion) Databanks:
p MSE-SRK (H30+ ion}
- MSE (H30+ ion)
@ grumbient Second Liguid phase
Selected Using Helgeson Direct
E 55.5082 *| Autoclave Calculation
Specification Type 0.0 Specifications:
00 Ambient Temperature  25.0000 °C
(®) Partial Pressure(s) . Final Temperature 0.0 °C
. f Final Pressure
Mole Fract A Fh.
(O Mole Fraction(s) in Aqueous Phase Vessel Volime 0.0
coz
— Calculation not done
[ﬁ Volume of vesselis invalid.
“fou must specify the Final Pressure
or Gas 1
v
. ort
X ~
L3
£||Calculation Complete!
TE v
For Help, press F1 @ NUM

12. Set the Final Temperature to 25°C, the Final Pressure to 1 atm and the Vessel Volume to 2 L

13. Set the compute results at Final Conditions. Click on the cell to enable the drop-down arrow.

Variable | Value

= Stream Parameters
Stream Amount (mol) 55.5082
Ambient: Temperature (*C) 25.0000
Ambient: Pressure (atm}

= Calculation Parameters
Final Temperature (*C}) 25.0000
Final Prezsure (atm}) 1.00000
Veszzel Volume (L) 2.00000

Partial Pressure: CO2 (atm)
Compute rezultz at which condition Ambient =

= inflows
Ambient

H200 e s
coz 0.0
HalH 0.0
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At this point the system is defined as 1 kg H20 (55.508 moles) at an ambient temperature of 25 °C. The partial
pressure of CO2 will be calculated at a final temperature, 25 °C and pressure, 1 atmin a 2 L vessel.

14. We are ready to perform the calculation. Click on the Calculate button or press the <F9> key
15. ltis time to save your file (File >Save as...) or using the save icon in the tool bar. You can save under the

same file that we created before named as Single Point Calculations.

Anaylyzing the Results
Review the Summary Box or Click on the Output-Minitab to see the results.

J Variable Value - Type of calculation
= Stream Parameters (mol) Autoclave - Specs...
Lf_l Stream Amount 55.5308
|— Moles (True) - Liguid-1 (mol) £C £3g7 Calculate 48
L Moles (True}) - Wapor (mol) 0.0405453
Summary
= Calculation Results
Final Temperature (*C} 25.0000 Unit Set: Metric (moles) e
Final P tmy) 1.00000
inal Pressure (atrm) Automatic Chemistry Model
Vessel Volume (L) 2.00002 MSE-SRK (H30+ ion) Databanks:
Partial Pressure: CO2 (atm) 0.963445 M3E-SRK (H30+ ion]
Condition that results were computed f| Final MSE (H30+ ion)
a Second Liguid phase
Ll Inflows (mol) Using Helgeson Direct
Hz2O 55.5082 *'| Autoclave Calculation
coz 0.0725218 Results for final conditions:
Ambient Temperature  25.0000 *C
Final Temperature 25.0000 *C
Final Pressure  1.00000 atm
Vesszel Volume 2.00000L
COZ 0.953445 atm

A total amount of 0.0725 moles of CO2 added was computed by the software to set the autoclave total pressure
to 1 atm. For comparison, the same scenario in Example 12-1_Anaylyzing the Results required 0.04 moles of
N2. The difference is the amount of CO: that dissolved in the water. CO2 is more soluble than Nz in water.

To analyze the CO2 distribution in more detail, go to the Report Tab, and Scroll down until you find the Element
Distribution table.

Element Distribution

Total Total Liguid-1 Vapor

maol mole % % of Total % of Total
H(+1) 111.016 66.5797 99.9977 2.32766e-3
0{-2) 55.6533 33.3768 99.8552 0.144823
Ci+4) 0.0725216 0.0434932 453222 54 6778

The Element Distribution table contains three rows, H(+), O(-2), and C(+4). These are the elements of H20
and CO:a. If you compare the C(+4) in the liquid and vapor phases, you will see that about 45.3% of the CO>
dissolved in the water phase. By comparison, 1.5% of the added N: dissolved in water at the same condition
(see Example 12-1).
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2. Using a Reactive Gas and a NaOH solution

In this example, you will further modify the chemistry by adding NaOH so that additional CO2 dissolves in water
to form bicarbonate. This will increase the gas requirement.

Starting the Simulation

You are going to use the same case that you built up in the example above, with the only difference that you
will add the 0.1 moles or NaOH.
1. Copy the Autoclave — COZ2 single point calculation and paste under the Autoclave Stream.

Name it Autoclave — CO2 — NaOH

Change the composition of NaOH to 0.1 moles and Calculate <F9>

| Variable Value

= Stream Parameters
Stream Amount {mol) 556082
Ambient: Temperature (*C) 25.0000
Ambient: Pressure (atm}

= Calculation Parameters
Final Temperature (*C}) 25.0000
Final Pressure (atm} 1.00000
Vessel Volume (L) 2.00000
Partial Prezsure; CO2 (atm)
Compute results at which condition Final

e Inflows (mol)
H20 55.5082
coz 0.0
NaOH 0.100000 |

At this point the system is defined as 1 kg H20 (55.508 moles) and 0.1 moles of NaOH at an ambient
temperature of 25 °C. The partial pressure of CO2 will be calculated at a final temperature, 25 °C and final
pressure, 1 atmin a 2 L vessel.

4. ltis time to save your file (File >Save as...) or using the save icon in the tool bar.

Anaylyzing the Results
Review the Summary Box or Click on the Output-Minitab to see the results.

e Inflows (mol)
H20 55.5082
coz 0.171500
MalH 0.100000

The CO: inflow is calculated to be 0.1716 moles. This is exactly 0.1 moles more than the calculation with only
CO2 (Example 13-1) and results from the acid-base reaction with the 0.1 moles of NaOH.
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To see the different species that have formed in solution go to the Report tab and select the Species Output
(True Species).

Species Qutput {True Species)

Row Filter Applied: Onhy Mon Zero Values

column Filter Applied: Onhy Non Zere Values

Total Liguid-1 Vapor
mal maol mal
H20 55.5083 55.507 1.28477e-3
Na+1 01 0.1
HCO31 0.0998917 0.0993917
co2 0.0716542 0.0320887 0.0395654
C03-2 5.42505e-5 5.42505e-5
H30+1 2.3994e-7 2.3994e-7
OH-1 6.87229e-8 6.87229e-8
NaOHCO3-2 276574814 27657414
NaOH 3.90126e-15 3.90126e-15
Total (by phase) 557799 557391 0.0408502

You can see that ~0.1 moles of bicarbonate (HC05) have been formed. This reaction is increasing the CO2 gas
requirement to reach a total final pressure of 1 atm.
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1.10. Custom

In the calculations that we have seen so far, variables were predefined. For instance, we selected either
temperature or pressure as a fixed value in order to find the dew point pressure or dew point temperature. With
the Custom calculation, however, you have the option to choose which parameters to set at fixed values and
which parameters to keep as variables, to calculate the desired information, such as, for example, to investigate
the solubility of gases in solution.

Example 14: Solubility of Oxygen in Water

With a custom calculation, we are going to calculate the solubility of Oz in water at 25°C and 1 atm.

Starting the Simulation

Use the inputs and parameters from the table below to create the stream’s composition. Certain inputs, such
as the name style, units, etc. will require further adjustments, and will be described as necessary.

Custom Calculation

Calculation Settings Stream Composition and Conditions
Calculation Type Single Point Calculation Stream Amount Default — 1kg
Calculation Sub-type Custom Temperature 30°C
Stream Name Custom Calculation Pressure 4 atm
Name Style Display Formula H20 Calculated
Unit Set Metric, Mass fraction — ppm (mass) | O2 0 mol
Framework MSE

Setting the pH

1. Add a new Stream

2. Click on the new Stream and press <F2> to change the name to Custom Calculation

3. Select the MSE thermodynamic Framework

4. Click on the Names Manager Icon and select the Formula option

5. Click ?n the Units Manager Icon, and select Metric, Batch, Mass Frac. This will change all inflows to
6. Qﬁii o/on. the Customize button. This opens the Edit Units window.

7. Under Basis Options change mass fraction from mass % to ppm (mass)

8. Enter 02 as an inflow and 0 moles

9. Change the T to 30 °C and P to 4 atm

10. Go to the Add Calculation button and select Single Point calculation
11. Select Custom as Type of Calculation

12. Change the SinglePoint name to Oxygen Solubility using the <F2> key

13. Select the Specs button. This will open the Calculation Options window
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Note: In the Calculation Options window, you have the option to select the Variables to Fix and the Variables
to Free. In this example, the Variable to Fix is the number of Moles (True) of Vapor which will be given a small
value of 1 x 1077 moles. You can interpret this as the first bubble of vapor formed, indicating that the aqueous
phase is saturated. The Variable to Free is the inflow of oxygen, in order to achieve saturation.

Calculation Options

Category

- Wariables
i Calculation Options

Cuztarm

Wariables bo Fix

Filter | Al i

Enthalpy - Tatal ~ Males [True] - Wapor
H20 %5
H20 - Sal
H20 -Yap £
H30+1

Males [True] - Liquid-1
02 - Ligl

02 -%Yap v | |1

Yarables to Free
Hide Related |nflows Mew Inflow

Hz20 oz
Prezzure
Temperature

>

L4

|.|—|

Select an equal number of variables to be fived and freed. Freed variables wil
be adjuzted to meet the specified value of the fised variables.

0k, Cancel Apply Help

14. In the Variables to Fix section, select Moles (True) Vapor, by double clicking or using the >> button.

15. In the Variables to Free section, select 02 as the inflow. Then click OK.
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This will add a Calculation Parameters sections, were the Target (Variable to Fix) and the Adjusted Inflow
(Variable to Free) are shown. The Target has a brown dot in front of it indicating that is fix value, and the
Adjusted Inflow is in green indicating that the software will adjust this value.

Description Definition [ Report 2} File Viewer

J Variable Value = Type of calculation
= Stream Parameters Cusgtom - Specs...
Stream Amount (kg) 1.00000
Temperature (°C} 30.0000 Calculate i
Pressure (atm) 4.00000 Summary
= Calculation Parameters
1o Target: Moles (True) - Vapor (mol) 0.0 Unit Set: =Custom:
Adpusted: 02 (ppm (mass)) | Lo Automatic Chemistry Model
e Inflows (ppm (mass)) MSE (H30+ ion) Databanks:
H20 1.00000e6 M3E (H30+ ion)

Adjusted: 02 Using Helgeson Direct

Custom Calculation
Fixed variable:
Moles (True) - Vapor, target:
0.0 mol
Free variable:
0z

Calculation not done
Moles (True) - Vapor must be
greater than 0.0.

IhpLt

Advanced Search Add az Stream Ewport

16. Fix the Moles (True) Vapor to 1e~”
17. We are ready to perform the calculation. Click on the Calculate button or press the <F9> key
18. ltis time to save your file (File >Save as...) or using the save icon in the tool bar. You can save under the

same file that we created before named as Single Point Calculations.
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Anaylyzing the Results

Review the Summary Box or Click on the Output-Minitab to see the results.

& Description Definition [ Report L} File Viewer

J Variable Value = Type of calculation
= Stream Parameters Custam - Specs..
|_|:_| Stream Amount (kg) 1.00015
|— Wass - Liquid-1 (k) 1.00015 Calculate &
[ Mass - Vapor (kg) 3.18493e-9 Surnmary
Temperature ("C) 30.0000
Pressure (atm) 4.00000 Unit Set: <Custom:
Calculation R It:
i culation Resulls Automatic Chemistry Modsl
®| Target Moles (True) - Vapor (mol} 1.00000e-7 MSE (H30+ ion) Databanks:
= Inflows (ppm (mass)) I_JSE (H30+ icn].-
Ha0 0008588t Using Helgeson Direct
= Custom Calculation
| Adiusted: 02 | 146.935 | Fixed variable

IMoles (True) - Vapor, target:
1.00000e-7 mol
Free variable:
02, total:
145.938 ppm (mass)

Phase Amounts
Agueous  1.00015 kg
Vapor 3.18493e-9 kg
Solid 0.0 kg

Agueous Phase Properties
pH 6.91733
lonic Strength  2.18165e-% molimol
Density 0.985710 g/ml

Calc. elapsed time: 1.053 sec

Calculation complete

Input

Advanced Search Add as Stream Export

At 30°C and 4 atm the solubility of Ozin water is 146.94 ppm (mass)
To get an estimate of the Henry’s constant, you can study the K-values reported by the software.

Right click on the gray area, go to Sections>K-values>m-based.



H +  Stream Parameters

Description Definition @ Rep Calculation Results
~  Inflows

- Type of calculation
Variable Related Inflows *

= Strea N ot 5 :
Additional Stream Parameters (Uit e pecs
1= Stream Amount (kg)

|7 Mass _ Liquid1 (kg) Phase Flow Properties Calculate

L Mass - Vapor (ko) Thermodynamic Properties —
Temperature (*C) Pre-scaling Tendencies
Pressure (atm) Pre-scaling Index Unit Set: <Customs=
Cale . .
= i Scaling Tendencies Automatic Chemistry Model

®| Target: Moles (True) - Vapor (mol} Scaling Index WSE (H30+ ion) Databanks:

= Inflow MSE (H30+ icn)
= Liquid-1 Using Ha\gesrjm Direct
Adjusted: 02 Vapor ‘Custom Calculation

Fixed variable:

Solid Moles (True) - Vapor, target:
Molecular Apparent > 1.00000e-7 mol
Free variable:

Totals 02, total:
Mealecular Totals 146.938 ppm (mass)

Phase Amounts
MESUES > | Aquesus 1.00015 kg
Activity Coefficients > | Vapor  3.18483e-9kg

: o Solid 0.0kg
Fugacity Coefficients - Vapor

Agueous Phase Properties

K-Values 7 (x-based) molmol
Gibbs Free Energy (m-based)
Units Manager...

Fugacities - Vapor

Gibbs Free Energy Standard State (x-based) Calc. elapsed time: 0.045 sec
Save default layout Entropy Calculation complete
Generste Model Entropy Standard State (x-based)
Input 0u o Hide Zero Values Mob'l'tlﬁ. .
Self Diffusivities »
Advancer Sections > Partial Pressures

@ & MNUM

The reciprocal of KO2VAP: 02VAP=02AQ will give you an estimate of the Henry’s constant.

= K-Values - (m-based)
KH20: 2H20=H30I0N+OHION 1.45564e-14
KH2OPPT: H2OPPT=H20 1.32964
KH20WAP: HZ0WAP=HZ0 23.8182
I KO2VAP: 02VAP=02A0 1.15985e-3




1.11. Reaction Kinetics

Most of the chemistry and calculations that we have presented so far assumes equilibrium. However, chemical
reactions vary in speed as they occur. Some can occur instantaneously, while others can take years to reach
equilibrium. The speed of a chemical reaction is given by the Reaction Rate, which is a measure of the change
in concentration of the reactants or the change in concentration of the products per unit time.

For the stoichiometric reaction below:

aA+bB+--—>cC+dD+ -

The reaction rate is defined as:

to = 1(d[A]\  1(d[B]\ 1/d[C]\ 1/(d[D]
rae= mu\Tar )T T\ ar )T c\Tar )T a\Tar
We can describe the kinetics of a chemical reaction by using a Rate Law, which is an expression that relates the
concentration of each reactant raised to an exponent that reflects the reaction order (which is determined
experimentally) and the rate constant, k, (a proportionality constate between reaction rate and concentration).
The general rate law is generally expressed as:

Rate = k [A]°[B]*

Where s + t gives us the reaction order of the reaction. s and t are not the same as the stoichiometric coefficients
a and b.

The reaction rate constant units are specific for the overall reaction order, since we always want the units of the
rate to be concentration units per unit of time, e.g., M/s.

Reaction order Units

0 M/s
1 1/s
2 1/(Mes)

The rate constant, k, is dependent on the temperature at which the reaction takes place. Its dependence with
temperature can be studied using the Arrhenius Equation, as shown below.

E,
k =Aexp (— ﬁ)

where: k= Reaction rate constant (units depend on reaction order)

A = Arrhenius frequency factor (has same units as k)
joule

E, = Activation energy (—)

gmole

R = Universal gas constant (8.314971:251{)

T = Temperature (K)
There are two different ways to enter rate laws reaction kinetics in OLI Studio: Stream Analyzer
1. Standard Rate Law which uses the Arrhenius equation for the reaction rate constant k, referred to as STD

type within the software.
2. Non-Standard Rate Law, referred to as SPEC type within the software.
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In this section, we will show you how to set up both types of reaction kinetics.

The reaction kinetics is enabled Under the Chemistry menu > Model Options > Phases > Kinetics

1.11.1. Standard Rate Law

The Standard Rate Law (STD) considers both the forward and reverse reaction rates, the individual species
reaction orders, and the forward and reverse reaction constants (determined using the Arrhenius Equation).

For the reaction below:
aA+bB+ o cC+dD + -

where: a, b, ... ¢, d are stoichiometric coefficients
A, B, ... are reactant species
C,D, ... are product species

The rate law is of the form:

Rate = (kraj‘a}? ... — k.ab'ah?)
where:
Rate = Reaction rate mTOI
ks = Forward reaction rate constant (units depend on reaction order)
k., = Reverse reaction rate constant (units depend on reaction order)
Ay, A, o = Activities of reactant species (1:1—031)
Ty e = Reaction order of individual reactant species
(normally from experimental data.Default is stoichiometric coef ficients: a,b,...)
ac,ap, .. = Activities of product species (";—031)
D1, P2y - = Reaction order of individual product species

(normally from experimental data.Default is stoichiometric coef ficients: c,d,...)

Within the software the naming of the constants defined above is the following:

OLI Keyword Description

KF Forward reaction rate constant

KR Reverse reaction rate constant

AF Forward reaction Arrhenius factor

AR Reverse reaction Arrhenius factor

BF Forward reaction activation energy divided by the universal gas constant (K)
BR Reverse reaction activation energy divided by the universal gas constant (K)
ER; Reaction order of reactant species i

EP; Reaction order of product species i

Thus, when specifying a standard rate expression, the user must define one of the following: (1) The Arrhenius
frequency factors (AF and AR), and reaction activation energies divided by the universal gas constant (BF and
BR) or, (2) the reaction rate constants (KF and KR) directly. In addition, the user can specify the individual
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species order coefficients for the forward and reverse reactions if these differ from the stoichiometric coefficients
(which are the default).

When defining the reaction order for a species, the order in which the species appears in the reaction equation
must be defined (i.e., subscript /) with a sequential number, for either the reactant or product species. Hence,
the first reactant is identified with the number 1, the second, 2 and so on. Similarly, the product species are
identified with the integers 1, 2, 3, etc.

If any of the keywords are not defined, the software assumes a default value for that variable. These default
values are assumed to be zero for the reaction rate constants, Arrhenius factors, and activation energies
(divided by the universal gas constant). For the species reaction order coefficients, the reaction stoichiometric
values are assumed. To complete the standard rate expression definition, the reaction temperature and initial
reactant molality are included in the process stream composition definition.

Example 15: Reaction of Ammonia and Carbon Dioxide

In this example, we are going to consider the reaction of ammonia and carbon dioxide to form urea and water,
according to the following reaction:

2NH3(aq) + COz(aq) A NHZCONHZ(aq) + HZO

This reaction will take place in a plug flow reactor at 200°C and 100 atm, with a total residence time of 100
hours.

Starting the Simulation

Use the inputs and parameters from the table below to create the stream’s composition. Certain inputs, such
as the name style, units, etc. will require further adjustments, and will be described as necessary.

Single Point Calculation with Reaction Kinetics Enabled

Calculation Settings Stream Composition and Conditions
Calculation Type Single Point Calculation | Stream Amount Calculated
Calculation Sub-type Isothermal Temperature 200 °C
Stream Name Standard Rxn Kinetics Pressure 100 atm
Single Point Name Rxn Ammonia/CO2 Water 55.5082
Name Style Display OLI Name (TAG) | CO2 2 moles
Unit Set Metric, Moles NH3 2 moles
Framework AQ UREA 0 moles
Kinetics Enabled
Kinetics Holdup Time 100 hours
Number of Kinetic Steps 10

1. Add a new Stream
2. Click on the new Stream and press <F2> to change the name to Standard Rxn Kinetics

3. Select the AQ thermodynamic Framework
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4. Click on the Names Manager Icon, and select the OLI Name (TAG) option, and click OK.
Mame Style  Search Criteria  Mames Dictionary

Component Name Style
(O Display name
Use Names Dictionary

() Formula

(® OLI Name (TAG)

Show mineral name after solids

5. Click on the Units Manager Icon, and select Metric, Batch, Moles.

6. Enter the stream composition, temperature and pressure given in the table above.
7. Go to the Add Calculation button and select Single Point calculation

8. Select Isothermal (default) as Type of Calculation.

9. Change the SinglePoint name to Rxn Ammonia/C0O2 using the <F2> key

So far, we have created an Isothermal calculation. Now, we are going to enable the Reaction Kinetics option
at the Single Point Level.

10. To enable reaction kinetics, make sure that you are at the Single Point Level by clicking on the Single Point
Icon, and then go to Chemistry menu > Model Options. This will open the Chemistry Model window.

{) OU Studic - [Single point calculations.cad*] - m] >
B File Edit Streams Calculations | Chemistry Tools View Winflow Help - 8 X
(= T K Pre-built Models ER - o Rt #Es O A fi4
Navigator Templates 3
Document1
- - Model Options... o .
Single point calculations.oad* ; - Definition 3] Report LI File Yiewer
%6 streams ~ = Type of calculation
- 1.0.a pHof 1 mFeCl3 J Variable Value -
- & 1.1.blsothermal - acetic acid - S Isathermal ¥ | | Specs..
& 1.10. Custom Calculation Stream Amount (moly 59.5082 Cocuste @
=& 1.11.1. Arrhenius Rxn Kinetics Temperature (*C} 200.000 %
£ Ran Ammonia/C0O2 Pressure (atm} 100.000 Summary
& 1.2. Acetone Bubble Point = Inflows (mol)
=-& 1.3. Sour Natural Gas Dew Point H20 55.5082 Unit Set: Metric (moles
i i coz 2.00000
b 14 '“_"hu”‘ ‘a"”_‘“t'”” ) Automatic Chemistry Model
- & 1.3. Brine Evaporation - Vapor Fractior NH3 2.00000 Aqueous (H+ ion) Databanks:
=& 1.6. Neutralizing Acid URE& 0.0 Agueous (H+ion)
P e | j Using K-fit Polynomials
< > T-span: 25.0 - 225.0
. I Aqueous *P-zpan: 1.0 - 201.0
Actions B o8 * = differs from default
Actions » | Isothermal Calculation
200.000 °C 100.000 atm
Calculation not done
v
Input
Plot Template Manager L o+ x
Advanced Search Add az Stream Export
Save
* ~
*||Calculation Complete!
1
S v
@ NUM
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11. Select the Phases tab and check the Kinetics box. Then click OK.

Databanks

Include Phases

Agueous
Vapor

Solids

[ 5econd Liquid

lon Exchange Model
(® Margules
() Wilson

Kinetics
Enable

Redox FPhases

T#P Span

Include Solid Phases

All Solids

Calculate Scaling Tendencies for excluded solids

OK Cancel

Apply Help

A new grid section named Calculation Parameters appears. In this grid the Kinetics Holdup Time, and the
Number of Kinetic Steps can be defined. The default values are 2 h and 2 steps respectively.

12. Change the Kinetics Holdup Time to 100 hours and the Number of Kinetic Steps to 10.

|

=

Variable

Value

Stream Parameters

- Type of calculation

v

|zothermal

Stream Amount {mel) 59.5082
Temperature (*C}) 200.000 Calculate &8
Pressure (atm) 100.000 Summary
= Calculation Parameters
Kinetics Holdup Time (hr) 100.000 Unit Set: Metric (moles)
pbe ket 1 Automatic Chemistry Model
= Inflows (mol) Agueous (H+ ion) Databanks:
H20 555082 Agueous (H+ion)
coz 200000 T epen 2502280
MH3 2.00000 *Pgpan: 1.0 -201.0
UREA 0.0 * = differs from default.

> Izothermal Calculation

Kinetics Holdup time is equivalent to Residence Time. The Number of Kinetic Steps is equivalent to At, thus Kinetics

Holdup time = ZAt.

Note: Kinetics Holdup Time vs Number of Kinetic Steps
For processes that have reaction kinetics, the software needs to know how the concentration of the reactants (or products) change over
time during the reaction, which is given by the rate law. It is necessary to divide the total residence time into small steps. Adding more
steps decreases the error; however, as you increase the number of stages, the computational time increases.
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Now, our next step is to define the reaction kinetics.

13. Click on the Specs button. This will open the Survey Options Window.
14. Select Kinetics under the Category window

15. Click the Add button to add a new reaction. This will open the Select a Reaction Window.

Calculation Options ? x
Categary F ate Limited Reactions
i Calculation Options
Edit Delete
Reactions:
Rate Spedification:
ak Cancel Apply Help

You will be given a list of reactions which are already in the chemistry model. For our example, we need to
create a new reaction.

16. Select the option Create a New Reaction, and then click OK.

Select a Reaction: *

=Create Mew Reacti
CO2A0+H20=HION+HCO3ION

CO2VAP=CO2AQ

HCO3ION=HIOM-+C0O3I0N

NH2CO 210N +H20 =NH3AQ +HCO3I0N

NH3AQ +H20 =NH4I0MN +0HION

NH3VAP=NH3AQ

NH44H2CO33PPT =4NH4I0OM +2HCO 3IOM+CO 310N
NHAHCCO 3PPT =MH4IOMN +HCO 310N

UREAPPT =UREAAQ
I IRFANVAR =l IRFAAM

oK Cancel

This enables the option to enter a new reaction.
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17. Type the following reaction: 2NH3AQ+CO2AQ=UREAAQ+H20 and then hit Enter. The window will update.

Note: You must use the OLI Tag Name for this step, and additionally specify the phase of the reactants and products. Water is a

special case; it is written only as H20.

As a general rule:
e  For an aqueous phase: AQ
. For a vapor/gas phase: VAP
. For a solid phase: PPT

. For a hydrated solid: SOLIDNAME.nH20O, where n is the hydration number

. For an ion: ION

You can find the OLI TAG Name of your specific species using the Component Search Tool.

18. Select the STD (Standard Rate Reaction Kinetics) as the Rate Specification

Calculation Options ? X
Category Fiate Limited Reactions
-~ Caloulation Options
i Kinetics
Add Edit Delete

Reactions:

2NH3AQ +CO2AQ=UREAAQ+H20

Rate Spedfication: STD o

Rate Constants:

J Constant Value Add

Delete

Cancel Apply Help

Now, let’s start entering the rate constants.
Remember, the forward and reverse reactions have the same format. The rate is the following:

For this example, the forward rate constant (KF) is a constant value equal to 2000.
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And, the reverse rate constant (KR) is defined as follows:

-BR
KR=AReT

—3480.78
T

KR=12x10""e¢

A summary of the Reaction Rate Parameters is given in the table below (These parameters where created for
illustration purposes, do not use them for any real design work).

Parameters Value Comment

KF 2000 Forward Rate Constant

KR Calculated | Reverse Rate Constant

AF Not needed

AR 1.2 x 10710

BF Not needed

BR 3480.78 | Determined from BR = % = 22222
ER1 2 This is the exponent of reactant 1 [NH3]?
ER2 1 This is the exponent of reactant 2 [CO2]
EP1 1 This is the exponent of product 1 in the

mechanism. In this case [NH2CONH2]

EP2 0 H20 does not participate in the reaction

Now that we have identified the parameters needed, we can add them.

19. Click on the Add button and select the parameters needed.

Calculation Options ? s

Categary Rate Limited Rezactions

¢ Calculation Options
- Kinetics

Add Edit Delete
Reactions:

2NH3AQ+CO2AQ =UREAAQ+H20

Rate Spedification: 5TD ~

Rate Constants:

J Constant Value

KF F
AR
KR
BR
ER1 bE?
ERZ AR
EP1 BF
BR

ER1

EP1
EP2

Cancel Apply Help
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20. Type the constant values, and then click OK.

Calculation Options

Category Fiate Limited Fieactions

- Calculation Optiohs
ics

Add Edit Delete
Reactions:

2NH3AQ+COZAQ=UREAAQ+H20

Rate Spedfication: sTD ~

Rate Constants:

J Constant Value Add
KF 2000

AR 1.26-10 Delete
BR 348078

ER1 2

ERZ

EP1 1

EPZ 0

Cancel Apply Help

21. We are ready to perform the calculation. Click on the Calculate button or press the <F9> key.

22. ltis time to save your file (File >Save as...) or using the save icon in the tool bar. You can save under the
same file that we created before named as Single Point Calculations.
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Anaylyzing the Results
1. Click on the Output-Minitab to see the Results.

2. Right click on the gray area and select Sections> Molecular Apparent - Aqueous

~  Stream Parameters

ry Tools View Window Help

~  Calculation Results
" Inflows

Related Inflows

Va So L2 Re & |me & 05 & a0 .

= 1 Additional Stream Parameters

Fa

Description Definition |

Kinetics Reactions
Phase Flow Properties

Thermodynamic Properties

B Variable

Pre-scaling Tendencies
e Strea

LI:_| Stream Amount {mol}
I— Moles (True) - Agueous (mal)
L Moles (True) - Vapor (mol}

Pre-scaling Index
Scaling Tendencies

Scaling Index

Temperature (*C) Aqueous
Pressure (atm) Vapor
i Calcy Solid

Kinetics Holdup Time (hr) Molecular Apparent - Aqueous

Number of Kinetics Steps Totals

Ing

g X

calculation

athermal - Specs...

Calculate @

Metric (moles)

ic Chemistry Model

pus (H+ ion) Databanks:
beous (H+ion)

K-fit Polynomials

ipan: 25.0 - 225.0

gpan: 1.0 - 201.0
differs from default.

al Calculation
*C 100.000 atm

mounts

pus 58.0473 mol
1.0250% mol
0.0 mol

& Phaze Properties

6.66199

Strength  7.48750e-3 mol/mel
ty 0.888732 g/ml

psed time: 1.130 sec

ion complete

= In
Meolecular Totals
Hz0
coz MEBG Totals
NH3 Activity Coefficients
Fugacity Coefficients
Fugacities - Vapor
K-Values
Gibbs Free Energy
Hoii=Nanaters Gibbs Free Energy Standard State (x-based)
Save default layout Entropy
Generate Model Entropy Standard State (x-based)
Mobilities
| HideZeroValues Self Diffusivities
Sections » Partial Pressures
Advanced Search Add az Stream Export

About 0.002 moles of Urea had been formed with a total residence time of 100 hours.

- Molecular Apparent - Aqueous (mol)
H20
NH3

UREA

You can make changes on the residence time, reaction conditions
production of urea.

55.2950
1.95686
122715

2.09657e-3

or the rate of reaction to maximize the
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1.11.2. Non-standard Rate Law

Non-Standard Rate Law, also referred to as SPEC type within the software. These reactions do not follow the
Arrhenius kinetics.

Example 16: Ammonia Hydrolysis
In this example we are using simpler chemistry. We are going to study the hydrolysis of ammonia.
NHjqy + H,0 = NHf + OH"

For this reaction we know the forward rate constant (ks) but need to constrain the reverse reaction to the
thermodynamic equilibrium constant. This implies that we are going to replace an existing equation within the
software.

Starting the Simulation

Use the inputs and parameters from the table below to create the stream’s composition. Certain inputs, such
as the name style, units, etc. will require further adjustments, and will be described as necessary.

Single Point Calculation with Reaction Kinetics Enabled

Calculation Settings Stream Composition and Conditions
Calculation Type Single Point Calculation Stream Amount Calculated
Calculation Sub-type Isothermal Temperature 25°C
Stream Name Non-Standard Rxn Kinetics | Pressure 1 atm
Single Point Name Ammonia Hydrolysis Water 55.5082
Name Style Display OLI Name (TAG) NH3 0.1 moles
Unit Set Metric, Moles
Framework AQ
Kinetics Enabled

Add a new Stream

Click on the new Stream and press <F2> to change the name to Non-Standard Rxn Kinetics
Select the AQ thermodynamic Framework

Click on the Names Manager Icon, and select the OLI Name (TAG) option, and click OK.
Click on the Units Manager Icon, and select Metric, Batch, Moles.

Enter the stream composition, temperature and pressure given in the table above.

Go to the Add Calculation button and select Single Point calculation

Select Isothermal (default) as Type of Calculation.

© ©o N o g A~ 0N =

Change the SinglePoint name to Ammonia Hydrolysis using the <F2> key
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10. To enable reaction kinetics, make sure that you are at the Single Point Level by clicking on the Single Point
Icon, and then go to Chemistry menu > Model Options. This will open the Chemistry Model window.
11. Select the Phases tab and check the Kinetics box. Then click OK.

1.11.2. Mon-5tandard Kinetics Chemistry Medel Options ? X
Databanks Redox Phases  T/P Span

Include Phases Include Solid Phases
Agqueous
Vapor

Solids

1 5econd Liquid

lon Exchange Model
(®) Margules

() Wilson

Kinetics

Enable

Calculate Scaling Tendencies for excluded solids

Cancel Apply Help

Now, our next step is to define the reaction kinetics.

12. Click on the Specs button. This will open the Survey Options Window.

13. Select Kinetics under the Category window

14. Click the Add button to add a new reaction. This will open the Select a Reaction Window.
15. Select the first reaction: NH3AQ+H20=NH4ION+OHION, and then click OK.

Select a Reaction: X

<Create Mew Reaction >
MNH3AQ +H20 =NH4 0N -+2HION
NH3VAP=NH3AQ

oK Cancel
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16. Select the SPEC as the Rate Specification.

Calculation Options 7 >
Category R ate Limited Reactions
i+ Calculation O ptions
e Kinatics
Add Edit Delete
Reactions:

NH3AQ +H20 =NH4ION-+OHICN

Rate Spedification: SPEC w
OL/ASAP DEFIMES:
J Variable Expression Add

Delete

Cancel Apply Help

For this example, the forward and reverse reaction rates are the following:
Rates = k¢ * Yy, [NH3,aq] *Y,0[H20] where k; =3

k
Rate, =k, Yy [NH{] you-10H™] where k, = K_f
eq

Thus, the total rate is given by:

Rate = Rater — Rate,
Rate = kf "VYNHzqq [NH3,aq] ' VHZO[HZO] =k, Vnuf [NHI] *You-[OH™]

These is where things get difficult. You now need to speak “OLI". We have some rules for SPEC type equations.
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We now need to turn these values into “OLI” terms3.

We can define any variable we want. We have some variables that you will need to use. Any concentration

variable such as [NHaa] is defined as the natural log and is designated with the letter “L”. So [NHaaq] is used as
LNH3AQ.

Similarly, activity coefficients y are also taken as the natural log. So, y,y- is written as Loge yon- = AOHION.

KEQ is the thermodynamic equilibrium constant for the equation. AH20O is special in the Aqueous
thermodynamic framework in that it is the variable Ln(ay, ).

We now need to add these variables to the kinetics window?®:

Variable Expression

FXRATE LNH3AQ+ANH3AQ+LH20+AH20

RXRATE LNH4ION+ANH4|ON+LOHION+AOHION

KF1 3

KR1 KF1/KEQ

RATE1 (KF1*EXP(FXRATE)-KR1*EXP(RXRATE))*VOLLIQ/1000

17. Change the Kinetics Holdup Time to 100 hours and the Number of Kinetic Steps to 10.

OL/ASAP DEFIMNES:

J Variable Expression Add

FXRATE 134 0+8NHIAQ+LHZ0+AHZD | —————8™
Delete

5 Commonly referred to as ASAP variables.

6 Copy and paste from this document can make this step easier
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You will notice in the image above that we have scrolled to the end. That is ok. Click the Add button to continue
with the equations. It is important that you keep the order correct. You see what we are using previously defined
variables in subsequent equations.

Complete the remainder of the variables.

Calculation Options (7 |[==]
Categary Rate Limited Reactions
- Caloulation Options
‘- Kinetics
[ add || Edt |[ Delete
Reactions:

MNH3IAQ -+HH20=NH4ION-+OHION

Rate Spedfication: SPEC hd

OL/ASAP DEFIMES:

J Variable Expression Add
FXRATE LMH3AQ+ANH3AQ+LHZ0+AH

RXRATE LNH4ION+ANHAION+LOHION+

KF1 3
KR1 KF1/KEQ
RATE1 (KF1T*EXP{FXRATE}-KR1*EXP(

[ ak. ] [ Cancel Apply

The completed equations

The variable VOLLIQ is the volume of the liquid phase in Liters. OLI requires the rate to be in mol/m3 we need
to divide by 1000.

Click the OK button.

Like the previous example, this is a plug-flow reactor with a holdup time of 100 hours and 10 steps.

Now Calculate
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Once the calculation is complete you can click the Output mini tab and add the Aqueous section (not molecular
aqueous):

Definition | & Reponlg File Viewerl

Variable | Value n Tupe of calculation
= Stream Parameters [ |zothermal v] [ Specs... ]
|$| Stream Amount (mol) 55.6082
L moles (True) - Aqueous (mol) 55.6032 Calculate 0 |
Temperature ("C) 25.0000 Summary
Pressure (atm) 1.00000 s
= Calculation Results Unit Set: Metric (moles)
Kinetics Holdup Time (hr) 100.000 " ic Chemistry Model
Number of Kinstics Steps 10 AQ (H+ ion) Databanks:
= Inflows (mol) Public
H20 555082 Izothermal Calculation
NH3 0100000 25.0000 *C 1.00000 atm
- Aqueous (mol) Phase Amounts
al Agueous 556082 mol
Hz0 55.5077 (= Vapor 0.0 mol
NH3 0.0994574 Solid 0.0 mol
2
OHION 5.42587e-4 Ag Phase Properties
NH4ION 5.4258Te-4 pH 107171
HION 1.87028e-11 lonic: Strength  9.75731e-8 molmol
Density  0.995159 g/ml
Calc. elapsed time: 0.387 sec
Calculation complete
[ Inpu | Output |
[ Advanced ][ Search ][ Add as Stream ][ Export ] i

You can see that some ammonium ion has been created. It is interesting to see what the equilibrium condition
would be.

Create another single point isothermal calculation and run it without any reaction kinetics. Here are results
below:

Variable | Value A
& Stream Parameters
=] Stream Amount (mol} 55,6082
L Moles (True) - Aqueous (mol) 55.6082
Temperature (°C) 25.0000
Pressure (atm) 1.00000
= Inflows (mal)
H20 55.5082
NH3 0.100000
= Agqueous (mol)
Hz0 55.5069
NH3 0.0986221
OHION 1.3778%8e-3
NH4ION 1.3778%e-3
HION 7.89755e-12

The reaction kinetics have forced the back reaction to be dominant. In the equilibrium case, approximately

1.3x10-® moles of NH4* have been created. By limiting the forward reactions, we allow the back reaction to take
place and that only formed 5.4x10 moles of NH4*.
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Section 2. Survey Calculations

Survey calculations are single point calculations strung together in series. They are also referred to as multiple
point calculations.

There are three different ways to set up surveys:

1. Single Survey: These calculations allow the user to designate one independent variable. The predefined
single surveys include survey by Temperature, Pressure, Composition, pH, Vapor Fraction and Vapor
Amount.

Dual Survey: These calculations allow the user to designate two independent variables.

Survey by changing the single point calculation type: By default, the isothermal calculation is selected

for survey calculations. If the user wants to study the solubility of a salt in solution, it is possible to change

the survey from Isothermal to the Precipitation Point calculation type.

In this section, you will learn how to set up survey types and introduce some additional features to get the
most out of your simulation results.

¢ 0Ll Studic - [Document1*] - O X
B File Edit Streams Calculations Chemistry Tools View Window Help - 8 X
LDedE 20 | l1valsoll2 [Res [me s sl | MBS BE s
Mavigator L o~ X
p £
Document1 |
&% Streams Description Definition i Plot [ Report LI File Viewer
J Variable Value - Survey by
= Stream Parameters
Stream Amount (mol) 55.5082 e Temperature
Temperature (*C)
Pressure cs
Pressure (atm) 1.00000 -
e Inflows (mol) Eompostion
H20 55.5082 pH
Vapor Fraction
Vapor Amount
o "
Summary
Temperature survey:
Actions L o x Range 25.0to100.0°C
n Step size 50°C
Actions > No. steps 15
No secondary survey selected
Unit Set: Metric (moles)
Automatic Chemistry Model
Agueous (H+ ion) Databanks:
Agueous (H+ ion)
Using K-fit Pelynomials
T-zpan: 25.0 - 225.0
Flot Template Manager L o+ X P-span: 1.0 - 1500.0
Isothermal Calculation
25.0000 *C 1.00000 atm
Calculation not done
v
Input
Advanced Search Add as Stream Export
Save
For Help, press F1 @ MNUM

114



2.1. Single Surveys

An introduction to single surveys is given here. We will illustrate, in detail, the steps necessary to conduct this
type of calculation. The example below was designed to be used as a guide for future reference.

Example 17: Removal of Nickel from Wastewater

This case study is a typical wastewater treatment problem, the removal of a trace heavy metal ion (nickel) from
a water stream in which the presence of another chemical (cyanide) significantly alters the treatment strategy.
In this case, we are considering precipitation as an approach to removal of the nickel.

The wastewater in this case study contains nickel ions at a concentration of 0.002 m (or moles/ 1 kg H20). The
existing treatment strategy is to precipitate the nickel ions as Nickel Hydroxide (Ni(OH)z). The soluble nickel
remaining after precipitation needs to be less than 1 ppm, which is the maximum contaminant level allowed.

During the course of the plant operation, some cyanide ion is inadvertently added to the waste stream. The
soluble nickel is now more than 1ppm. Sulfide salts were then added to hopefully precipitate the nickel and
once again achieve the design specification.

This example will be divided into three different scenarios:

1. Scenario 1: Wastewater without Additives
2. Scenario 2: Wastewater with Cyanide Content
3. Scenario 3: Wastewater with Sulfide Salts

The power of the Stream Analyzer becomes apparent when we are seeking to study the chemistry of individual
streams. For this specific example a Survey by pH will be used.
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Scenario 1: Wastewater without Additives

We begin by starting the Stream Analyzer Program. This may be accomplished by clicking on the
OLI Studio : Stream Analyzer icon or by using the Start button and finding OLI Studio under

Programs, which will take you to the New window where you start creating your calculations. oLl E-.tud.ic-
9.6

1. Select the AQ-Databank (The default databank)
2. Click on Add Stream icon (in the actions panel). This will display the Definition window. We should add

some descriptive information about this stream, so we can later identify the stream

w

Click on the Description tab. This will display the description information

B

Replace the name Stream with the name Nickel Waste. It is advisable to change the name of the stream
from the default name. You may be entering many streams and will need to sort them out later

5. Add the following text to the Description box: “Nickel waste water for the OLI Aqueous Modeling Course”

Note: The summary box will contain additional information as the calculations proceed. This information maybe the name of additional
databases or chemistry models imported from other OLI software packages. The filled-out window should look like the figure below.

& OLl Studic - [Document1*] - O >
B File Edit Streams Calculations Chemistry Tools View Window Help - 8 X
=== ﬁ Cancel
DS M| Mvasol2 Red malfs s MEF: GEE2D
Mavigator L o+ X N
Document1*
&% Streams 3 &/ Description Definition 53 Report
i Nickel Waste
Name: |Nickel W aste o Date: | 4/8/2019  |w
Description
Nickel waste water for the OLI Aquecus Modeling C.'c:urse| e ~
Actions L o+ x v
j £ >
9 [¢] Add Stream [Z] Add Survey
Add Mixer Add Chemical Diag) Summary
[4] Add Single Point =) Add Stability Diagra
Unit Set: Metric (moles) ~
£ >
Autematic Chemistry Model
Plot Template Manager L o+ X Agueous (H+ ion) Databanks:
Agueous (H+ ion)
Using K-fit Polynomials.
T-gpan: 25.0 - 225.0
*P-span: 1.0 - 201.0
* = differs from default (¥
Save
x
L3
L
5
£
E
[5)
For Help, press F1 @ NUM
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Click on the Definition tab to start defining the wastewater stream
Click in the white box in the grid below the Inflows line. Add the formula Ni(OH)2

Note: Stream Analyzer will automatically change the name of the species to the selected display name. In this instance, the name
you entered was Ni(OH); but it may have changed to a different form. If it changed you can specify which display name to use in the

8.
update the list
Names Manager icon B
9.

icon % . This will open a new window.

10. Change moles to Mass Frac. Using the drop-down arrow

11. Click on the Customize button. The Units Manager window will appear.

Click in the white box next to the species you just entered and enter the value 0.002. Press <Enter> to

For the output results, we want output units in ppm. To change the output units, click on the Units Manager

File Edit Streams Calculations Chemistry Tools View Window Help
ﬁ = (ldle Cancel
D E 28 Mvasol2|Ret|me s | ME::  SEE 2D
Mavigator L o~ X N
Remaoving Mickel from wastewater_2 oad* |
b Streams Descrip Definition [ Report
Lo Mickel Waste
J Variable Value - Add Calculation -
e Stream Parameters . -
Special Conditions
| Stream Amount (mol) 55.5102 )
| Temperature (-C) 25,0000 L] Solids Only
Pressure (atm) 1.00000
Summary
= Inflows (mol)
Hz0 55.5082 Unit Set: Metric (moles)
| Ni(OH)2 2.00000e-3
Automatic Chemistry Model
Agueous (H+ ion) Databanks:
1| Actions o~ % Aqueocus (H+ ion)
Actions Units Manager - Nickel Waste ? X Using K-fit Polynomials
T-zpan: 25.0 - 225.0
@Add Stream Add Stability Diagra Units Manager *P-gpan: 1.0 - 201.0
Add Mixer Add Corrosion Rate * = differs from default.
(4] Add Single Point
Bt t idden:
@Add Survey Metric ~ Batch Mass Frac, rse:ar:fur;clnl::;ll gverncden
| Add Chemical Diagram .
£ >
Plot Template Manager . x
e g = Customize... 0
Input
Gl | [ oy || reb
Advanced
Save p—




12. Change the Mass Fraction Units to ppm (mass)

13. Click OK

Edit Units - Mickel Waste

Composition  Parameters  Corrosion

s

(®) Batch System () Flowing System

Mass Fraction

Mnla Fractinn

Variable | Basis Units
Inflow variables
Stream Amount Masz kg
Inflows Mass Fraction mass %
Dutput variables
Agueous Composition Masz Fraction mass %
Wapor Composition Masz Fraction mass %
Solid Compositien Mass Fraction mass %
2nd Liguid Composition Masz Fraction mass %
Total Composition Masz Fraction mass %
Basis options
Moles mol
Mass kg
Wolume L
Cencentration mgiL
Molar Concentration molL

Our primary interest in this application is finding the optimum pH for nickel removal. To create a plot of Ni*? as

function of pH, we will need to run a pH survey.
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Creating a pH Survey to find the optimum pH for nickel removal

Click on the Nickel Waste stream icon in the tree view on the left-hand side of the window. This will bring you
back to the top of the series of calculations by displaying just the stream information.

1.
2. Select Survey

Click on the Add Calculation button

DSE| L 202 2R | Wvasel2 Res mets ms | MEs B EE~ |

| Navigator g - x|
nickel waste oad* |
6“ Streams
Mickel Waste
| Actions g «x|
Actions
[8] Add Stream 8] Add Chemical Diagr:
&) Add Mixer =] Add Stability Diagrar
Add Single Point Add Corrosion Rates
] Add Survey
< >
| Plot Template Manager L - x
Save

b

Variable [ Value j
~ Stream Parameters g Single Point
Stream Amount (kg) 1.0001% S
Temperature (C) 25.0000 Urvey
Pressure (atm) 1.00000 Chemical Diagram
Summary
= Inflows (ppm (mass)) Stability Diagram
H20 9.99815e3 Unit Set Corrosion Rates
Ni(OH)2 185.335
Automatic Chemistry Model
q (H+ ion) Databanks:
Agueous (H+ ion)
Using K-fit Polynomials
T-span: 25.0 - 225.0
*P-span: 1.0 - 201.0
* = differs from default.
3
v
Input
Advanced Search Add as Stream Export
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You can now add descriptive information about this calculation.

3. Enter a new Survey name: Base Survey. You can also double click on ‘Survey’ to change the name

4. Enter a Description: Base pH survey without additives.

Since we do not want a temperature survey which is the default, we will need to change the survey type.

5. Click on the Definition tab to do the survey calculation.

6. Click on the Survey by button

7. Select pH

Note: The default acid titrant and the base titrant are already defined (HCI and NaOH). We are now ready to begin the calculations.

W7 File Edit Streams Calculations Chemistry Tools View Window Help g %
D&M | PR Uvasolz[Red mffeiat MAES G FE A
| Navigator g - x| z
nickel waste oad®
4 Streams Description Definition {1 Plot [ Report L3 File Viewer
= 0 Mickel Waste
______ (‘E Base Survey Variable | Value ~ Survey by
= Stream Parameters - Specs...
Stream Amount (kg) 1.0001% Temperature
Temperature (*C) 25.0000 P
ressure
Pressure (atm) 1.00000
e Calculation Parameters Eomposiion
L ] Target pH .
Use Single Titrant No Vapor Fraction
pH Acid Titrant HCI ‘u’apor Amount
pH Base Titrant NaOH
= Inflows (ppm (mass)) ST
Hz0 5.99815e5
[Actions LR Ni{OH}2 185.335 A
Actions el 0.0 */| pHsurvey:
Acid - HCI
NaOH 0.0 Base - NaOH
Range 0.0to 14.0
Step size 1.0
No. steps 14
No secondary survey selected
Unit Set: <Custom:=
|Plot Template Manager g «x
Automatic Chemistry Model
Agueous (H+ ion) Databanks:
) Agueous (H+ ion)
Using K-fit Pelynomials
ot T-zpan: 25.0 - 225.0
P *P_gpan: 1.0 - 201.0
* = differs from default. v
5 Advanced Search Add as Stream Export T .
ave
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We should now save our work. It is very frustrating to work for a long period of time and forget to save our work.
So please save.

8. Select File

9. Select Save As from the menu. Give the name Removing nickel from wastewater

10. Click on the Calculate button

C

[Mav
Re

e:“
=

1z [zl

File

Edit Streams Calculations Chemistry
New
Open...
Close
Save

Import

Print...
Print Preview

Print Setup...
Properties

1 Removing Nickel from wastewater_2.0ad
2 Removing Mickel from wastewater.cad
3 Removing Nickel from wastewater_1.cad

4 azeotrope_HCL-water_9.6.1.0ad

Exit

|Plot Template Manager

Save

OLI Studio - [Removing Mickel from wastewater_2.0ad]

— O *
Tools View Window Help - 8 X
Ctrl+N |
GO s mafsas | MBS GEEFD
+5
ftion Definition [l Plot [ Report L3 File Viewer
i Variable | Value - Survey by
Ctil+P Stream Parameters I vI Specs..
Amount (k: 1.00018 .
tka) Then by [optional]
rature (°C} 25.0000
re (atm) 1.00000 None -] | Specs..
Calculation Parameters Yary
pH Independently
ngle Titrant No Together
id Titrant HCL
se Titrant NAOH Calculate @
Inflows (ppm [mass)) Summary
9.99815e5
i2 185.335 ~
pH survey:
Acid - HCLIN
Base - NADHIN
Range 0.0to14.0
Step size 1.0
No. steps 14
No secondary survey selected
W Unit Set: <Custom:=
Input Automatic Chemistry Model
Agueous (H+ ion) Databanks: v
Advanced Search Add az Stream Expart . Aqufu,"!i(ﬂ)' ion) X
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The program will run for a short time. When the orbit disappears, check the summary box to see if the calculation
is complete. In the tree-view, you can expand the survey to see if all the points converged.

®7 File Edit Streams Calculations Chemistry Tools View Window Help - 8 X
| CR=E - ==
DSEE| %8R0 |5 2R | 1lvasi2 [Res|m i sy | sEs % WegasD |
| Navigator g s x| Z
Remaoving Mickel from wastewater_2 oad* |
EY] - Description Definition il Plot [ Report UI File Viewer
----- &y Target pH=0.0
0’ Target pH=1.0 Variable Value - Survey by
_____ L Target pH=2.0 = Stream Parameters pH - Specs...
— Sh A it (k 1.00019
..... 4y Target pH=3.0 T Thenby [optional]
..... 0, Target pH=4.0 Temperature (°C) 25.0000
..... Ly Target pH=5.0 Pressure (atm) 1.00000 Mone v| | Specs..
..... 0, Target pH=6.0 = Calculation Parameters Wary
..... 4y Target pH=7.0 @ TargetpH Independently
-4y Target pH=8.0 Use Single Titrant No Tagether
----- £ Target pH=9.0 N pH Acid Titrant HEl
[Actions L owm pH Base Titrant NaOH Calcuate @ |
Actions = LT P (e ) Summary
Hz0 5.95815e5 5
Ni(OH)2 185.335 A
HCl 0.0 PH survey:
Acid - HCI
NaOH 0.0 Base - NaOH
Range 0.0tc14.0
Step size 1.0
No. steps 14
|Plot Template Manager L o % Mo secondary survey selected
W Unit Set: <Custom:=
Input 1 2 3 4 5 [ 7 g Dz‘ Automatic Chemistry Model
Agueous (H+ ion) Databanks: v
g Advanced Search Add as Stream E=port . ,F\qLIEU—L!SH(I:H |0n.} .
ave
* =P-gpan: 1.0 - 201.0 ~
4 = = differs from default.
IS
5
i§ Calculation Complete!
5 v
For Help, press F1 @ NUM |
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We can now obtain some graphical results.

11. Click on the Plot tab

12. Click on the Variables button

W7 File Edit Streams Calculations Chemistry Tools View Window Help - 8 X
o ~—4r ==
DEd | =2 k‘" L1 Va So L2 [Re & |me & U & mi‘ M%i|ﬁ'}ﬂt&l}‘
| Navigator g - x| Z
Remaoving Mickel from wastewater_2 oad* |
- 45 Base Survey " Description Def@ (il Plot 5 Report L2 File Viewer
----- &y Target pH=0.0
..... 4y Target pH=1.0 @ 2 =] | WiewData Wariables Options
----- 4y Target pH=2.0
""" & Target pH=3.0 1
----- 4y Target pH=4.0 L A ]
----- 4y Target pH=5.0 45000 ~ | B
----- 4y Target pH=6.0 L | 1
—a#— HCl[ppm (mass)] i
..... 4 Target pH=7.0 40000 I'I
_____ & Target pH=8.0 35000 —dc— NaOH [ppm (mass)] | _
----- & Target pH=9.0 v ||I |
Actions L - x g 30000 II| 4
3 ] | J
Acti
L5 = 25000 | 1
=} | J
T 20000 | B
| J
|
15000 | B
|
| J
10000 I,' 4
| J
5000 B
Flot Template Manager L o~ x ) /A i
[Default Plat] 0 FA FA ah ah U S ST Sy & .
Anquenus and Solids ¥ & & -~ & & LR T CRE R -
MGE Aqueous Mi+2)
Target pH
Save

123



This will open a new window. The NaOH and HCI variables in the Y-Axis box should be displayed.

13. Select them and then Click on the left double-arrow (<<) button which will remove NaOH and HCI from the
list. You can also select and double click to remove them.

14. Scroll down the left-hand window to find MBG Totals - Aqueous and expand the list by clicking the # box.

Note: MGB is an abbreviation for Material Balance Groups. The MGB variable is a sum of all the species for that material in the phase

requested.

Select Data To Plot

Curves

[#- Stream Parameters

[+ Calculation Results

(- Inflows

[#- Additional Stream Parameters

-- Phase How Properties

-- Thermodynamic Properties

-- Pre-scaling Tendencies

[#- Pre-scaling Index

-- Scaling Tendencies

[#- Sealing Index

[#- Aqueous

[&]- Vapor

- Solid

Molecular Totals

MEBG Totals - Totals

15
BG Totals - Vapor

- MBG Totals - Second Liquid

- MBG Totals - Solid

- MBG Totals - Surface

A X Axis
5 Target pH

2 Axis |

5%

Ardivits Cocdfininedn A snnssn (v hoanadl
[ Use short names
Hide zero species 7 A
Plot data which is enly within temperature range. - Select -

Cae | [ hoy | [ e

The grid updates to show the MGB totals available to display. In this case we desire the Nickel(+2) species. in
this case all the Ni(+2) Aq variable is a sum of all nickel containing ions in the aqueous phase in solution. Any
solids are excluded from the summation.
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15. Double-Click the Ni(+2) item or select it and use the >> button.

16. Click on the OK button.

Select Data To Plot ? x
Curves
.. Inflows A X Puis
[+- Additional Stream Parameters - ITargei pH
1 Ais |
<L
Y2 Ais |
- Dominant MBG Tetals - Aqueous
-Cli-1) Aq
-Hi+1) Ag 33

- Nal+1) Ag
<

W 012 A v
1 MW Toad-la  Afanae
[ Use short names
Hide zero species Z Axis
Plot data which is only within temperature range. - Select -

@[ oK e Spply Help
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You will see the new plot.

For many calculations, the values on the plot extend over a very large range of numbers. The default linear axis
may not capture all the details we require.

17. Above the plot window locate and select the Options button. This opens a new window.

B File Edit Streams Calculations Chemistry Tools View Window Help - 8 X
[l =y = S TN | 11 vasol2 Ret mrlfs s | #E: SEEED
Mavigator Lo+~ x i
Remaoving Mickel from wastewater_2 oad* |
(- 4 Base Survey " Description Definition Ul Plot [ Report LI File Viewer
- fy Target pH=0.0
- £y Target pH=1.0 |
-y Target pH=2.0
- fy Target pH=3.0 . . . . .
- £y Target pH=4.0 120
- fy Target pH=5.0 110 y
. £ Target pH=6.0 F )
& Targetp 100 [ —#—1li(=2) Aq [ppm (mass]
-y Target pH=7.0 [
- fy Target pH=8.0 — 90 |
w F
. & Target pH=9.0 v g a0 b
Actions p o~ % = [
: e T0F
Actions = L
= 60k
z L
& 50
& L
= 40 r
30 -
20 -
Plot Template Manaager L o+~ x 10 __
[Default Plot] 0 1
Aqueous and Solids o 7 < & ¥ &
MGE Aqueous Mi+2]
Target pH
Save
* =P-gpan: 1.0 - 201.0 ~
4 = = differs from default.
:
iE Calculation Completel
5 v
For Help, press F1 @ MNUM
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18. Select Y-Axis from the Category List
19. Check the Logarithmic Scale Box
20. Click on the OK box

Customize Plot

Category Scale  Fomat Title

- General
i Legend

@ ¥ Ais fol

- Az ..

4 ol

L Curves inimum

bd &irnum
WMajor Lt

Finor Unit

@ Logarithmic scale

2183

2 1 Cancel Apply Help

The modified plot is then displayed. The limit of 1 ppm for Ni*? is approximately 2 x 10-> moles. Above pH=9,
we are several orders of magnitude below this limit. Additionally, you can see that a minimum amount of Ni?* in
the aqueous phase seems to occur in the pH=11 range. This is the result of nickel solids forming and leaving
the aqueous phase.

Ni(+2) Ag [ppm (mass)]

letld pr—7—T—T— 7

fe+02 b

—g— Ni(+2) Ag [ppm (mass)]

fe+01 £

1e+00 —---- --- ---

Te-01 g

1e-02 L

1e-03 |

S5 I R U SR BRI E——
&

& -~

Target pH

Note: The red line was put as a reference. it was not plot with the software.

Let's make the plot shown above the default plot. To do that we are going to use the Plot Template Manager

Tool.
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21. Save the description in the left-hand corner panel named Plot Template Manager. Type MBG Aqueous
Ni(+2) as the name in this case.

22. Click Save
B File Edit Streams Calculations Chemistry Tools View Window Help - 8 %
== S 7M Livasol2|Red |m i s ME: GEEHFaD
Mavigator g o~ x £
Remaving Nickel from wastewater_2. oad* |
- 5% Base Survey ~ Description Definition [l Plot [E] Report CZ File Viewer
-y Target pH=0.0
4 Target pH=1.0 @ S| | By [=] | WiewData Wariables Options
-y Target pH=2.0
- &y Target pH=3.0 1e+03 ¢ T T T T T T T T
Q, Target pH=4.0 F
- &y Target pH=5.0 L
& Tar _ 1e+02 B E
get pH=6.0 E E
- {y Target pH=7.0 F
-4 Target pH=8.0 = Te+01 E
... & Target pH=9.0 v § E E
Actions X £ 1e+00 : 3
Actions £ E 3
= F
F 1e01 | 4
x i
< 1e-02 L E
1e-03 £ E
III-'PIotTempIabta Manager L o= x| F 1
[Crefault Plat] 1e-04
@ %
Target pH
@ [MEB Aquepis Nis2] |[save @
|| “P_span- 1.0- 201.0 a
* = = differs from default.
z
5
'_‘;1 Calculation Complete!
E]
s w
For Help, press F1 @ NUM

Now there will be two plots on that list now. First is default and second is MBG Aqueous Ni(+2). You are now
able to see these plot conditions for any other analyzer object in this case when you add survey for that object.
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What else is important in this solution?

23. Click once more on the Variables button

24. Add the following Aqueous species to the plot. (you may need to scroll up or down to find all the species):

Ni(OH)2
NiOH+1
Ni+2
Ni(OH)3-1
25. Add the following Solids species to the plot:
Ni(OH)2

26. Click on the OK button when done

W7 File Edit Streams Calculations Chemistry Tools View Window Help - & x
o~ ==
D& d | BN Uvasol2[Ret mifftas ME: GFEHD
| Navigator g - x| Z
Removing Mickel from wastewater_2 oad® |
- 45 Base Survey " Description Definition [l Plot [ Report I File Viewer
----- &y Target pH=0.0
_____ L Target pH=1.0 (7 RO Wiew Data Options
""" & Ta Select Data To Plot ? *
..... & Ta | S :
----- £ Tal Curves
..... 0 i ) -
_____ - Aqueous X Auis #2) Ag [ppm (mass)] E
..... & - Dominant Aqueous >3 ITarget pH b
O
..... 0 Ta el b
..... & Ta o Y1 fois I 3
~HZO NOH=1
Actions - HCl - Ag Ni+2 E
Actions - Na+1 > | [NioH)3 E
- NifOH)4-2 NifOH)2 - Ag
- NiZOH+3 << ) - §
Mi{OH)2 (Theophrastite) - Sol E
- Nid{OH)M+4 Nif+2) Aq
- NiCl+1
- OH-1 4
(- Vapor
=8 Solid | Y2 A [
i Dominant Solid E
|Plot Template Mana| [#]- Molecular Totals
[Default Plat] - MBG Totals - Totals >3 | Lo
L [+- MBG Totals - Aqueocus L7, 7 7 z Z
MGE Aqueous Mi[ & MBG Totals - V- ce g e (] -4 o
- MBG Totals - Second Liguid
0 RN Teod e  Calid
MGE Aquepis Mi[+2 [ Use short names
— Hide zero species Z Puis
x
» Plot data which is only within temperature range. - Select - ~
IS
5
ig Calculation C 27 Cancel Apply Help
5 v
or Help, press
For Help, press F1 @& NUM
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You can see that the soluble nickel (Ni(+2) Aq) is a summation of the other species. The large drop in the value
is because most of the nickel leaves the aqueous solution as Ni(OH)2-Solid at pH values greater than 7.0 with

a maximum near pH=11.

27. Let’s save this as a default plot as well in the Plot Template Manager as Aqueous and Solids

B File Edit Streams Calculations Chemistry Tools View Window Help - 8 X
ey = E TN 1Mvasol2 Red milfs s WEF:: GEE&D
Mavigator L o~ X £
Remaoving Mickel from wastewater_2 oad* |
- 45 Base Survey " Description Definition [l Plot [ Report I File Viewer
----- &y Target pH=0.0
_____ L Target pH=1.0 @ = |5 =] | WiewData W ariables Options
----- 4y Target pH=2.0
""" 4y Target pH=3.0 1e+06 T T T T T T T T T T T T T
----- 4y Target pH=4.0 r
— 1e+03 g
----- 4y Target pH=5.0 |
..... & Target pH=6.0 16400 |
----- Target pH=7.0 r
& Targetp 1e-03 F
----- 4y Target pH=8.0 r
..... A Target pH=9.0 A o 1e-06 r
a =
Actions g o+ % $‘ 1e-09 §
Actions i_ 1612 E —— NiOH+1 [ppm (mass)]
:E 1e-15 | — & Ni+2 [ppm (mass)]
2 tots E @ Ni{OH)3-1 [ppm (mass)]
r —¢— Ni(OH)2 - Ag [ppm (mass)]
1e-21 E __’_.A‘/ !,. — s Ni{OH)2 (Theophrastite) - Sol [ppm (mass)]
Te-24 4 /’l —g— Mi(+2) Ag [ppm (mass)]
r
Flot Template Manager L - x Te-27 -~
-
[Default Plot] e300 ML v v 1)
MGE Aqueous Mi+2) o 7 < & ¥ & & - @ @ ] 7y <) ] “z 5
Target pH
Aqueous and Solids || Save @
= *P-span: 1.0 - 201.0 ~
4 = = differs from default.
IS
5
"_E Calculation Complete!
TE v
For Help, press F1 @ MNUM
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Scenario 2: Wastewater with Cyanide Content

The real importance of aqueous speciation modeling of this treatment is only really appreciated if we introduce
the cyanides, which brings us to the real waste treatment problem.

For this scenario, you will repeat many of the same steps as in Scenario 1. We recommend that you create new
calculations below the Nickel Waste stream. This will keep the core composition the same without affecting
the results of other calculations.

Please follow these steps for this scenario. Please note that we will only show the screens that are substantially
different from those that you have already seen.

Creating a pH Survey to find the optimum pH for nickel removal

1. Click on the Nickel Waste stream in the tree view in the left-hand window
2. This will display the Actions pane in the bottom left corner of the Stream Analyzer window. Click on the

Add Survey icon in the Actions pane

= = A | LLvasolz Red me 30+ s | fhEgns S R
MNavigator L o~ X N
nickel waste.oad* |
# Streams Description Definition [ Report
. & Mickel Waste
.@ Base Survey ] Variable Value ~ Add Calculation -
T Stream Parameters
Special Conditions
Stream Amount (ko) 1.0001% 5
Temperature (°C) 25.0000 L] Solics Only
Pressure (atm) 1.00000
Surmmary
= Inflows (ppm (mass))
Hzo 9.99815€5 Unit Set: <Customs=
Ni{OH)2 185335
Automatic Chemistry Model
Agueous (H+ ion) Databanks:
Agueous (H+ ion)
Using K-fit Polynomials
T-span: 25.0 - 225.0
- *P-span: 1.0 - 201.0
Actions v X * = differs from default.
Actions »
(&) Add Stream 8] Add Chemic
&) Add Mixer 3] Add Stability
Add Single Point Add Corrosit
@ Add Survey
< >
Flot Template Manager L o+ x
v
Input
Advanced Search Add az Stream Expoit
Save
x
L3
1
&
For Help, press F1 @ NUM
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3. Click on the Description Tab, and change the Name and Description in the Description tab.

Name: Waste Survey with CN
Description: pH survey with both Nickel and CN

4. Click on the Definition Tab
5. Add NaCN to the grid with a value of 490 ppm

6. Click on the Survey By button and select pH. Note that HCI and NaOH are the default titrants and are
automatically added

7. Click on the Calculate button.

W7 File Edit Streams Calculations Chemistry Tools View Window Help - 8 X
D& PR lvasol2[Red[m il at MERS |G N AL
| Navigator L o~ x| i
nickel waste oad®
&% Streams Description Definition i Plot [ Report UI File Viewer
=& Mickel Waste
‘g Base Survey Variable | Value ~ Survey by
4T Waste Survey with CN = Stream Parameters | pH - Specs...
Stream Amount (k 1.0001% .
tka) Then by  [optional)
Temperature (*C) 25.0000
Pressure (atm) 1.00000 Mone v| | Specs..
e Calculation Parameters Yary
@ TargetpH Independently
Use Single Titrant No Together
pH Acid Titrant HCL
pH Base Titrant NaOH Caloulate &
= Inflows (ppm (mass)) ST
Hz0 9.99325e5
| Actions g +x Ni(OH}2 185.335 ~
Actions NaCN 290.000 > | PH survey:
Acid - HCLIN
h Base - NaOH
Range 0.0to 14.0
Step size 1.0
No. steps 14
No secondary survey selected
Unit Set: <Custom:=
|Plot Template Manager g - x
Automatic Chemistry Model
Agueous (H+ ion) Databanks:
Agueous (H+ ion)
b Using K-fit Pelynomials
T-zpan: 25.0 - 225.0
Input *P-zpan: 1.0 - 201.0
* = differs from default. W
5 Advanced Search Add as Stream Expart Set oH Calculation
ave
x|
L3
L
&
For Help, press F1 @ NUM |

132




Let’s review the results.

8. Click on the Plot tab
9. Go to the Plot Template Manager tool, and click on MGB Aqueous Ni(+2)

For Help, press F1
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The results have changed very dramatically. The new optimum pH for Ni removal is around 4.0, rather than 11.
However, the lowest total Ni remaining in solution is now around 4 ppm which is well over 1 ppm.
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Let's analyze why this is happening. We can now modify the plot to display more variables. Select the Aqueous

and Solids plot saved in the Plot Template Manager.

10. Click on Variables

11. Add the following new Aqueous species: Ni(CN)4-2
12. Add the following new Solid species: NiNi(CN)4-Solid
13. Click OK
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Let’s analyze the results.

The culprit is the Ni(CN)42 complex of nickel and cyanide. Basically, the plot of the total Ni in solution and the
Ni(CN)42 complex overlap over the interval pH=5 to 12. This means that virtually all nickel in solution is in the
form of this complex.

This complex thus holds the Ni in solution and does not allow the nickel hydroxide to even form. Instead, a
much weaker precipitate, the NiNi(CN)4 salt forms over a narrow range of pH with 4.0 being the optimum.
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Scenario 3: Wastewater with Sulfide Salts

We can now try to influence nature by introducing a source of sulfide. We do this because nearly all metal
sulfide salts are highly insoluble.

Create a new single point calculation and a survey as you did in the previous two scenarios.
Add 490 ppm of NaCN
Add 340 ppm of H2S

For the survey case, use the plot template manager to start off with the MBG— Aqueous (Ni+2) and then add
the following variables:

1. Aqueous Species: Ni(CN)4-2
2. Aqueous Species: Ni+2
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3. Solid Species: NiS-Solid
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The results reflect a "power struggle" between the Ni(CN)2 which is holding the nickel in solution and the NiS
solid which clearly has a greater tendency to form than the NiNi(CN)s solid. As a result, our optimum pH is still
around 4.0 and we are now around 10-® ppm total nickel in solution which is a bit below 1 ppm.

This would be a good time to save your work. You may use the File/Save As... menu item or use the Save icon
on the toolbar.

Final Thoughts...

Aqueous speciation modeling can teach us a great deal about complex chemical systems and the interactions
of individual species.

The actual removal achieved with sulfide may not be quite enough to satisfy the regulations. This is useful
information to have. In addition, with the power of OLI Studio: Stream Analyzer, one could now explore alternative
treatment methods such as ion exchange.

Although such a simulation is beyond the scope of this demonstration, consider how vital it is to know that the

dominant species to be exchanged (removed from solution) is an anion Ni(CN)2 and not the cation (Ni+2) as the
conventional wisdom might dictate.
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2.1.1. Temperature Survey

The default single survey calculation is the Survey by Temperature. The software computes solution properties
based on a known composition and pressure at different temperatures.

Example 18: Studying a Four-phase mixture and its Partioning

The purpose of this first example is to present the basic Temperature survey. You will study how a four-phase
mixture partitions as a function of temperature. The system composition will be basic, containing one primary
phase component, H20 (liquid), CH4 (gas), Decane (organic), and NaCl (solid). Each component will partition
each of the other three phases.

Starting the Simulation

Use the inputs and parameters from the table below to create the stream’s composition. Certain inputs, such
as the name style, units, etc. will require further adjustments, and will be described as necessary.

Temperature Survey Calculation

Calculation Settings

Stream Composition and Conditions

Calculation Type

Survey

Stream Amount

Calculated

Stream Name

Temperature Survey

Temperature Range

25-100 °C

Survey Name 4-Phase Partioning Step Size Increment by 5 °C
Name Style Display Formula Pressure 1 atm
Unit Set Metric, Moles H20 50 moles
Framework MSE-SRK CH4 10 moles
C10H22 10 moles
NaCl 10 moles
1. Add a new Stream
2. Click on the new Stream and press <F2> to change the name to Temperature Survey
3. Select the MSE-SRK thermodynamic Framework
4. Click on the Names Manager Icon and select the Formula option
5. Click on the Units Manager Icon, and select Metric, Batch, Moles
6. Enter the composition of the stream given in the table above
7. Go to the Add Calculation button and select Survey calculation
8. Select Temperature as Type of Survey - Default
9. Change the Survey name to 4-Phase Partioning using the <F2> key
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10. Click on the Specs button. This will open the Survey Options Window

Variable Value ~ Survey by
= Stream Parameters Temperature -
Stream Amount (mol) 20.0000 X
(mol) Then by  [optional]
Temperature ("C)
Pressure (atm) 1.00000 Mone v | | Specs..
= Inflows (maol) Wary
H20 50.0000 Independently
CH4 10.0000 Together
C10H22 10.0000

NaCl 10.0000 Calculate &8

11. The Temperature Range is entered in the End Point section. The default values for the Temperature Range
are 25°C (Start) to 100°C (End). Leave the default values.
12. The Step Size can be given as Increments or Number of Steps. By default, in the Temperature Survey

the Step Size by 5 increments is selected. Leave the default values. Then click OK.

Survey Options ? X
Cateqgory Survey Range
r. 1 - Temperature
- Calculation Type Temperature Fiange |Init:
- Caloulation Options Selected Range
250t 100.0in15 Mew
Delete

(®) Linear () Log () Pairtt List
End Pointz

Start 250000
End |100.000

Step Size

Select one, the other is
caloulated

Increment (O] }

Mumber Steps 15 O

Cancel Apply Help

13. We are ready to perform the calculation. Click on the Calculate button or press the <F9> key
14. ltis time to save your file (File >Save as...) or using the save icon in the tool bar. You can save under the

same file that we created before named as Survey Calculations.
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Anaylyzing the Results
Click on the Plot tab (il Plot ),

The default plot is the phase amounts in grams of Liquid-1 (Aqueous Phase), Liquid-2 (Organic Phase), Solid
and Vapor.

The plot below, shows that as temperature increases, the mass of Liquid-1 and Liquid-2 (organic) decreases,
as they evaporate, and hence the Vapor phase increases. The solid phase mass remains constant up to 80°C,
and then increases at higher temperatures.

Description Definition [l Plot [E Report i File Viewer

|Mass—Liqui|:I—2[g]=[5l].l],141l].l]2] |@ e & Bl [ viewData || vaisbies || ptions

1900_'|'|'|'|'|'|'|'|'|'|'|'|'|'|'|'|'_
1800 | 3
1700 |
1600 |
1500 |
1400 | — 888 B _.__..__.___.___
1300 | _.& l"‘h--l
1200 [ +——+—+ & ———— o _‘__‘__‘_ “Hl
r . “
1100 | * u
1000 —&— Maszs - Vapor [g] “~.
900 L —— Mass - Solid [g] . N,
800 | —m— Mass - Liguid-2 [g]
700
600 [
500 |
400 |
300 |
200 F
100 | 3

—— Mass - Liguid-1 [g]

Mass - Vapor, Mass - Solid, etc.
#

Temperature [*C]

Note: When the mouse-pointer is positioned over a point on one of the curves, the message box at the top of the plot indicates
the variable and the coordinates of that point.
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2.1.2. Pressure Survey

In the Survey by Pressure, the software computes solution properties based on a known composition and
temperature at different pressures.

Example 19: Dissolution of CO: in water as a Function of Pressure

Many thermodynamic properties are less dependent on pressure than they are on temperature. Vapor-Liquid-
Equilibrium (VLE) is affected by pressure.

In this example, the dissolution of CO: in water (which is a direct reflect of VLE) will be studied as a function of

pressure.

Starting the Simulation

Use the inputs and parameters from the table below to create the stream’s composition. Certain inputs, such
as the name style, units, etc. will require further adjustments, and will be described as necessary.

Pressure Survey Calculation

Calculation Settings

Stream Composition and Conditions

Calculation Type Survey Stream Amount Calculated
Stream Name Pressure Survey Pressure Range 5-100 atm
Survey Name CO2 dissolved in water Step Size Increment by 5 atm
Name Style Display Formula Temperature 25°C
Unit Set Metric, Moles H20 55.5082 moles
Framework MSE-SRK CO2 10 moles

1. Add a new Stream

2. Click on the new Stream and press <F2> to change the name to Pressure Survey

3. Select the MSE-SRK thermodynamic Framework

4. Click on the Names Manager Icon and select the Formula option

5. Click on the Units Manager Icon, and select Metric, Batch, Moles

6. Enter the composition of the stream given in the table above

7. Go to the Add Calculation button and select Survey calculation

8. Select Pressure as Type of Survey

9. Change the Survey name to CO2 dissolved in water using the <F2> key

10. Click on the Specs button. This will open the Survey Options Window

—

Pressure (atm)
=

H20

coz

J Variable

Temperature (*C}

Value
Stream Parameters

Stream Amaunt {mol)

Inflows (miol)

- Survey by
Pressure - Specs...
§5.5082
Then by  [optional
25.0000 v [op )
MNone - Specs...
Vary

55 5052 Independently

10.0000 Together
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11. The default pressure range is from 1-10 atm with an increment of 1 atm. Change the Pressure Range to
5-100 atm. Set the Step Size to 5 atm increments. Then click OK.

12. We are ready to perform the calculation. Click on the Calculate button or press the <F9> key

13. ltis time to save your file (File >Save as...) or using the save icon in the tool bar. You can save under the

same file that we created before named as Survey Calculations.

Anaylyzing the Results

Click on the Plot tab (ﬂ Plot ) The default plot is the phase amounts in grams of Liquid-1 (Aqueous Phase),

Liquid-2 (Organic Phase), Solid and Vapor.

You can see that the Liquid-1 phase increases up to around 60 atm, and then it follows a constant trend as the
pressure continues to increase. Regarding the Vapor phase, you can see that it shows a sudden decrease in
mass from around 400 g at 60 atm to 0 g at 65 atm. The pressure of the system has increased in such a way
that causes a phase change from vapor phase to Liquid-2 phase.

We are interested in the solubility of CO2 in water, i.e. in the Liquid-1 phase. We can change the default plot to
show the molecular CO2 dissolved in water (CO2-Liq1).

1. Click on the Variables button. This will open the Select Data to Plot window.
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2. Double click or use the << button to remove the Phase Amount variables.

3. Look for Liquid-1 and click on the [ box to show all the available variables. Select CO2-Liq1 and put it in
the Y1 Axis using the >> button.

4. Look for Additional Stream Parameters section and click on the & box to show all the available variables.
Select pH and put it in the Y2 Axis using the >> button. Then click OK.

Select Data To Plot ? x

Curves

" Caleulation Results £ Pressure
(- Inflows
[I- Additional Stream Parameters 1 Axis i
- Diensity - Liquid-1 C02- Lgl

- Diensity - Liquid-2
- Density - Total wn
- Density - Vapor

- Diglectric Constant - Liquid-1

- Dielectric Constant - Liquid-2

- |onic Strength (m-based) - Liquid-1
- lonic Strength (x-based) - Liquid-1
- pH - Liquid-2

- Standard Liquid Volume - Liquid-1 Y2 fuis [
- Standard Liquid Volume - Liquid-2 pH

- Standard Liquid Velume - Vapor
- Vapor Fraction (Vapor/Inflow [mol]) >
[+ Phazse How Properties

[+- Thermodynamic Properties
[+- Pre-scaling Tendencies

I D 1 H B rllrns h
[ Use short names
Hide zero species Z Puis
Plot data which is only within temperature range. - Select -

Cancel Apply Help

The default plot now is showing the selected variables: The dissolved COz: in the water (Liquid-1 Phase) in the
Y1 Axis, and the pH in the Y2 Axis. Both variables are presented as function of pressure.

6—TTT 77T T T T T T T T T T T T T T T
| A . | 3.575
14 L —a— COZ - Lig1 [mel] 4 3525
L\ | —aeHO2) 1 3475
12} 1
L - 3.425
E 10 | — 3375
N {2325 5
' L - 3.275
o ]
o 06rF 4 3.225
o4 b {3175
: _ 13125
02r e 1
> i
_ Ay, 3075
U-U L L | | I T | | I I I I BN B R 3-025
o TS B D%

Pressure [atm)]

142



The dissolved COz in solution increases as the pressure increases. When the pressure goes above 65 atm, the
dissolved COz2 remains nearly constant.

A similar behavior is seen in the pH. As the pressure increases, a decrease in pH is observed. This is attributed
to the following equilibria dissociation reactions:

COzpap © CO,4q
C0y4q + H,0 & H* + HCO3
HCO; < H* + C0%
Thus, as the amount of CO:z in the aqueous phase increases, the dissociation reactions create more hydrogen

ions (H*) available in solution, subsequently decreasing the pH. As the pressure reaches values above 65 atm,
the pH value remains constant. Hence, the pH is a direct reflection of the dissolved CO: in solution.
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2.1.3. Composition Survey

In the Survey by Composition, the software computes solution properties based on a given composition of

species (or set of species) at a specific temperature and pressure.

Example 20: Dissolution of Calcite (CaCOs) as a function of CO:2

Calcite is a scale that forms very easily in the production of oil. It has been found that the addition of CO2
promotes the dissolution of Calcite scale. In this example, you are going to evaluate the effect of different CO2

concentrations on the dissolution of Calcite.

Starting the Simulation

Use the inputs and parameters from the table below to create the stream’s composition. Certain inputs, such

as the name style, units, etc. will require further adjustments, and will be described as necessary.

Composition Survey Calculation

Calculation Settings

Stream Composition and Conditions

Calculation Type Survey Stream Amount Calculated
Stream Name Composition Survey Temperature 25°C
Survey Name Calcite Dissolution Pressure 75 atm
Name Style Display Formula H20 55.5082 moles
Unit Set Metric, Moles CaCo03 0.05 moles
Framework MSE CO2 concentration range 0-1 moles
Step Size Increment by 0.05 moles

1. Add a new Stream

2. Click on the new Stream and press <F2> to change the name to Composition Survey

3. Select the MSE thermodynamic Framework

4. Click on the Names Manager Icon and select the Formula option

5. Click on the Units Manager Icon, and select Metric, Batch, Moles

6. Enter the composition of the stream given in the table above

7. Go to the Add Calculation button and select Survey calculation

8. Select Composition as Type of Survey.

9. Change the Survey name to Calcite Dissolution using the <F2> key

Note: In the summary box a message in red appears: ‘Component not selected for composition survey

variable’. This means that we need to select the component that we want to vary. In this example CO2.

10. To specify the component, click on the Specs button. This will open the Survey Options Window.
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11. Under the Component tab, select CO2

Survey Options

Category

Calculation Options

Survey Range

Component [nflows

Hide Related Inflows

Mew Inflow

CalC03

Hz0

Select a component inflow which will be varied ower the specified range.

Cancel Apply

Help

12. Now, click on the Survey Range tab

0.05 moles. Then click OK.

Survey Options

Category

+%ar, 1 - Compaosition
- Calculation Type
- Caloulation Options

Compogzition Range

Selected Range

0.0t 1.00n

Component | Survey Range

Urit: | mal

(®) Linear (O Log

() Paint List

Mew

Delete

End Puaints

Step Size

Mumber Steps 20

Increment | 0.0500000 ®

e } calculated

Cancel Apply

Select one, the other is

Help

. Enter the CO2 composition range from 0 to 1 mol, by increments of
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13. We are ready to perform the calculation. Click on the Calculate button or press the <F9> key

14. ltis time to save your file (File >Save as...) or using the save icon in the tool bar. You can save under the

same file that we created before named as Survey Calculations.

Anaylyzing the Results

Click on the Plot tab (ﬂ Plot ). The default plot is the pH as a function of total CO2 in moles. As the

concentration of CO2 increases, the pH decreases (as it was explained in the example above).

We are interested in understanding the dissolution of Calcite as a function of CO2. To see these results, we

need to study how the moles of solid calcite change as the concentration of CO:2 increases.

1. Click on the Variables button. This will open the Select Data to Plot window.
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2. Double click or use the << button to remove the pH variable

3. Look for Solid section and click on the [# box to show all the available variables. Select CaCO3 (Calcite)
— Sol and put it in the Y1 Axis using the >> button. Click OK.

The default plot now is showing the selected variable: CaCO3 (Calcite) — Sol as a function of CO..
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0.045 _'\ —a—CaC03 (Calcite) - Sol [mol]

0 043 }
0.041F
0039 F *

0037 F N\

0.035 | 7'\\k
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0.019 [
0.017 F
0.015 L
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As it was expected, the amount of CaCOs (Calcite) decreases with increasing COz. In an oil production setting,
when there is a significant pressure drop, CO2 will be lost. This will decrease the solubility of CaCOs and will
increase the likelihood of scale formation.
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2.1.4. pH Survey

In the Survey by pH, the software adjusts the flowrate of acid or basic titrants to at a predefined set of pH values
and computes the solution properties of a solution based on a given composition of species (or set of species)
at a specific temperature and pressure.

Example 21: A Speciation Diagram for the Carbonic Acid System as a Function of pH

In this survey calculation, a 1 molal CO2 solution is titrated with HCI and NaOH. Instead of defining the amount
of acid/base to add, the pH will be specified, and the software will compute the amounts of HCl and NaOH
needed.

Starting the Simulation

Use the inputs and parameters from the table below to create the stream’s composition. Certain inputs, such
as the name style, units, etc. will require further adjustments, and will be described as necessary.

pH Survey Calculation

Calculation Settings Stream Composition and Conditions
Calculation Type Survey Stream Amount Calculated
Stream Name pH Survey Temperature 25°C
Survey Name Carbonic Acid System | Pressure 1 atm
Name Style Display Formula H20 55.5082 moles
Unit Set Metric, Moles CO2 0.001 moles
Framework AQ pH range 4-12
Step Size Increment by 0.1
1. Add a new Stream
2. Click on the new Stream and press <F2> to change the name to pH Survey
3. Select the AQ thermodynamic Framework
4. Click on the Names Manager Icon and select the Formula option
5. Click on the Units Manager Icon, and select Metric, Batch, Moles
6. Enter the composition of the stream given in the table above
7. Go to the Add Calculation button and select Survey calculation
8. Select pH as Type of Survey
9. Change the Survey name to Carbonic Acid System using the <F2> key

The calculation can be run without modification. The default titrants are HCI and NaOH, and the default pH
range is set from 0 to 14 with a step size of 1 increment. However, this pH range is too broad for the carbonate
system, in which most of the speciation occurs between pH=4 and 12. Additionally, it is ideal to specify finer
increments to see a smoother curve.
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10. Click on the Specs button. This will open the Survey Options Window
11. In the pH Titrants tab, leave the default pH Titrants: HCI and NaOH

pH Titrants | Survey Range
Select an add and base to adjust to meet the specified pH.
[ use single Titrant Hide Related Inflows New Inflow
Acid Base
co2 coz2
H20 H20
NACH

12. Now, click on the Survey Range tab. Enter the pH range from 4 to 12, with increments of 0.1. Then click
OK.

pH Tirantz | Survey R ange

Target pH Fange

Selected Range

(®) Linear [ () Point List

End Points
Start
Step Size
e ® } Select one, the other iz
Mumber Steps 20 O calculated

13. We are ready to perform the calculation. Click on the Calculate button or press the <F9> key

14. ltis time to save your file (File >Save as...) or using the save icon in the tool bar. You can save under the
same file that we created before named as Survey Calculations.
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Anaylyzing the Results

Click on the Plot tab (Wl Plot ) The default plot is the moles of added HCI and NaOH vs Target pH. This is not
the target variable and you will change it to display the carbonate-containing species.

1. Click on the Variables button
Remove the NaOH and HCI from the Y1 axis (double click or use the << button)
Look for Aqueous section and click on the # box to show all the available species. Select the following
species: CO2-Aq, HCO3-1, CO3-2, and H+ and put them in the Y1 Axis using the >> button or by double

clicking. When you are done, click OK.
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You can also present this plot on a semi-log scale.

4. Click on the Options button. This will bring the Customize Plot window

5. Select Y Axis in the Category window
6. Check the Logarithmic scale box, and then click OK.

Custornize Plot

Category Scale  Format Title
Auto
Minirmurn
M awirnum
Major Urit
Minar Uit

Logarithmic scale

Cancel

Apply Help

Before analyzing the plot, let’'s add the OH- species.

7. Click on the Variables button, look for OH-1 in the Aqueous section, add it to the Y1 Axis, and then click

OK. Now we are ready to analyze the plot.
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At lower pH, CO2-Agq dominates the system, and notice how the HCO3-1 slope is 1 and the CO3-2 slope is 2.
Likewise, in the pH region where CO3-2 dominates (high pH), the HCO3-1 slope is -1 and the CO2-Aq slope is

-2. These ":Ze slopes are based on the number of H+ ions added or removed in the chemical reactions. See

reactions below.

COyqq + H,0 & H* + HCO3
HCO; & H* + C0%™

Note the pH where the CO2-Ag and HCO3-1 lines intersect (pH~6.3), and where the HCO3-1 and CO3-2 lines
intersect (pH~10.3). These pH values are the same as the pKa values (the equilibrium equations the specific
equilibrium reactions).

As NaOH is added to convert HCO3- to CO3-2, a portion of the NaOH remains as free base, OH-1. This fraction

increases at higher pH values, and its concentration is reflected in the calculated pH. A similar pattern is seen
at pH below ~3 for HCI and H+.
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2.1.5. Vapor Fraction / Vapor Amount Survey

The purpose of the Vapor Fraction/Vapor Amount Survey calculation is to set a specific fraction of the stream
to the vapor phase, and compute the temperature or pressure required to achieve the specified Vapor
Fraction/Vapor amount.

Example 22: Seawater Evaporation

Seawater contains a variety of salts, and when seawater evaporates, these solids are left behind. The most
abundant salt in seawater is sodium chloride (NaCl) which is also technically referred to as halite.

You will evaporate seawater to dryness and look at the solids that form. What is interesting is the number of
phases that can be produced when seawater evaporates, giving you a sense of how certain natural systems
build up sediment of a particular nature.

In this example we will also introduce the Object Library tool.

Starting the Simulation

1. Open the Object Library window — from the menu, View > Toolbar > Object Library. The Object Library
appears in the right-hand side of the window.

tudio - [Survey calculations.oa -
¢ 0Ll Studio - [Survey calculati d*] O X
B File Edit Strearns Calculations  Chemistry  Tools | Wiew  Window  Help - 8 X
(=2 = % K2 |11 va So L: Print Layout MET B
Iavigator L o+ X N Vieww 5 Object Library L oTx
Documentt My Objects
- = Arrange lcons > -
Survey calculations.oad” Descrif ) eport Standard Objects
3 Line up lcons
‘9 srearms T Walue |~ Add Caleulati @ @
& 21, Nickel Waste u Full Screen ualue . LEBIEED
& 211, Temperature Survey 55 T Tondiions Arabian Gulf Basic
G- 2.2 Pressure Survey Toolbars » +  Standard oics Onip SeaWifater...  Produc.
& 2.1.3. Composition Survey «  Status Bar " Chemistry Model Options
‘ 214, pH Sur\.-'ey Pressurersmy B Tools @ @
= Inflowsi{mal) — DryAir  Bxtended
Hzo Calculation Status moles) Produc...
o2 ~  Calculation Qutput
= ) istry Model @ @
J v Actions ion) Databanks:
+  Plot Template Manager i+ ion) Maist Sir Pseuda
B Naigator 'g”“g;‘% (50% hu.. Components
Actions L - x e‘/ Object Library - 15000 E @
ctions v Sea Wiater Seawater
[&] 2dd Stream B &dd Chemic {Malecul...
&) 2dd Mixer 3] 2dd Stahility,
[4]) 5dd Single Paint 5] £dd Corrosic @ @
Add S
@ Hrey Standard Wiater
a 2 Seawvat.. Analysis
Plat Template Manager p o+ x
v
Input
Advanced Search Add az Stream Export
Save
x
L3
2
[8]
@
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2. Drag the Seawater (Molecular inflows) stream to the navigation panel (in the white-space below the other

streams and calculation objects)

¢ 0Ll Studio - [Survey calculations.oad®] — O e
B File Edit Strearns Calculations  Chemisty  Tools  Wiew Window Help - 8 X
D=EE TN | Lvasol2 Red w3+ | MAEF: G EHE
Mavigator L o+ X N Object Library L oTx
Documentt My Ohjects
Survey calculations.oad* Description Definition [ Report Standard Objects
&b Streams
+6 2.1, Mickel Waste J Variable Value A Add Calculation -
+ & 211, Terperature Survey = Stcamiiarameters Special Conditions Arabian Gulf Basic
+- 212 Pressure Sursey CEED ARV i) 5 S [ Salids O Seatlater..  Produc..
+-#& 2.1.3. Compaosition Survey VEmFEFETD () 25.0000 s
- 214 pH Sureey Pressure (atm) 1.00000 5 @ @
: ummary
L Seawater (Malecular inflows)-1 = Inflows (mol} Dry Air Extended
~o H20 555082 Unit Set: Metric (moles) Praduc...
-~ [ala)r] 1.00000&-3
S Automatic Chermistry Model @ @
b Agqueous (H+ ion) Databanks:
\\ Aqueous (H+ ion) Maist Air Pseuda
“\ Using K-fit Polynomials (50% hu... Components
L. T-span: 25.0 - 225.0
o P-span: 1.0 - 1500.0
i -~
Actions Lo~ X ~a
Actions --.,___‘_-. b Sea Water
[&] 2dd Stream B &dd Chemic Bttt T I | ——
&) 2dd Mixer =) 2dd Stability
(4] £dd Single Paint [B1] 2dd Carrasic @
Add
@ Hrey Standard Wiater
a 2 Seawvat.. Analysis
Flot Template Manager L o x
v
Input
5 Advanced Search Add as Stream Export
ave
x
L3
IS
g
or Help, press
For Help, p F1 @

The inputs and parameters are automatically populated when selecting the Seawater (molecular inflows) form
the Object Library.

Click on the new Stream and press <F2> to change the name to Vapor Fraction Survey

Go to the Add Calculation button and select Survey calculation

Select Vapor Fraction as Type of Survey

Change the Survey name to Seawater Evaporation using the <F2> key

Click on the Specs button. This will open the Survey Options Window

The default Vapor Fraction range is from 0-1 with an increment of 0.1. Change the Vapor Fraction Range
to Survey End to 0.95. Set the Step Size to 0.05 increments. Then click OK.

. We are ready to perform the calculation. Click on the Calculate button or press the <F9> key

10. ltis time to save your file (File >Save as...) or using the save icon in the tool bar. You can save under the
same file that we created before named as Survey Calculations.

® N O AW
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Anaylyzing the Results

Click on the Plot tab (ﬂ Plot ) The default plot is the Vapor Fraction plot (as the dependent variable) vs
Temperature. It shows that seawater boils initially at 100°C, and at near complete evaporation (95%) the
temperature is 109.4°C.

L L e e L I e B I B B B B B N B B B B
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101.0 _—//.__.__.__.__,_;—0-—.-——0—
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.

6. 0 0 0 0 0 0 0, 0 0 0 0 0. 0. 0 0, 0 0, 0. 0 7
D h T H o s o D R R R D G e R D %D

99.0

Vapor Fraction (Vapor/Inflow [maol]} [mol/mol]

We are also interested to know which solid phases precipitate as the water evaporates.

1.

Click on the Variables button

Remove Temperature from the Y1 axis (double click or use the << button)

Look for Solid section and click on the # box to show all the available species. Select the option Dominant
Solids and put it in the Y1 Axis using the >> button or by double clicking. When you are done, click OK.
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4. The default plot is not very easy to read. To see the plot more clearly, right click on any number in the Y
axis, and select the Logarithmic Scale option.
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As the water evaporates CaSO4, Mg(OH)2 and SrSOq salts precipitate at all temperatures. NaCl and a Mg/SO4
double salt start to precipitate at 95% vapor fraction.
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2.2.

Dual Surveys allow you to study the effect of two independent variables on your system under study.

Dual Surveys

The option for the dual survey is highlighted in red box highlighted in the image below. There are three options
available, survey by Temperature, Pressure and Composition.

Additionally, you have the option of varying the selected variables independently or together. We will explore
this in more detail in the upcoming examples.

Description Definition [}l Plot [ Report [} File Viewer

J Variable
=
Stream Amount (mel)
Temperature (*C)
Pressure (atm)
=
H20

Input

Advanced Search

Stream Parameters

Inflows (mol)

&dd ag Stream

Export

Value

55.5082

55.5082

Survey by

Thenby  [optional)

Temperature - Specs..

Range 25.0t0 100.0 °C
Step size 5.0°C
Mo. steps 15

Pressure survey
Range 1.0 te 10.0 atm
Step size 1.0 atm
Mo, steps 9

Primary and secondary survey
variables
move independently

Total points: 160

Unit Set: Metric {moles)

Lutomatic Chemistry Moedel

I Pressure: vI Specs...
YWary
(® Independently
() Together
Calculate 4
Summary
Temperature survey:

Aqueocus (H+ ion) Databanks:
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Temperature and Pressure Survey

In this type of survey two variables are adjusted simultaneously, temperature and pressure. This type of survey
creates a matrix of results, which can then be interpreted using the plot function in different ways.

Example 23: Dissolution of CO: in water as a Function of Temperature and Pressure

In Example 19, the dissolution of CO2 in water was studied only as a function of pressure. In this case, we are
going to study the effect of both temperature and pressure on the CO:2 dissolution.

In this example the Contour Plot will be used to analyze the results.
Starting the Simulation

Use the inputs and parameters from the table below to create the stream’s composition. Certain inputs, such
as the name style, units, etc. will require further adjustments, and will be described as necessary.

Temperature and Pressure Survey Calculation

Calculation Settings Stream Composition and Conditions

Calculation Type Survey Stream Amount Calculated

Stream Name T/P Survey Pressure Range 5-100 atm

Survey Name CO2 dissolution — T/P Step Size Increment by 5 atm

Name Style Display Formula Temperature Range 5-100 °C

Unit Set Metric, Moles Step Size Increment by 5 °C

Framework MSE-SRK Vary Independently
H20 55.5082 moles
CO2 10 moles

Add a new Stream

Click on the new Stream and press <F2> to change the name to T/P Survey
Select the MSE-SRK thermodynamic Framework

Click on the Names Manager Icon and select the Formula option

Click on the Units Manager Icon, and select Metric, Batch, Moles

Enter the composition of the stream given in the table above

Go to the Add Calculation button and select Survey calculation

Select Temperature and then by Pressure

Change the Survey name to CO2 dissolution T/P using the <F2> key

2 © ©o N o o s~ D=

0. Click on the Temperature Specs button. This will open the Survey Options Window
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11. Change the Temperature Range to 5-100 °C. Set the Step Size to 5 °C increments.
12. Click on Var. 2 — Pressure, in the Category Window to define the Pressure Range.
13. Change the Pressure Range to 5-100 atm. Set the Step Size to 5 atm increments. Then click OK.

Survey Options ? *

Category Survey Range

Pressure Range Unit:

atm

- Lalculahon | ype Selected Range
- Calculation Options B.0to 100,00 19

Mews

Delete

(@) Linear (O Log () Pairt List

End Paints
Start
2
Step Size
inerement C } Select one. the other is
Murnber Steps 19 e caleulated

Cancel Apply Help

14. In the summary box, notice that a total of 400 points will be calculated. We are ready to perform the
calculation. Click on the Calculate button or press the <F9> key

Description (&F Definition i}l Plot [l Report LJ File Viewer

] Variable Value A Survey by

= Stream Parameters Temperature: hd

Stream Amount (mel) 65.5082
(mol) Thenby  [optional)

Temperature ("C)
Pressure (atm) Pressure ~| | Specs.

=l Inflows (mol) Wary
H20 55.5082 (@) Independeantly
coz 10.0000 O Tagether

Calculate &8

Summary

=

Temperature survey:
Range 5.0t 100.0°C
Stepsize 5.0°C
Mo. steps 19

Pressure survey
Range 5.0 to 100.0 atm
Step size 5.0 atm
Mo. steps 19

Primary and secondary survey
wariables

move independently

v Total points: 400

Unit Set: Metric (moles)

Input

Automatic Chemistry Medel (vl
Advanced Search Add as Stream Expart MSE-SRK (H30+ ion) Databanks
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15. Itis time to save your file (File >Save as...) or using the save icon in the tool bar. You can save under the

same file that we created before named as Survey Calculations.

Anaylyzing the Results

Click on the Plot tab (ﬂ Plot ) The default plot is the phase amounts in grams of Liquid-1 (Aqueous Phase),
Liquid-2 (Organic Phase), Solid and Vapor.

We are interested in the solubility of CO2 in water, i.e. in the Liquid-1 phase. We can change the default plot to
show the molecular CO2 dissolved in water (CO2-Liq1).

1. Click on the Variables button. This will open the Select Data to Plot window.
2. Double click or use the << button to remove the Phase Amount variables.

3. Look for Liquid-1 and click on the [# box to show all the available variables. Select CO2-Liq1 and put it in
the Y1 Axis using the >> button. Then click OK.

Select Data To Plot ? *

Curves

[#- Stream Parameters - X s

t1- Calculation Results 35 Temperature
nflows
Additional Stream Parameters ¥1 Axis |
: Phase How Properties C02- Lig1

[#- Thermodynamic Properties
-- Pre-scaling Tendencies
[+ Pre-scaling Index
-- Scaling Tendencies
[+ Scaling Index

- Liquid-1

- Dominant Liguid-1

- H20 ¥2 Asis |

L OH-1 -

[
[ Liquid-2
[

o Rl dmr Tt

[ Use short names
Hide zero species 7 Mais
Plot data which iz only within temperature range. | Pressure »

QK Cancel Apply Help
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The default plot now is showing the dissolved COz in the water (Liquid-1 Phase) in the Y1 Axis as function of
pressure. Unfortunately, the legend is covering the plot.

4. To move the legend to the side without interfering with the results, right click on any white space within the
plot and Allow Layout Changes. This option allows you to select and reposition the plot.

Description Definition @l Plot [ Report I File Viewer
‘ @ =% Wiew Data Variables Options

R R SEEEErr R e e e e n
22 = T T T T T T T T T T T T T T T T T T
: 20 Options > ]
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E CO2 - Lig1 [mol] - Pressure = 10.0 atm
: 16 |+ Allow Layout Changes m
' 2 - Lig1 [mol] - Pressure = 15.0 atm =
H Hide Legend 1
Vo 14k [mol] - Pressure = 20.0 atm
- ssure = 25.0 atm Zoom ? :
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L3 H
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Lo 10 Copy K -
e F reposition the plot
H 08| Export CSV... — H
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5. Resize the plot to make it smaller and create space for the legend. Drag the legend to the right.
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As the temperature increases (at a fixed pressure) the solubility of CO-. This is to be expected since at higher
temperatures it is easy to overcome the vapor pressure and CO: is released as gas. As the pressure increases
(at a fixed temperature) the solubility of COz2 in solution increases.

The plot above can be represented better using a Contour Plot. To convert the results into a contour plot view,
simply click on the contour plot icon (E).

The resulting plot is now a pixilated color plot showing the moles of molecular CO2 dissolved in the Liquid-1
(Aqueous) phase, at each T and P value.

The number of moles of COz is characterized by a different color that is shown in the legend (maximum value
is given in red, and minimum value is given in blue). You can mouse over any location in the plot and the moles
of CO2 dissolved in the Liquid-1 phase at each T and P value will be shown in the left corner box.

[c02 - Lig1 (5.0, 95.0) = 2.03232 |a & | Wi i
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| Options |

Pressure [atm)]

T s % o R D B DB D B DS

Temperature [°C]

Note: The legend scale can also be optimized by either right-mouse-clicking on the Legend and selecting Options>Plot
Options>Contour or clicking on the Options button in the upper right and selecting Contour. Both open to the Contour
options window, where the color and range can be modified.

In the contour plot, you can see the effect of both Temperature (x-axis) and Pressure (y-axis) on the solubility
of COz2 in water. Higher solubilities are obtained at high pressures and low temperatures, while lower solubilities
are obtained at high temperatures and low pressures.
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Survey by changing the single point calculation type

Sections 2.1 and 2.2 so far have presented single and dual surveys. In addition to adjusting these survey
variables, you can select one of several single point calculations embedded within the survey. The embedded
single point calculations include: Isothermal (default), bubble point, dew point, vapor amount, vapor fraction,
set pH, precipitation point, composition point, and isochoric.

Survey Options ? x

Categary Calculation Type
- ar. 1 - Temperature

- it Type of Calclation
- Calculation Type Temperature Specs...
alculabion Uptions Pressure

~ |sothermal

Bubble Point etz Mew Inflowr

Dew Point

Vapor Amount
Vapor Fraction

Set pH
Precipitation Point

Composition Point

Isochoric

Cancel Apply Help

Temperature Survey with a Precipitation Point Calculation

In this Temperature Survey, the Calculation Type will be changed from Isothermal Calculation to Precipitation
Point. This will allow us to model the solid solubility vs temperature.

Example 24: Solubility of Halite as a Function of Temperature
In this example, we are going to study the solubility of NaCl (halite) as a function of temperature.
Starting the Simulation

Use the inputs and parameters from the table below to create the stream’s composition. Certain inputs, such
as the name style, units, etc. will require further adjustments, and will be described as necessary.

Temperature Survey with a Precipitation Point Calculation

Calculation Settings Stream Composition and Conditions
Calculation Type Survey Stream Amount Calculated
Stream Name Solubility vs T Pressure 1 atm
Survey Name Halite Solubility vs T Temperature Range 5-100 °C
Calculation Type Precipitation Point Step Size Increment by 5 °C
Name Style Display Formula H20 55.5082 moles
Unit Set Metric, Moles NaCl 0 moles
Framework MSE
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14.

Add a new Stream

Click on the new Stream and press <F2> to change the name to Halite Solubility vs T and P
Select the MSE thermodynamic Framework

Click on the Names Manager Icon and select the Formula option

Click on the Units Manager Icon, and select Metric, Batch, Moles

Enter the composition of the stream given in the table above

Go to the Add Calculation button and select Survey calculation

Select Temperature as the type of survey

Change the Survey name to Halite Solubility vs T using the <F2> key

. Click on the Temperature Specs button. This will open the Survey Options Window
11.
12.
13.

Change the Temperature Range to 0-100 °C. Set the Step Size to 5 °C increments.
Click on Calculation Type, in the Category Window to define the Type of Calculation

Under Type of Calculation Change the Default Isothermal to Precipitation Point (use the drop-down arrow)

Select NaCl (Halite)-Sol as the Solid Precipitate and NaCl as the Adjusted Inflow. Then click OK.

Survey Options ? x

Category Calculation Type

Tepe of Calculation

Calculation Type
i Caleulahon Options

Temperature

Precipitation Point - | Specs..

Pressune

Lze Single Titrank Hide Related Inflows MNew [nflow

Solid Precipitate Adjusted |nflow

H20 - Sal -
HCL.1H20

HCL.2HZ20

HCL 3H20

MaCl [Halite] - Sol

acr paronae
MalH - Sal
MaOH.1Hz20
MaOH.2H20
Ma0H.3.5H20
MaOH.4H20 W

Cancel Apply Help
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The Calculation Parameters section is now shown in the Definition Tab, highlighting the Precipitant (NaCl
(Halite)) and the Adjusted Inflow (NaCl).

= Stream Parameters
Stream Amount (mol} 55.5082
Temperature (*C}
Pressure (atm) 1.00000

= Calculation Parameters

@ Precipitant: NaCl (Halite)

Adjusted Inflow: NaCl

& Inflows (mol)
H20 55.5082
NaCl 0.0

15. We are ready to perform the calculation. Click on the Calculate button or press the <F9> key
16. Itis time to save your file (File >Save as...) or using the save icon in the tool bar. You can save under the

same file that we created before named as Survey Calculations.

Anaylyzing the Results

Click on the Plot tab (ﬂ Plot ) The default plot is the amount of NaCl in moles added to 1 kg of water before
Halite precipitates as a function of Temperature.
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Temperature [*C]

Halite solubility increases slightly with temperature, from 6.16 moles/1kg H20 at 25°C to 6.68 moles/1kg H20
at 100°C.
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Example 25: Solubility of Halite as a Function of Temperature and Pressure

The effects of pressure on mineral solubility is generally less important than temperature. There is still an effect
that can be observed. The same stream created on Example 24 will be used.

Starting the Simulation

N o o s~ D=

10.

11

Under the Solubility vs T stream add a new Survey (see Stream information in Example 24)

Change the Survey name to Halite Solubility vs T and P using the <F2> key

Select Survey by Temperature and then by Pressure (This is a dual survey)

Click on the Temperature Specs button. This will open the Survey Options Window

Change the Temperature Range to 0-100 °C. Set the Step Size to 5 °C increments.

Click on Var. 2 — Pressure, in the Category Window to define the Pressure Range.

Change the Scale to Log, change the Pressure Range from 1 to 1000 atm, and set the Number of Steps
to 3 (i.e. it will plot the following pressures: 1, 10, 100 and 1000 atm). Then click OK.

Survey Options ? x

Categary Survey Range

Pressure Range Unit: | atm

Selected Range
1.0 to 1000.0

Delete

() Linear (®) Log () Pairt List
End Paints

Start |1.00000
End (1000.00

Step Size

Select one, the ather is

Increment  333.000
} calculated

Mumber Steps

Cancel Apply Help

Click on Calculation Type, in the Category Window to define the Type of Calculation
Under Type of Calculation Change the Default Isothermal to Precipitation Point (use the drop-down arrow)
Select NaCl (Halite)-Sol as the Solid Precipitate and NaCl as the Adjusted Inflow. Then click OK.

. We are ready to perform the calculation. Click on the Calculate button or press the <F9> key.
12.

It is time to save your file (File >Save as...) or using the save icon in the tool bar. You can save under the
same file that we created before named as Survey Calculations.
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Anaylyzing the Results

Click on the Plot tab (il Plot ) The default plot is the amount of NaCl in moles added to 1 kg of water before
Halite precipitates as a function of Temperature.
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The effect of pressure is significant between 100 and 1000 atm relative to the effects between 1 and 100 atm.

We can also present the Halite Solubility using a Contour Diagram. It would be ideal to define a finer range of
temperature and pressure.

Return to the Definition Tab
Click on the Temperature Specs button.

Change the Temperature Range to 0-150 °C. Set the Step Size to 2 °C increments.

Click on Var. 2 — Pressure, in the Category Window to define the Pressure Range.

o M Dbd =

Change the survey to Linear scale, change the Pressure Range from 20 to 1000 atm, and set the Step

Size to 20 atm increments. Then click OK.

Note: In the Summary box we can see that survey creates a matrix of 75 steps x 49 steps for a total of 76
temperature and 50 pressure points, or 3800 points in total.

6. Click the Calculate button. This calculation will take a few minutes to compute.

7. Click on the Plot tab and change the Plot to contour (E).
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The solubility is shown to increase as temperature and pressure increase. The increase is up to 50% from the
low values. A few of the points failed to converge at the low temperature and high-pressure conditions (shown
in gray).
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Composition Survey with a Bubble and Dew Point Calculation

In this Composition Survey, the Calculation Type will be changed from Isothermal Calculation to Bubble and
Dew Point calculations. This will allow us to model the vapor liquid equilibria (VLE) of mixtures.

Example 26: Ethanol-Water Azeotrope

In this example, you are going to calculate both the bubble point and dew points as a function of Ethanol-Water
composition.

The two data sets will then be transferred to a spreadsheet where the curves will be plotted together to locate
the azeotrope. You will need a spreadsheet/plotting software to complete this case.

Starting the Simulation

Use the inputs and parameters from the table below to create the stream’s composition. Certain inputs, such
as the name style, units, etc. will require further adjustments, and will be described as necessary.

Composition Survey with a Bubble and Dew Point Calculation

Calculation Settings Stream Composition and Conditions
Calculation Type Survey Stream Amount Default — 1kg
Stream Name Composition survey - Azeotrope | Pressure 1 atm
Survey Name Ethanol-Water Azeotrope Temperature It will be calculated
Calculation(s) Type Bubble Point / Dew Point H20 100 mass % - default
Name Style Display Name Ethanol 0 mass%
Unit Set Metric, Mass Frac. Composition Range | 0-100 mass%
Framework MSE Step Size Increment by 2 mass%

Calculating the Bubble Point

Add a new Stream
Click on the new Stream and press <F2> to change the name to Composition survey - Azeotrope
Select the MSE thermodynamic Framework

Click on the Names Manager Icon and select the Display Name option

1
2
3
4
5. Click on the Units Manager Icon, and select Metric, Batch, Mass Frac.
6. Enter the composition of the stream given in the table above

7. Go to the Add Calculation button and select Survey calculation

8. Select Composition as the type of survey

9. Change the Survey name to Ethanol-Water Azeotrope using the <F2> key

10. Click on the Composition Specs button. This will open the Survey Options Window
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11. Under the Component tab, select Ethanol

12. Click on the Survey Range tab. Change the Composition Range to 0-100 mass%. Set the Step Size to
2 mass% increments.

Survey Range Companert | Survey Fange

Cariponent [nflows

Hide Related Inflows

Mew [nflow Selected Range

0.0ta 100.0in 50

(®) Linear ) Log () Paint List

End Pointz
-
Step Size

Select a component inflaw which will be varied aver the specified range. Select ane, the ather iz

calculated

Increment (O] }

Mumber Steps 50 [

13. Click on Calculation Type, in the Category Window to define the Type of Calculation

14. Under Type of Calculation Change the Default Isothermal to Bubble Point (use the drop-down arrow).
Then click OK.

Survey Options ? >

Category Calculation Type

-~ Yar_1 - Composition

Type af Calculation

- Calculabion Options Bubblz Prirt - (®) Temperature

Solvent (_) Pressure

Specz...

Usze Single Titrant Hide Related Inflows Mew Inflaw

Cancel Lpply Help

170



15. We are ready to perform the calculation. Click on the Calculate button or press the <F9> key.
16. Itis time to save your file (File >Save as...) or using the save icon in the tool bar. You can save under the
same file that we created before named as Survey Calculations.

Anaylyzing the Results

Click on the Plot tab (ﬂ Plot ) The default plot is the bubble point temperature vs the mass fraction ethanol.
As the mass% of ethanol increases the bubble point temperature decreases.

| @ |5 |9 = |ViewData| ariables Options

o1+ % B E L N B N B B L BN B S B B B B B B B

1 i 1
99 [\ Q Options > ]
97 —\ —a— Temperature [C] S R 4

Allow Layout Changes

9

L b\ Hide Legend ]
93 =
L b\ Zoom > |
nr . Load Default Plot il

89-— Copy | —-
871 Export csv...l 0

Temperature [°C]

85 - Copy Scaled Image... 1
a3 . Save Image As... 1
L ".'.,. ]
T ““.‘.“-.“"““. ]
9 r B
| see® |
77 L . 1 1 1 1 1 1 1 L . . . . . 1 Ll 1

| - | I I N [T NI ——| L
©F % DB DE DS DTS

Ethanol [mass %]

You have 3 different options to retrieve this data to use it in your preferred plotting software.
Option 1: Right-click on the white region of the plot to open the drop-down menu and select Copy.
Option 2: Right-click on the white region of the plot to open the drop-down menu and select Export CSV.

Option 3: Click on the View Data button, select all data by clicking on the upper left corner of the table, and
copy the data using Ctri+C.

W Ethanol | Temperature
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In this case let’s use Option 1. Right click and Copy the data, then open your preferred plotting tool and Paste
the data.

Calculating the Dew Point

Return to the Definition tab

Click on the Composition Specs button. This will open the Survey Options Window
Click on Calculation Type, in the Category Window to define the Type of Calculation

Change the calculation type to Dew Point (use the drop-down arrow). Then click OK.

Recalculate, and click on the Plot tab

Right click and Copy the data, then open your preferred plotting tool and Paste the data

N o g kMoo Db =

Plot the two temperature curves vs mass% of ethanol and format as needed

Ethanol-Water VLE at 1 atm

100 +
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80
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——Dew Point Temperature [°C] Bubble Point Temperature [°C]

The azeotrope occurs at about 95% ethanol where the two curves intersect, at 78.15 °C.
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Section 3. Water Analysis (lonic Inputs)
OLI Studio: Stream Analyzer can accept two input types: molecular inflows and ionic inflows.
Sections 2 and 3 focused on molecular inflows. In this section, we will focus on ionic inflows, and we will learn

how to enter cations and anions using the object called Water Analysis. Additionally, we will show how the
reconciled sample can be converted into a molecular representation.

& Ol Studic - [Water Analysis.oad)] — O =
@7 File Edit Streams Calculations Chemistry Tools View Window Help = | =] e
DSE L0002 R | haseiz Res mallsme | MBS |G FE
| Navigator g x|
Water Analysis.oad | o
&} Streams Description Analysis [ Report
Variable | Value -
= Analysis Parameters Template Manager
Stream Amount (L) 1.00000
Temperature (*C) 25.0000
Pressure (atm) 1.00000
= Recorded Properties
Total Dissolved Solids (mg/L) 0.0 Surnmary
Measured pH 0.0
Measured Alkalinity (mg HCO3/L) 00 Unit Set: Metric (mass concentration)
Density (g/ml) 0.0 Automatic Chemistry Model
Specific Electrical Conductivity (umho/cm) 0.0 Aqueous (H+ ion) Databanks:
Agueous (H+ ion)
= Neutrals (mg/L) Using K-fit Polynomials
H20 T-zpan: 25.0 - 225.0
coz 0.0 P-span: 1.0 - 1500.0
| Actions L - x H2s 00
Actions si02 00 >
B(OH)3 0.0
Adfi_ Add Wa_ter = Cations (mgiL)
Reconciliat..  Analysis
Na+1 0.0
K+1 0.0
Ca+2 0.0
Mg+2 0.0
|Plot Template Manager L - x a2 00
Ba+2 0.0
Fe+2 0.0
v
Measured
| Advarced |
Save —
For Help, press F1 @ NUM
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3.1. Basic Terminology

When reviewing laboratory analysis of water samples, it is quite common for the positive ions (cations) and the
negatively charged ions (anions) in solution to not balance. This may be due to the precision limits of the various
experimental procedures used to measure the ions - i.e. some ions may not have been analyzed. These
solutions must have a neutral charge. Stream Analyzer will adjust/modify inflows in order to balance the charges
and make the solution neutral. This adjusting procedure is referred to as Reconciliation.

The pH and the alkalinity of the solution are frequently measured. However, since the analysis is experimental
and subject to errors, the pH and alkalinity values that are calculated by the Water Analysis tool may be different
from what is measured experimentally. Stream Analyzer can also reconcile this difference.

Scaling

Scaling is the deposition of a mineral salt on processing equipment. Scaling is a result of supersaturation of
mineral ions in the process fluid. Through changes in temperature, or solvent evaporation or degasification, the
concentration of salts may exceed the saturation, leading to a precipitation of solids (usually crystals). The
saturation level of a salt in water is a good indicator of the potential for scaling.

The potential for scaling is calculated using the solubility product constant (Kj,) and lon Activity Product (/AP)
definitions.

Solubility Product Constant, K g,

The solubility of ionic compounds of salts and minerals in water are governed by a solubility equilibrium
expression and a solubility product constant known as K, It is important to note that the solubility product, K,

is a function of both temperature and pressure. Consider the general dissolution reaction below (in aqueous
solutions):

aA(s) = bB(aq) + dD(aq)

With equilibrium constant K, defined as:
Ksp = (aB)b ' (aD)d

Where, ag and aj are the activities of the aqueous species. The activity of any species i is defined as the
product of its concentration in molality by its corresponding activity coefficient:

a; = myy;

lon Activity Product, IAP

A real solution may not be in the state of equilibrium. This non-equilibrium state is described by the ion activity
product (IAP). It has the same form as the equilibrium constant K;,,, but involves the actual activities of the
species in solution.

IAP = (aB)thual ' (aD)gctual
Scaling Tendency and Scale Index
The Scaling Tendency (ST) is defined as the ratio of the lon Activity Product (IAP) divided by the equilibrium
constant (K,).

oT = IAP
K¢y

Equation (1)
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Scaling tendencies are essentially saturation ratios. Thus, if
ST < 1 |Indicates sub-saturation, and the solid is not expected to form
ST = 1 Indicates saturation, and the solid is in equilibrium with water
ST > 1 Indicates supersaturation, and solids will form

Note: The Scaling Tendency (ST) is reported in the software as Post-Scale.

The Scale Index (Sl) (aka: Saturation Index in the literature), is given by the following relationship:

IAP

SI =logqg (K—> Equation (2)
sp

Thus, if
SI < 0 Indicates sub-saturation, and the solid is not expected to form
SI = 0 Indicates saturation, and the solid is in equilibrium with water
SI > 0 Indicates supersaturation, and solids will form

Note: The Scaling Index (SI) is reported in the software as Sl, Index under the Post-Scale name.

Pre-scaling Tendency and Scale Index

Pre-Scaling tendency is defined as the scaling tendency before any solids are formed (this can be seen as all
the species suspended in solution). The same equations (Equations 1 and 2) are used for calculating ST and
Sl

The Pre-Scaling tendency is reported in the software as Pre-Scale, with its respective Sl, index.

Difference between Post-scale and Pre-scale

Pre-Scale: The saturation ratio before solids precipitate.

Post-Scale: The saturation ratio after solids precipitate (if solids are selected).
Another way to interpret these two definitions is:

Pre-Scale represents the condition before any solids are allowed to form. This is a non-equilibrium condition
and can be viewed as the condition where time = 0.

Post-Scale Tendency is the saturation ratio after all potential solids come to equilibrium with water. This is the
true equilibrium condition (time = o).
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Example 27: Calculation the Scaling Tendency and the Scale Index of CaS0, - 2H,0

Let's calculate the Scaling Tendency and the Scale Index of 0.01 moles of gypsum (CaSO0, - 2H,0) dissolved in
1 kg of water at 25°C and 1 atm.

The equilibrium expression for the dissolution reaction is:
CaS0, - 2H,0 = Ca** + SO0} + 2H,0
Where, K, = 3.2 x 1073
The molal concentration and the activity coefficients for each one of the species are:
[Ca*?] = 0.0093 m Yea+z = 0.4663
[SO;%] = 0.0093 m Vso;2 = 04663

ay,0 = 0.9997

Calculating the IAP
With the information given above, we can calculate the IAP as follows:

2
IAP = a¢g+2 " Qg2 - (aHZO)

2
IAP = (mpg+2 Veg+2) (mSO;z 750;2) “(an,0)
IAP = (0.0093 x 0.4663) - (0.0093 X 0.4663) - (0.9997)2
IAP = 1.879 x 107°

Calculating the Scaling Tendency
_ 1879 X 1075

3.2x 1075

ST ~ 0.587
This result indicates that the solution is under-saturated with respect to calcium sulfate.

Calculating the Scaling Index

IAP
Sl = 10g10 — = loglo ST
Ky

SI = 10g10 (0.587)

SI = —0.231
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3.2. Entering Data for Water Analysis

The grid for water analysis has 5 different grids where we need to enter information: Analysis Parameters,
Recorded Properties, and Neutrals, Cations and Anions concentration in solution.

The Analysis Parameters grid is where you enter the conditions at which the sample properties were
measured. The default values are 1 L, 25°C and 1 atm.

= Analysis Parameters
Stream Amount (L) 1.00000
Temperature (*C} 25.0000
Pressure (atm) 1.00000

The Recorded Properties grid is where you enter the laboratory measured properties of the solution. These
are: Total Dissolved Solids (TDS), Measured pH, Measured Alkalinity, Density, and Specific Electrical
Conductivity. You can always change the units of these properties by clicking on the units highlighted in blue.
This action will open the Units Manager Window.

T Recorded Properties
Total Dizzolved Solids (mo/L) 0.0
Measured pH 0.0
Measured Alkalinity (mg HCO3/L) 0.0
Density (g/ml) 0.0
Specific Electrical Conductivity (pmho/cm) 0.0

The concentration of Neutrals, Cations and Anions is entered in the section. The Water Analysis grid comes
already prepopulated with some of the most common cations, anions, and neutrals species found in laboratory
water analyses. If your species is not present in the prepopulated grid, simply click on the white grid and type
the ion or neutral of interest. If it is a cation, type the element followed by a plus (+) sign and the corresponding
oxidation state, e.g. Cu+2. Ifit is an anion, type the element followed by a minus (-) sign and the corresponding
oxidation state, e.g. Br-1. If it is a neutral, simple type the species either using the formula name or its name,
as has been shown in the previous sections.

- Neutrals (mgil)
H20
coz 0.0
H2S 0.0
Si0z2 0.0
B(OH)3 0.0
& Cations (mg/L)
Na+1 0.0
K+1 0.0
Ca+2 0.0
Mg+2 0.0
Srs2 0.0
Ba+2 0.0
Fe+2 0.0
& Anions (mgiL)
CH1 0.0
504-2 0.0
HCO3-1 0.0
HE-1 0.0
C2H302-1 0.0
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The Water Analysis grid also contains search aids to find a specific cation or anion. The first search aid is the
drop list located in each the cation, anion, and neutral grid sections. The list is alphabetic and is activated using
the drop-down arrow within the cell, after the first few letters of the ion is typed.

e Cations (rmg/L)
Na+1 0.0
K+1 0.0
Ca+2 0.0
Mg+2 0.0
Sr+2 0.0
Ba+2 0.0
Fe+2 0.0
Cu j

Display Mame OLl Name

OLICSION CSION

o) v |

SN Cu++) CUION

#HCu(+1) CUloMN

#HCu(+2) CUION

If a name is misspelled or if the text is unrecognized, then a red X’ appears to the left of the name. This name
needs to be corrected or the row deleted before proceeding. To delete the row, simply select the wrong entry
(which will turn black) and hit the key <Delete>.

Variable Value
Density (g/ml) 0.0
Specific Electrical Conductivity (pmhodcm) 0.0
e Neutrals (mgiL)

H20

coz 0.0
H2S 0.0
5i0z2 0.0
B(OH)3 0.0

3.3. Water Analyses - Reported Elements

Water analysis data obtained from ICP measurements will contain concentrations for B, P, S, and Si. These
elements do not exist in the water, rather they exist as dissolved ions. If they are part of your analysis, then you
should convert them to the following before entering them into the Water Analyses object.

Table 1. Converting element concentration to species for Brine or Water Analysis

B, boron Boric Acid H3BO3 B (mg/l) x 5.72 = H3BO3 (mg/l)
Si, Silicon Silica Si02 Si (mg/l) x 2.14 = SiO2 (mg/l)
P, Phosphorus Dihydrogen Phosphate H2P0O4-1 P (mg/l) x 3.13 = H2PO4 (mg/l)
S (mg/l) x 1.03 for HS-1 (mg/I
HS-1 or SO4-2 (mgh) (mg/)
S, Sulfur Sulfate or Sulfide or

(cannot tell from total S only)
S (mg/l) x 3.0 for SO4-2 (mg/l)
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3.4. A Basic Water Analysis

A brief introduction to the water analysis tool will be shown in the example below. As we go through the example,
the basic definitions, functionalities and reporting for the Water Analysis tool will be introduced.

Example 28: Ground Water Analysis

Will calculate the pH and density of a Ground Water sample based upon its measured composition at 1 atm
and 25 °C. Then we will create a molecular stream based on the ionic inflows.

Starting the Simulation

Use the inputs and parameters from the table below to create the water analysis. Certain inputs, such as the
name style, units, etc. will require further adjustments, and will be described as necessary.

Ground Water Analysis

Analysis Parameters/Settings Recorded Properties
Stream Amount 1 L (Default) Total Dissolved Solids Not recorded
Temperature 25°C Measured pH 6.7
Pressure 1 atm Measured Alkalinity Not recorded
Name Style Display Formula Density Not recorded
Unit Set Metric, Batch, Specific Electrical Not recorded
Concentration Conductivity
Framework MSE
Calculation Type Water Analysis
Stream Name Basic Water Analysis
Composition
Neutrals (mg/L) Cations (mgl/L) Anions (mg/L)

CO2 150 Na+1 1060 Cl-1 3896
H2S 15 K+1 50 S04-2 54
NH3 5 Ca+2 773

Mg+2 177

Sr+2 0.18

Ba+2 0.46

Fe+2 62.1

Mn+2 2.80

Al+3 0.74

Setting the Water Analysis

Add a Water Analysis

Click on the new WaterAnalysis and press <F2> to change the name to Basic Water Analysis
Select the MSE thermodynamic Framework

Click on the Names Manager Icon and select the Formula option

ARl S A

Click on the Units Manager Icon, and select Metric, Batch, Concentration (it may be defined by default)
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Under the Analysis Tab, enter the Analysis Parameters, Recorded properties, and composition of the

water given in the table above.

Go to the Add Reconciliation button of the top right corner or select Add Reconciliation from the Actions

Panel.

& OLl Studio - [Water Analysis.oad*]

7 File Edit Streams Calculations

Chemistry Tools

View Window Help

DSE| 022N | Lvase res mesns | BE: G FF

| Navigator g x|

Il Add Reconciliation |I

Template Manager

Standard ~

Summary

Documenti 'G
Water Analysis oad* Description Analysis [ZF] Report
6‘° Streams
'ﬂ Basic Water Analysis ¥ iablo | flabucy
= Analysis Parameters
Stream Amount (L) 1.00000
Temperature (*C) 25.0000
Pressure (atm) 1.00000
= Recorded Properties
Total Dissolved Solids (ma/L) 0.0
Measured pH 6.70000
Measured Alkalinity {(mg HCO3/L) 0.0
Density (g/mi) 0.0
Specific Electrical Conductivity (umho/cm) 0.0
e Neutrals (mgiL)
HzO
coz 150.000
H2S 15.0000
Sio2 0.0
B(OH)3 0.0
NH3 5.00000
| Actions po-x = Cations (mgiL)
Adtions Na+1 1060.00
F hdd Reconciliation K+1 £0.0000
e Add Water Analysis Casz 773000
Mg+2 177.000
Sr+2 0.180000
Ba+2 0.450000
Fes2 82.1000
Mn+2 2.80000
AR3 0.740000
| Plot Template Manager L o+ x| = Anions (mg/L)
CH1 38596.00
S04-2 54.0000
HCO3-1 0.0
HE-1 0.0
C2H3021 0.0
Measured
Save

For Help, press F1

Unit Set: Metric (mase concentration)

Automatic Chemistry Model
MSE (H30+ ion) Databanks:
MSE (H30+ ion)
Using Helgeson Direct

@B

NUM
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Note: You may notice that after selecting Add Reconciliation option, the navigator panel displays a sub-stream
called Reconcile, and this Reconcile sub-stream opens a new tab named Reconciliation. The Reconcile sub-
stream copies the original inputs entered in the Water Analysis. Any changes made in the sub-stream will not
change the original Water Analysis.

Additionally, three different types of reconciliation are enabled in the upper right corner of the window: (1) No
Reconcile, (2) Reconcile pH and (3) Reconcile pH/Alkalinity. These types of reconciliation will be described in
more detail later in the next section.

The selected default calculation is No Reconcile. This option means that the software will compute the water

properties based on the current concentration of neutral, cations, and anions species. The calculation will not
use the measured pH, or the measured alkalinity entered (if any).

The Calculate Alkalinity box ( [1Calculate 4kalinity ) glows you to compute the alkalinity, also based on the
concentration entered.

8. Select the No Reconcile option

¢y OU Studic - [Water Analysis.oad*] — O x
B File Edit Streams Calculations Chemistry Tools View Window Help - & %
LeEE 2N Lvasol2 [Res|msiEs s | B O BE A
MNavigator gL =X
Documentt | A
Water Analysis.oad* | Description Molecular Basis [ Report L3 File Viewer
"A‘ Strﬁa"‘_s . ] Variable Value = Reconcililation
= bd_Basic Water Analysis
= Analysis Parameters ] Specs...
Stream Amount (L) 1.00000 Reconcile
Temperature (*C) 25.0000 @ Mo Reconcile
Pressure (atm) 1.00000 O Reconcie pH
= Recorded Properties (O Reconcile pH A4k alirity
Total Dissolved Solids (mg/L) 00 |:| Caleulate Alkalinity
Measured pH §.70000
Measured Alkalinity (mg HCO3/L) 0.0
Density (g/ml} 0.0 Calculate &
Specific Electrical Conductivity (umho/cm) 0.0
= Neutrals (mgiL) SHmDEL
H20 Unit Set: Metric {(mass concentration)
coz 150.000
Autematic Chemistry Model
H2s 15.0000 MSE (H30+ ion) Databanks:
S0z 0.0 MSE (H30+ ion)
B(OH)3 0.0 Using Helgeson Direct
NH3 £.00000 Dominant lon Charge Balance (eg/L):
Isothermal Calculation
Aors Eor = T 2E.unuu.=c 1.00000 atm
Actions = 0000 5 Calculation not done
K+1 50.0000
Ca+Z T73.000
Mg=2 177.000
Sr+2 0.180000
Ba+2 0.450000
Fe+2 521000
Mn+2 2.30000
A3 0.740000
Flot Template Manager 5 =% e Anions (mgiL)
CH1 3896.00
504-2 54.0000
HCO3-1 0.0
H3-1 0.0
C2H302-1 0.0
v
Meazured
Advanced Search Add as Stream Export
Save
For Help, press F1 @ NUM
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9. Now, we are ready to perform the calculation. Click on the Calculate button or press the <F9> key
10. It is time to save your file (File >Save as...) or using the save icon in the tool bar. Create a new file and
name it: Water Analysis Calculations.

Analyzing the Results

Viewing the Summary Box

Review the Summary Box. Let’s analyze it in detail since it contains several pieces of important information, as
shown in the image below.

Specific Electrical Conductivity (pmhodcm) 0.0 S,
= MNeutrals {(mg/L)
H20 Unit Set: Metric (mass concentration))
coz 150.000
- Automatic Chemistry Model
H23 15.0000 MSE (H30+ ion) Databanks:
5i02 0.0 MSE (H30+ ion)
B(OH)3 0.0 Using Helgeson Direct
NH3 £.00000 Duminlﬁnt lon Charge Balance (egiL):
Cation Charge:  0.102945 eg/L
Anion Charge:  -0.111016 eg/L Charge Balance
= Cations (mgiL) Imbalance: -8.07170e-3 eg/L Information
Na+1 1060.00
& 185.568 ma/L of Na+1
K+1 50.0000 is needed to balance.
Cas2 773.000 2| |[ 1sothermal Calculation Calculation Type
Mg+2 177.000 25,0000 *C 1.00000 atm
Sr+2 0.180000 Phase Amounts
Agueous 1001598g
Ba:2 0.460000 Vapor 009 Phase Amounts
Fe+2 62.1000 Solid 0.011575& g
Mn+2 2.80000
Agueous Phase Properties
Ab3 0.740000 pH 447595
lonic Strength  2.49905e-3 Aqueous Properties
= Anions [mg/L) mol/mel
Density 1.00198 g/ml
CH1 3895.00
S04-2 54.0000 Calc. elapsed time: 30.438 sec
HCO3-1 0.0 )
Calculation complete
HS-1 0.0
C2H302-1 0.0

The top section contains the charge balance information showing the total equivalent charge (positive and
negative), and the charge imbalance. This example has a negative imbalance of -8.072x10-3 eq/L, indicating
that more cations are needed in solution in order to reach electroneutrality. The software calculates that 185.568
mg/L of Na+ are needed to balance the solution. The software adds this amount of Na+ to the solution. This
information can be further confirmed in the Report Tab in the Charge Balance table.

The calculation type information shows the calculation type the software used. In this example, the software
performed a default isothermal calculation at 25 °C and 1 atm. If we selected other calculation specifications,
they would appear here.

The phase amounts information shows the distribution of species in the different phases. This analysis
contains two phases: aqueous and solid.

The aqueous properties information shows the computed pH, ionic strength, and density of the solution. It is
important to note here that the measured pH is 6.70 and the computed pH is 4.47. The density of this solution
is 1.00198 g/ml. Remember, for this example the software used only the concentration of neutrals, cations and
anions in solution to do a reconciliation.

| 182



Viewing the Molecular Basis Tab

Let's review the Molecular Basis Tab. The Molecular Basis tab is one of several tabs of the Reconciliation
object. The information contained in this tab is the molecular composition of the solution after it has been
reconciliated. In other words, the software has converted the ionic inflows into a molecular stream.

J Variable Value -

e Analysis Parameters

|_|:_| Stream Amount (L) 1.00000

|_ Volume - Liguid-1 (L) 1.00000

L volume - Solid (zm3) 2.402%98e-3
Temperature (*C) 25.0000
Pressure (atm) 1.00000

& Molecular Totals (mg/L)
AICI3 361208
AlOH)3 0.0262829
BaCl2 0.631654
BaS04 0.0738067
CaCl2 2092.78
Cal 24.1565
coz 150.000
FeClz 124.359%
FesS 11.4757
H20 9.95556e5
H2S 10.5511
KCI 95.3381
MgCI2 693.363
MnCi2 6.41382
NaCl 3166.36
NH3 499999
503 449809
SrCi2 0.325663

v

Add az Stream E=part

Note: The software generates molecular concentrations based on two priorities. The first priority is to create
the least number of molecular inflows. This example contains eighteen inflows (plus H20 not shown). The
second priority is to create the least number of total moles. Moles are not shown here, since the units are mg/I.
The moles are shown in the Report tab.

You can use this molecular form as a new Stream in OLI Studio, by using the Add as Stream button, or it can
be exported to a separate software like Flowsheet: ESP, Aspen Plus, UniSim Design, or other simulators.
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Converting the lonic Inflows into a Molecular Stream
For practice, let's add this Molecular Basis as a Stream into the Navigator Panel.

1. Click on the Add as Stream button. This will open a new window

Save Selected Result Streams ? *

Export

N1 Hl WMolecular Export of Recondle

Indude the following phases in the stream(s)
Agueous Vapor
Second Liquid Solids

Optional

Phases that are not incduded may be exported
separately.

Agueous
Vapor
Second Liquid

Solid

Cancel

Note: By default, the name of the stream is Molecular Export of Reconcile. You can change the name if you

prefer. Additionally, you can include or exclude the phases that you want to export into your stream by checking
or unchecking the corresponding boxes.

2. Leave the defaults and click OK. The program automatically adds a new stream in the navigation panel.

O OLl Studio - [Water Analysis Calculations.oad]

O x
B File Edit Streams Calculations Chemistry Tools View Window Help - 8 X
Dl & B TR | 11vasol?2 Red | meiiftwed dMEm: G REE
Navigator g o~ X &
Documentt |
Water Analysis Calculations.oad | Description [£¥ Definition (5] Report
& Streams -
5T Basic Water Analysis J Variable Value ~ Add Caloulation -
FE | = Stream Parameters N "
i Joe Reconcile = 7 5 100000 Special Conditions
— Molecular Export of Reconcile ream Amount ()
Temperature (*C) 25,0000 L] Sclick Oy
Pressure (atm) 1.00000
Summary
= Inflows (mg/L)
H20 Unit Set: Metric (mass concentration)
coz 150.000
Automatic Chemistry Model
H25 105511
MSE (H30+ ion) Databanks:
NH3 4.99959 MSE (H30+ ion)
Al 381208 Using Helgeson Direct
BaCz 0.631654
CaClz 209278
Ca0 241565
Ach.ons 4 =X FeCl2 124,399
HERTS Kel 95,3381 ’
(&) Add Stream 3] Add Stabi Mocz P
]
ﬁ:j 2‘1"‘&" o 51 Add Com Jnc2 e
= ngle Point NaCl 316636
] Add Survey
[8] Add Chemical Diagram s03 44,9609
SrCi2 0.325663
< > Bas04 0.0738067
FeS 11.4757
Plot Template Manager § - X
Al(OH)3 0.0262829
v
Input
Advanced Search Add az Stream Export
Save
For Help, press F1 @ NUM
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Viewing the Report Tab

The Report tab is slightly different from the Single Point report described in Section 1. This Report contains
three additional tables, all of which are located at the top. These tables are the Reconciliation Summary, Stream
Inflows, and Charge Balance.

Description Reconciliation Molecular Basis | @ Report |L7 File Viewer

Jump to: | Reconciliation Summary w @ ag Customize Export

Stream |nflows
Charge B alance A
Reconsy o Paramatars
Sped Total and Phase Flows [Amounts]
Scaling Tendencies
Charg Species Output [Tue Species)
pH ReqElement Balance

The Reconciliation Summary table confirms the specifications for the reconciliation such as the charge
balance method and the reconciliation type (these concepts will be discussed in more detail later in the manual).
Additionally, shows the conditions at which the calculation was run, in this case 25°C and 1 atm. And finally,
shows a comparison between the measured and calculated properties, in this case it shows the measured vs
calculated pH.

Reconciliation Summary

Specification
Charge Balance Method Dominantlon
pH Reconciliation Type Mo reconciliation

Measured Calculated
Temperature, *C 25.0000
Pressure, atm 1.00000
pH 6.70000 4 47595
Density, g/ml 1.00198
VWater, mg/L 9.95554e5

Stream Inflows

Row Filter Applied: Only Non Zero Values

The Stream Inflows table summarizes all the species that were entered in the water analysis grid.

Input Qutput
Species mgiL mg/L
H20 1.00000e6 9.05554e5
Na+1 1060.00
K+1 50.0000
Ca+2 773.000
Mg+2 177.000
Sr+2 0.130000
Ba+2 0.460000
Fe+2 62.1000
Mn+2 2.30000
Al+3 0.740000
co2 150.000 150.000
H2S 15.0000 15.0000
Cl1 3896.00
504-2 54.0000
NH3 5.00000 499999

185



The Charge Balance table contains the concentrations entered and the final balanced values. In this case only
the sodium (Na+1) concentration was changed.

Charge Balance

Cation Charge: 0.102945 eq/iL

Anion Charge: -0.111016 eq/L

Imbalance: -8.07170e-3 eq/L

Adjusted Species: Ma+1

Charged Species Input Balanced Difference
magiL mag/L %

Na+1 1060.00 124557 17.51

K+1 50.0000 50.0000

Ca+2 773.000 773.000

Mg+2 177.000 177.000

Sr+2 0.180000 0.180000

Ba+2 0.460000 0.460000

Fe+2 62.1000 521000

Mn+2 2.80000 2.80000

Al+3 0.740000 0.740000

CI1 3896.00 3896.00

S04.2 54.0000 54.0000

HCO3-1 0.0 0.0

HS1 0.0 0.0

C2H30241 0.0 0.0

186



3.5. Exploring Reconciliation Options

When reconciling a Water Analysis, there are three options for reconciliation:

1.

No Reconcile: The software will run an electroneutrality reconciliation only, and then compute the water
properties such as pH, density, etc., based on the entered concentration of neutral, cations, and anions

species. In the No Reconcile option you may allow the program to pick the species to adjust for

electroneutrality or you may manually choose the species to perform the adjustment. (See electroneutrality

options).

Reconcile pH: The software will run both an electroneutrality and pH reconciliation. This type of
reconciliation will match your recorded pH. Additionally, the software will compute the water properties such
as, density, electrical conductivity, etc. The pH of the solution is automatically adjusted by the software by

adding either HCI or NaOH, or you may select your preferred acids and bases to adjust the pH.

Reconcile pH/Alkalinity: The software will run an electroneutrality, pH and alkalinity reconciliation. This
type of reconciliation will match your recorded pH and alkalinity values. Additionally, the software will
compute the water properties such as density, electrical conductivity, etc. The pH of the solution is
automatically adjusted by the software by adding either HCI or NaOH or you may select your preferred
acids and bases to adjust the pH. The Alkalinity is automatically calculated by the software, using CO2 as
the alkalinity titrant, H2SO4 as the alkalinity pH titrant and 4.5 as the alkalinity end point pH. You can also

change a different alkalinity titrant if you prefer.

Additionally, there is the option to Calculate Alkalinity: [Calouste &kslinty It s important to note, that this is only
an alkalinity calculation based on the concentration entered, it is not an alkalinity reconciliation.

We will explore the different types of reconciliation and introduce the different specification options according
to the reconciliation type.

In this section we will create a new file. We will run a basic water analysis, from which the various reconciliation
options will be explored.
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Example 29: Water Analysis — No Reconcile Option

In this example we will calculate the pH and different properties of a Produced Water sample based upon its

measured composition at 1 atm and 25 °C.

Starting the Simulation

Use the inputs and parameters from the table below to create the water analysis. Certain inputs, such as the

name style, units, etc. will require further adjustments, and will be described as necessary.

Water Analysis — Reconcile Options

Analysis Parameters/Settings Recorded Properties
Stream Amount 1 L (Default) Total Dissolved Solids 36500 mg/L
Temperature 25°C Measured pH 7.8
Pressure 1 atm Measured Alkalinity 160 mg HCO3/L
Name Style Display Formula Density 1.013
Unit Set Metric, Batch, Specific Electrical Not recorded
Concentration Conductivity
Framework MSE
Calculation Type Water Analysis
Stream Name Water Analysis —
Reconcile Options

Composition

Neutrals (mg/L) Cations (mg/L) Anions (mg/L)
SiO2 16 Na+1 10000 Cl-1 19000
Ca+2 500 S0O4-2 2700
Mg+2 1200 HCO3-1 142
Sr+2 200 AsO4-3 12
Ba+2 5 CHO2-1 20
Fe+2 5 C2H302-1 50

Calculating the pH

Setting the Water Analysis
1. Add a Water Analysis

Click on the new WaterAnalysis and press <F2> to change the name to Water Analysis — Reconcile Options
Select the MSE thermodynamic Framework
Click on the Names Manager Icon and select the Formula option

Click on the Units Manager Icon, and select Metric, Batch, Concentration (it may be defined by default)

2L S A

Under the Analysis Tab, enter the Analysis Parameters, Recorded properties, and Composition of the
water given in the table above.
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7. Go to the Add Reconciliation button of the top right corner or select Add Reconciliation from the Actions
Panel, and name it No Reconcile.

8. Select the No Reconcile option (selected by default)

Description Reconciliation Molecular Basis (& Report CI File Viewer

J Variable Value - Feconcililation

b Analysis Parameters Specs...
Stream Amount (L) 1.00000 Reconcile
Temperature ("C) 25.0000
Pressure (atm) 1.00000 (C Reconcile pH

— Recorded Properties () Rreconcile pHAAkalinity
Total Dissolved Solids (mag/L) 36500.0 D Calcoulate Alkalrity
Measured pH 7.80000
Measured Alkalinity (mg HCO2/L) 160.000
Density (gimil) 1.01300 Calculate i@
Specific Electrical Conductivity (pmho/cm) 0.0 SummE

G Neutrals (mg/L)
H20 Unit Set: Metric (mass concentration)
coz 0.0

Automatic Chemistry Model

i 0.0 MSE (H30+ ion) Databanks:
Zi0z2 16.0000 MSE (H30+ ion)
B(OH)3 0.0 Using Helgeson Direct

| j Dominant lon Charge Balance (eg/L):

= Cations (mgi/L) Isuth&rma?l Calculation
Nast 100000 R 25.0000 *C 1.00000 atm

Calculation not done

Ca+2 500.000
Mg+2 1200.00
Sr+2 200.000
Ba+2 5.00000
Fes2 5.00000

= Anions (mg/L)
Ck1 19000.0
S04-2 2700.00
HCO3-1 142.000
As04-3 12.0000
HCOO-1 20.0000
C2H302-1 50.0000

W
 easured
Advanced Search Add as Stream Export

Note: In the No reconcile option, the software runs an electroneutrality reconciliation. The type of balance
for reconciling electroneutrality is the Dominant lon method. You can select different types of balance for
electroneutrality by clicking on the Specs button.
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Types of Balance for Electroneutrality
9. Click on the Specs button. This will open a new window.

Reconciliation Data ? *

Balance Calculation Options  Convergence

Type of balance - New Inflow

Cations ~  Dominant lon

MNa=+1 Prorate

Ca+2 Prorate Cations

Mg+2 .

.y Prorate Anions

ar+£

Ba+2 MNa,/Cl

Fesl Make-up lon \

Uzer Choice

Needed to balance:
747 753 mg/L of Na+1

Charges on the Cations and Anions is needed to balance.

must be evenly balanced

Cation charge: 0.563486 eg/L
Anion charge: 0.556011 eq/L
Imbalance: 0.0325252 eq/L

QK Cancel Apply Help

There are 7 different Types of Balance:

1. Dominant lon: This is the default method. The largest counter ion is used to adjust the electroneutrality. In
our example,747.753 mg/L of Na+1 are added since there is an excess of negative charge (see the above
image).

2. Prorate: This option keeps the relative amount of the counter ions (for this example, the cations) the same
and are adjusted up or down equally until reaching electroneutrality.

3. Prorate Cations: All cations are adjusted up or down equally
4. Prorate Anions: All anions are adjusted up or down equally

5. Na+/Cl-: Sodium is added when there is an excess of negative charge. Chloride is added when there is an
excess of positive charge.

6. Make-up lon: This option allows for a single ion species to be adjusted. User selects an ion to increase or
decrease.

7. User Choice: The software determines if an anion or cation is needed to balance the solution and the user
choses the specific ion.
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10. Keep the default option, Dominant lon, as the balance type then press OK

11. Now, we are ready to perform the calculation. Click on the Calculate button or press the <F9> key

12. Itis time to save your file (File >Save as...) or using the save icon in the tool bar. You can save under the
same file that we created before named Water Analysis Calculations.

Analyzing the Results

Once you run the simulation there are two options to analyze the results: The summary box and the Report
1. Go to the Report Tab and look at the Reconciliation Summary Table.

Jump to: | Reconciliation Surmmary ~ @, Ek Customize E spart

Reconciliation Summary ~
Specification

Charge Balance Method Dominantlon

pH Reconciliation Type Mo reconciliation

Measured Calculated
Temperature, °C 25.0000
Pressure, atm 1.00000
pH 7.80000 7.48368
Density, giml 1.01300 1.02250
Water, mg/L 9.88311eb

The calculated pH and density are different to the measured values. The software only used the concentration
data to calculate these properties.
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Example 30: Water Analysis — pH Reconcile Option

In this example we will reconcile the sample by pH and also calculate the alkalinity of the same Produced
Water sample used in the previous Example 29: Water Analysis — No Reconcile Option.

Starting the Simulation

1. Under the Water Analysis — Reconcile Options Stream go to the Add Reconciliation button

Click on the new Reconcile-1 icon and press <F2> to change the name to Reconcile pH

2
3. The default units, names and framework have been previously defined
4

Select the Reconcile pH option

Variable [ Value
e Analysis Parameters
Stream Amount (L} 1.00000
Temperature (*C} 25.0000
Pressure (atm) 1.00000
e Recorded Properties
Total Dissolved Solids (mag/L) 35500.0
7] Measured pH 780000
Measured Alkalinity (mg HCO3/L) 160.000
Density (g/ml) 1.01300
Specific Electrical Conductivity (pmho/cm 0.0
= Calculation Parameters
Use Single pH Titrant No
pH Acid Titrant HCL
pH Base Titrant NAOH
- Neutrals (mg/L)
H20
coz 0.0
H25 0.0
sio2 16.0000
B(OH)3 0.0
e Cations (mgiL)
Na+1 10000.0
Ca+2 500.000
Mg+2 1200.00
Sr+2 200.000
Ba+2 5.00000
Fe+2 5.00000
e Anions (mg/L)
Ck1 15000.0
304-2 2700.00
HCO3-1 142.000
As04-3 1z.0000
HCOO-1 20.0000
C2H302-1 50.0000
Measured
Advanced Search Add az Stream Expant

Lal

Reconcililation
Specs...
Reconcile
Mo Reconcile
(® Reconcile pH
Reconcile pH /Alkalinity

[ Calculate Ak alinity

Calculate &8 |

Summary

Unit Set: Metric (mass concentration)

Autematic Chemistry Model
MSE (H30+ ion) Databanks:
MSE (H30+ ion)
Using Helgeson Direct
Dominant lon Charge Balance (eg/L):
Set pH Calculation
Weasured pH: 7.20000
pH Titrants:
Acid: HCI
> Base: NaOH

Calculation not done
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Note that by selecting the Reconcile pH option, now the measured pH is a fixed value (and brown dot appears
in front of this cell). To match the measured pH, the software added a Calculation Parameters section which
indicates the acid and basic pH titrants to adjust the pH. By default, HCl and NaOH are selected by the software.
This is similar to the set pH single point calculation.

5. Now, we are ready to perform the calculation. Click on the Calculate button or press the <F9> key
6. Itis time to save your file (File >Save as...) or using the save icon in the tool bar. You can save under the

same file that we created before named Water Analysis Calculations.

Analyzing the Results

1. Go to the Report Tab and look at the Reconciliation Summary Table.

Jump to: | Reconciliation Summary A @ 9@, Customize E xport

Reconciliation Summanry ~
Specification

Charge Balance Method Dominant lon

pH Reconciliation Type Reconcile pH

Measured Calculated

Temperature, “C 25.0000
Pressure, atm 1.00000

H 7.80000 7.80000
pH Titrant Acid: HCI, mg/L * 0.0
pH Titrant Base: NaOH, ma/L * 0.0 44 5892
Density, g/ml 1.01300 1.02243
Water, ma/L 9.88320e5

* Calculated value indicates added or removed amount.

The measured and calculated pH are the same. The software added 44.5892 mg/L of NaOH to match the
experimentally measured pH.
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Calculating Alkalinity
Now we will instruct the software to calculate Alkalinity.

1. Go back to the Reconciliation Tab and check the Calculate Alkalinity box.

Variable | Valuc = Reconcililation
e Analysis Parameters Specs...
Stream Amount (L) 1.00000 Fieconcile
Temperature (*C) 25.0000 () Ho Reconcile
Pressure (atm) 1.00000 (® Reconcile pH
- Recorded Properties () Reconcile pHAkaliniy
Total Dissolved Solids (mg/L) 36500.0 o
Calculate Alkalinity
Measured pH 7.80000
Measured Alkalinity (mg HCO2/L) 160.000
Density (a/ml} 1.01300 Calculste @ |
Specific Electrical Conductivity (pmhao/cm 0.0 SmRER
= Calculation Parameters
P - Alkalinity pH Titrant HZs04 Unit Set: Metric (mass concentration)
Alkalinity titrants — . !
Alkalinity End Paint pH 450000
= Automatic Chemistry Model
. IEZE BN No MSE (H30+ ion) Databanks:
pH titrants pH Acid Titrant HCL MSE (H30+ ion)
oH Base Tirant NAOH Using Helgeson Direct
= Neutrals (mg/L) Dnmin_ant lon Charge Balance (eg/L):
Cation Charge:  0.563486 egil
H20 Anion Charge:  -0.596011 eqiL
coz 0.0 Imbalance: -0.0325252 eg/L
H2S 0.0
- 5 T47.753 mg/L of Na+1
5i02 16.0000 iz needed to balance.
B(OH)2 0o Set pH Calculation
Measured pH: 7.20000
: pH Titrants:
e Cations (mg/L) Acid: HCI
Na+1 10000.0 Base: NaOH
Ca+2? S00.000 Calculation not done
Mg+2 1200.00
Sr+2 200.000
Ba+2 5.00000
Fe+2 5.00000
= Anions (mg/L)
Ck1 15000.0
504-2 2700.00
HCO3-1 142.000
Asz04-3 12.0000
HCOO-1 20.0000
C2H302-1 S0.0000 ™
Measured
Advanced Search Aidd ag Stream E wport

Notice that by selecting the Calculate Alkalinity box two more rows were added to the Calculation Parameters
section: Alkalinity pH Titrant and Alkalinity End Point pH, besides the pH titrants rows. These two new rows
indicate that the software will add H2SO4 (selected by default) until the pH reduces to 4.5. The software then
converts the amount of additional H2SO4 into the alkalinity value.

2. Now, we are ready to perform the calculation. Click on the Calculate button or press the <F9> key.

3. ltis time to save your file (File >Save as...) or using the save icon in the tool bar.
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Analyzing the Results
1. Go to the Report Tab and look at the Reconciliation Summary Table.

Description Reconciliation Molecular Basis

Jumpta: | Recanciliation Summary ~ a &, Customize Export

Reconciliation Summary ~

Specification

Charge Balance Method DCominantlon
pH Reconciliation Type Reconcile pH
Alkalinity pH Titrant: H2304

Measured Calculated
Temperature, “C 25.0000
Pressure, atm 1.00000
pH 7.80000 7.80000
pH Titrant Acid: HCI, mg/L * 0.0
pH Titrant Base: NaOH, mg/L * 0.0 44 5892
Alkalinity, mg HCO3IL 160.000 251.834
Density, g/ml 1.01300 1.02243
Water, mg/L 9.88320e5

The calculated alkalinity value is different to the measured value. This is because the software is not doing an
alkalinity reconciliation, rather the software is using only the concentration data to calculate alkalinity. You can
see this as single point alkalinity calculation.

Note that in this example, the alkalinity being reported because we checked the Calculate Alkalinity box; if the
box wasn’t checked we would not see the calculated value in the Reconciliation Summary table.
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Example 31: Water Analysis — Reconcile pH/Alkalinity Option

In this example we will reconcile the sample by pH and alkalinity and also calculate the pre-scaling
tendencies of the same Produced Water sample used in the previous Example 29: Water Analysis — No
Reconcile Option.

Starting the Simulation

1.

2
3.
4

Select the Reconcile pH/Alkalinity option

The default units, names and framework have been previously defined

Variable | Value -
T Analysis Parameters
Stream Amount (L} 1.00000
Temperature (*C) 25.0000
Pressure (atm) 1.00000
s Recorded Properties
Total Dissobved Solids (mo/L) 36500.0
L] Measured pH T7.80000
@| Measured Alkalinity (mg HCO3/L) 160.000
Density (o/ml) 1.01300
Specific Electrical Conductivity (umhoJ/cm 0o
= Calculation Parameters
Alkalinity Titrant coz
Alkalin ity titrants Alkalinity pH Titrant H2504
@| Alkalinity End Point pH 4.50000
Use Single pH Titrant No
pH titrants pH Acid Titrant HCL
pH Ea_se Titrant MNAOH
T Neutrals (mgiL)
HZ0
coz 0.0
H25 0.0
si02 16.0000
B{OH)3 0.0
s Cations (mgiL)
Na+1 10000.0
Ca+2 500.000
Mg+2 1200.00
Sr+2 200.000
Ba+2 5.00000
Fe+2 5.00000
T Anions (mgiL)
CH 19000.0
S04-2 2700.00
HCO3-1 142.000
As04-3 12.0000
HCOO-1 20.0000
C2H302-1 50.0000 | »
M easured
Advanced Search Add as Stream E xpart

Under the Water Analysis — Reconcile Options Stream go to the Add Reconciliation button

Click on the new Reconcile-1 icon and press <F2> to change the name to Reconcile pH

Reconcillation

Specs..
Reconcile
(") Mo Reconcile
() Recancile pH
| ® Recancile pH/alk ity |

Calculate Alkalinity

Calculate &8 |

Summary

Unit Set: Metric (mass concentration)

Automatic Chemistry Model
MSE (H30+ ion) Databanks:
MSE (H30+ ion}
Using Helgeson Direct

Dominant lon Charge Balance (eg/L):

Reconcile pH Alkalinity Calculation
Alkalinity: 160.000 mg HCO3/L
Titration End Pt: 4.50000

Alkalinity Titrant: CO2
Alkalinity pH Titrant: H2504
pH Reconciliation:
Measured pH: 7.20000
pH Titrants:
Acid: HCI
Base: NaOH

Calculation not done
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Note that by selecting the Reconcile pH/Alkalinity option, now both the measured pH and alkalinity values are
fixed values (and brown dot appears in front of this cell).

To match the measured alkalinity value, the software added a Calculation Parameters section which indicates
the alkalinity titrant and the pH titrant used to adjust the alkalinity. CO2 is used by default as the alkalinity titrant.
This is similar to an alkalinity single point calculation.

To match the measured pH, the software also added a Calculation Parameters section which indicates the
acid and basic pH titrants to adjust the pH. By default, HCl and NaOH are selected by the software. This is
similar to the set pH single point calculation. Also notice that the alkalinity box is grayed out. This is because
we have asked the software to match the measured alkalinity value. This means that calculated alkalinity value
is no longer needed.

7. Now, we are ready to perform the calculation. Click on the Calculate button or press the <F9> key
8. ltis time to save your file (File >Save as...) or using the save icon in the tool bar. You can save under the

same file that we created before named Water Analysis Calculations.

Analyzing the Results

1. Go to the Report Tab and look at the Reconciliation Summary Table.

Jump to: | Reconciliation Surmmary e @ 9@, Customize Export

Reconciliation Summary ~
Specification
Charge Balance Method Dominantlon

pH Reconciliation Type Reconcile pH and Alkalinity
Alkalinity pH Titrant: H2504

Measured Calculated

Temperature, *C 25.0000
Pressure, atm 1.00000

H 7.80000 7.80000
pH Titrant Acid: HCI, mg/L * 00 14 8320
pH Titrant Base: NaOH, mg/L * 0.0
Alkalinity Titrant: CO2, mg/L * -35.0147
Alkalinity, mg HCO3IL 160.000 160.006
Density, giml 1.01300 1.02245
Water, mgiL 9.88327e5

The measured and calculated pH and alkalinity values are the same. The software added 14.9320 mg/L of HCI
to match the experimentally measured pH and removed 35.0147 mg/L of CO2 to match the experimentally
measured alkalinity value.
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Calculating Pre-scaling Tendencies

Now we will instruct the software to calculate Pre-scaling tendencies. In OLI Studio: Stream Analyzer, Pre-
scaling tendencies are turned OFF by default. We need to enable this option.

Setting the Water Analysis
1. Go back to the Reconciliation tab of the Reconcile pH/Alkalinity water analysis

ﬁv’
2. Click on the Calculation Options icon | This will open the Calculation Options window.

3. Check the Pre-scaling Tendencies box and select the Rigorous method. Then click OK.

Ja So L2 Re d med I & | @S

Calculation Options - Mo Reconcile - Pre-scaling ? *

ol
== Calculstion Options  Corvergence -
] General Diagnostics B
Show status dialog [IEnable trace "
i Verbose Lo
H Optional Properties E[
H Diffusivities and Mobilities Eo
§ [ oiffusivities Matrix ot
| Viscosity b.(
L] Electrical Conductivity l
1 |:| Heat Capacity —
| Activities, Fugadities, and K-Values I
: [ ibbs Free Energy :
4 |:| Entropy E[
] Thermal Conductivity B
| Surface Tension 0
L Interfacial Tension I
B I Pre-scaling Tendencies I E:_EI[
1 Method bo
L () Estimated b
| Jot
| Jot

] Cancel Apply Help

£ I 1800

4. Now, we are ready to perform the calculation. Click on the Calculate button or press the <F9> key

5. ltis time to save your file (File >Save as...) or using the save icon in the tool bar.
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Analyzing the Results

1. Go to the Report Tab and search for the Scaling Tendencies Table.

Jump to: | Scaling Tendencies ~ @ Ek Customize Expart
Scaling Tendencies ~
Row Filter Applied: Values = 1.0e-4
Solids Post-Scale Pre-Scale
Sr504 (Celestine (celestite)) 1.00000 11.9186
CaCo03 (Calcite) 1.00000 10.3094
FeCO3 (Siderite) 1.00000 40.5449
BaSO4 (Barite) 1.00000 171.668
H20 0774211 0774141
CaCO3 (Aragonite) 0.736014 7.58784
SrCO3 (Strontianite) 0.333100 35.1595
CaS04.2H20 (Gypsum) 0.209524 0.243863
CasS04 (Anhydrite) 0.165465 0.192618
$i02 (lechatelierite) 0.143306 0.123409
CaS04.0.5H20 (Bassanite) 0.0497131 0.0578684
:'?t?gS;Zr;)ei{OHH{Poor-{:rystallme 0.0204063 10068.6
Na2504.10H20 (Mirabilite) 3.02821e-3 3.46068e-3
NaCl.2H20 (hydrohalite} 2.98632e-3 2.97543e-3
NaCl (Halite) 2.93999e-3 2.92980e-3
CaHAsO4.1H20 2.86793e-3 2.94910e-3
MgCO3 1.79463e-3 0.0183869
Fe(OH)2 (Amakinite) 6.02784e-4 0.208240
Mg 504.7H20 (Epsomite) 5.95029e-4 6.87951e-4
NaHCO3 (Nahcolite) 4.63537e-4 5.05378e-4
Na2504 (Thenardite) 4.42762e-4 5.06448e-4
Mg 504.12H20 418746e-4 4.83922e-4
Mag(OH)2 (Brucite) 277905e-4 0.0242604
Mg $04.6H20 (Hexahydrite) 2.61561e-4 3.02435e-4
Na2504.CaS04 (Glauberite) 1.67513e-4 2.23051e-4
Mg 504.5H20 (Pentahydrite) 9.46601e-5 1.09462e-4
BaCO3 (Witherite) 2.85374e-5 0.0433856
Mg35i205(0H)4 (Antigorite amorphous) 5.53363e-10 2.73033e-4

This table reports both the Post-Scale and Pre-scale Tendencies. See the section 3.1 Basic Terminology to see
a more detailed explanation.

The Scaling Tendencies (reported in the software as Post-Scale), are essentially saturation ratios. When the
scaling tendency for a given mineral is equal to 1.0 (saturation conditions) it indicates that the mineral is in
equilibrium with water, a solid phase has formed. A scaling tendency below 1.0 indicates sub-saturation and
that the solid phase will not form. A solid is at risk of forming when the scale tendency value is greater than 1.0
(supersaturation conditions).

The Pre-Scaling Tendencies (reported in the software as Pre-Scale), is defined as the scaling tendency before
any solids are formed (this can be seen as all the species suspended in solution).

Note: The Post-Scale and the Pre-Scale tendencies are equivalent if the solid phase is turned OFF.
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Section 4. Hydrocarbons and Pseudocomponents

So far, we have learned how to enter molecular and ionic inflows in Stream Analyzer. Stream Analyzer also
allows you to enter assays or pseudocomponents in order to crude oils as streams.

Crude oils are complex groups of organic molecules containing hundreds, perhaps thousands of pure
components in a single oil. Modeling crude oils using pure components is impractical, because analyzing for
each pure component is cost prohibitive and the number of species would make calculations overwhelming. A
convenient solution to this problem and to modeling the properties of a crude oil is to create pseudo
components.

Crude Oil properties may be defined through a distillation curve, where each boiling point range is a progression
of molecular weights, densities, solubilities, viscosities and other properties associated with that section. It is
reasonable for low boiling point molecules to be low molecular weight, low density, low viscosity, and more
soluble in water. We can dice boiling point curves using well accepted methods standard to create
pseudocomponents that in combination reflect the property of the whole oil.

There are two ways to create a crude oil stream on Stream Analyzer:

1. The firstis to start with a PVT curve and create pseudocomponents using one of the three thermodynamic
methods coded into the software.

2. The second is to enter the pseudocomponent data directly and using the same thermodynamic methods to
predict the component properties.

The three thermodynamic methods are: API, Lee Kesler, and Cavett. More details about this method can be
found in Section 11. Basic Terminology.

A brief introduction of how to enter PVT curves and/or pseudocomponents will be shown in the examples below.

4.1. Entering a PVT Analysis

Example 32: Creating an Assay
In this example, we are going to learn how to enter a simple PVT analysis in order to create a Crude Oil Stream.

Starting the Simulation

1. Add a new Stream

2. Click on the new Stream and press <F2> to change the name to Crude Oil

3. Select the MSE-SRK thermodynamic Framework

4. Click on the Names Manager Icon and select the Formula option

5. Click on the Units Manager Icon, and select Metric, Batch, Moles

6. Enter the conditions of the Stream T= 25 °C and 1 atm

Crude Oil Stream
Calculation Settings Conditions

Stream Name Crude Ol Stream Amount Default
Name Style Display Formula Temperature 25°C
Unit Set Metric, Moles Pressure 1 atm
Framework MSE-SRK
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In the inflows grid, in the white cell below H20, type ASSAY and then press <Shift + Enter>. You can

assign other name to your Assay; however, you are limited to 5 characters for the name of the Assay.

Note: The <Shift + Enter> action instructs the software to create an Assay rather than look for a species
or pure component from the database.

—

Pressure (atm)
=

H20

4554y

J Variable

Stream Amount (mol}
Temperature (*C)

Shift

Value
Stream Parameters

Inflows (mol)

]

+ Enter

55.5082
25.0000
1.00000

1]
en
4]
=]
]

Add Calculation -

Special Conditiong
] Solids Orily

Surnrnary

Unit Set: Metric (males)

Automatic Chemistry Model
MSE-SRK (H30+ ion) Databanks:
M3E-SRK (H30+ ion)
MSE (H30+ ion)
Second Liguid phase
Using Helgeson Direct

Note: After typing the name of your Assay, immediately press Shift + Enter command keys together.

8. Use the information provided in the table below to complete the grid.

Assay Information

Calculation Settings

Distillation Data

Assay amount 1000 moles Percent Distilled Temperature, °C
Assay Data Type ASTM D86 1 20
Average Bulk Density Type | API Gravity 5 30
API| Gravity 40 10 50
Distillation Curve Cuts 10 20 60
Distillation Data See next two columns 40 80
Thermo Method API-8 60 120
80 150
90 180
95 200
99 220
100 240
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Your screen should look like the image below:

Description Definition [ Report

J Variable Value ~ Add Calculation -
= Stream Parameters . .
Special Conditions
Stream Amount {mol) 1055.51 )
Temperature (°C} 250000 L solids Only
Pressure (atm) 1.00000
Suramnary
- Inflows (mol)
H20 55.5082 Unit Set: Metric (moles)
A | ASSAY 1000.00
Automatic Chemistry Model
R TNEES ASTH D38 MSE-SRK (H30+ ion) Databanks:
— Awerage Bulk Density Type AP Gravity MSE-SRK (H30+ ion)
| API Gravity 40.0000 WSE (H30+ ion)
P— Second Liguid phase
x| |— Distillation Curve Cuts 10 Using Helgeson Direct
x| |— Distilation Data Edit...
'— Thermo Method APL8 hd > Species ASSAY is not valid.
Insufficient distillation data.

Note: You can change the Assay Data Type, the Average Bulk Density Type and the Thermo Method options by
clicking on the white cells. This will enable a drop-down arrow that will show you the different options.

9. Click on the Edit button next to the Distillation Data. This will open a new window. Complete the Distillation
Data using the information given in the table above. Then click OK.

Note: Ctrl+C and then Ctrl+V can be used to copy and paste the data in the Distillation Data table.

Assay ASSAY ? *

Distilation Data

J Percent Distilled Temperature °C
[ 1.000 | 20.00
5.000 30.00
10.00 50.00
20.00 60.00
40.00 80.00
50.00 120.0
20.00 150.0
50.00 180.0
95.00 200.0
99.00 220.0
100.0 240.0

Cancel Apply Help

The Distillation Curve Cuts will eventually become individual pseudocomponents, each with its own critical
parameters and thermodynamic reference data.

10. At this point we are ready to perform a calculation. Add a Single Point calculation, and then select an
Isothermal calculation.

11. Change the SinglePoint name to Assay using the <F2> key

12. Click on the Calculate button or press the <F9> key to run the simulation

13. ltis time to save your file (File >Save as...) or using the save icon in the tool bar. Save the calculations of
this section under the name Hydrocarbons and Pseudocomponents.
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Analyzing the Results
We will review the results first in the Output Tab and the in the Report Tab.

1. Click on the Output Tab

The Output Tab shows a grid with 10 different pseudocomponents, identified with the letter P,
corresponding to each distillation cut of the crude. Notice that the name of each cut is the combination of

the oil name (ASSAY for this example) plus its boiling point in K.

The ‘+’ sign adjacent to each Assay expands a sub-table that contains the critical properties of each cut.

These properties are: Normal boiling point, density and molecular weight.

Description Definition [35 Report

J Variable Value = Type of calculation
~ Stream Parameters lzathermal - Specs...
L|:_| Stream Amount {mol} 1055.51
}_ Moles (True) - Liquid-1 (mol) 550810 Calculate 48
L Moles (True) - Liquid-2 (mol) 1000.43 Summary
Temperature (*C) 25.0000
Pressure (atm) 1.00000 Unit Set: Metric (moles)
Infl I
i nflows (mol} Automatic Chemistry Model
H20 55.5082 MSE-SRK (H30+ icn) Databanks:
P|E_| ASSAY_243K | a7 BR15 M3E-SRK (H30+ ion)
MSE (H30+ ion)
| Thermo Method APLE Second Liquid phase
l— Mormal Beiling Point (*C) -30 2796 Using Helgeson Direct
l— Specific Gravity 0.717259 Isothermal Calculation
L Molecular Weight 47.1886 5| | 25.0000°C 1.00000 atm
P|E ASSAY_273K 822275 Phase Amounts
Agueous 550810 mol
| ASSAY 07K 200.849 ‘apor 0.0 mol
P ASSAY 33TK 173.140 Solid 0.0 mel
P ASSAY 370K 109 658 2nd Ligquid  1000.43 mol
P ASSAY_403K 131.728 Agueous Phase Properties
' ASSAY 431K 110.848 pH 699753
P ASSAY_464K S7 0493 lonic §trength 1.81245e-9 mol'mol
Density 0.957043 g/ml
| ASSAY 496K 35.2169
P ASSAY 524K 116247 Calc. elapsed time: 1.137 sec
hd Calculation complete
Input | Output
Advanced Search Add as Stream Export
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2. Click on the Report Tab and scroll down to the Species Output table.

This table shows how the pseudocomponents are distributed between the Liquid-1 and Liquid-2 phases.

Notice how the Liquid-1 (or aqueous) solubility decreases with each increasing boiling point.

Jurnp to: | Species Output [True Species) w @ =N Cuztomize Ewpart
Species Qutput (True Species) .
Row Filter Applied: Onby Mon Zzro Valuss
column Filter Applied: Onhy Mon Zero Values

Total Liquid-1 Liquid-2

mal mal maol
ASSAY 307K 200.849 8.35967e-5 200.849
ASSAY_33TK 17314 2.54502e-5 173.14
ASSAY_403K 131.728 1.3826e-6 131.728
ASSAY_ 431K 110.846 3.8351e-7 110.846
ASSAY_3TO0K 109.657 4.50941e-6 109.657
ASSAY 243K 87.6615 27479e-4 87.6612
ASSAY_278K 822275 8.8662e-5 822274
ASSAY_464K 57.0493 4.39268e-8 57.0493
H20 55.5082 55.0806 0427678
ASSAY_496K 352169 4.91447e-9 35.2169
ASSAY 524K 11.6246 2.999959e-10 11.6246
OHA1 9.98321e-8 9.98321e-8
H30+1 9.98321e-8 9.98321e-8
Total (by phase) 1055.51 55.081 1000.43

W
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4.2.

Entering Pseudocomponents to a Stream

There are times when the user does not have (or does not want to use) distillation data. Rather the user had
the individual properties for a single pseudocomponent. OLI allows the user to enter the individual
pseudocomponents. In the following example we will illustrate how.

Example 33: Creating Pseudocomponents

In this example, we will enter two properties - boiling point and density. The software will use one of four
thermodynamic models — API-8, API-5, Cavett or Kessler-Lee — to calculate critical properties of
pseudocomponents.

Starting the Simulation

N o g s~ oD =

Add a new Stream

Click on the new Stream and press <F2> to change the name to Crude Oil - Pseudocomponents
Select the MSE-SRK thermodynamic Framework

Click on the Names Manager Icon and select the Formula option

Click on the Units Manager Icon, and select Metric, Batch, Moles

Enter the conditions of the Stream T= 15 °C and 1 atm

Change H20 from the default value to 20 moles

Crude Oil Stream

Calculation Settings Conditions
Stream Name Crude Oil - Pseudocomponents | Stream Amount Calculated
Name Style Display Formula Temperature 15°C
Unit Set Metric, Moles Pressure 1 atm
Framework MSE-SRK H20 20 moles

8. Inthe inflows grid, in the white cell below H20, type PC1 and then press <Crtl + Enter>

Note: The <Crtl + Enter> action instructs the software to create an pseudocomponent rather than look for

a species or pure component from the database.

| Variable A &dd Calculation -
= Stream Parameters
Special Conditions
Stream Amount {mol} 20.0000 ;
Temperature (*C} 15.0000 L Salids Orly
Preszure (atm} 1.00000
Sunnmary
T Inflows (mol)
H20 20.0000 Unit Set: Metric (meles)
pci| R
Automatic Chemistry Model
MSE-SRK (H30+ ion) Databanks:
MSE-SRK (H30+ ion)
MSE (H20+ ion)
Ctrl + Enter Second Liguid phase
Using Helgezon Direct

Note: After typing the name of your pseudocomponent, immediately press Ctrl + Enter command keys together.
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9. Repeat step 8 four more time with the following names: PC2, PC3, PC4 and PC5. Use the information

provided in the table below to complete the grid. The molecular weight will be calculated by the software.

In general, only two of the three parameters need be entered.

Pseudocomponents Information

Pseudocomponent name PC1 PC2 PC3 PC4 PC5
Inflow (moles) 100 200 250 250 180
Thermo Method API-8 API-8 API-8 API-8 API-8
Boiling Point (°C) 33 60 100 140 190
Specific Gravity 0.72 0.76 0.8 0.85 0.9
Your screen should look like the image below:
Description Definition (3 Report
J Variable Value Add Calculation -
5t P 3!
i ream Farameters Special Conditions
Stream Amount {mol) 1000.00 )
Temperature (:C) 15.0000 L] Solids Only
Pressure (atm) 1.00000
Summary
= Inflows (mol)
H20 20.0000 Unit Set: Metric (moles)
P& PC1 100.000
Automatic Chemistry Model
— Termo Method AR MSE-SRK (H30+ ion) Databanks:
|— MNormal Boiling Point (*C) 33.0000 MSE-SRK (H20+ ion)
|— Specific Gravity 0.720000 WMSE (H30+ ion)
P Second Liquid phase
— Molecular Weight Using Helgeson Direct
Calculated Properties
P PC2 200.000
I— Thermo Method APLE
|— Mormal Boiling Peint (*C) 60.0000
— Specific Gravity 0. 780000
— Molecular Weight
Calculated Properties
P PC3 250.000
— Thermo Method APLE N
|— Mormal Boiling Peint (*C) 100.000
— Specific Gravity 0.800000
— Molecular Weight
Calculated Properties
P PC4 250.000
— Thermo Method APLE
— Mormal Boiling Peint (*C) 140.000
— Specific Gravity 0.850000
— Molecular Weight
Calculated Properties
P PCS 180.000
— Therma Method APLE
— Mormal Boiling Peint (*C) 190,000
— Specific Gravity 0.500000
— Molecular Weight
Calculated Properties
Input
Advanced Search Add az Stream Export
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Notice that at the bottom of each pseudocomponent there is a “+” and a field called calculated properties.
Stream Analyzer immediately predicts all the calculated properties for each pseudocomponent. Click the “+”

sign next to PC1 to expand and see these properties.

Description Definition [ Report

H Variable Value
= Stream Parameters
Stream Amount (mol) 1000.00
Temperature (*C) 15.0000
Pressure (atm} 1.00000
= Inflows (mol)
H20 20.0000
P|C PC1 100.000
— Thermo Method APLE
— Mormal Boiling Point (*C} 33.0000
— Specific Gravity 0.720000
— Molecular Weight
=] Calculated Properties
|— Calc:Molecular Weight 70.3287|
|— Calc:Specific Gravity 0.720000
I— Calc:Boiling Point (*C} 33.0000
— Calc:Critical Temperature ("C} 213.813
\— Calc:Critical Pressure (atm) 42 1427
— Calc:Critical Wolume (L/mal) 0.271025
— Calc:Acentric Factor 0.1597 144
— Calc:HREF Vapor -1.28412e5
— Calc:GREF Vapor -0586.264
— Calc:SREF Vapor J43.881
— Calc:CPREF Wapor 103,303
|— Calc:WREF 244483
|— Calc:HREF Agqueous -1.39845e5
|— Calc:GREF Agueous 59148.25
— Calc:SREF Agueous 242380
— Calc:CPREF Agueous 244 425
L~ Calc:Rackett 0.277605
P |_|:_| PC2 200.000
[~ Thermo Method APLE
|— Normal Boiling Point (*C) 50.0000
[~ Specific Gravity 0.760000
|— Molecular Weight
Calculated Properties
P |_|=_| PC3 250.000
[~ Thermo Method APLE
i— e P
Ihput
Advanced Search Add as Stream Expart

The values in the green boxes can be changed to match data from other programs.

10. At this point we are ready to perform a calculation. Add a Single Point calculation, and then select an
Isothermal calculation.
11. Change the SinglePoint name to Pseudocomponents using the <F2> key

12. Click on the Calculate button or press the <F9> key to run the simulation
13. ltis time to save your file (File >Save as...) or using the save icon in the tool bar. Save the calculations of

this section under the name Hydrocarbons and Pseudocomponents.
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Analyzing the Results
1. Click on the Report Tab and scroll down to the Species Output table.

This table shows how the pseudocomponents are distributed between the Liquid-1 and Liquid-2 phases.

Jump to: | Species Output [True Species) A @ 9@, Customize E xport
Species Qutput [True Species) A
Row Filter Applied: Only Non Zero Values
column Filter Applied: Onby Mon Zero Values

Total Ligquid-1 Liquid-2
mal mol mal
PC3 250.0 1.97215e-6 250.0
PC4 250.0 4 54519e-7 250.0
pC2 200.0 8.03965e-6 200.0
PC5 180.0 5.40506e-8 180.0
PC1 100.0 1.1074e-5 100.0
H20 20.0 19.7405 0.259476
H30+1 2.40152e-8 2.40152e-8
0OHA1 2.40152e-8 2.40152e-8
Total (by phase) 1000.0 18.7405 980.259
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Section 5. Mixers

Mixers are a useful tool to mix one or more streams. This tool allows you to mix Molecular Streams or
Reconciled Streams.

¢ OLl Studio - [Mixers.oad] - ] *
W File Edit Streams Calculations Chemistry Tools View Window Help - 8 X

DEH| TN Lvase 2 [Re s m i Bt s | MEEE B RE NS
| Navigator 3 - x|

Mixers oad ‘ &

8 Streams Description Definition ([l Plot & Report L3 File Yiewer

& Stream -
.. Stream-1 Available Streams Selected Miring Method
Stream - [40] iSingle Point Mixi ~ «| | Specs.
Strearn-1 - [AQ] ¥
#®  Single Point Mix
&3 Volume
Ratic
Multiplier
§ T
Variable | Value -
Muttiplier | Need at least 1 input stream.
Stream Parameters
Total Inflows

| Actions L 4 x Temperature (*C) 25.0000

Actions Pressure (atm) 1.00000 >

Flot Template Manager g o+ X

v
Input
Advanced Search Add as Stream Expart
Save

x|

3

2

3

For Help, press F1 & NUM

In this section, you will learn how to set up a Mixer and differentiate the different mixing options to get the most
out of your simulation results.
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5.1. Mixing Options (Definitions)

The Mixer Object has four different mixing options: Single point mix, Volume, Ratio, and Multiplier. A quick

summary of what each mixing options allows you to do is summarized here.

Single Point Mix

This option allows you to multiply up or down a stream inflow. When selecting the streams to mix, this option
will enable the multiplier option for both streams. You can leave the default values that are set by default to 1.0
or change the multiplier values to any other number.

Volume

In this option, one stream stays at a constant volume, while the other stream’s volume changes within a range
specified by the user, as is illustrated in the table below:

Ratio

Stream 1 Stream 2
1L 1L
1L 2L
1L nL

In the ratio mixing type, both streams change at the same time. For example, stream will be 100% and Stream
will be 0%, then Stream 1 will be 90% and Stream 2 will be 10%, and so on, until it reaches Stream 1 0% and

Stream 2 100%.

Multiplier

Stream 1 Stream 2
100 % 0%
90 % 10%

0 % 100 %

In this mixing option, one stream stays constant, while the other stream changes using a multiplier. The range
of the multiplier values is given by the user.

Stream 1

Stream 2

1

Stream 2 x 0

1

Stream 2 x 1

1

Stream 2 x n
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5.2. A Basic Mixer Calculation

A brief introduction to the Mixer tool will be shown in the example below. As we go through the example, basic
definitions, functionalities and reporting for the Mixer tool will be introduced.

Example 34: Calculating the Heat of Mixing

You will mix 1 L of a 10 wt% Ca(OH):z solution with 1 L of a 10% HCI solution, and then you will ask the software
to calculate the heat of mixing and the final temperature of the mixture.

Starting the Simulation
In this example we need to create two different streams: a 10 wt% Ca(OH)2 solution and a 10% HCI solution.

Use the inputs and parameters from the table below to create each stream. Certain inputs, such as the name
style, units, etc. will require further adjustments, and will be described as necessary.

Basic Mixing Calculation

1t Stream 2"d Stream
Stream Name Ca(OH)2 Stream Name HCI
Name Style Display Formula Name Style Display Formula
Unit Set Metric, Batch, Mass Frac. Unit Set Metric, Batch, Mass Frac.
Framework MSE Framework MSE
Stream Amount 1 kg Stream Amount 1 kg
Temperature 25°C Temperature 25°C
Pressure 1 atm Pressure 1 atm
H20 Calculated H20 Calculated
Ca(OH)2 10 mass% HCI 10 mass%

1. After creating the streams, Add a Mixer. The Mixer object can be accessed from the Menu Bar by selecting
Calculations > Add Mixer or by selecting the Add Mixer in the Actions Pane.

2. Press <F2> to rename the mixer to Basic Mixing

Notice that the display layout for the Mixer tool is slightly different. There are two different windows (see image
below).

e The first window displays all possible streams available for the mix calculation. There is no limit to the
number of streams to be mixed.

e The second window allows you to change the mixing conditions, e.g. temperature, and pressure of the

mixing.
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& 0L Studio - [Mixer calculations.cad®] — O e
W7 File Edit Streams Calculations Chemistry Tools View Window Help - 8 X
DS | SRR uvasetz[Re s [ms i com e | MBS |G RE
| Navigator g x| &
Water Analysis Calculations.oad
Hydrocarbons and Pseudocompaonents.oad Description Definition i Plot [ Report
Mixer calculations oad® — .
5 Available Streams Selected Mixing Method
4> Streams Cal0H)2 - [M5E] Single Point bix Specs.
a - A
Ca(OH)2 HEI - [MSE] -
HCI Type of calculation
Al Basic Mixing <1 |sothermal -
Window that display all the possible
streams available for mixing Cacute @ |
Summary
Variable Value -
ALITET Need at least 1 input stream.
Stream Parameters
Total Inflow
Temperature (*C) 25.0000
| Actions L o-x Pressure (atm) 1.00000
Actions >
Window that allows you to change
the mixing conditions
|Plot Template Manager L - x
v
Input
Advanced Search Add as Stream Export
Save
ﬂl[ﬁalculalion Complete! =
3
@ y

For Help, press F1

3. Select the Ca(OH)2 stream from the available streams and use the >> button to put it under the Selected

window

4. Selectthe HCI stream from the available streams and use the >> button to put it under the Selected window

Mixing Method
Single Point Mis
Tupe of calculation

|sothermal

- Specs...

-

Calculate &8 |

Summary

Available Streams Selected
Cal0H)2
3 HCI
<8
Variable Value | Ca(OH)2 HCI A
Multiplier 1.00000 1.00000
Stream Parameters
Total Inflow 1000.00 g 1000.00 g
Temperature (°C) | 25.0000 | 25.0000 25.0000
Pressure (atm) 1.00000 | 1.00000 1.00000

Automatic Chemistry

WSE (H30+ ion)

Single Point Mix

Calculation not done

Unit Set: Metric (moles)

Model

MSE (H30+ ion) Databanks:

Using Helgeson Direct

Isothermal Calculation
25.0000 *C 1.00000 atm
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Also notice that the default calculation is the Single Point Mix Method at Isothermal conditions. In this
example, we want to calculate the heat of mixing and the final temperature of the mixture. Thus, an adiabatic
calculation is required to see this effect.

5. Click on the Type of Calculation button and select the Adiabatic calculation option

Note: Once the streams for the mixing have been selected, notice that the multipliers of both streams:
Ca(OH)2 and HCI can be edited. This specific calculation will be carried out at a constant pressure of 1
atm, and the final temperature of the mixture will be calculated.

Awailable Streams Selected Miring M ethod
CallH)2 Single Paint Mix = Specs..
o HLCI
Tepe of calculation
o Adiahatic -
Calculate 48
Summary
J Variable Value Ca(OH)2 HCI ~ Unit Set. Hetric (moles)
- ( =
Muttiplier 1.00000 1.00000 nit Set: Metric (moles)
Stream Parameters Automatic Chemistry Model
Total Inflowe 1000.00 g 1000.00 g MSE (H30+ ion) Databanks:
= MSE (H30+ ion)
0| Temperature (*C) 25.0000 25.0000 25.0000 Using Helgeson Direct
i Pressure (atm} 1.00000 1.00000 1.00000 Isenthalpic Calculation
> 0.0 cal
1.00000 atm
Single Point Mix
Calculation not done
v
Input
Advanced Search Add as Stream Export

6. Now, we are ready to perform the calculation. Click on the Calculate button or press the <F9> key

7. ltis time to save your file (File >Save as...) or using the save icon in the tool bar. You can save it and
name it as Mixer Calculations.

Analyzing the Results

Review the Summary Box. After mixing these two streams, the temperature increased from 25 °C to
approximately 48.65 °C at a constant pressure of 1 atm. This indicates that that the enthalpy (or heat) of mixing
is exothermic, and the software calculated this value to be approximately -7.25x108 calories.
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5.3. A Titration Experiment

In this example, you will explore the volume mixing option to recreate a titration experiment. As we go through
the example, different functionalities, reporting and plotting for the Mixer tool will be introduced.

Example 35: HF Titration with CaCl,

In this example, first, we will create two new streams, a 0.1 m HF solution and a 0.1 m CaClz solution. What is
the pH of these individual streams?

Second, we will mix these two streams in equal amounts. What is the final pH of the mixture?

And finally, the 0.1 m HF solution will be titrated with a 0.1 m CaCl2 solution. What will the titration curve look
like?

Starting the Simulation
For this example, we need to create two different streams: a 0.1 m HF solution and a 0.1 m CaCl2 solution.

Use the inputs and parameters from the table below to create each stream. Certain inputs, such as the name
style, units, etc. will require further adjustments, and will be described as necessary.

Titration Calculation

1t Stream 2" Stream
Stream Name 0.1 mHF Stream Name 0.1 m CaCl2
Name Style Display Formula Name Style Display Formula
Unit Set Metric, Batch, Moles Unit Set Metric, Batch, Moles
Framework AQ Framework AQ
Stream Amount Calculated Stream Amount Calculated
Temperature 30°C Temperature 30°C
Pressure 1 atm Pressure 1 atm
H20 55.5082 moles H20 55.5082 moles
HF 0.1 moles CaCl2 0.1 moles

Calculating the pH of the individual streams
1. Add a Single Point — Isothermal calculation for each stream

2. Change the name to pH 0.1 m HF and pH 0.1 m CaCI2 respectively using the <F2> key
3. Calculate the isothermal calculation for each stream

4. Check the pH values of the individual streams in the Summary Box

Results — pH of the individual streams

pH0.1m HF pHO0.1 m CaCl2
[ 213 | 6.82 |
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Calculating the pH of the Mixture

5. After creating the streams, Add a Mixer. The Mixer object can be accessed from the Menu Bar by selecting
Calculations > Add Mixer or by selecting the Add Mixer in the Actions Pane.
6. Press <F2> to rename the mixer to Titration

Note: Notice that the Available Streams window is showing all the available streams for the mixing
calculation. Also notice that this window is showing both: Streams and Single Point calculations.
Additionally, in front of the name of the available streams, the thermodynamic framework appears within
brackets, e.g. AQ, MSE or MSE-SRK. This is important because in order to carry out mixing calculations,
the selected streams need to use the same thermodynamic framework.

Description Definition [l Plot [E] Report

Available Streams

Selected

Cal0H]2 - [M5E]
HCI - [M5E]

0.1 HF - [40]

0.1 CaCl2 - [40Q]
Basic Mixing - [MSE]
pH 0.1 HF - [43]

pH 0.1 CaClz - [40]

>

<4

= © ® N

place to 30 °C.

Available Streams Selected
pH 0.1 HF - [a0] 0.1 HF
pH 0.1 CaClz2 - [40] b3 0.1 CaCl2
<4
J Variable Value 0.1 HF 0.1 CaCl2 A
| Multiplier 1.00000 1.00000 |
Stream Parameters
Total Inflows 55.6082 mol 55.6082 mol
| Temperature (°C) | 30.0000 30.0000 30.0000

Pressure (atm) 1.00000

1.00000 1.00000

Select the 0.1 HF — [AQ] stream. Use the >> button to move it to the Selected window

Select the 0.1 CaCl2 stream. Use the >> button to move it to the Selected window

Select Single Point Mix as the Mixing Method and Isothermal as the Type of Calculation

0. Leave the default values for the multipliers (1.0) and change the temperature at which the mixture takes

Mixing Method
Single Point Mis - Specs...
Tuvpe of calculation

|zothermal -

Calculate 48

Surnmary

Unit Set: Metric (moles)

Automatic Chemistry Model

Agueous (H+ ion) Databanks:
Agueous (H+ ion)

Using K-fit Polynomials.
T-span: 25.0 - 225.0
P-span: 1.0 - 1500.0

Isothermal Calculation
30.0000 °C 1.00000 atm

Single Point Mix

Calculation not done

11. Now, we are ready to perform the calculation. Click on the Calculate button or press the <F9> key

12. At this point is time to save your file (File >Save as...) or using the save icon in the tool bar. You can save
under the same file that we created before named as Mixer Calculations.

13. Check the pH values of the individual streams in the Summary Box
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Results — pH of the individual streams
The resultant pH is 1.44. How can this be? An acid stream (the HF stream had a pH of approximately 2.13) and
a nominally basic stream (the CaClz stream had a pH of 6.82) are mixed and the pH is outside the value of

either stream.

We will continue using Stream Analyzer to further examine the chemistry in more detail. We will titrate the HF
stream with CaCla.

Titrating HF with CaCl;
14. Change the Single Point Mix as the Mixing Method to the Volume option.
Note: You will receive a warning message: Need 1 stream selected as the variable stream (Specs...)

15. Click on the Specs button. This will open a new window indicating you to select the Stream to vary
16. In the Select Stream tab Select the 0.1m CaCl2 stream

Volume Survey Options ? *

Categorny Select Sheam Survey Range

- Y ariable - Yolume .
... Caloulation Options Select inlet stream to vary

0.1 HF

17. Select the Survey Range tab. Change the Volume Range from O L to 1 L.
18. Change the Number of Steps to 50. Then click OK.

Volume Survey Options ? x
Category Select Geam  Survey Flange
Wariable - Volurne
.. Caleulation Options Wolume Range Unit:
Selected Range
0.0t01.0in1 steps of 1.0 Hew
Delete
(®) Linear (O Log () Pirt List
End Paints
End |1.00000
Step Size
Increment | 1.00000
O } Select one, the ather is
Mumber Steps ® calculated
Cancel Apply Help
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19. Now, we are ready to perform the calculation. Click on the Calculate button or press the <F9> key
20. Itis time to save your file (File >Save as...) or using the save icon in the tool bar. You can save under the
same file that we created before named as Mixer Calculations.

Titration Results and Plotting

1. Click on the Plot tab. Note: You will see an empty plot, since we need to define the variables that we want
to report.

2. Click on the Variables button and expand the Aqueous section. Select and put the following species in
the Y1 axis using the >> button: HF-Aq, H+1, F-1, Ca+2. Expand the Solid section and select CaF2(s).

3. Next, expand the Additional Parameters Section and Select pH. Put it in the Y2 Axis using the >> button.
Then click OK.
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As you can see, adding CaCl: to this solution lowers the pH to values as low as 1.33. The pH does begin to
slowly increase after 0.48 L of CaClz have been added.

Why the unusual pH behavior? You can see that a small amount of Ca*? in solution, causes the formation of
the solid CaF,. This effectively removes F~ from solution according to the following equation:

Ca*? 4+ 2F~ - CaFy
As we add more CaCl:z in solution, more CaF: is formed. As a result, the molecular HF decreases, because it
dissociates in order to maintain the equilibrium, by producing more F~ ions. This shifts the following equilibrium
to the right:

HF & H* + F~

This causes an increase of H* in solution, and as a result a decrease in the pH. At some point, at around 0.48
L of 0.1 m CaClz, the solid reaches a steady value, indicating that the solid has reached its saturation value.
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5.4. Cascading Mixers

Example 36: Cascading Mixers
In this example, we will mix two streams, one basic and one acidic, and mix them together under adiabatic

conditions. The output of this mixer will then be used as the input to a second mixer where a new caustic
stream is added. The schematic in the figure below illustrates the layout.

Base Waste j |/_

SinglePoint1

Acid Waste

Caustic

For this example, we need to create three streams. You have already done this in other examples, so we will
only give you the input data (for all streams, we will use the AQ — default — thermodynamic framework)

Cascading Mixer Stream Data

Stream Name Base Waste

Temperature 25.0 °C

Pressure 1.0 Atmospheres
Stream Amount 55.5082 (Default) Mole

H20 55.5082 Mole

CO2 0.1 Mole

NH3 0.01 Mole

SO2 0.01 Mole

Stream Name Acid Waste

Temperature 25.0 °C

Pressure 1.0 Atmospheres
H20 55.5082 Mole

HCI 0.1 Mole

H2S04 1.0 Mole

Stream Name Acid Waste

Temperature 25.0 °C

Pressure 1.0 Atmospheres
H20 55.5082 Mole

NaOH 1.0 Mole

To test that our streams are representing their respective names, perform a single point isothermal flash on
each stream. When you are done you should have a window that looks like Figure 0-6 below:
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{ OLIStudio - [Chapter 8 Tour.cad*] [E=@]=]
H File Edit Streams Calculations Chemistry Tools View Window Help [= =]
Do |5 2 % (WlalSazn e+ 1 + (@)t | 4 ER S G 9 e s |
[ Navigator e -x]| A
Chapter & Tour.oad*
- Stream - || &7 Description | [£¥ Definition IE H:pnﬂlg File Vi:w:l‘
4 Survey b
Uob Sweamd s T T = Type of calculation
45 Survey-1 = Stream Parameters Isothermal -] [ Spess... |
b Stream-2 15"“"”:"'”"”_;(”"’" :;’;’;ﬂn Bubkle/Dew Poirt
o - emperature
& Survey-2 ! P '( ) - @ Temperature
.. Citric Acid ressure (atm) : Pressure
. NaOH - Inflows (mol)
&l Mixer S H20 555082
E1-# Base Waste NaOH 1.00000 Calculste @
&y SinglePoint S
2-d Acid Waste B
4 SinglePoint-1 Unit Set: Metric (moles)
Causti
& Coustic Automatic Chemistry Model
4y SinglePoint-2 - AQ (H+ ion) Databanks:
L Public
| Actions g ax Isothermal Calculation
Actions .| | 25.0000 " 1.00000 atm
Phase Amounts
Aqueous  57.5082 mol
vapor 0.0 mol
Solid 0.0 mol
Aqueous Phase Properties
pH 13,8891
lonic Strength 0.0173888 mokmol
Density 1.03546 giml
[Plot Tempiate Mariager ok Calc. elapsed time: 0250 sec
Calculation complete
Input | Output
[ Advanced || Seach |[AddasSteam|[  Expot -
Save e
For Help, press F1 @ NUM

Now we are ready to begin. Click on the “Streams” at the top of the tree-view in the left-hand window and then
select Add Mixer from the actions panel.

| Navigator g o« x|
Chapter 8 Touroad* |

[

]

& Citric Acid

& NaOH

K Mixer

5. & BaseWaste

4y SinglePoint

E| & Acid Waste
4y SinglePoint-1

Caustic

i fy SinglePoint-2

| Actions Vi g -
Actions

B E =
) —

Add Stream Add Mixer

—_—
Add Water Add
Apalysis  Standard E...

L A

Add Brine Add il
Analysis Analysis

& &

Add Gas Add

Anzhecic Caturatar

m

We can now add the “Base Waste” and “Acid Waste” stream as we have done in previous examples. The only
difference here is that we are selecting an Adiabatic calculation instead of the default isothermal calculation.
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&

Available Streams

Stream

Stream-1

Stream-2

Citric Acid

MalH

Caustic

Mixer - [A0]
SinglePaint - [A0]
SinglePaint-1 - [A0Q]

m

EX

<

Selected

Base Waste
Acid Waste

1 Variahla

Valua

Raca WWasta Arid Wacta

bdixing Method

[ Single Point Mix

v] [ Specs... ]

Type of calculation

Bubble/Dew Point
@ Temperature

Pressure

Let's calculate this mixer. Click the Calculate button. If everything is set up correctly the resultant mixed pH

should be approximately 0.3.

In the stream tree-view panel, locate your mixer and click the “+” sign.

Click the “+” sign to expand the tree.

Base Waste
-y SinglePoint
& Acid Waste
-4y SinglePoint-1
& Caustic

-y SinglePoint-2

K

E| & Base Waste
j i {y SinglePoint
E| & Acid Waste

i~ {y Flash of Base Waste
£y Flash of Acid Waste

You can see that the program has performed an equilibrium calculation on each of our input streams as well as
calculated the mixer. The results of the mixer are stored in the object “1 of 1”.

We will now add a second mixer from the actions panel.

MNavigator

&

Chapter 8 Tour.oad*
¢ G 4 Survey-2
- & Citric Acid
& MaOH
K Mixer
£l & BaseWaste
i iy SinglePoint
Acid Waste
- & SinglePoint-1
Caustic
. L. SinglePoint-2
£l Mixer-1
i iy Flash of Base Waste
- £ Flash of Acid Waste
Lofylofl
L ] Micer-2

m

Actions
Actions

Description | &¥ Definition @ Plot | 5 Report | L3 File Viewer

Available Streams Selected

NaOH - [A0]

Base Waste - [40]
Acid Wastes - (0]
Caustic - [40] 3 e
Miser - [AQ]

SinglePoint - [&0] =
SinglePoint-1 - [AG]

SmE\ernl-Z - [a0 | 4

|

Variable Value
Multiplier
Stream Parameters
Total Inflow
Temperature (*C)
Pressure (atm)

25.0000
1.00000
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When we add a subsequent mixer, we will see all of our previous objects still displayed. It is possible to reuse
a stream that we already used (this is not possible in OLI’s other simulators such as OLI Flowsheet.) We want
to connect the output from our first mixer (Mixer1) to the inlet of the Caustic stream. Click the object Mixer-1-

(AQ) as highlighted in Figure 0-11 above.

Then add the Caustic Reagent. Select the type of calculation as Isothermal.

Description | &% Definition @ Plutl E Repont | 3 File Viewer|
Available Streams Selected Mising Method
Sheam . Mixer-1 [ Single Paint Mix v] [ Specs... ]
Stream-1 wh Caustic
Stream-2 Type of calculation
Citric &.cid c Fe
Base'Waste .
Acid Waste Bubble D ew Paint
Mixer - [40] @) Temperature
SinglePaint - [40] = Pressure
H Variable Value Mixer-1 Caustic -
Multiplier 1.00000 1.00000 Calculaste @
Stream Parameters Summary
Total Inflow 113.236 mol 56.5082 mol n
Temperature (°C) 25.0000 25.0000 25.0000 Unit Set: Metric (moles)
Pressure (atm) 1.00000 1.00000 1.00000 ) )
Autnmatic: Chemistry Model

We are now ready to calculate the second mixer. Press the calculate button.

The resultant pH should be approximately 1.0. We want to increase this value. Change the Multiplier value
for Caustic Stream from 1.0 to 2.4

J Variable Value Mixer-1 Caustic
Muttiplier 1.00000 2.40000
Stream Parameters
Total Inflow 113.236 mol 56.5082 mol
Temperature (=C} 25.0000 4 25.0000
Pressure (atm) 1.00000 1.00000 - 1.00000

Click the calculate button again. The new pH should be approximately 12.4.

The real value of the cascading mixer is the quick ability to re-calculate the objects if we want to change
something. Let's add some diethanolamine to the series of calculations. Click the Acid Waste stream (not the
single point calculation below it) and add the component DEXH? to the grid with a value of 10.0 moles.

- & Stream
& Stream-1 J Variable Value
s & Stream-2 = Stream Parameters
- #& Citric Acid Stream Amount (mol) 66.6082
- MaOH Temperature (*C) 25.0000
ﬁ Mixer Pressure (atm) 1.00000
& Base Waste w Inflows {mol)
-4y SinglePoint Water 55.5082
Acid Waste Hydrogen chioride 0.100000
-4y SinglePaint-1 Sulfuric(V) acid 1.00000
Caustic DEXH| | 10.0000
-y SinglePoint-2

7 This is the OLI Tag name for diethanolamine, which is easier to type if you know the name.
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Return to the last mixer you created (Mixer-2 in our example) and then reduce the Caustic Multiplier back to

1.0

To recalculate all the objects at once, press the control+F9 keys and all objects will be calculated. Now if you
look at the summary of Mixer2 you will see that the pH has changed to approximately 10.

Iixirg bethod

[ Single Paint Mix V] [ Specs... ]

Tupe of calculation

|sothermal -
Calculate &8 |

Summary

Description Definition | {fi Plot | 3 Report
Awailable Streams Selected
Stream - Mixer-1
Stream-1 r 3y Caustic
Stream-2
Citric Acid = I
MaOH 0
Base Waste
Acid Waste —
Mixer - [A0]
§!ng!eE’o!nt - [A_Q]_ i -
Variable Value Mixer-1 Caustic
Muttiplier 1.00000 1.00000 |
Stream Parameters
Total Inflow 123.236 mol 56.5082 mol
Temperature 25.0000 25.0000 25.0000
Pressure (at 1.00000 1.00000 1.00000
Input |
Search Add as Stream Export

Unit Set: Metric (moles)

Automatic Chemistry Model
A (H+ ion) Databanks:
Public
Isothermal Calculation
25.0000 *C 1.00000 atm

Single Point Mix

Calculation Results:
Temperature 25.0000 °C
Heat Duty -11867.3 cal

Phase Amounts
Agqueous  179.430 mol
Vapor 0.0 mol
Solid 0.0 mal

Agueous Phase Properties
pH 10.0738
lonic Strength  0.0158132 mol'mel
Density 1.05177 g/ml

Calc. elapsed time: 0.582 sec

Calculation complete

Calculation complete

»

m
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Section 6. Chemical Stability Diagrams

“Predicting the stability of chemical compounds as a function of solution chemistry is crucial towards
understanding the electrochemical characteristics of materials in real-world applications. There are several
commonly considered factors that affect the stability of a chemical compound, such as metal ion concentration,
mixtures of ion concentrations, pH, buffering agents, complexation agents, and temperature. Chemical stability
diagrams graphically describe the relative stabilities of chemical compounds, ions, and complexes of a single
element as a function of bulk solution chemistry (pH and metal ion concentration) and also describe how solution
chemistry changes upon the thermodynamically driven dissolution of a species into solution as the system
progresses towards equilibrium™e.

Stream Analyzer has the capability of building chemical stability diagrams by using the Chemical Diagram tool
that allows to study the precipitation of species as function of ion concentration and other parameters such as
pH. In this section we will explore with different examples how to set up cases to use the Chemical Diagram
tool.

& OU Studio - [Chemical Diagrams.cad™] — [m] *
B File Edit Streams Calculations Chemistry Tools View Window Help - 8 x
ODEH TR | LWvasol? Red w3t MEE OB
Navigator - x
= t =
Chemical Diagrams.oad*
‘o‘ Streams Description @ Definition [l Chemical Diagram [ Report
=& Stream T i di
: e of diagram
i@ Chemical Diagram W Variable Value Q y? d
< Stream Parameters Species vs, Spegiesi | | Specs
Stream Amount {mol} 55.5082 - -
Species vs. Species
Temperature (*C} 25.0000
Solids Yield
Pressure (atm) 1.00000
mmnan
= Inflows (mol)
H20 55.5082 Unit Set: Wetric (moles)
Automatic Chemistry Model
Agueous (H+ ion) Databanks
Agueous (H+ ion
Using K-fit Polynomials
T-span: 25.0 - 225.0
P-span: 1.0 - 1500.0
Stabilty diagram: vs
Specify an X variable component
for this diagram type.
Actions L Specify at least 1 variable
Actions > | component for this diagram type.
Calculation not done
Plot Template Manager p - X
v
Input
Advanced Search Add as Stream Expart.
Save
*||Calculation Complete! =
»
For Help, press F1 @ NUM

8 Santucci, R.J., McMahon, M.E. and Scully, J.R., 2018. Utilization of chemical stability diagrams for improved understanding of
electrochemical systems: evolution of solution chemistry towards equilibrium. npj Materials Degradation, 2(1), p.1.

223



6.1. Building a Chemical Diagram

In this section, first we will go through the steps of building a basic chemical diagram, and then we will explore
how the concentration of species and other variables such as temperature and pressure have a significant
influence on the stability of chemical species.

Example 37: La(C2H;0.); — KsPO4 Chemical Diagram
For this example, we are going to reproduce the work found in the following paper: Andelman, T., Tan, M. C.,

& Riman, R. (2010). Thermochemical engineering of hydrothermal crystallization processes. Materials
Research Innovations, 14(1), 9-15. https://doi.org/10.1179/143307510X12599329343123.

Starting the Simulation

Use the inputs and parameters from the table below to create the stream’s composition. Certain inputs, such
as the name style, units, etc. will require further adjustments, and will be described as necessary.

La(C2H302); — KsPO4 Chemical Diagram

Calculation Settings Stream Composition and Conditions

Stream Name Chemical Diagrams Stream Amount Calculated

Name Style Display Formula Temperature 25°C

Unit Set Metric, Batch, Moles Pressure 1 atm

Framework AQ H20 55.5082 moles

Type of Calculation Chemical Diagram La[C2H302]3 0.1 moles
K3PO4 0.1 moles
HNO3 0.0 moles
NaOH 0.0 moles

Add a new Stream

Click on the new Stream and press <F2> to change the name to Chemical Diagrams
Select the AQ thermodynamic Framework

Click on the Names Manager Icon and select the Formula option

Click on the Units Manager Icon, and select Metric, Batch, Moles

L

Enter the composition of the stream given in the table above. Notice that the concentrations of
La(C2H302)3 and K3PO4 are held at a 1:1 molal ratio.

7. Go to the Add Calculation button and select Chemical Diagram calculation or by selecting the Chemical
Diagram icon in the Actions Pane

Select Species vs Species as Type of Diagram — Default

Change the Chemical Diagram name to Lanthanum/Phosphate using the <F2> key
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¢\ 0Ll Studio - [Chemical Diagrams.oad”] — [m] X
W File Edit Streams Calculations Chemistry Tools View Window Help - & x
DEE 4BE © 2| Lws|e: meBHses | BE: | GEE |
Navigator - %
(= r - x| =
Chemical Diagrams.oad*
& Streams Description Definition (i Chemical Diagram [ Report
=& Chemical Diagrams T »
: : & of diagram
Lanthanum/Phosphate Variable [ Value L & d
= Stream Parameters Species vs. Species
Stream Amount (moly 55.7082
Temperature (*C} 25.0000 Calculate &8 |
Pressure (atm) 1.00000
Summary
= Calculation Parameters
Use Single Titrant Ho Unit Set: Metric (moles)
pH Acid Titrant HNO3
Automatic Chemistry Model
pilbcecyNun NaOH Agueous (H+ ion) Databanks:
e Inflows (mol) Agueous (H+ ion)
HzO 555082 Using K-fit Polynomials.
T-span: 25.0 - 225.0
La[CZH302]3 0100000 P-span: 1.0 - 1500.0
[Actions Tom K3PO4 0.100000
fEh HNO3 o0 5 Stability dlagram: La[C2H302]3 vs pH
NaOH 0.0 User-selected tirants
Acid: HNO3
Base: NaOH
Range on La[C2H302]3:
1.00000e-14 to 1.00000 mol
Range on pH
0.0 to 14.0000
Subsystems
Flot Template Manager L o« x Lanthanum
Calculation not done
v
Irput
Advanced Search Add as Stream Export
Save
x ~
v
v
For Help, press F1 @ NUM

10. Click on the Specs button. This will open the Chemical Diagram Options window
11. In the Display Choices tab, select the No Aqueous lines button and check the box for Lanthanum as the
subsystems to display

Chemical Diagram Options ? x

Categorny Dizplay Choices

Agueous and Solid Lines Shading
() Sunerimnase line (C) No shading

(®) No Aqueous lines (®) Shade selected subsystem

(_) Only Aqueous lines

Display Subsystem

Potassium
o

[ ]5edium
[mitrogen
[CJPhespharus

Cancel Apply Help
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12. Click on the Axes category. The dialog changes to display the X Axis tab.

13. In the Variable section select the pH option. Leave the default pH Range: 0-14. This also enables the
Titrants button.

Chemical Diagram Options ? x
Category Kbz Y s
- Dizplay
Variable Species
() Spedies Amount Hide Related Inflows
(®) pH Titrants H20
HNO3
K3PO4
IR La[C2H302]3
o
Log scale
Cancel Apply Help

14. Click on the Titrants button. Select HNO3 as the acid titrant and NaOH as the base titrant. Then click
OK.

Note: These titrants were added in the stream definition, and that’s why they appear as possible titrants.

Select Titrants

? X
Titrants
Hide Related Inflows Mew Inflow
Acid Base
H20 H20
HNO3
KIro4 KIPo4
La[C2H302]3 La[C2H302]2
NaQH

\Select the acid and the base which will be used to vary the pH.

Cancel

Apply Help
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15. Select the Y Axis tab. Select the Species Amount button as the variable to change

16. Select La[C2H302]3 and K3PO4 species

17. For the Inflow Range keep the default range: from 1E-14 to 1.0 moles on a log scale.
Note: This means we will have initially 1.0E-14 moles of La(C2H302)3 and 1.0E-14 moles of K3PO4
increasing equally until we have 1.0 moles of each.

18. Click OK

Category 5 Ais | Y Auis |
i~ Display |
[ Variable Spedes (maximum of 4)

(®) Species Amount Inflow(s) Hide Related Inflows I
|
() Temperature [JH20 |
[ 12 T |

P04

Inflow R
IR a[c2H307]3 f
Start | 1le-014 mal L= |
Log scale
|
(1] Cancel Apply Help

19. We are ready to perform the calculation. Click on the Calculate button or press the <F9> key

20. It is time to save your file (File >Save as...) or using the save icon in the tool bar. You can save it and
name it Chemical Diagrams.
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Anaylyzing the Results

Click on the Chemical Diagram tab ( il Chemical Diagram ) Tps ta, displays the Species vs pH diagram for
the Lanthanum species.

The X axis of the diagram is pH, varied by adding HCI or NaOH, and the Y axis variable is the concentrations
of La(C2H302)3 and K3P0O4, held at a 1:1 molar ratio. From this figure, we can see that at room temperature
there is a large pH range over which lanthanum phosphate will be the thermodynamically stable product. As pH
increases, and more OH- ions are present, La(OH)3 begins to form. The pH range in which La(OH)3 forms is
the right bounded region in the diagram. The area below the lines is where only aqueous species exist.
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Example 38: Adding 50% Lanthanum Acetate

In this second example we will add 50% more to the lanthanum acetate species and see the effect of this
increase in concentration on the chemical diagram.

Starting the Simulation

1. Copy the Lanthanum/Phosphate chemical diagram calculated in the Example 37: La(C2H302)3 — KsPO4

Chemical Diagram, and paste it under the Chemical Diagrams stream.

2. Change the name to Lanthanum 50% increase using the <F2> key

Change the Lanthanum Acetate amount to 0.15 moles

¢ 0Ll Studio - [Chemical Diagrams.oad*] — O e
B File Edit Streams Calculations Chemistry Tools View Window Help - 8 X
Iafll= = R =] A 11 vaSol2 Red m=3lfd e | MER S PRE N
Mavigator L o~ X
i [
Chemical Diagrams.oad*® |
&% Streams Description Definition i Chemical Diagram (& Report
- #& Chemical Diagrams T i
; : e of diagram
[ Lanthanum/Phosphate u Variable Value i d
L @ T e = Stream Parameters Species ve. Species Specs...
Stream Amount (mol) 55.7582
Temperature (*C} 25.0000 Calculate 48
Preszure (atm) 1.00000
Summary
e Calculation Parameters
Use Single Titrant Mo Unit Set: Metric (moles)
pH Acid Titrant HNO3
- Automatic Chemistry Model
il FEER LT NaOH Agueous (H+ ion) Databanks:
& Inflows {mol) Agueous (H+ ion)
H20 555082 Using K-fit Polynomials
T- 125.0-225.0
| LalcaH3oza 0.150000 | P_:ﬁ::. 1015000
= K3PO4 0.100000
Actions I
Aeions HHO3 0.0 Stability diagram: La[CZH302]3 vs pH
NaOH 0.0 User-selected titrants
Acid: HNO3
j Base: HaOH
Range on La[C2H302]3:
1.00000e-14 to 1.00000 mol
Range on pH:
0.0 to 14.0000
Subsystems
Flot Template Manager L o+ X Lanthanum
Calculation complete
Input  Output
Advanced Search Add as Stream Export
Save
* - ’ ~
,||Calculation Complete!
v
o
For Help, press F1 @ MNUM

4. We are ready to perform the calculation. Click on the Calculate button or press the <F9> key

5. ltis time to save your file (File >Save as...) or using the save icon in the tool bar.
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Anaylyzing the Results

Click on the Chemical Diagram tab (ﬂ Chemical Diagram ) t js important to note that the Y axis label has

changed to reflect the increased amount of the lanthanum acetate.

From this figure, we can see that by increasing amount of Lanthanum acetate it favors the stability of La(OH)3
over a wider range of pH.
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Example 39: Changing temperature and pressure

In this second example we will add 50% more to the lanthanum acetate species and see the effect of this
increase in concentration on the chemical diagram.

Starting the Simulation

1. Copy the Lanthanum/Phosphate chemical diagram calculated in the Example 37: La(C2H302)3 — KsPO4

Chemical Diagram, and paste it under the Chemical Diagrams stream.
2. Change the name to Lanthanum HTHP using the <F2> key

Change the temperature to 200 °C and the pressure to 25 atmospheres

For Help, press F1

¢ 0Ll Studio - [Chemical Diagrams.oad*] — O e
B File Edit Streams Calculations Chemistry Tools View Window Help - 8 X
he A 11 vaSol2 Red m=3lfd e | MER S PRE N
Mavigator L o~ X
i [
Chemical Diagrams.oad*® |
& Streams &/ Description Definition Chemical Diagram Report
() P 9 P
- #& Chemical Diagrams T i
; : e of diagram
[ Lanthanum/Phosphate u Variable Value i d
= Stream Parameters Species ve. Species Specs...
Stream Amount (mol) 55.7082
Temperature (*C} 200.000 Calculate 48
Preszure (atm) 25.0000
Summary
e Calculation Parameters
Use Single Titrant | Mo ﬂ Unit Set: Metric (moles)
pH Acid Titrant HNO3
- Automatic Chemistry Model
il FEER LT NaOH Agueous (H+ ion) Databanks:
& Inflows {mol) Agueous (H+ ion)
H20 555082 Using K-fit Polynomials
T-zpan: 25.0 - 225.0
La[C2H302]3 0.100000 Pspan: 1.0 - 1500.0
= K3PO4 0.100000
Actions I
R HHO3 0.0 Stability diagram: La[CZH302]3 vs pH
Actions -
NaOH 0.0 Auto-selected titrants
Acid: HNO3
Base: HaOH
Range on La[C2H302]3:
1.00000e-14 to 1.00000 mol
Range on pH:
0.0 to 14.0000
Subsystems
Flot Template Manager L o+ X Lanthanum
Calculation not done
Input
Advanced Search Add as Stream Export
Save
x ~ - ~
,||Calculation Complete!
v
o
@ NUM

6. We are ready to perform the calculation. Click on the Calculate button or press the <F9> key

7. ltis time to save your file (File >Save as...) or using the save icon in the tool bar.
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Anaylyzing the Results

Click on the Chemical Diagram tab ( Wl Chemical Diagram ). This figure shows the stability diagram for
La(C2H302)3 and K3PO4 over a range of pH values at 200°C and 25 atm. Under these conditions, there is a
decrease in the pH range over which LaPO4 is the stable product. This is because as temperature increases,
the insoluble rare earth hydroxides [RE(OH)3] become more stable. The aqueous area of the single-phase
increases at elevated temperatures due to the increased solubility of the different species. Again, at high pH

values, only La(OH)3 will form.
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Corrosion Analyzer is a module within the OLI Studio. A separate license enables this module. Corrosion
Analyzer is first-principles corrosion prediction tool. As in Stream Analyzer, for all calculations we will create
one or more objects, referred to as a Streams, which are used to define a particular chemistry, temperature
and pressure.

There are two different types of calculations that can be carried out in Corrosion Analyzer: Corrosion Rates and
Stability Diagrams. A brief definition of each type of calculation is given below.

as a function of T, P and solution composition. With this tool you can draw
conclusions about the ranges of immunity to corrosion, possible passivation and
dissolution of metals in the presence of species that promote or inhibit corrosion.

E Stability Diagram is used to predict the stability of metals, metal ions, oxides, etc.

Corrosion Rates is used to predict the general corrosion rate, the propensity for

localized corrosion (pitting or crevice corrosion) to occur, polarization curves, and

heat treatment effects of metallic materials at one specific equilibrium state. The

Add Corrosion Rates effects of temperature, pressure, pH, concentration of species, and velocity on
corrosion are also included.

In this chapter several examples will be provided to cover these calculation types.
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Section 7. Stability Diagrams

In this section you are going to learn how to set up a Stability Diagram and how to interpret the results when
using this tool.

¢ 0Ll Studic - [Document1*] - O X
®7 File Edit Streams Calculations Chemistry Tools View Window Help - 8 X
DSE| & 080 2R | hvasetz Ret melfsias | MBS G FE W
Mavigator L o~ X
| | B
Document1® |
&% Streams Description Definition i Stability Diagram (& Report
- Stream T i di
— 5 e of diagram
IE Stability Diagram I Variable | Value A e g
= Stream Parameters Specs...
Stream Amount (mol) 55.5082 Pourbaix Diagram
Temperature (*C) 25.0000 X X
Potential vs. Species
Pressure (atm) 1.00000 g
e Calculation Parameters
Use Single Titrant No Unit Set: Metric (moles)
pH Acid Titrant HCL
Autematic Chemistry Model
Tl FEER e NACH Agqueous (H+ ion) Databanks:
= Inflows (mol) Corrosion (AQ)
H20 55.5082 Agqueous (H+ ion)
Redox selected
Using K-fit Polynomials
|Acﬁon5 L o x = Contact Surface T-span: 25.0 - 225.0
AT P-span: 1.0 - 1500.0
5 Stability diagram: Evs pH
User-selected titrants
Enter the contact surface for this
calculation in the contact surface
section of the grid.
Alloy Activity Module:
Activated
Calculation not done
|Plot Template Manager L - x
v
Input
Advanced Search Add as Stream Export
Save
For Help, press F1 @ NUM |
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7.1. How to Interpret a Stability Diagram

A Stability Diagram also known as Pourbaix Diagram or simply Potential vs pH diagram, maps out the possible
stable species in an aqueous environment at different pH and potential combinations. This diagram, however,
does not provide information of reaction rates or kinetic effects.

A schematic representation of the Pourbaix diagram for copper in water at 25 °C and 1 atm is shown in the
image below.

The gray color represents the immune to
T ' corrosion region. It is the stability field of the
elemental metal. Cu is the base metal in the
above plot.
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0 - Wat . uO{s}
O+ 4 b4z " “ater Oxidation Line The green color represents the range of

possible passivation. It is the stability field
of a sparingly soluble compound (usually an
oxide or hydroxide or salt). This compound
will form a layer on the surface of the metal,
which may protect the metal from corrosion.
Having determined that a layer is formed, it
is necessary to verify whether it is
protective or not because this depends on
the crystalline structure of the sparingly
2g soluble compound. In the above plot, the

0 40 &0 80 100 20 green area contains CuO and Cuz20 as the

H
Acidic P Basic solid phases produced by oxidation of Cu.

0.5+ O 4217 T Ne|

E (SHE)

The light-yellow color represents the corrosion region. It is the stability field(s) of dissolved (ionic or neutral)
metal species in which neither the metal nor passivating solids are stable. In the plot above, Cu?* is the ionic
species that is the most stable.

The diagonal dashed lines, represented by the letters a and b are the water reduction and water oxidation lines,
respectively.

Below the water reduction line (a): Water decomposes to form Hz gas. Above the water oxidation line (b): Water
decomposes to form Oz gas. The region within these lines (a and b) is called the stability region of water.

The lines that divide different species in the Pourbaix diagram show the equilibrium conditions. These lines
represent the equilibrium for chemical and electrochemical reactions.

Finally, as a reference, the values of the Natural pH and the Oxidation Reduction Potential (ORP) are
superimposed on the diagram. The natural pH line of the water sample is the water’'s computed pH before it is
adjusted using with acid or base to create the diagram. The ORP is represented by the red circle and indicates
the initial electrochemical potential of the water phase. This is the value before the potential is adjusted using
a potentiostat, for example.
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7.2. How to determine if corrosion in the absence of oxygen is possible?
In the absence of oxygen, the most common reduction reaction is the reduction of the proton to elemental
hydrogen (as shown by line a in the plot below). Depending of the pH that reactions that can occur are the
following:

Acidic: H* +2é - H,

Basic: 2H,0 + 2é - H, + OH™

For a corrosion process to proceed, the line a must lie above a line that corresponds to an equilibrium between
the metal and metal-containing ions.

In oxygen-containing solutions, O, can be reduced to H,O (as shown by line b). Depending of the pH that
reactions that can occur are the following:

Acidic: 0, + 4H* + 46— H,0
Basic: 0, + 2H,0 + 46— 40H"

For a corrosion process to occur, the line b must lie above a line that corresponds to an equilibrium between
the metal and metal-containing ions.

Passivation is likely if b lies above a line that corresponds to an equilibrium between the metal and a sparingly
soluble compound.
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Stability diagram for Copper in Water at 25°C and 1 atm

236



7.3.
Example 40: Pourbaix Diagram of Fe-H20 System

Building a Pourbaix Diagram

After completing this example, you will learn how to set up a Pourbaix Diagram using the Stability Diagram
tool.

Starting the Simulation

¥y

To start the software, double-click the OLI Studio icon on the desktop, which will take you to the OLI e
Studio interface where you can start creating your calculations. Tos

Use the inputs and parameters from the table below to create the stream’s composition. Certain inputs, such
as the name style, units, etc. will require further adjustments, and will be described as necessary.

Stability Diagram Calculation

Calculation Settings Stream Composition and Conditions
Stream Name Fe-H20 System Stream Amount Calculated
Name Style Display Formula Temperature 25°C
Unit Set Metric, Batch, Moles Pressure 1 atm
Framework AQ pH Range 2-12
Calculation Type Stability Diagram H20 55.5082 moles
Contact Surface Fe

Add a new Stream

Click on the new Stream and press <F2> to change the name to Fe-H20 System

Select the AQ thermodynamic Framework

Click on the Names Manager Icon and select the Formula option

Click on the Units Manager Icon, and select Metric, Batch, Moles

Enter the composition, temperature and pressure of the stream given in the table above

Go to the Add Calculation button and select Stability Diagram calculation or by selecting the Chemical
Diagram icon in the Actions Pane.

No ok~ ON =

¢ OU Studic - [Stability Diagrams.oad*] - m} =
B File Edit Streams Calculations Chemistry Tools View Window Help - 8 %
O 7K |11 VaSol? Red med (3 s | Mgms O B
MNavigator L o+ X N
Documenti* |
Stability Diagrams.oad* | Description Definition [ Report
b“ Streams - -
- Fe-H20 System J ‘Variable Value - ifdd Calculation: =
& Stream Parameters .
S Single Point
Stream Amount (mely 55.5082
Temperature (C) 25,0000 SLEEY
Pressure (atm) 1.00000 . Chemical Diagram
ummary
= Inflows (mol) 4' Stability Diagram
Hzo 55.5082 Uit Set Corrosion Rates
Auvtomatic Chemistry Medel
Aqueous (H+ ion) Databanks:
Aqueous (H+ ion)
Actions e X Using K-fit Polynomials
: T-span: 25.0 - 225.0
HETE P-span: 1.0 - 1500.0
@Add Stream
Add Mixer >
[£] Add Single Paint
) Add Survey
B) Add Cherical Diagram
=] Add Stability Diagram
B] Add Corrosion Rates
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8. Select Pourbaix Diagram as Type of Survey — Default

9. Click on the new Stability Diagram and press <F2> to change the name to Fe-H20 Pourbaix Diagram

Note: Notice that two new sections appear in the Definition tab: Calculation Parameters and Contact
Surface grids. Additionally, the Redox button is turned ON.

In the Calculation Parameters grid is where the pH titrants need to be defined. These default pH titrants

selected by default are HCI and NaOH. You have the option to change the default titrants to your preferred

titrants.

In the Contact Surface grid is where the metal or alloy of interest needs to be defined. E.g. Fe, Cu, carbon

steel, etc.

The Redox button (Re) is turned ON for this calculation since reduction and oxidation reactions are need

it to create the Pourbaix Diagram. This option will enable the different oxidation states of the selected metal.

{) Ol Studic - [Stability Diagrams.oad*] - m] *
B File Edit Streams Calculations Chemistry Tools View Window Help - & %
== - BN | 1 Vasol2 |Red me 3l e | ME: S RE N
Navigator - X
g + B
Document1* |
Stability Diagrams.oad* | Description Definition (il Stability Diagram [ Report
65‘ Streams Type of diagram
-# Fe-H20 System J Variable Value ~ =t
"|A Fe-H20 Pourbaix oo =2 Stream Parameters Pourbaix Diagram = Specs...
Stream Amount (maol) 55.5082
Temperature ("Ch 25.0000 Calculate &
Pressure (atm) 1.00000
= Summary
[~ Calculation Parameters
Use Single Titrant No Unit Set: Metric (moles)
pH Acid Titrant HCL
" Auvtomatic Chemistry Model
BB NaoH Agueous (H+ion) Databanks:
= Inflows (maol) Corrosion (AQ)
Actions o+ x Hz20 555082 Aqueous (H+ ion)
3 Redox selected
RERTE S Using K-fit Polynormials
= Contact Surface T-span: 25.0 - 225.0
P-span: 1.0 - 1500.0
Stability diagram: Evs pH
User-selected titrants
Enter the ceontact surface for this
calculation in the contact surface
section of the grid.
Alloy Activity Medule:
Plot Template Manager L o+ X Activated
Calculation not done
v
Input
Advanced Search Add as Stream Export
Save

Cat - X

For Help, press F1

@8

MNUM
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10. Leave the default titrants for this calculation: HCl and NaOH
11. Under the Contact Surface grid type Fe

Note: You also have the option to use the drop-down arrow to search for the metal or alloy of interest.

{) 0L Studioc - [Stability Diagrams.cad*] - m] >
W File Edit Streams Calculations Chemistry Tools View Window Help - 8 X
DESHE|[48E & 2K | s Res (msfsias | ME: & FE |
| Navigator L o+ x
=
Document1® =
Stability Diagrams.oad* Description @ Definition (i Stability Diagram [ Report
0‘5 Streams e | Val Type of diagram
=& Fe-H20 System arial alue A e
L.|® Fe-H20 Pourbaix Diagram = Stream Parameters Pourbaiz Diagam v | | Specs..
Stream Amount (mol) 55.5082
Temperature (*C} 25.0000 Calculate @ |
Pressure (atm) 1.00000
Summary
~ Calculation Parameters
Use Single Titrant No Unit Set: Metric (moles)
pH Acid Titrant HCL
Automatic Chemistry Model
plEssc N NAOH Aqueous (H+ion) Databanks:
= Inflows (mol) Corrosion (AQ)
| Actions L ax H20 | 555082 Agqueous (H+ ion)
= Redox selected
Actions | Using K-fit Polynomials
= Contact Surface T-span: 25.0 - 225.0
Fe jl P-span: 1.0 - 1500.0
Display Name OLI Name & Stabilty diagran Evs pH
OLIF2 F2 User-selected fitrants
~E2 F2 Enter th_e cc_]rrlaclsurface for this
calculation in the contact surface
L Fe FEEL section of the grid.
OLIFEEL FEEL
" Flowers of sulphur SULFUREL i .
L, Alloy Actvity Module:
Plot Template Manager L - x $HFlarine F2 Activated
G tion not dene
v
Input
Advanced Search Add as Stream Export
Save
H ~
3
2
('_l; v
For Help, press F1 @ NUM
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At this point all the basic inputs to create a Pourbaix Diagram have been defined. Notice that in the summary
box the following default plotting settings have been defined: Potential range: -2 to 2 V vs SHE and pH range:
0-14. You can modify these default values before running the calculation.

¢ 0Ll Studio - [Stability Diagrams.oad™] — [m] X
B File Edit Streams Calculations Chemistry Tools View Window Help - & x
L + 2@ TN 1vasol2 Red |me s s fE: S BRI A
Navigator gL & x
B
Documentt |
Stability Diagrams.oad* | | < Description [&¥ Definition il Stability Diagram (& Report
A“ strezms - Type of diagram
Fe-H20 System J Variable Value
[A Fe-H20 Pourbaix Diagram ~ Stream Parameters Pourbaix Diagram = | | Specs...
Stream Amount (mol) 55.5082
Temperature (*C) 25.0000 Calculate &
Pressure (atm) 1.00000
Surnmary
w7 Calculation Parameters
Use Single Titrant Ho Unit Set: Metric (moles)
pH Acid Titrant HCI
Automatic Chemistry Model
il BRI NaOH Aqueous (H+ ion) Databanks:
< Inflows (mol) Corrosion (AQ)
Hzo 555082 Agueous (H+ion)
Redox selected
HCl 0o Using K-fit Polynomials
NaOH 0.0 T-span: 25.0 - 225.0
Fe ‘ 0.0 P-zpan: 1.0 - 1500.0
Actions L X
Actions > Stability diagram: E vs pH
= (ETUEA SR (] User-selected tirants
Fe Acid: HCI
Base: NaOH
Range on E:
-2.00000 to 2.00000 W (SHE)
Range on pH
0.0 to 12.0000
Subsystems
Iren
Plot Template Manager L - X Water
Alloy Activity Medule:
Activated
Calculation not done
Input
Advanced Search Add as Stream Export
Save
For Help, press F1 @ NUM
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15.
16.

17.
18.
19.

Click on the Specs button. This will open the Stability Diagram Options Window

Under the Display Category you will see the Display Choices tab. Under this tab make sure to select the

following options:
i. No Aqueous lines
ii. Show natural pH
ii.  Show ORP

Under Display Subsystems check the Iron and Water boxes

Under Shading select the option Shade Subsystem and select Iron.

Click OK to close the window

& O Stacio - (tabilty Dingrame.cne

m' File Edit Streams Calculations Chemistry

L1 Va So L2 |Re &

Tools View Window Help

LR A

i 5+

% 3 o A

bDe 7N
MNavigator gL X
Document1*

Stability Diagrams oad*
0.‘ Streams

=]

Description ¥ Definition il Stability Diagram [ Report

= Typpe of diagram
- Fe-H20 System J Variable Value ~ .
{.JA Fe-H20 Pourbaix Diagram & Stream Parameters Pourbaix Diagram
Stream Amount (mol) 55.5082
Temperature (*C) 25,0000 Calculate &g
| Pressure (atm) 1.00000
| Summary
! = Calculation Parameters
Use Single Titrant Mo Unit Set: Metric (moles)
Stability Options X ftomatic Chemistry Model
Rquecus (H+ion) Databanks:
Category Display Choices Corrosion (AQ)
. |D|s E I Aqueous (H+ion)
Actions ! N id Li i Redox selected
— | é--Axes Aqueous and Solid Lines Shading . Using K.fit Polynomials
ions £ Metal Activitg () superimpose lines (O Mo shading T-span: 25.0 - 225.0
Shade subsystem: P-span: 1.0 - 1500.0
Orodazanie:  —
OUH|Y Aqueous lines ability diagramx Evs pH
[er-selected titrants
iid: HCH
[ Show natural pH ise: NaOH
[ 5how oRP inge on E:
Display Subsystems £2.00000 to 2.00000 V (SHE)
Inge cn pH:
0.0 to 14.0000
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Plot Template Manager [Awater Jron
Sodium WWater
py Activity Medule:
Pctivated
fculation not done
Cancel Apply Help

For Help, press F1

@@
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20. Click on the Axes Category. This will show you the Plot Variables tab.

21.
22.
23.
24.
25.

Note: In the Axes Category you can modify the axes of the Pourbaix Diagram and change the default

titrants.

Stability Opticns

Y Az

Potertial R ange

Start ¥ (SHE]
End Y [SHE)

Category Plot ¥ ariables
- Display 2
Aves ¥ Az
- Metal Activity pH Range
Erd
Titrants
pH Titrants

Cancel Aoy

Help

Change the X Axis or pH range to 2-12

Leave the default values for the Y Axis of Potential Range (-2 to 2 V SHE)

Click OK to close the window

We are ready to perform the calculation. Click on the Calculate button or press the <F9> key

It is time to save your file (File >Save as...) or using the save icon in the tool bar. You can save it and

name it as Stability Diagrams.
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Analyzing the Results
Click on the Chemical Diagram tab (Ml Stability Diagram ) This tab displays the Pourbaix Diagram for the Fe-
H20 system at 25 °C and 1 atm.

20 T T T T T

E (SHE)

The obtained diagram is useful for assessing the corrosion behavior of iron in pure water.

Elemental iron (gray section) is stable from -2 to -0.6 V SHE. At a potential greater than -0.6 V SHE, Fe oxidizes
to Fe*2. If the pH is above 10, the boundary is at a lower potential for example, -0.7 V SHE at 12 pH.

The software computes that FesO4 (magnetite) is stable between a pH range of ~8.3 and 12. This is also known
as the Passive Film that protects the iron surface from active corrosion. At higher potentials, the software
computes Fe203 (hematite). Hematite is the dehydrated form of Fe(OH)s and FeOOH, two forms of rust. These
phases provide less corrosion protection the iron surface than the magnetite. These two phases are represented
in the plot by the green color.

The white sections of the plot represent the dominant iron-containing species dissolved in solution. The species
with the largest range is Fe*2. The software computes stability for this species from -0.6 V to 0.77 V SHE, at
low pH, and it is no longer stable at pH 10. Active corrosion of the iron surface is predicted if the pH is between
0 and 10. The actual corrosion rate cannot be predicted from this plot, nor can the pH of the water film (diffusion
layer) in contact with the iron surface. Therefore, the pH range of 0 to 10 is a guideline and not a direct
prediction.

The natural pH and the oxidation reduction potential (ORP) of water, which is represented by the red circle, are
showing that when placing Fe in pure water at 25 °C and 1 atm. The point at which the natural pH and the ORP
intersects (7 pH, 0.4 V SHE) indicates that Fe203 (hematite) is the most stable species that forms.

Additionally, notice that the oxidation of iron can be coupled with the reduction of water because water reduction

line (line a) lies above the lines that represent the oxidation of iron. Therefore, corrosion of iron can occur with
the evolution of hydrogen and formation of soluble iron-containing ions e.g. Fe?*.
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7.4. Selective Oxidation and Reduction Chemistry

Occasionally you may want to remove a specific oxidation state for an element when building a Stability
Diagram. There are a variety of reasons to perform such an activity, one being that a specific oxidation state
may be kinetically unavailable for the reaction. Another case is that perhaps you need to compare and contrast
two systems. We will explore how to do this in the following example.

Example 41: Turning off the Fe*® oxidation state in the Stability Diagram

In this example you will create a Stability diagram for iron in water at ambient conditions (see previous example
for details on how to create this stream), learn how to change the default titrants and turn off/on different specific
oxidation states of the metal of interest.

Starting the Simulation

Use the inputs and parameters from the table below to create the stream’s composition. Certain inputs, such
as the name style, units, etc. will require further adjustments, and will be described as necessary.

Stability Diagram Calculation

Calculation Settings Stream Composition and Conditions
Stream Name Fe-H20 System Stream Amount Calculated
Name Style Display Formula Temperature 25°C
Unit Set Metric, Batch, Moles Pressure 1 atm
Framework AQ pH Range 0-14 (Default)
Calculation Type Stability Diagram H20 55.5082 moles
Contact Surface Fe H2S04 0 moles

NaOH 0 moles

1. Under the Fe-H20 System add a new Stability Diagram calculation. Go to the Add Calculation button and
select Stability Diagram calculation or by selecting the Chemical Diagram icon in the Actions Pane.
Select the AQ thermodynamic Framework

Click on the Names Manager Icon and select the Formula option

Click on the Units Manager Icon, and select Metric, Batch, Moles

Enter the composition, temperature and pressure of the stream given in the table above. Add H2SO4 and
NaOH as inflows. Note: H2SO4 and NaOH will be used as titrants to adjust pH

Select Pourbaix Diagram as Type of Survey — Default

Click on the new Stability Diagram and press <F2> to change the name to Fe-H20 Selective Oxidation

8. Under the Contact Surface grid type Fe

ar~wbd

N o

Changing the Default Titrant
9. In the Calculation Parameters grid, click on HCI (which is default titrant). A drop-down arrow appears,
click on it and select H2SO4. NaOH has been selected by default.

= Calculation Parameters
Use Single Titrant
pH Acid Titrant
pH Base Titrant
=
H20
H2304
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Note: You can also change the default titrant using the Specs button

1. Click on the Specs button

2. Select the Axes option under the Category window
3. Click on pH Titrants. This will open a new window
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.“ Streams = Type of diagram
-8 FeH20 System Variable ‘ Value A
@ Fe-H20 Pourbaix Diagram = Stream Parameters Fourbaix Diagram
" B Fe-H20 Selective Oxidation Stream Amount (mol} ‘ 55.5082 g 1)
Stability Options 7 X B @
Categary Plot Wariables
.... Dipl
. ¥ divis ¥ s
- Metal &ctivity pH Range Potential Range lode!
e D Stat Y [SHE) gabanks:
vere
s
Titrarts 0
o
= —
Actions H
W/ (SHE)
| Plot Template Manager L =
Cancel Apply Help
. : T
Input
5 Advanced Search Add az Steam Export
ave
For Help, press F1 @ NUM

¥

4. Select H2S04 as the Acid titrant, and NaOH as the Base titrant. Then click OK to exit both windows.

MaOH

Select Titrants ? *
Titrants
Hide Related Inflows New Irflow
Acid Base
Fe Fe
H20 H20
H2504

'Select the acid and the base which will be used to vary the pH.

Cancel Apphy Help
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The screen should look like the image below after all the inputs and definitions have been entered:

¢ 0L Studio - [Stability Diagrams.oad®] - O *
B File Edit Streams Calculations Chemistry Tools View Window Help - 8 %
= =] TR | 11vasol2 | Res |m:s{swes | fE:r G EE N
Navigator L o~ X
=
Document1 B

Stability Diagrams oad*
0.‘ Streams

Description &¥ Definition i Stability Diagram [B] Report C# File Viewer

5 & Fe-H20 System B Variable Value A~ Type of diagram
@ Fe-H20 Pourbaix Diagram - Stream Parameters Pouwrbaix Diagram =~ = Specs...
LB Fe-H20 Selective Oxidation RGO ] FTE
Temperature (*C) 25.0000 Calculate 4G
Pressure (atm) 1.00000
Summary
e Calculation Parameters
Use Single Titrant Ho Unit Set: Metric (moles)
pH Acid Titrant [ HZ504 |
pH Base Titrant NACH Au?omatlc Cr.lemlstry Model B
Agueous (H+ ion) Databanks:
= Inflows (mol) Corrosion (AQ)
HzO 55,5082 Agueous (H+ien})
Redox selected
Has04 oo Using K-fit Polynomials
Fe 0.0 T-span: 25.0 - 225.0
P-span: 1.0 - 1500.0
GELLS b o8 = Contact Surface (mol) "
Actions F +| | Stability diagram: E vs pH
e Auto-selected titrants.
Acid: H2504
Base:
Range on E:
-2.00000 to 2.00000 WV (SHE)
Range on pH
0.0 to 14.0000
Subsystems
Iren
Plot Template Manager L ax Water
Alloy Activity Module:
Activated
W Calculation not done
Input
5 Advanced Seaich Add 3 Stream Export
ave
For Help, press F1 & MNUM

10. We are ready to perform the calculation. Click on the Calculate button or press the <F9> key
11. ltis time to save your file (File >Save as...) or using the save icon in the tool bar. You can save it under
the same file created in the previous example named Stability Diagrams.
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Analyzing the Results
Click on the Chemical Diagram tab (Ml Stability Diagram ) This tab displays the Pourbaix Diagram for the Fe-

H20 system at 25 °C and 1 atm.

E (SHE)

24

pH

Marcell Pourbaix did not consider the FeQ4% ion in his work. This is iron in the +6 oxidation state for which there
was little thermodynamic data available in the1960s. To reproduce his work, we need to remove the redox

subsystem that pertains to Fe(+6).

Selective Redox, removing an undesired oxidation state

1. In the Menu bar go to Chemistry > Model Options. This will open a new window

@ OLI Studic - [Stability Diagrams.oad™]

T,

W7 File Edit Streams Calculations | Chemistry Tools View Win

DEH| BE SN  PeniMos > Erifsler EL | EE |

Jow Help

- & x

>

I 1

6‘. Strearns

=-# Fe-H20 System

|’ Fe-H20 Pourbaix Diagram
.. Fe-H20 Selective Oxidation

Actions

Documentt
Stability Diagrams.oad® _Ieﬁnitinn Blll Stability Diagram [ Report L3 File Viewer

II].IJZITT pH. 1.647 ¥ [SHE]

E (SHE)

2.0
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2. Select the Redox tab, expand the Iron Subsystems by clicking on the ‘+’ icon, and uncheck the Fe(+6)
oxidation state. Note that if you have an inflow component with this oxidation state it will remain in the

calculation. Click the OK button to save your changes and close the window.

Fe-H20 Selective Oxidation Chemistry Model Options ? X

Databanks Phases T/P Span

] Include Redox Chemistry
Include Subsystems

D Sulfur

Lok |l Concel [ ek || Hee |

12. We are ready to recalculate to consider the changes. Press the <F9> key or go to the Definition tab and

click on the Calculate button.

Analyzing the Results

Click on the Chemical Diagram tab (ﬂ Stability Diagram ) |n the figure below, you can see that the region
dominated by the FeQ4? ion is not present.

20

E (SHE)
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7.5.

Modeling the Effects of Hydrogen Sulfide on Corrosion

Example 42: The Effect of Hydrogen Sulfide on the Corrosion of Iron

The H2S (S2) forms a relatively insoluble precipitate with Fe*2. This precipitate has the potential to cover the
metal surface and enhance the pH region where iron is protected from the water. We will model this using the
Stability Diagram tool.

Starting the Simulation

Use the inputs and parameters from the table below to create the stream’s composition. Certain inputs, such
as the name style, units, etc. will require further adjustments, and will be described as necessary.

Stability Diagram Calculation

Calculation Settings Stream Composition and Conditions
Stream Name Fe-H20 System Stream Amount Calculated
Name Style Display Formula Temperature 25°C
Unit Set Metric, Batch, Moles Pressure 1 atm
Framework AQ pH Range 0-14 (Default)
Calculation Type Stability Diagram H20 55.5082 moles
Contact Surface Fe H2S 1e-4 moles

aorwbd

No

of H2S as an inflow.

Select Pourbaix Diagram as Type of Survey — Default
Click on the new Stability Diagram and press <F2> to change the name to Fe-H20-H2S System
Under the Contact Surface grid type Fe

The screen should look like the image below after all the inputs and definitions have been entered:

el | + 2@
Navigator L
Documentt

B File Edit Streams Calculations Chemistry Tools

0 OLI Studic - [Stability Diagrams.oad*]

x

Stability Diagrams. oad*

65‘ Streams

=& Fe-H20 System
.. [ Fe-H20 Pourbaix Diagram
.| Fe-H20 Selective Oxidation
[A Fe-H20-H25 System

Pressure (atm)
=

Use Single Titrant

pH Acid Titrant

pH Base Titrant
=

H20

HZS

Fe

Actions

Actions gL =

1.00000
Calculation Parameters
No
HCL
NAOH
Inflows {mol)

55.5082
1.00000e-4
[ 0.0

Contact Surface (mol)

- O X
View Window Help - & x
BN | L1vasol2 Ret |meaiTs s MEL RIS
il
& Description [&¥ Definition {ll| Stability Diagram (@ Report 22 File Viewer
J Variable Value ~ Type of diagiam
= Stream Parameters Pourbaix Diagram = Specs...
Stream Amount (maol) 555083 |
Temperature (*C) 25.0000 Calculate  &@

Summary

Unit Set: Metric (moles)

Automatic Chemistry Model

Agqueous (H+ ien) Databanks
Corresion (AQ)
Agqueous (H+ion

Redox selected

Using K-fit Pelynomials
T-span: 25.0 - 225.0
P-span: 1.0 - 1500.0

Stability diagram: E vs pH
Auto-selected titrants
Acid:

.....

Under the Fe-H20 System add a new Stability Diagram calculation. Go to the Add Calculation button and
select Stability Diagram calculation or by selecting the Chemical Diagram icon in the Actions Pane.

Select the AQ thermodynamic Framework
Click on the Names Manager Icon and select the Formula option
Click on the Units Manager Icon, and select Metric, Batch, Moles
Enter the composition, temperature and pressure of the stream given in the table above. Add 1e-4 moles
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Note: By default, only the transition metals are turned ON. The different oxidation states of elements that are
not transition metals are not turned on automatically. You need to turn them ON manually.

9. Go to the Redox button (Re), and click on the drop-down arrow
10. Select Sulfur. This will turn the oxidation states of sulfur ON

0 OLI Studico - [Stability Diagrams.oad™]

File Edit Streams Calculations Chemistry Tools View Window Help

DSH| % BB & %K | 1vasl2

Re s me & 5 s

| Navigator

g ax]

Document1

=

Stability Diagrams. oad®

b“ Streams
= & Fe-H20 System

a!|

e

¢

s G EE A

- 8 x

. Iron
= Sulfur
Descriptju

Stability Diagram @ Report Q File Viewer

Variable

Value

= Type of diagram

[ Fe-H2Q Pourbaix Diagram =

Stream Parameters

Powbaix Diagram = Specs

[B Fe-H20 Selective Oxidation Stream Amount (mol)

55.5083

|8 Fe-H20-H25 System Temperature (°C)

25.0000

Calculate &8 |

Pressure (atm)

1.00000

=

Calculation Parameters

Summary

Use Single Titrant

No

Unit Set: Metric (moles)

pH Acid Titrant

HCL

pH Base Titrant

NACOH

Automatic Chemistry Model
Agueous (H+ ion) Databanks:

=

Inflows

{mol)

Corrosion (AQ)

HZ0

55.5082 Agueous (H+ion)

H23

Redox selected

1.00000e-4 Using K-fit Polynomials

Fe

0.0 T-span: 25.0 - 225.0

P-gpan: 1.0 - 1500.0

11. We are ready to perform the calculation. Click on the Calculate button or press the <F9> key
12. It is time to save your file (File >Save as...) or using the save icon in the tool bar. You can save it under
the same file created in the previous example named Stability Diagrams.

Analyzing the Results

Click on the Chemical Diagram tab (ﬂ Stability Diagram ) Thjs tab displays the Pourbaix Diagram for the Fe-
H20-H2S system at 25 °C and 1 atm.

Inspection of the diagram reveals a profound effect of H2S on the corrosion of iron. New stability fields of FeS

20

05

E (SHE)

T FeCT, T

1 FelOH)ag)
EeOyfs}

and FeS:2 are observed. Elemental iron is
found to be in equilibrium with FeS over for
pH values ranging from ca. 6.0 to 12.5.

Since the Fe/FeS equilibrium line lies
below the H* reduction line (a), a process
consisting of the reduction of H* to H® and
oxidation of Fe to FeS is likely to occur in
de-aerated environments. FeS forms a
passive film and offers some protection
against corrosion.

In fact, the protection due to the formation
of FeS is possible over a much wider pH
range than that due to the formation of
FesO4 (magnetite) in the absence of H2S.
This has important implications for
corrosion in refinery installations, where
H2S is frequently present.
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7.6.

Example 43: High Temperature Iron in Water

Starting the Simulation

Modeling Corrosion at High Temperature

Use the inputs and parameters from the table below to create the stream’s composition. Certain inputs, such
as the name style, units, etc. will require further adjustments, and will be described as necessary.

Stability Diagram Calculation

Calculation Settings Stream Composition and Conditions
Stream Name Fe-H20 System Stream Amount Calculated
Name Style Display Formula Temperature 300 °C
Unit Set Metric, Batch, Moles Pressure 150 atm
Framework AQ pH Range 0-14 (Default)
Calculation Type Stability Diagram H20 55.5082 moles
Contact Surface Fe

1. Under the Fe-H20 System add a new Stability Diagram calculation. Go to the Add Calculation button and
select Stability Diagram calculation or by selecting the Chemical Diagram icon in the Actions Pane.
Select the AQ thermodynamic Framework

Click on the Names Manager Icon and select the Formula option

Click on the Units Manager Icon, and select Metric, Batch, Moles

Enter the composition, temperature and pressure of the stream given in the table above

Select Pourbaix Diagram as Type of Survey — Default

Click on the new Stability Diagram and press <F2> to change the name to Fe-H20 High T

Under the Contact Surface grid type Fe

S S i

The screen should look like the image below after all the inputs and definitions have been entered:

¢ OUl Studic - [Stability Diagrams.oad*] - m] =
B File Edit Streams Calculations Chemistry Tools View Window Help -5 X
== BN | 1 vasol2 | Red medUE 8 o | B | G BRE A
MNavigator gL =X
=
Documentt | B
Stability Diagrams.oad* | Description Definition ({lj Stability Diagram [E Report 3 File Viewer
6“ Streams = Type of diagram
S-& Fe-HI0 Systern J Variable Value - —
@ Fe-H20 Pourbaix Diagram = Stream Parameters Pourbaix Diagram = Specs..
H [ Fe-H20 Selective Oxidation Stream Amount (mal} 585082
[ Fe-H20-H25 System Temperature (*C) 300.000 Calculate &
@, Fe-H20 High T Pressure (atm) 150.000 S
= Calculation Parameters
Use Single Titrant Unit Set: Metric (moles)
pH Acid Titrant HCI
" Automatic Chemistry Model
il BRI NaoH Aqueous (H+ ion) Databanks:
e Inflows (mol) Corrosion (AQ)
H20 £5.5082 Agueous (H+ ion)
Redox selected
HCt 0.0 Using K-fit Polynomials
NaOH 0.0 T-gpan: 25.0 - 225.0
Fe 0.0 P-span: 1.0 - 1500.0
Actions L s X
Actions 5 Stability diagram: E vs pH
| = Contact Surface (mol) User-selected ttrants
Fe Acid: HCI
Base: NaOH

9. We are ready to perform the calculation. Click on the Calculate button or press the <F9> key
10. It is time to save your file (File >Save as...) or using the save icon in the tool bar. You can save it under

the same file created in the previous example named Stability Diagrams.
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Analyzing the Results
Click on the Chemical Diagram tab (Ml Stability Diagram ) Thjs tab displays the Pourbaix Diagram for the Fe-

H20 system at 300 °C and 150 atm.

20 T T

E (SHE)

14.0

20 4.0 6.0

pH

We can see from the diagram above that passivation is only possible at moderate pH’s.
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Example 44: Neutralization of Refinery Streams with Alkanolamines

In this example you will create a stability diagram for alkaline neutralization in an oil refinery.

Starting the Simulation

Use the inputs and parameters from the table below to create the stream’s composition. Certain inputs, such

as the name style, units, etc. will require further adjustments, and will be described as necessary.

Stability Diagram Calculation

Calculation Settings Stream Composition and Conditions
Stream Name Fe-H20 System Stream Amount Calculated
Name Style Display Formula Temperature 50 °C
Unit Set Metric, Batch, Moles Pressure 1 atm
Framework AQ pH Range 0-14 (Default)
Calculation Type Stability Diagram H20 55.5082 moles
Contact Surface Fe HCI 0 moles (Acid Titrant)
DEA?® 0 moles (Base Titrant)
C8H18 2E-07 moles
C7H16 8E-07 moles
C3H8 1.2E-04 moles
C4H10 2E-05 moles
C5H12 7E-6 moles
C6H14 2E-6 moles
H2S 0.01 moles

= © © N o o bk~ 0D

Under the Fe-H20 System add a new Stability Diagram calculation. Go to the Add Calculation button and
select Stability Diagram calculation or by selecting the Chemical Diagram icon in the Actions Pane
Select the AQ thermodynamic Framework

Click on the Names Manager Icon and select the Formula option

Click on the Units Manager Icon, and select Metric, Batch, Moles

Enter the composition, temperature and pressure of the stream given in the table above

Select Pourbaix Diagram as Type of Survey — Default

Click on the new Stability Diagram and press <F2> to change the name to Fe-H20-Alkanoamines

Under the Contact Surface grid type Fe

Change the Base Titrant to DEA

. Turn Redox ON for Sulfur. Click on the drop-down arrow next to the Re button and select Sulfur

Note: You can also enable Redox reactions via the menu bar: Chemistry > Model Options > Redox tab.

Make sure that Sulfur is checked.

9 The “ESP” name for this species is DEXH, which can be used as an input to make your life easier. The formula name is: HN(C2H40H)2
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The screen should look like the image below after all the inputs and definitions have been entered:

¢ 0Ll Studio - [Stability Diagrams.oad*] — O e
W7 File Edit Streams Calculations Chemistry Tools View Window Help - 8 X
w=2=] 2R uvasdiz[res[m et s | MBS G FE |
[Navigator + + x| Chlorine
Documentt I ion
Stability Diagrams.oad* Sodium efinition ({{l Stability Diagram [E] Report 3 File Viewer
&b Streams }
¢ Sulfur Tupe of diagram
E-& Fe-H20 System | i A -
[ Fe-H20 Pourbaix Diagram - Stream Parameters Pourbaix Diagram Specs...
[B Fe-H20 Selective Oxidation SiEsn Ci)) i
& Fe-H20-H2S System Temperature (*C) 50.0000 Calculate &8 |
& Fe-H20 High T Pressure (atm) 1.00000 S
B Fe-H20-Alkancamines e Calculation Parameters
Use Single Titrant o Unit Set: Metric (moles)
pH Acid Titrant HCI
Automatic Chemistry Model
il SEEIET HN(C2H40H)2 Agueous (H+ ion) Databanks:
& Inflows (mol) Corrosion (AQ)
Hz0 555082 Agueous (H+ion)
Second Liguid phase
HCl 0.0 Redox selected
HN{C2H40H)2 0.0 Using K-fit Pelynomials
C8H13 2.00000e-7 T-span: 25.0 - 225.0
| Actions L o x CTHiE 20000057 P-zpan: 1.0 - 1500.0
Actions
CaHs 1.20000e-4 Stability diagram: E vs pH
n-C4H10 2.00000e-5 Auto-selected titrants
CEHIZ 7.00000e-5 Acid: HCI
Base: HN(C2ZH40H)2
C5H14 2.00000e-6
H25 0.0100000 Range on E:
NaOH ) -2.00000 to 2.00000 V' (SHE)
Range on pH:
Fe 0.0 0.0 o 14.0000
Subsystems
Plot Template Manager . X
| z g E = Contact Surface (mol) Ll;l?:ter
Fe
Alloy Activity Module:
Activated
v
Calculation not done
Input
Advanced Search Add as Stream Export
Save
@ NUM

11. We are ready to perform the calculation. Click on the Calculate button or press the <F9> key

12. It is time to save your file (File >Save as...) or using the save icon in the tool bar. You can save it under

the same file created in the previous example named Stability Diagrams.
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Analyzing the Results
Click on the Chemical Diagram tab (Ml Stability Diagram ) Thjs tab displays the Pourbaix Diagram for the Fe-

H20 system at 50 °C and 1 atm.

E (SHE)
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7.7. Modeling the Effects of Complexation on Corrosion

In this section we will simulate the reaction of Copper with Ammonia and Gold metal with Cyanide. This section
attempts to answer the question of how strong complexing agents affect the passivation of these metals.

Example 45: Copper and Ammonia
Starting the Simulation

Use the inputs and parameters from the table below to create the stream’s composition. Certain inputs, such
as the name style, units, etc. will require further adjustments, and will be described as necessary.

Stability Diagram Calculation

Calculation Settings Stream Composition and Conditions
Stream Name Cu-H20 System Stream Amount Calculated
Name Style Display Formula Temperature 25°C
Unit Set Metric, Batch, Moles Pressure 1 atm
Framework AQ pH Range 0-14 (Default)
Calculation Type Stability Diagram H20 55.5082 moles
Contact Surface Cu NH3 0 moles

Add a new Stream

Click on the new Stream and press <F2> to change the name to Cu-H20 System

Select the AQ thermodynamic Framework

Click on the Names Manager Icon and select the Formula option

Click on the Units Manager Icon, and select Metric, Batch, Moles

Enter the composition, temperature and pressure of the stream given in the table above

Under the Cu-H20 System Stream add a new Stability Diagram calculation. Go to the Add Calculation
button and select Stability Diagram calculation or by selecting the Chemical Diagram icon in the Actions
Pane

8. Select Pourbaix Diagram as Type of Survey — Default

9. Click on the new Stability Diagram and press <F2> to change the name to Cu-H20-NH3

10. Under the Contact Surface grid type Cu

Nooh~wh =

The screen should look like the image below after all the inputs and definitions have been entered:

A

» Red |mc U3 s | MEF G EE N

=
Description Definition [l Stability Diagram [& Re

J Variable Value -~
e Stream Parameters
Stream Amount (mel) 55.5082
Temperature ("C) 25.0000
Pressure (atm) 1.00000
e Calculation Parameters

Use Single Titrant
pH Acid Titrant
pH Baze Titrant

No
HCL
NAOH

= Inflows (mol)
H20 5.5082
NH3 0.0
Cu [ 0.0

wn

e Contact Surface (mol)
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13. We are ready to perform the calculation. Click on the Calculate button or press the <F9> key
14. It is time to save your file (File >Save as...) or using the save icon in the tool bar. You can save it under
the same file created in the previous example named Stability Diagrams.

Analyzing the Results

Click on the Chemical Diagram tab (lll Stability Diagram ) This tab displays the Pourbaix Diagram for the Cu-
H20 system at 25 °C and 1 atm.

20 T T

0.5

above the hydrogen a line. This means there is
insufficient oxidizing power in the water to corrode
copper metal in pure water.

- g
% - 42 . = = . .
10-0 Seeeo 2l ZuOfs} 53 Inthe absence of oxygen (looking at only the a line),
S E 3|d we can see that the copper equilibrium line lays
4

)

aar

05 What happens if Ammonia (NHz3) is added to the
solution? The next step is to understand the effect
of NHs on the stability of copper.

2% 20 4.0 6.0 8.0 10.0 12.0 14.0

pH

Effect of NH3 on the Stability of Copper
1. Go to the Definition tab, and change the amount of NH3 from 0 to 0.1 moles
2. Click on the Calculate button or press the <F9> key

Analyzing the Results

Click on the Chemical Diagram tab (I8 Stability Diagram ) This tab displays the Pourbaix Diagram for the Cu-
H20-NH3 system at 25 °C and 1 atm in a 0.1 m of NH3 solution.

20 T T

RERF
I Y CuNH;? £ = : C b
' Tl |8 3| cunny |8
s O - ' & O
05+ o TI -

I
by

Notice that a large area of corrosive liquid has
appeared in the stability field for the copper oxides.
This means that it is thermodynamically possible for
the ammonia to break down the passivation layer of
copper oxide in the presence of oxygen. Notice that
in the absence of oxygen (the a line only), copper is
still stable.
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Now repeat the exercise with 1.5 moles of NH3

1. Go to the Definition tab, and change the amount of NH3 from 0 to 1.5 moles
2. Click on the Calculate button or press the <F9> key

Analyzing the Results

Click on the Chemical Diagram tab (Wl Stability Diagram ) Thjs tab displays the Pourbaix Diagram for the Cu-
H20-NH3 system at 25 °C and 1 atm in a 1.5 m of NH3 solution.

20 T

+2
1

“oe--ocugl'
10k Cuel N CuNH;

(Cu(NH);?
{Cu(NH,)

05 ) “-r--.____§  Atthis concentration of ammonia, most, if not all the

————— ; passivating copper oxide has been reacted away.
Only at very high pH values are there any stable
oxides.

E (SHE)
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Example 46: Gold in the presence of Cyanides

Starting the Simulation

Use the inputs and parameters from the table below to create the stream’s composition. Certain inputs, such
as the name style, units, etc. will require further adjustments, and will be described as necessary.

Stability Diagram Calculation

Calculation Settings Stream Composition and Conditions
Stream Name Au-H20 System Stream Amount Calculated
Name Style Display Formula Temperature 25°C
Unit Set Metric, Batch, Moles Pressure 1 atm
Framework AQ pH Range 0-14 (Default)
Calculation Type Stability Diagram H20 55.5082 moles
Contact Surface Au NaCN 0 moles

Nookrwh =

8.

9.

Add a new Stream

Click on the new Stream and press <F2> to change the name to Au-H20 System

Select the AQ thermodynamic Framework

Click on the Names Manager Icon and select the Formula option

Click on the Units Manager Icon, and select Metric, Batch, Moles

Enter the composition, temperature and pressure of the stream given in the table above

Under the Au-H20 System Stream add a new Stability Diagram calculation. Go to the Add Calculation

button and select Stability Diagram calculation or by selecting the Chemical Diagram icon in the Actions

Pane

Select Pourbaix Diagram as Type of Survey — Default

Click on the new Stability Diagram and press <F2> to change the name to Au-H20
10. Under the Contact Surface grid type Au

The screen should look like the image below after all the inputs and definitions have been entered:

2 |Re ¥ |me * UE 4 ad | @4

14| S B &

=
Description Definition (i Stability Diagram (5 Re
| Variable Value A
T Stream Parameters
Stream Amount {mol) 55.5082
Temperature ("C) 25.0000
Pressure (atm) 1.00000
e Calculation Parameters
Use Single Titrant Mo
pH Acid Titrant HCL
pH Baze Titrant NaOH
- Inflows (mol)
Hz20 55.5082
NaCH 0.0
Au 0.0
-]
e Contact Surface (mol)
Au

11. We are ready to perform the calculation. Click on the Calculate button or press the <F9> key
12. It is time to save your file (File >Save as...) or using the save icon in the tool bar. You can save it under
the same file created in the previous example named Stability Diagrams.
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Analyzing the Results

Click on the Chemical Diagram tab (ﬂ Stability Diagram ) Thjs tab displays the Pourbaix Diagram for the Au-

H20 system at 25 °C and 1 atm.

2.0 T T

Au(

s st

0.5

H) faq}

Au(OH),

-2
E

AUu(OH)

You can see that without oxygen, gold
metal is immune to corrosion. The
hydrogen line a is below the gold
equilibrium line. In the presence of oxygen,
gold is still immune to corrosion except at
very low pH.

One of the most commonly used leaching

@ processes for gold extraction is the
w 0.0 . . . .
o cyanidation process. This process is a
hydrometallurgical technique for extracting
-0.5

2% 20 4.0

6.0
pH

8.0 10.0

120

Effect of Cyanide on the Stability of Gold

1. Go to the Definition tab, and change the amount of NaCN from 0 to 1e-4 moles
2. Click on the Calculate button or press the <F9> key

Analyzing the Results

14.0

gold from low-grade ores by converting
the gold to a water-soluble coordination
complex. Basically, this approach adds
cyanide salts to water. We are going to
simulate this using the software.

Click on the Chemical Diagram tab (il Stability Diagram ) This tab displays the Pourbaix Diagram for the Au-

H20O-NaCN system at 25 °C and 1 atm.

E (SHE)

2.0

Au(OH),{aq}

AU(CN), "+

pH

14.0

In the presence of oxygen, gold completely
corrodes with cyanide. This is primarily due
to the formation of the gold complex:
Au(CN)3. This complex is stable over all
regions where water is also stable. This
means that now gold can be processed in
water in a variety of conditions.
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7.8. Modeling the Effect of Oxidizing Inhibitors on Corrosion

In this chapter we will look at the effect of modeling corrosion inhibitors. We will do this by superimposing two
stability diagrams over one another. If one solid field overlaps the corrosion range of the other system, then

passivation is likely.

Example 47: Iron in the presence of chromates

Starting the Simulation

Use the inputs and parameters from the table below to create the stream’s composition. Certain inputs, such
as the name style, units, etc. will require further adjustments, and will be described as necessary.

Stability Diagram Calculation

Calculation Settings

Stream Composition and Conditions

Stream Name Inhibitors Stream Amount Calculated
Name Style Display Formula Temperature 25°C

Unit Set Metric, Batch, Moles Pressure 1 atm
Framework AQ pH Range 0-14 (Default)
Calculation Type Stability Diagram H20 55.5082 moles
Contact Surface Fe

Contact Surface Cr

N o g kMoo=

Add a new Stream

Click on the new Stream and press <F2> to change the name to /nhibitors

Select the AQ thermodynamic Framework

Click on the Names Manager Icon and select the Formula option

Click on the Units Manager Icon, and select Metric, Batch, Moles

Enter the composition, temperature and pressure of the stream given in the table above

Under the Inhibitors Stream add a new Stability Diagram calculation. Go to the Add Calculation button
and select Stability Diagram calculation or by selecting the Chemical Diagram icon in the Actions Pane
Select Pourbaix Diagram as Type of Survey — Default

Click on the new Stability Diagram and press <F2> to change the name to Fe-Cr-H20 Pourbaix Diagram

. Under the Contact Surface grid type Fe and then Cr

Note: Make sure that both Fe and Cr are enabled for Redox reactions. Use the arrow next to the Re button
to expand the list.

You can also enable Redox reactions via the menu bar: Chemistry > Model Options > Redox tab. Make
sure that Fe and Cr boxes are checked.
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The screen should look like the image below after all the inputs and definitions have been entered:

¢ 0Ll Studio - [Stability Diagrams.oad™] — [m] X
W File Edit Streams Calculations Chemistry Tools View Window Help - & x
DMl 4B W Lvaso[rer miEeal | MEL G EEN
[Mavigator a2 x| ~  Chromium
Stability Diagrams.oad* | B ron =
5‘ Streams TUSCITPRoT oS t ﬂ Stability Diagram @ Report Q File Viewer
=& Fe-H20 System
[ Fe-H20 Pourbaix Diagram Variable [ Value R Type of diagram
[ Fe-H20 Selective Oxidation =z e R Pourbaix Diagram = | | Specs...
I& Fe-H20-H25 System Stream Amount (mol) 55.5082
[ Fe-H20 High T Temperature ("C) 25.0000 Calculate |
* [ Fe-H20-Alkanoamines Pressure (atm) 1.00000 5
UrMmaryY
= #& Cu-H20 System - Calculation Parameters
[ Cu-H20-NH3 Use Single Titrant No Unit Set: Metric (moles)
[ Cu-H20-NH3 0.1 moles pH Acid Titrant HCL
Cu-H20-NH3 1.5 I Automatic Chemistry Model
B cu metes il SRS NAGH Aqueous (H+ ion) Databanks:
Au-H20 System - Inflows (mol) Corrosion (AQ)
[ Au-H20 Pourbaix Diagram Hz20 55.5082 Agueous (H+ion)
Au-H20-NaCN 1e-4 moles Redox selected
& ﬁ bit Fe 0o Using K-fit Polynomials
nhibitors cr 0.0 T-span: 25.0 - 225.0
B Fe-Cr-H20 Pourbaix Diagram = P-gpan: 1.0 - 1500.0
= Contact Surface (mol)
> Stability diagram: E vs pH
Fe Auto-selected tirants
Cr Acid:
Base:
| Actions g ~x
Actions Range on E:
-2.00000 to 2.00000 W (SHE)
Range on pH
0.0 to 14.0000
Subsystems
Chromium
Iren
Water
Flot Template Manager I
Alloy Activity Module:
v Activated
Calculation not done
Input
5 Advanced Search Add a3z Stream Export
ave
For Help, press F1 NUM

11. Click the Specs button and under the Display Choices tab check the following options:
a) No aqueous lines
b) Show ORP

Stability Options

Category

Anes
M etal Activity

Dizplay Choices

Agueous and Solid Lines

() superimpose lines

(®) No Agqueous lines

() only Aqueous lines

Display Subsystems

Shading
(C)No shading
(®) Shade subsystem:

Chromium

Iron

[Cchlorine
[~ Chromium

[water
[Opotassium
[Osodium

Cancel Apply

Help
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12. Click OK to close the Stability Options window
13. We are ready to perform the calculation. Click on the Calculate button or press the <F9> key
14. It is time to save your file (File >Save as...) or using the save icon in the tool bar. You can save it under

the same file created in the previous example named Stability Diagrams.

Analyzing the Results

Click on the Chemical Diagram tab (ﬂ Stability Diagram ) Thjs tab displays the Pourbaix Diagram for the Fe-
Cr-H20 system at 25 °C and 1 atm.

20

E (SHE)

80 X . 14.0

6.0
pH

As you can see in this diagram, the shaded chrome passivating solid (Cr(OH)appt) overlays the corrosive region
of the iron system. This means that there is potential for passivating the metal in that region.

The Cr(OH)s field overlaps with the corrosion range of Fe in most of the pH range. This causes inhibition
because of the coupling of: Oxidation of Fe to Fe2*, reduction of chromates to Cr(OH)s, and the deposition of a

protective layer of Cr(OH)s.
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Example 48: Iron in the presence of arsenates

Starting the Simulation

Use the inputs and parameters from the table below to create the stream’s composition. Certain inputs, such
as the name style, units, etc. will require further adjustments, and will be described as necessary.

Stability Diagram Calculation

Calculation Settings

Stream Composition and Conditions

Stream Name Inhibitors Stream Amount Calculated
Name Style Display Formula Temperature 25°C

Unit Set Metric, Batch, Moles Pressure 1 atm
Framework AQ pH Range 0-14 (Default)
Calculation Type Stability Diagram H20 55.5082 moles

Contact Surface

Fe

Contact Surface

As

1. Under the Inhibitors Stream add a new Stability Diagram calculation. Go to the Add Calculation button
and select Stability Diagram calculation or by selecting the Chemical Diagram icon in the Actions Pane

Pon

Select Pourbaix Diagram as Type of Survey — Default
Click on the new Stability Diagram and press <F2> to change the name to Fe-As-H20 Pourbaix Diagram
Under the Contact Surface grid type Fe and then As

Note: Make sure that both Fe and As are enabled for Redox reactions. Use the arrow next to the Re button

to expand the list.

You can also enable Redox reactions via the menu bar: Chemistry > Model Options > Redox tab. Make
sure that Fe and As boxes are checked.

The screen should look like the image below after all the inputs and definitions have been entered:

0 0Ll Studic - [Stability Diagrams.cad™] — [m]
g
B File Edit Streams Calculations Chemistry Tools View Window Help - &8 %
O &8 TR L1vasolz|Red |med{E 3 s MEHs G EE S
Navigator £ = x| [ Arsenic
Stability Diagrams.oad* | B ron
&: Streams TOSCITPOTT S ﬂ Stability Diagram @ Report Q File Viewer
=& Fe-H20 System .
I@ Fe-H20 Pourbaix Diagram H Variable Value @ [iostidcon
B Fe-H20 Selective Oxidation = Stream Parameters Pourbaix Diagram — + Specs
@, Fe-H20-H25 System Stream Amount (mol) 55.5082
B Fe-H20 High T Temperature (*C) 25.0000 Calculate &8
@ Fe-H20-4lkanocamines Pressure (atm) 1.00000 5
urmmary
—- & Cu-H20 System = Calculation Parameters
[ Cu-H20-NH3 Use Single Titrant No Unit Set: Metric (moles)
[ Cu-H20-NH3 0.1 moles pH Acid Titrant HCL )
| Cu-H20-NH3 1.5 moles pH Base Titrant NAOH A”i“jzztc'iET:T‘;‘:YE";::LN_Q
_¢ Au-H20 System - Inflows (mol) Corrosien ‘_;.Q.:
i Au-H20 Pourbaix Diagram H20 555082 Aguesus (H+ ion)
) Au-H20-MaCN Te-4 moles Redox selected
& %ﬂhitnrs Fe 0o Using K-fit Polynomials
= ) As 0.0 T-span: 25.0 - 225.0
@ Fe-Cr-H20 Pourbaix Diagram ﬂ P-span: 1.0 - 1500.0
LB Fe-As-H20 Pourbaix Diagram - T
5 Stability diagram: E vs pH
Fe User-selected tirants
As Acid:
Base:
Actions L X
Actions Range on E
-2.00000 to 2.00000 V' (SHE)
Range on pH:
0.0 to 14.0000
Subsystems
Arsenic

Iren
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5. Click the Specs button and under the Display Choices tab check the following options:

c) No aqueous lines
d) Show ORP

Category

Stability Options

Dizplay Choices

+ Digplay
i RET

o Metal Activity

Agqueous and Solid Lines

() Superimpose lines

(®) No Agqueous lines

(O only Aqueous lines

Show natural pH

Show ORP

Display Subsystems

Shading
() No shading

(®) Shade subsystem:

Arsenic

[~ arsenic
[Atron
[ water

Canicel Apply Help

i

Click OK to close the Stability Options window
We are ready to perform the calculation. Click on the Calculate button or press the <F9> key
It is time to save your file (File >Save as...) or using the save icon in the tool bar. You can save it under

the same file created in the previous example named Stability Diagrams.

Analyzing the Results

Click on the Chemical Diagram tab (Ml Stability Diagram ) Thjs tab displays the Pourbaix Diagram for the Fe-
As-H20 system at 25 °C and 1 atm.

E (SHE)

2% 20 40

6.0

pH

8.0

120

14.0

The elemental arsenic field overlaps with
the corrosion range of Fe in most of the pH
range provided that the conditions are
reducing (absence of oxygen). This
promotes inhibition because of the coupling
of: Oxidation of Fe to Fe*? and the
reduction of arsenates to elemental As.
This promotes the deposition of a
protective layer of As. This can only work in
reducing environments; otherwise the
protective layer of As will oxidize and
dissolve.
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7.9. Implications of Stability Diagrams on Cathodic Protection

Cathodic protection works by shifting the potential of the metal into its immunity range. Stability diagrams can
help you to answer the following questions:

o Whatis the potential range that ensures that the metal stays in the immunity range?

o Whatis the effect of environmental variables on the immunity domain?

We will explore the Fe-H20 system at different temperatures and pressures to answer these questions.

Example 49: Effect of Temperature and Pressure on the Pourbaix Diagram of Fe-H20 System
Starting the Simulation
Iron at 30 °C and 1 atm

Use the inputs and parameters from the table below to create the stream’s composition. Certain inputs, such
as the name style, units, etc. will require further adjustments, and will be described as necessary.

Stability Diagram Calculation

Calculation Settings Stream Composition and Conditions

Stream Name Cathodic Protection Stream Amount Calculated
Name Style Display Formula Temperature 30°C
Unit Set Metric, Batch, Moles Pressure 1 atm
Framework AQ pH Range 0-14 (Default)
Calculation Type Stability Diagram H20 55.5082 moles
Contact Surface Fe

1. Add a new Stream

2. Click on the new Stream and press <F2> to change the name to Cathodic Protection

3. Select the AQ thermodynamic Framework

4. Click on the Names Manager Icon and select the Formula option

5. Click on the Units Manager Icon, and select Metric, Batch, Moles

6. Enter the composition, temperature and pressure of the stream given in the table above

7. Under the Cathodic Protection Stream add a new Stability Diagram calculation. Go to the Add Calculation

button and select Stability Diagram calculation or by selecting the Chemical Diagram icon in the Actions
Pane

8. Select Pourbaix Diagram as Type of Survey — Default

9. Click on the new Stability Diagram and press <F2> to change the name to Fe-H20 at 30C and 1 atm

10. Under the Contact Surface grid type Fe
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The screen should look like the image below after all the inputs and definitions have been entered:

For Help, press F1

{ 0L Studio - [Stability Diagrams.oad®] — O *
W7 File Edit Streams Calculations Chemistry Tools View Window Help - 8 %
DSE| BB 52N s Res mafsias | WEL & BEw
| Mavigator g - x|
=
Stability Diagrams.cad* | B
&% Streams Description Definition ({li Stability Diagram [ Report L} File Viewer
Fe-H20 System .
[ Fe-H20 Pourbaix Diagram Variable [ Value (& Type of diagram
[ Fe-H20 Selective Oxidation R SLEaniarancicrs | PoubsisDisgram  ~| | Specs... |
& Fe-H20-H25 System Stream Amount (mol) 55.5082
| Temperature (*C) 30.0000 Calculate 38
[ Fe-H2O High T
[ Fe-H20-Alkanoamines Pressure (atm) 1.00000 5
ummany
Cu-H20 System = Calculation Parameters
Cu-H20-NH3 Use Single Titrant No Unit Set: Metric (moles)
(1 )
[ Cu-H20-NH3 0.1 moles pH Acid Titrant HCL
| g Automatic Chemistry Model
ﬁ Cu-H20-NH3 1.5 moles pilizac) one NAOH Agueous (H+ ion) Databanks:
- #& Au-H20 System - Inflows (mol} Corrosion (AQ)
[ Au-H20 Pourbaix Diagram Hz0 55 5082 Agueous (H+ion)
Au-H20-NaCN 1e-4 moles Redox selected
E:nb\tor; Fe oo Using K-fit Polynomials
T-span: 25.0 - 225.0
[ Fe-Cr-H20 Pourbaix Diagram - Contact Surface (mal) P-span: 1.0 - 1500.0
[ Fe-As-H20 Pourbaix Diagram Fe |
=- Cathodic Protection Stability diagram: E vs pH
>
B Fe-H20 at 30C | :u:;r-se\ected titrants.
cid:
Base:
Range on E:
| Actions 2 - x -2.00000 to 2.00000 V (SHE)
Range on pH
REITE 0.0 to 14.0000
Subsystems
Iren
Water
Plot Template Manager L - X Alloy Activity Module:
Activated
w Calculation net done
Input
5 Advanced Search Add as Stream Expart
ave =

@ 3 NUM

Analyzing the Results

Click on the Chemical Diagram tab (lll Stability Diagram ) This tab displays the Pourbaix Diagram for the Fe-

H20 system at 30 °C and 1 atm.

2.0 T

0.5

E (SHE)

- Fe(OHya)
“Fe,Os}

14.0

pH

In the whole pH range, cathodic protection

will

require shifting

moderately negative values.

the potential

to
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Iron at 300 °C and 100 atm

1. Go to the Definition tab, and change the Temperature and Pressure to 300°C and 100 atm
2. Click on the Calculate button or press the <F9> key

Analyzing the Results

Click on the Chemical Diagram tab (il Stability Diagram ) Thjs tab displays the Pourbaix Diagram for the Cu-
H20O-NH3 system at 300 °C and 100 atm.

The immunity range in acidic and neutral
solutions is weakly affected by
temperature. However, the immunity
range in alkaline solutions is shifted to
much lower potentials which makes
cathodic protection much more difficult.

E (SHE)
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Section 8. Introduction to Rates of Corrosion

In this section you are going to learn how to set up a Corrosion Rate calculation, how to study the effect of
different variables on the corrosion rates of different alloys, such as temperature, pH, flow velocity, etc., and

how to interpret the results

when using this tool.

We will also explore how to interpret the results for the propensity to localized corrosion, polarization curves

and heat treatment effects.

¢ 0Ll Studic - [Document1*] - O X
B File Edit Streams Calculations Chemistry Tools View Window Help - 8 X
Iafll= = R =] A 11vasol2 Ret | m:ti¥d s ME: GREN
Mavigator L o~ X
= %
Document1 |
6:“ Streams Description Definition [l General Corr. Rate [l Localized Corr. [l Polarization Curve B 1 * "
= #&_ Stream
J Variable Value - Survey by
= Streamn Parameters Temperature 4 Specs...
Stream Amount (mol} 55.5082 .
(mol) Then by  [optional)
Temperature (*C)
Pressure (atm) 1.00000 Mone v| | Specs..
e Calculation Parameters Yary
Flow Type Static Independently
Effect of FeCO3 / FeS Scales Include Together
= Inflows (mol)
H20 555082 Calculate @
Fe 0.0
Summary
= Contact Surface Unit Set: Metric (moles) ~
Carbon steel G10100 (generic) . .
Actions L o x Automatic Chemistry Model
Acti Agueous (H+ ion) Databanks:
Bl Corrosion (AQ)
Agueous (H+ ion)
Redox selected
Using K-fit Pelynomials
T-zpan: 25.0 - 225.0
P-span: 1.0 - 1500.0
Isothermal Calculation
25.0000 *C 1.00000 atm
Calculation not done
Flot Template Manager L o x
Temperature survey:
Range 25010 100.0 °C
Step size 50°C
No. steps 15
v
No secondary survey selected
Input
Polarization Curve Range
Advanced Search Add az Stream Expart Range  -2.0to 2.0V (SHE)
Save
For Help, press F1 @ MNUM
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8.1.

A Basic General Corrosion Rate Calculation

A brief introduction to the corrosion rate tool will be shown in the example below. As we go through the example,
the basic definitions, functionalities and reporting for the Corrosion rate tool will be introduced.

Example 50: Corrosion rate of an oxygenated 0.1 m NaCl solution

Starting the Simulation

To start the software, double-click the OLI Studio icon on the desktop, which will take you to the OLI

Studio interface where you can start creating your calculations.

Use the inputs and parameters from the table below to create the stream’s composition. Certain inputs, such
as the name style, units, etc. will require further adjustments, and will be described as necessary.

Corrosion Rate Calculation

Calculation Settings Stream Composition and Conditions
Stream Name CR of carbon steel Stream Amount Calculated
Name Style Display Formula Temperature 25°C
Unit Set Metric, Batch, Moles Pressure 1 atm
Framework AQ H20 55.5082 moles
Calculation Type Corrosion Rates 02 2.5e-4 moles
Contact Surface Carbon Steel G10100 (generic) | NaCl 0.1 moles

Add a new Stream

No ok =

Click on the new Stream and press <F2> to change the name to CR of carbon steel
Select the AQ thermodynamic Framework
Click on the Names Manager Icon and select the Formula option
Click on the Units Manager Icon, and select Metric, Batch, Moles
Enter the composition, temperature and pressure of the stream given in the table above

Go to the Add Calculation button and select Corrosion Rates calculation or by selecting the Add

Corrosion Rates icon in the Actions Pane. Your screen should look like the image below.

DEHE % B0
Mavigator
Corrosion Rates.oad®

& OLl Studio - [Corrosion Rates.oad*]

B File Edit Streams Calculations Chemistry Tools View Window Help

7 N2

L1 Va So L2 Red me & 0% 4 ud

dh e

% B S

- & ®

ﬂ-‘x|

‘6‘ Streams
=-# CR of carbon steel
7] single CR

J Variable

Stream Amount (mol)
Temperature (*C)

Pressure (atm)

Actions
Actions

Carbon steel G10100 (generic)

Value -

~ Stream Parameters

55.5085 |

1.00000

= Calculation Parameters
Flow Type Static
Effect of FeCO3 / FeS Scales Include

= Inflows (mol)
H20 555082 |
02 2.50011e-4
NaCl 0.100000

\ =]

e Contact Surface

*

Description Definition [}l General Corr. Rate [l Localized Corr. [ill Polarization Curve | *|°*

Survep by

Temperature - Specs...

Then by  [optional]
Mone - Specs...

Vary
Independentiy

Together

Calculate i

Summary

unit Set: <Custom: ~

Automatic Chemistry Model
Agueous (H+ ion) Databanks:
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Note: By default, the software has selected Carbon steel G10100 (generic) as the default contact surface to
perform the corrosion rates on. You can click on the white space of the Carbon steel G10100 (generic) name,
and it will show a drop-down arrow. You can then click on the dropdown arrow, and you will be able to see and
select any alloy present in the Alloy database.

= Contact Surface
=
Display Name OLI Name 2
ks Carbon steel G10100 (generic) Carbon steel G1010...
* Carbon steel 1018 Carbon steel 1018
# Stainless steel 304 Stainless steel 304
# Stainless steel 316 Stainless steel 316
# Alloy 2345MO Alloy 2545M0
H Munlev ctainlece 2205 Munley ctainlece 2705 ¥

Additionally, the Calculation Parameters grid shows two options: (1) Flow Type and (2) Effect of FeCO3 /FeS
scales on corrosion rates.

By default, the software selects Static as Flow Type. There are 7 options for Flow Type, and a brief description
of the first five options will be given below.

== Calculation Parameters
Flow Type
Effect of FeCO3 / FeS Scales
Pipe Flow
Infl
i MHOWS| o stating Disk
H20 Rotating Cylinder
0z Complete Agitation
NaCl Defined Shear Stress
Approximate Multiphase Flow
Fe 0.0

Static
The solution is not flowing in this calculation.

Pipe Flow
The fluid is flowing through a pipe. The pipe diameter and flow velocity must be defined. The default pipe
diameter is 0.1 meters and the default flow velocity is 2 m/s.

Rotating disk

This reproduces a type of experiment that is used quite frequently in the laboratory. A disk is rotated to bring
fluid to the surface of the electrode in a predictable manner. The diameter of the disk is specified as well as the
revolutions per minute (RPM). The default diameter is 0.01 meters and the default RPM is 5000 RPM.

Rotating Cylinder

This reproduces a type of experiment that is used quite frequently in the laboratory. A cylindrical rotor is rotated
to bring fluid to the surface of the electrode in a predictable manner. The diameter of the rotor is specified as
well as the revolutions per minute (RPM). The default diameter is 0.01 meters and the default RPM is 5000
RPM.

Complete Agitation
In this calculation, the liquid phase is completely agitated, and no mass transfer limitations apply.
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8. Leave the default alloy Carbon steel G10100 (generic) as the contact surface
9. Go to the Survey by option and select Single Point Rate. This option will allow you to calculate the
corrosion rate at the temperature and pressure specified.

T
Description Definition i General Corr. Rate {illl Localized Corr. il Polarization Curve | *|°
H Variable Value - Survey by
= Stream Parameters Single Point Rate! Specs...
s 55 Gfja5
Stream Amount {mel} 55.5085 | ®  Single Point Rate
Temperature ("C) 25.0000
Temperature
Preszure (atm) 1.00000
= Calculation Parameters ==
Flow Type Static Compaosition
Effect of FeCO3/ FeS Scales Include pH
i Inflows (mol) Pipe Flow
= =5.5082 Rotating Disk
0z 2.50011e-4
Su Rotating Cylinder
MaCl 0.100000 i
Thermal Aging Temp.
= Contact Surface Thermal Aging Time
Carbon steel G10100 (generic) Shear Stress
b L —
Liquid Flow in Pipe
ﬁn'Anu unlﬂa—;:.; - B

Note: You can also study the effect of other variables such as temperature, pressure, (chemical species)
composition, pH, pipe flow, etc. on the corrosion rate. The effect of these variables can be set up as a survey
calculation. In the upcoming corrosion rate examples, survey calculations to study corrosion rates will be shown
in more detail.

A brief description of the most common survey types for studying corrosion rates are given below.

pH Survey — This calculation is similar to the pH survey available in OLI Studio: Stream Analyzer. The
specification requires a titrant acid and base to change the pH.

Temperature Survey — The default range is from 25-100 °C. Any range may be used by changing the Range
option. The user should consider that some points in the survey may not converge due to phase changes (e.g.,
boiling off of aqueous liquids).

Composition Survey — The composition of a chemical compound, for example NaCl, can be varied to study its
effects on corrosion rates. The range of the chemical compound defaults from 0 to 1 mole with an increment of
0.1 moles. This range can be changed via the Range option.

Care should be taken when adding salts that can form hydrates (e.g., CaCl2.6H20). When these hydrated salts
begin to precipitate from solution, large amounts of water may be complexed with the crystal. The solution may
dehydrate, and non-convergence may be the result.

Pressure Survey — The pressure of the system can also be varied. The default range can be changed via the
Range option. Care should be taken when working at very low pressures since the solution may inadvertently
boil off the liquid and non-convergence may result.

Flow Velocity Survey — In systems that are flowing, the flowrate of the stream can be varied.
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10. Now, we are ready to perform the calculation. Click on the Calculate button or press the <F9> key

11. It is time to save your file (File >Save as...) or using the save icon in the tool bar. Create a new file and
name it: Corrosion Rates.

Analyzing the Results

1. Click on the General Corr. Rate tab ( lll General Corr. Rate ) This tab displays a plot showing the results of
corrosion rate and pH.

Description Definition Mll General Corr. Rate (il Localized Corr. [l Polarization Cur * | *

@al = = [=] | wiew Data ariahles Optiotz

0.143
0.142
0141
0.140
0.139

0137
0.136
0.135

Corrosion Rate [mmiyr]

0.133
0.132

0.130
0.129

0138

0.134

0131

—a— Corrosion Rate [mmifyr]
L ——PH (¥2)

7.7
7.66

7.61
7.56
7.51

746
741
7.36

Hd

7.3
7.26

7.1
7.16
711
7.06
7.01

I.I.I.I.I.I.I.E_gs

b R R R E R
¥ Iy o o o Iy &
A

B - - N NN
5 % & % 5 B G

Temperature [°C]

2. Click on the View Data button to see the results in tabulated form.

Temperature

Corrosion Rate pH

“C

mmiyr

1 25.0000

0.125801 | 6.995156

The predicted corrosion rate of carbon steel at 25 °C and 1 atm is ~0.13 mm/year when exposed to an

oxygenated 0.1 m NaCl solution. It is important to highlight that this predicted corrosion rate is the corrosion

rate once the system

has reached a steady state.
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3. Click on the Localized Corr. Rate tab (ﬂ Localized Corr. ). This tab displays a plot showing the results
of three different calculated data:
e Corrosion Potential (red dot)
e Repassivation Potential (yellow triangle)

e Maximum Pit Current Density (blue square)

Description Definition [{ll General Corr. Rate Iﬂ Localized Corr. I ffll Polarization Curve | * '

‘ a 2 & =] Variahles Ophions

S —

s L 0.01595

16 L - 0.01585

14 - 0.01575

—g— Corrosion Potential [ (SHE)]

s 12 - . 4 0.01565
= 10k —4&— Repassivation Potential [ (SHE)] -
% U-B —@— Maximum Pit Current Density [A/sg-m] (v2) - 0.01555 %
a 08 =
é 06 L < 0.01545 g
= 04} - 0.01535 o
= 02 H 001825 £
z =
e oor J 001515 2
2 02} 2
g 04 . - 0.01505 "_3,
& 06} ] 0.01495 %
S 08| 4 0.01485 2
8 3
£ 10 1001475 =
5] B

1.2 - 0.01465

14

L6l - 0.01455

4L ™ - 0.01445

_2_0 L | N | L 1 L | N | | L 1 L | L | L | L 1 L | L | L ] 0_01435

D D 2 D D S e D D D D S S 2
- o o i o o & & & & & - e - -
":Pé\ %\ "?5\ - ‘%\ 'd':i\ ' "?S\ e l%\ "%\ ’ "?5\ R ‘%\
Temperature [°C]

Click on the View Data button to see the results in tabulated form.

Temperature | Corrosion Potential | Repassivation Potential| Maximum Pit Current Density
*C V [SHE) V [SHE) Alsg-m
1 25.0000 -0.472418 -0.431502 0.0144536

Notice that in this case, the corrosion potential has a higher value than the repassivation potential. This
indicates that carbon steel at 25 °C and 1 atm when exposed to an oxygenated 0.1 m NaCl solution will
likely suffer localized corrosion (pitting or crevice corrosion). The maximum pit current density gives the

worst-case pitting rate for these conditions.
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5.

Now, click on the Polarization Curve tab ( il Polarization Curve) This tab displays a plot showing the

calculated polarization curve of carbon steel.

7 MR- N (=] | “iewData ariahles O ptionz

2-5 L S Dl O I DL IR LR DL L LR DL L, IR B

¥ Corrosion Potential

20 1 Met Current Density i

I Peak Current Density il
15 | r/’ i
Hi+}=05H2 -2

— H20=10.5H2 + OH{-}- &

1.0 1 Fe(3+)=Fe(2+)-¢ 1
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Current Density (Afsg-m)

The net polarization curve is given by the red curve. This red curve is obtained by adding up all the currents
of the half reactions at a given potential. The corrosion potential is calculated by applying the mixed potential
theory, and it is represented by this red triangle. Once the corrosion potential is obtained, the corrosion

current density also is computed and subsequently the corrosion rate.
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8.2. Exploring corrosion rate calculation options

Example 51: Corrosion in a Water-Filled Carbon Steel Tank

In the following example you are going to study the corrosion rate of a carbon steel tank with a volume of 10
m3 tank (3.2 cm high and 200 cm in diameter) that is filled to the top with water. The tank’s wall thickness is
1.27 cm.

These are the operation conditions:

Sometimes the water in the tank remains static (mixer off), closed to the atmosphere

Some other times the tank is fully mixed (complete agitation)

The tank when operating has a variable speed mixer with a rotation speed between 0 and 12,000 rpm
At other times, the tank is open to the atmosphere. The effects of O2, CO2 and flow will be studied.

PoON-~

We will evaluate each instance to compute the corrosion risk.

. .-:}{ S

L
L

Starting the Simulation

First operation condition: Static flow, tank closed to the atmosphere at ambient conditions

Use the inputs and parameters from the table below to create the stream’s composition. Certain inputs, such
as the name style, units, etc. will require further adjustments, and will be described as necessary.

Corrosion rate calculation of tank as a function of flow

Calculation Settings Stream Composition and Conditions
Stream Name CR vs flow Stream Amount 10000 L
Calculation Type Corrosion Rates Temperature 25°C
Name Style Display Name Pressure 1 atm
Unit Set Metric, Batch, Concentration Water Calculated
Framework AQ
Contact surface Carbon Steel G10100 (generic)

Add a new Stream

Click on the new Stream and press <F2> to change the name to CR vs flow

Select the AQ thermodynamic Framework

Click on the Names Manager Icon, and select the Display Name option, and click OK
Click on the Units Manager Icon, and select the Metric, Batch, Conc. option, and click OK

ok wbd-=
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Units Manager - CR vs flow ? X

Units Manager

Metric ~ Batch Canc, ~ 4
In the Definition tab, notice that the units of the Stream Amount changed from moles (mol) to liters (L).

6. Enter the composition, temperature and pressure of the stream given in the table above

7. Go to the Add Calculation button and select Corrosion Rates calculation or by selecting the Add
Corrosion Rates icon in the Actions Pane.

8. Change the Rates name to Static Flow, 25C using the <F2> key.

9. Leave the default Flow Type as Static

10. Leave the default alloy Carbon steel G10100 (generic) as the contact surface

11. Go to the Survey by option and select Single Point Rate. This option will allow you to calculate the
corrosion rate at the temperature and pressure specified.

Your screen should look like the image below.

& OLlStudic - [Corrosion Rates.oad] — O x
B File Edit Streams Calculations Chemistry Tools View Window Help - 8 X
== = N | 11 VvaSol2 Red |me I3 | fiEms | S BE s
Mavigator L o~ x
]
Corrosion Rates.oad |
reams J Description [&¥ Definiti eneral Corr. Rate ocalized Corr. olarization Cur
b8 st & Description [&¥ Definition [{ll General Corr. Rat Localized C Polarization Cur| * | *
+ & CR of carbon steel
_‘ CRvs flow J Variable Value -~ Survey by
Static Flow, 25C = Stream Parameters Single Point Rate = Spece...
Stream Amount (L) 10000.0 q
) Then by  [optional]
Temperature ("C) 25.0000
Pressure (atm) 1.00000 Specs
= Calculation Parameters Wary
Flow Type Static Independently
Effect of FeCO3 / FeS Scales Include Together
= Inflows (mgiL)
HzO Calculate &8
Actions L o+ X Fe 0.0 Summary
Actions
= Contact Surface Unit Set: Metric (mass concentration) /A
Carbon steel G10100 (generic)
Automatic Chemistry Model
Aqueous (H+ ion) Databanks:
Corrosion (&0)
Agueous (H+ion)
Redox selected
Plot Template Manager L oa X Using K-fit Polynomials
T-zpan: 25.0 - 225.0
w P-span: 1.0 - 1500.0
lzothermal Calculation
Input 25.0000 *C 1.00000 atm
. v
Calculation not done
5 Advanced Search Add az Stieam Erpart
ave

12. We are ready to perform the calculation. Click on the Calculate button or press the <F9> key.

13. It is time to save your file (File >Save as...) or using the save icon in the tool bar. You can save it under
the same file created in the previous example named Corrosion Rates.
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Analyzing the Results

Click on the output tab labeled 1 (next to the input tab), and check the results located in the Corrosion Values
tab.

Description Definition [l General Corr. Rate [l Localized Corr. [l Polarization Cur * | *

J Variable Value ”~
= Stream Parameters
|$_| Stream Amount (L) 10000.0
L wolume - Aqueous (L) 10000.0
Temperature (*C) 25.0000
Pressure (atm) 1.00000
= Corrosion Values
Repassivation Potential (V' (SHE)) 59.5000
Corrosion Rate (mmiyr) 7.12696e-3
Corrosion Potential (v (SHE)) -0.552268
Corrosion Current Density (&/sg- 6.14631e-3
2 Inflows [mgiL)
HzO 9.96987e5
= Contact Surface
Carbon steel G10100 (generic)
v
Input
Advanced Search Add as Stream Erport

Survey by
Single Point Rate Specs..
Thenby [optional)
Specs..
WVary

Independently
Together

Calculate &8

Summary

Unit Set: Metric (mass concentration)

Automatic Chemistry Model
Aguecus (H+ ion) Databanks:
Corrosion (AQ)
Agueous (H+ion)
Redox selected
Using K-fit Polynomials
T-span: 25.0 - 225.0
P-zpan: 1.0 - 1500.0
Isothermal Calculation
25.0000 *C 1.00000 atm

Calculation complete

~

The corrosion rate is 7.13e-3 mm/yr. This is a negligible rate, since the thickness of the tank is ~12.7 mm, then

corroding half the wall thickness would take about 900 years.

Second operation condition: Turbulent flow, tank closed to the atmosphere at ambient conditions

1.

aoRwd

Under the stream ‘CR vs Flow’ add new corrosion rate calculation. Go to the Add Calculation button and
select Corrosion Rates calculation or by selecting the Add Corrosion Rates icon in the Actions Pane

Change the Rates name to Turbulent Flow, 25C using the <F2> key.
Change the default Flow Type to Complete Agitation

Leave the default alloy Carbon steel G10100 (generic) as the contact surface
Go to the Survey by option and select Single Point Rate.

Your screen should look like the image below.

Mavigator
Corrosion Rates.oad*

6“ Streams
#-& CRof carbon steel
=-# CRuvsflow

[ Turbulent Flow, 25C

Actions
Actiong

L o+ X
| A
Description Definition {fil General Corr. Rate [l Localized Corr. [l Polarization Cur| * | *
J Variable Value A Sy

= Stream Parameters Single Paint Rate Specs...

Stream Amount (L} 10000.0 .
- (L Thenby  [optional)

Temperature (°C) 25.0000
Pressure (atm) 1.00000 E[EEES

- Calculation Parameters Wary

| Flow Type [ Complete Agitation Jd | Independently

Effect of FeCO3 / FeS Scales Include Together

= Inflows (mg/L)
HzO0 Caloulate

poex Fe 0.0 Summary
| >

e Contact Surface Unit Set: Metric (mass concentration) /A

Carbon steel G10100 (generic)
Automatic Chemistry Model
Anuaniie (Ha inn) Natahanke:
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Analyzing the Results

Click on the output tab labeled 1 (next to the input tab), and check the results located in the Corrosion

Values tab.

Description Definition [l General Corr. Rate [l Localized Corr. [l Polarization Cur * | *

J Variable Value ”~ Survey by
2 Stream Parameters Single Point Rate Specs..
Stream Amount (L) 10000.0 q
g ) Thenby [optional)
L wolume - Aqueous (L) 10000.0
Temperature (:C) 25,0000 Speced
Preszure (atm) 1.00000 WVary
< Corrosion Values Independsntly
Repassivation Potential (V' (SHE)) 59.5000 Together
Corrosion Rate (mmiyr) 0.0195420
Corrosion Potential (v (SHE)) -0.535169 Calculate
Corrosion Current Density (&/sg- 0.0165394 g
urmmary
= Inflows [mg/L)
H20 9.96987e5 Unit Set: Metric (mass concentration)  #
= Contact Surface
— Automatic Chemistry Model
Carbon steel G10100 (generic) Aqueous (H+ ion) Databanks:
Corrosion (AQ)
Agueous (H+ ion)
Redox selected
Using K-fit Polynomials
T-span: 25.0 - 225.0
v P-zpan: 1.0 - 1500.0
Isothermal Calculation
iz 25.0000 °C 1.00000 atm
W

Advanced Search Add as Stream Erport

Calculation complete

The corrosion rate increased 0.0196 mm/year, still a relatively low value.

Third operation condition: Varying flow, tank closed to the atmosphere at ambient conditions

1. Under the stream ‘CR vs Flow’ add new corrosion rate calculation. Go to the Add Calculation button and

select Corrosion Rates calculation or by selecting the Add Corrosion Rates icon in the Actions Pane

2. Change the Rates name to Varying Flow, 25C using the <F2> key
3. Go to the Survey by button and select Rotating Disk
4. Under the Calculation Parameters grid. change the Disk Diameter to 200 cm

Note: At this point the vertical dimensions of the tank are unimportant. We will assume that the tank can be
modeled like a rotating cylinder. The propeller rotates at 1200 rpm, although it is not expected that the wall
velocity will approach this value, and so a lower value will be used (we still want it to be high enough to see the

effects of shear).

5. The next step is to set the speed of the mixer. Go to the Specs button next to the Rotating Disk option
6. Change the Disk Rotation Speed Range from 0 to 300 cycles/min with an increment of 10 cycles/min. Then

click OK.

Categom Survey Range
Yar. 1-Disk
Polarization Curve
Calculation Type Selected Range
Caleulation Options 0.0

Disk Rotation Speed Fange

New

Delete

@) Linear O Log
End Points

Step Size

Increment

Mumber Steps 30

() Paint List

®
0]

Select one. the other is
calculated
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7. Leave the default alloy Carbon steel G10100 (generic) as the contact surface

Your screen should look like the image below.

6 0Ll Studio - [Corrosion Rates.oad*]

- O =
B File Edit Streams Calculations Chemistry Tools View Window Help - 8 X
D= | & B B R | 11vasol2 Red medlfs oo | ME SR
MNavigator p o~ X
Corrosion Rates.oad |
&2 Streams Description & Definition [l General Corr. Rate [l Localized Corr. [l Polarization Cur| * | *
.. & CR of carbon steel
E| & CRvsflow J Variable Value s Survey by
ﬁ Static Flow, 25C = Stream Parameters Rotating Disk - Specs...
ﬁ Turbulent Flow, 25C LI:_| Stream Amount (L} 10000.0 Tzl {pitane]
Varying Flow, 25C '— Density correlation Fixed condition
F Fixed: Temperature ("C} 25.0000 None v | Specs..
L Fixed: Pressure (atm) 1.00000 Wary
Temperature (:C) 25.0000 Independently
Pressure (atm) 1.00000 Together
= Calculation Parameters
Flow Type Rotating Disk Caloulste &8
Digk Diameter (cm) 200.000 Summary
Disk Rotation Speed (cycle/min)
Effect of FeCO3 / FeS Scales Include Unit Set: Metric (mass concentration) ¥
= Inflows {mgiL) . .
Actions 1 o« x 20 Automatic Chemistry Model
Acti Agueous (H+ion) Databanks:
LiE Fe 0.0 Corrosion (AQ)
Agueous (H+ion)
Redox selected
= Contact Surface Using K-fit Polynomials
Carbon steel G10100 (generic) T-span: 25.0 - 225.0
P-zpan: 1.0 - 1500.0
lzothermal Calculation
25.0000 *C 1.00000 atm
Calculation not done
Flot Template Manager L - x
Rotating Disk survey:
Range 0.0 to 300.0 cycle/min
Step size  10.0 cycle/min
Mo. steps 30
w
o secondary survey selected
Input
Polarization Curve Range
Advanced Search Add az Stream Expart Range  -2.010 2.0V (SHE)
Save
For Help, press F1 @ NUM

8. We are ready to perform the calculation. Click on the Calculate button or press the <F9> key

9.

It is time to save your file (File >Save as...) or using the save icon in the tool bar. You can save it under
the same file created in the previous example named Corrosion Rates.
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Analyzing the Results

Click on the General Corr. Rate tab ( il General Corr. Rate ) This tab displays a plot showing the results of
corrosion rate and pH.

Description Definition Mll General Corr. Rate [l Localized Corr. [l Polarization Cur| * | *

| @al = = =] ariahles Optiotz

QooTROsE T T T T T T T T T T T T T T T _—
0.007555 ] 7.66
—#— Corrosion Rate [mmiyr] ] 7.61
0.007505 oH (v2) 1756
0.007455 + 1 751
= I - 745
E 0.007405 | .)’ 1741
g I ] 7.36
o 0007355 1=
s 4731
a
= 0.007305 1796
&)
-4 721
0.007255
- 7.16
0.007205 { 7.11
- 7.06
0.007155
i - 7.01
0.007105 PN T TN TN AT AT S AN S NN SN AN TN AN S AN SN T SN [ T AN TN SN S SN W' ] 6.96
¢ B o B % T b, e B G R T W B Y
Disk Rotation Speed [cycle/min]

The corrosion rate is computed to increase as the bulk liquid velocity increases from 0 to 300 rpm near the wall
surface. The reason is straightforward; the higher velocity reduces the static water film thickness on the metal
surface. This diffusion layer film limits the mass transfer of corrosion products and bulk chemicals to and from
the surface. As the liquid velocity (and therefore shear force) increases, the film thickness decreases, and the
concentration gradient increase. This increases the flux of materials to and from the surface, which increase
corrosion rates.

Fourth operation condition: Static flow, tank open to the atmosphere (aerated with O, only) at ambient
conditions

Open steel tanks are in contact with oxygen in the air. To simulate this, follow the steps below.

1. Under the stream ‘CR vs Flow’ add new corrosion rate calculation. Go to the Add Calculation button and
select Corrosion Rates calculation or by selecting the Add Corrosion Rates icon in the Actions Pane

2. Change the Rates name to Static Flow, O2 using the <F2> key

Add Oxygen (02) to the inflow grid

4. Leave the default Flow Type as Static

w
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5. Go to the Survey by button and select Composition

o

Change the Disk Diameter to 200 cm
The next step is the concentration range of oxygen. Go to the Specs button next to the Composition

option. This will open a new window.

as follows: Log Scale, Start=1e-6, End=10, Steps=10. Then click OK.

Composition Rates Calculation

Categony

Yar. 1 - Composition
Polarization Curve
* Caleulation Type
- Caleulation Options

Comporent  Survey Range
Component Inflows

Hide Related Inflows

Under component select (click on) O2. Then select the Survey Range tab and enter the Survey Range

T X Composition Rates Calculation
Categony
: Yar. 1 - Composition
- Palarization Curve
New Inflow L Caleulation Type

.- Caleulation Dptions

Fe

Cancel

Select a component inflow which will be vaned over the specified range.

Apply

Help

T x
Component Survey Range
Composition Fiangs Urit:
Selected Range
New
Delete
O Linear @ Log ) Point List
End Points
Start |1.00000k
End |10.0000
Step Size
Increment 100000
} Select one, the other is
Mumber Steps calculated
Cancel Apply Help

9. Leave the default alloy Carbon steel G10100 (generic) as the contact surface

Your screen should look like the image below.

b“ Streams

- CR of carbon steel

[z% Single CR

- & CRuvsflow

fz& Static Flow, 25C

[z Turbulent Flow, 25C
E Varying Flow, 25C
Static Flow, 02

Actions L s X
Actions
Flot Template Manager . x

Description Definition [l General Corr. Rate [ill Localized Corr. [l Polarization Cur * | *
] Variable Value ~ Survey by
7 Stream Parameters Composzition - Specs...
Stream Amount (L 10000.0 2
2 L) Then by [optional]
}— Density correlation Fixed condition
I Fixed: Temperature (°C} 25,0000 None | | Specs..
L Fixed: Pressure (atm}) 1.00000 Wary
Temperature ("C) 25.0000 Independently
Pressure (atm) 1.00000 Together
i Calculation Parameters
| Flow Type Static | Calculate &
Effect of FeCO3 / FeS Scales Include
Surmnmary
= Inflows (mgiL)
H20 Unit Set: Metric (mass concentration) A
Fe 0.0
Automatic Chemistry Model
02 | Agueous (H+ ion) Databanks:
* Corrosion (AQ)
~ Contact Surface Agqueous (H+ ion)
— Redox selected
Carbon steel G10100 (generic) Using K-fit Polynomials
T-span: 25.0 - 225.0
P-span: 1.0 - 1500.0
Isothermal Calculation
25.0000 *C 1.00000 atm
Calculation not done
Composition survey:
o2
Range 1.0e-6 to 10.0 mg/L
Legarithmic Scale
L No. steps 10

282



10. We are ready to perform the calculation. Click on the Calculate button or press the <F9> key

11. Itis time to save your file (File >Save as...) or using the save icon in the tool bar. You can save it under
the same file created in the previous example named Corrosion Rates.

Analyzing the Results

Click on the General Corr. Rate tab ( il General Corr. Rate ) This tab displays a plot showing the results of
corrosion rate and pH.

1. Right-mouse click on the X-axis and change it to Logarithmic Scale

& Description [&¥ Definition [l General Corr. Rate [Jij Localized Corr. [{ll Polarization Cur * | *

| a s &3] Variables Optians

017 i . . . .
016} 6.996546
ote - 6.996546
0.14 - —#— Corrosion Rate [mmyr] 1 & sa6546
013 —&—PH (Y2}

| 5.996546
0z [

SR - 6996546

E oo - 6.996546

= 009 [

£ - 6.996546 3.

= 008

2 | 6.996545

2 go7 [

S ool - 6.996546
005 | 6.996545
ol | 6.996545
003 [

- 6.996545

oz [
001 1 6.996545
000 St e 6.996545

2 Ep— P — . :

@ Q Format X Axis... o o o 2,

Adjust Scale...
[ Logarithmic Scale

2. Right-mouse click on the pH curve and select Remove

Description [£¥ Definition [l General Corr. Rate [l Localized Corr. il Polarization Cur * | *

| a = % = Vaibles Options

017 . . : . .
. 6996546
ot [ pH [Y2) Options...
oy I Hid 6.996546
ide
014 [
ol | Switch to ¥ Axis 5.996546
I 6 996546
o2l |
Fonr 5.996546
Eonp "I | 6 996546
é vl | | 5.996546 3.
008 |
z ' 6.996546
2007} |
Sooer| 6 996546
005/ 6.996545
o 6.996545
003 H
' 6.996545
o2 b
0L o o o 4 6 996545
0o e P p P = L ! 6.996545
3 ® 3 ) s 2
% Qe o Qs 2 o, S&% S*o),
02 [mgll]
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&J Description (£¥ Definition il General Corr. Rate il Localized Corr. [l Polarization Cur * | *

a 3 |8 & Variables Dptions

017
0.16
015
014
013
0.12
0
0.10
0.09
0.08
0.07
0.06
0.05
0.04
0.03
0.02
0.01

Corrosion Rate [mm/yr]

& Corrosion Rate [mmiyr] /_

0.00
%

v
- . . Py Py P ..-/A T
1 L 1 L 1 1
Fa Fa Fa Z Fa Fa z
<, Q Q <, q, Y
% % o % % 2, o e,
02 [mglL]

The resulting plot shows the impact of oxygen on the corrosion rate. Corrosion increases by a factor of 20 once
the concentration increases beyond 100 ug/l. Aerated water contains approximately 8 mg/l O2. Corrosion on
the tank wall is 0.16 mm/yr. At this rate, 50% of the 12.3 mm wall will be dissolved in 40 years.

Fifth operation condition: Static flow, tank open to the atmosphere (aerated with O, and CO;) at ambient

conditions

The atmosphere contains ~400 ppmV CO:x. At this concentration 0.6 mg/l COz is dissolved in water as molecular
COz, this CO2 hydrolyzes water to form the following reactants:

CO,+ H,0 =H*+ HCO;

The resulting pH is about 5.6 at ambient conditions.

The impact of CO2 on corrosion is two-fold, as two separate reactions occur at the metal surface:

1
H* + e~ <—>§H2

1
HCO; +e™ = EHZ + €032

To test the CO2 impact, you will recalculate the corrosion rate using two COz2 concentrations: 0 and 0.6 ppm.

Under the stream ‘CR vs Flow’' add new corrosion rate calculation. Go to the Add Calculation button and
select Corrosion Rates calculation or by selecting the Add Corrosion Rates icon in the Actions Pane
Change the Rates name to Static Flow, 02 and CO2 using the <F2> key

Add Oxygen (02) and carbon dioxide (CO2) to the inflow grid

Leave the default Flow Type as Static

284



V. Go to the Survey by button and select Survey by Composition and then by Composition (as shown below)

Survey by

Composition - Specs...

Then by [optional]

Composition - Specs...

Wary
(®) Independently

() Togsther

VI. The next step is the concentration range of oxygen and carbon dioxide. Go to the Specs button next to the

Composition option. This will open a new window.

VILI. Under the Category section, make sure to select Var. 1 -Composition. Go to the Component tab, and

Compaosition Rates Calculation ? X
Survey Range
Component Inflows
; Polarization Curve Hide Related Inflows Mew Inflow

- Caloulation Type
‘. Caloulation Options

coz

o]

Select a component inflow which will be vared over the specified range.

Cancel Apply Help

VIII. Then select the Survey Range tab and enter the Survey Range as follows: Log Scale, Start=1e-6, End=10,

Steps=10. Then click OK.

Composition Rates Calculation

Category Component  Survey Range

~ War. 1 - Composiion

+Var 2- Compasiion Compastion Range Uit
- Polatization Curve Selected Range
- Caloulation Typs

1.0
i Caloulation Options New

Delete

(O Linear (® Log () Paint List

End Paints
Start | 1.00000=-6
End |10.0000
Step Size
Increment  1.00000 )
} Select one, the other is
Humber Steps calculated

Cancel Apply Help
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IX.

X.

XL

Under the Category section, select Var. 2 -Composition. Go to the Component tab, and select CO2

Category

Compaosition Rates Calculation ?

Companent  Survey Range

+ Var 1 - Composition

iion
olatization Curve
- Caloulation Type
‘.. Caleulation Dptions

Companent Inflows

Hide Related Inflows

Mew Inflow

Select a component inflow which will be varied over the specified range.

Cancel Apply Help

X

Then select the Survey Range tab. Select the Point List option. Create two point with values of 0 and 0.6

mg/L. Then click OK.

Catenoty

Compaosition Rates Calculation

+War. 1 - Composition
o War. 2 - Composition
i Polarization Curve
o Caleulation Type

% Calculation Options

Component  Survey Flange

Composition Range

Selected
P

Delete

O Linear Olog (® Point List

Value

1 0.0 Add Point

Remave Pts

Cancel Apply Help

Leave the default alloy Carbon steel G10100 (generic) as the contact surface
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Your screen should look like the image below.

& OLI Studio - [Corrosion Rates.oad*] — [} x
B File Edit Streams Calculations Chemistry Tools View Window Help - 8 X
DESHE| % B TR 11vasolz Res meiid s ME: | GPREEN
MNavigator P
- " %
Corrosion Rates.oad |
&% Streams Description & Definition i General Corr. Rate [Mlll Localized Corr. [lll Polarization Cur * |’
E| CR of carbon steel
ﬁ Single CR J Variable Value -~ Survey by
CR vs flow 2 Stream Parameters Composition - Specs...
i Stream Amount (L) 10000.0
FZ Static Flow, 25C =] ! (_r : _ Thenty  (optionsl]
ﬁ. Turbulent Flow, 25C '— Density correlation Fixed condition —
& Varying Flow, 25C [ Fixed: Temperature (:C) 25.0000 Lo v e
[ Static Flow, 02 L Fixed: Pressure (atm) 1.00000 Wary
Static Flow, 02 and CO2 Temperature (°C) 25.0000 ® Independently
Pressure (atm) 1.00000 O Together
e Calculation Parameters
Flow Type Static Calculate @
Effect of FeCO3 / FeS Scales Include
Summary
= Inflows (mg/L) N
Agueous (H+ ion) Databanks:
H20 Corrosion (AQ) ~
Fe 0.0 Agueous (H+ ion)
Actions P 0z Redox selected
Actions 5 Using K-fit Polynomials
coz T-zpan: 25.0 - 225.0
P-gpan: 1.0 - 1500.0
= Contact Surface Isothermal Calculation
Carbon steel G10100 (generic) 25.0000 °C 1.00000 atm
Calculation not done
Composition survey:
Range 1.0e-6 to 10.0 mg/L
Flot Template Manager L - x Logarithmic Scale
No. steps 10
Composition survey
w Range: List with 2 points
(0.0, 0.5 mg/L}
Input
Primary and secondary survey W
Advanced Search Add az Stream Export variables
Save
For Help, press F1 @ NUM

12. We are ready to perform the calculation. Click on the Calculate button or press the <F9> key

13. It is time to save your file (File >Save as...) or using the save icon in the tool bar. You can save it under
the same file created in the previous example named Corrosion Rates.
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Analyzing the Results

Click on the General Corr. Rate tab ( il General Corr. Rate ) This tab displays a plot showing the results of
corrosion rate and pH.

1. Right-mouse click on the X-axis and change it to Logarithmic Scale
2. Right-mouse click on the Y-axis and change it to Logarithmic Scale
3. Right-mouse click on the pH curve and select Remove Series

Description [£¥ Definition bl General Corr. Rate [l Localized Corr. [lll Polarization Cur| * | *

| @ 3, & = Wariables Options

1e+00 TP T T

—ua— Corrosion Rate [mméyr] - CO2 = 0.0 mg/L
& Corrosion Rate [mmiyr] - COZ2 = 0.6 mgiL

le-01 |

Corrosion Rate [mmfyr]

1e-02 |

A
o
T3
A
&

1e-03
>

% s " e %’

02 [mgiL]

The effects of CO2 are small, particularly in relation to the oxygen effects. The Corrosion rates at low Oz content
are about 0.0071 mm/yr with no CO2 and 0.0083 mm/yr with 0.6 mg/I COz2; a small difference between two small
rates. At 10 mg/l Oz the corrosion rate is 0.16 mm/y and it is the same with and without CO2. Thus, CO2 has no
effect on corrosion at high Oz concentrations meaning that the surface is corroded by oxygen and small
concentrations of CO2 does not change this rate.
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Sixth operation condition: 300 cycles/min flow, tank open to the atmosphere (aerated with O, and CO>) at

ambient conditions

Lastly, you will look at the effects of shear rates on the tank in contact with CO2 and O2.

1. Copy (right-mouse click or Ctrl+C) ‘Static Flow, O2 and COZ2’ corrosion calculation, and paste (right-mouse
click or Ctrl+V)under the stream ‘CR vs Flow’

Nook~WN

4, Streams 4, Streams
£l & CRof carbon steel £l & CRof carbon steel
F} Single CR Fd Single CR
Bd CRusflow b "
[ Static Flow, 25C B st Arrange
Fgd Turbulent Flow, 25C BT i
g} Varying Flow, 25C & .
B Static Flow, 02 B oR
7] tatic Flow. Bt Paste
Arrange >
Delete
@t Rename
Coj
Py Add As Stream
Paste
Clear Results
e Clear Status

Your screen should look like the image below.

L1 va So

Change the Static Flow, 02 and CO2-1 name to 300 rpom flow, O2 and CO2 using the <F2> key
Add Oxygen (02) and carbon dioxide (CO2) to the inflow grid
Change the Flow Type from Static to Rotating Cylinder

Set the Rotor Diameter to 200 cm

Set the Rotor Rotation to 300 cycles/min

Leave the default alloy Carbon steel G10100 (generic) as the contact surface

Inout

D 7N L2 |[Red me &[4t Mhims | S RE
Navigator L o+ X
Corrosion Rates.oad* |
b“ Streams
=& CRof carbon steel
@, Single CR J Variable Value
- & CRuvsflow < Stream Parameters
_ @, Static Flow, 25C L?_I Stream Amount (L) 10000.0
@, Turbulent Flow, 25C I— Deensity correlation Fixed condition
@; Varying Flow, 25C l— Fixed: Temperature (*C) 25.0000
@! Static Flow, 02 L Fixed: Pressure (atm) 1.00000
@ Static Flow, 02 and C02 Temperature (*C} 25.0000
300 rpm Flow, 02 and CO2 Pressure (atm) 1.00000
o Calculation Parameters
Flow Type Rotating Cylinder
Rotor Diameter (cm) 200.000
Rotor Retation {cycle/min} 300.000
Effect of FeCO3 / FeS Scales
= Inflows (mg/L)
Actions B oax H20
Actions 0z
coz
& Contact Surface
Carbon steel G10100 (generic)
Flot Template Manager T

Description (& Definition [}l General Corr. Rate @il Localized Corr. |l Polarization Cur * | *

Survey by

Composition - Specs...

Then by [optional]
Composition - Specs...

Wary
(®) Independently

() Together

Calculate @

Summary

Agueous (H+ ion) Databanks
Corrosion (AQ)
Agueous (H+ ion)
Redox selected
Using K-fit Polynomials
T-span: 25.0 - 225.0
P-span: 1.0 - 1500.0
lzothermal Calculation
25.0000 °C 1.00000 atm

Calculation not done

Composition survey:
oz
Range 1.0e-6 to 10.0 mg/L
Logarithmic Scale
No. steps 10

Composition survey
coz
Range: List with 2 points
(0.0, 0.6 mgiL)

8. We are ready to perform the calculation. Click on the Calculate button or press the <F9> key
9. ltis time to save your file (File >Save as...) or using the save icon in the tool bar. You can save it under
the same file created in the previous example named Corrosion Rates.
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Analyzing the Results

Click on the General Corr. Rate tab ( il General Corr. Rate ) This tab displays a plot showing the results of
corrosion rate and pH.

Right-mouse click on the X-axis and change it to Logarithmic Scale

Right-mouse click on the Y-axis and change it to Logarithmic Scale

Right-mouse click on the pH curve and select Remove Series

Double click on the CO2=0.6 mg/L. This will open a new window. Change the color to blue.

el

Curve Properties ? X

Curves

Cormrosion Rate [mm/Ar] - CO2 =0.0ma/L
Corrogion Rate [mm/r] - COZ = 0.6 mg/L

Auto Legend Text

|Corros|0n Rate [mm.yr] -CO2 = 0.6 mg/L

Auto Line Style [ Auto Line Weight [ Auto Color
—— [

Auto Symbol [ Auto Scaling Factor [ Hidden

Filed Trangle D:
Cancl Aoply Help

The plot should look like the image below.

& Description [£¥ Definition @l General Corr. Rate | Localized Corr. [l Polarization Cur * | *
‘ a s |8 & | ViewData Wariables Options

Te+02 T T T T

_— Corrosion Rate [mmiyr] - C02 = 0.0 mgiL

—a&— Corrosion Rate [mmiyr] - CO2 = 0.6 mg/L

1e+01

1e+00

Corrosion Rate [mm/dyr]

1e-01

1e-02
7

The 0.6 mg/L CO:2 curve shifted to higher values at low Oz concentrations compared to no COz presence. Now,
when comparing the corrosion rate for the 0.6 mg/L CO2 concentration at 300 rpm vs static conditions, the rates
are 0.067 mm/year and 0.008 mm/year respectively. The effect of shear at high Oz concentrations (right side

of the plot) is also pronounced. Corrosion is still dominated by O: attack, but the rate is now over 10 mm/year,
about 100x greater than the static conditions.
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8.3. Gas condensate corrosion

Example 52: Condensed overhead gas and mitigation strategies
An alkanolamine gas sweetening plant has corrosion problems in the condensed overhead gas.

Diethanolamine is used to neutralize an acid gas containing carbon dioxide (CO2) and hydrogen sulfide (H2S).
The diethanolamine is regenerated and the acid gases are driven off in a stripper. The off gas from this stripper
is saturated with water vapor. As these gases cool, they will condense. This condensate can be very corrosive.
The plant’s service life can be shortened considerably due to these condensed acid gases.

In this example, you will calculate the gas dew point temperature, remove the condensed aqueous phase and
perform a Corrosion Rate calculation with the condensed water. Lastly, you will consider mitigation strategies
for the pipes.

You are introducing fluid velocity and liquid condensation into the calculation. The software uses a diffusion
layer model to compute mass transfer to and from corroding surfaces. Higher rates produce thinner layers,
resulting in faster mass transfer rates, and thus higher corrosion rates. The liquid condensation point is
straightforward; it calculates the temperature (or pressure) where the first liquid drop forms.

Starting the Simulation

Use the inputs and parameters from the table below to create the stream’s composition. Certain inputs, such
as the name style, units, etc. will require further adjustments, and will be described as necessary.

Corrosion Rate Calculation
Stream Composition and Conditions

Calculation Settings

Stream Name Gas condensate Stream Amount 1e5 moles

Name Style Display Formula Temperature 38°C

Unit Set Metric, Batch, Mole Fraction Pressure 1.2 atm

Framework AQ H20 Calculated (mole%)
Calculation Type Corrosion Rates CO2 77.4

Survey Single Point Rate N2 0.02

Flow Type Pipe Flow H2S 16.6

Pipe Diameter 10 cm CH4 0.5

Pipe Flow Velocity 2m/s C2H6 0.03

Contact Surface Carbon Steel G10100 (generic) | C3H8 0.03

Add a new Stream

Click on the new Stream and press <F2> to change the name to Gas Condensate
Select the AQ thermodynamic Framework

Click on the Names Manager Icon and select the Formula option

Click on the Units Manager Icon, and select Metric, Batch, Mole Fraction

Enter the composition, temperature and pressure of the stream given in the table above

No a ks~ wbdhd -

Go to the Add Calculation button and select Corrosion Rates calculation or by selecting the Add
Corrosion Rates icon in the Actions Pane.

8. Go to the Survey by option and select Single Point Rate. Change the name to Gas Cond. Dew Point.
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9.

Change the Flow Type from Static to Pipe Flow.

10. Specify the Pipe Diameter = 10 cm and the Pipe Flow Velocity = 2 m/s.

11

. Leave the default alloy Carbon steel G10100 (generic) as the contact surface

Your screen should look like the image below.

& OLl Studio - [Corrosion Rates.oad*] — [} s
B File Edit Streams Calculations Chemistry Tools View Window Help -
DEE| & B TR 11 vasSol2 | Red mels 0| MEL G REN
Navigator L o« x
B
Documentt
Corrosion Rates.oad® Definition [}l General Corr. Rate [l Localized Corr. [{ll Polarization Curve [ Report [ *°*
6“’ Streams Sy
- CRof carbon steel | (Al (fakie ~ - -
i & CRvsflow = Stream Parameters Single Point Fate  » | | Specs...
Stream Amount {mol} 1.00000e5 .
=-& GasCondensate - ol Thenby [optional
+@, Gas Cond. Dew Point o Temperature ("C) 3g.0000
®| Pressure (atm) 1.20000 Specs...
= Calculation Parameters Wary
Calculate Temperaturs Independently
Flow Type Fipe Flow Together
Pipe Diameter (cm) 10.0000
Pipe Flow Velocity (m/s) 2.00000 Caleulste &8
Effect of FeCO3 / FeS Scales Include g
umnmary
= Inflows (mole %)
H20 5.42000 Unit Set: Metric (mole fraction) ~
coz T7.4000 Automatic Chemistry Hodel
Actions L - x utornatic Chemistry Model
st NZ 0.0200000 Agueous (H+ ion) Databanks:
HETETE H2s 16.6000 b Corrosion (AQ)
CHA 0.500000 Aquecus (H+ ion)
Redox selected
C2He 0.0300000 Using K-fit Polynomials
C3H8 0.0300000 T-span: 25.0 - 225.0
Fe 00 P-gpan: 1.0 - 1500.0
ﬂ Dew Foint Calculation
1.20000 atm
= Contact Surface 37.5851°C
Carbon steel G10100 (generic) i
Plot Template Manager G om (g ) Calculation complete
Single Point
No secondary survey selected
W Polarization Curve Range
Range -2.0t0 2.0V (SHE)
Input 1 Step size 001V (SHE)
No. steps 400 [¥]
Advanced Search Add as Stream Expart
Save
For Help, press F1 @ NUM

Now that the gas condensate stream is created, the next task is to isolate the condensed water at the dew point

temperature.

12. Click on the Specs button. This will open a new window

13. Under the Category section, select Calculation Type

14. Change the Type of Calculation from Isothermal to Dew Point. Make sure that radio button for temperature
is selected since we are going to calculate the Dew Point temperature for this example. Then click OK.

15. Now, we are ready to perform the calculation. Click on the Calculate button or press the <F9> key

16. It is time to save your file (File >Save as...) or using the save icon in the tool bar. You can save it under

the same file created in the previous example named Corrosion Rates.
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Analyzing the Results

1.

2.

Click on the General Corr. Rate tab ( @l General Corr. Rate ).

Click on the View Data button to see the results in tabulated form.

Temperature | Corrosion Rate pH
“C mmiyr
1 37.5851 0.704502 | 3.92719

Notice that the calculated dew temperature is 37.6°C, corrosion rate is 0.7 mm/year, and the dew point pH

is 3.9. To further interpret the results of this calculation, we are going to study the polarization curve.

Click on the Polarization Curve tab (i Polarization Curve ) Before interpreting this plot, we will format it for
easy viewing.

Click on the Options button. This will open a new window.

il Polarization Curve [ Report [ *|*

ﬂ = Wiew Data Wariablez

Under the Category section select X axis. Change the Minimum to 1e-6 and Maximum to 1e6.
Now, select Y axis. Change the Minimum to -1.5 and Maximum to 1.5. Then click OK.

Click on the Variables button. This will open a new window.

b1 Polarization Curve [ Report f *|*

ﬂ E] Yiew Data Optiong

Remove the following variables by unchecking them. See image below. Then Click OK.

Select Data To Plot ? *
Survey Poirts & Reactions

Half-Reactions

02 +4H(+) = 2H20 - 42
Peak Cument Density

Clear all reactions Select all reactions

Cocel | | homy || b
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9. Your polarization curve should look like the image below.

Definition ([l General Corr. Rate [l Localized Corr. il Polarization Curve @ Report { *

a & & =) | viewData Optians

15
13
11

0af —

Ty T T

_2H20 =02+ 4H(+) + de
¥ Corrosion Potential

Fe=Fe(2+) + Ze

HE)=05H2 - ¢

H2C03 = 0.5H2 + HCO3(-) - &

— H20=0.5H2+ OHC) -2
H25aq = 0.5HZ = HS(-) - & B

— HS(}=05H2+5(2) -

Potential (v (SHE))

Current Density (A/sq-m)

You can click and drag the legend of the polarization curve to your desired position.

This is a measured potential vs. current density plot. The anodic portion (green curve) is the carbon steel. There
are cathodic reactions. The sum of the cathodic currents adds up to the anode curve at a single point: The
corrosion potential (represented by the inverted red triangle V) with a value of -0.43 V vs SHE. At the corrosion
potential, the anodic and cathodic currents are equal, and this value is also known as the icorr. For this example,
icorr=0.61 A/m2.

Notice that the cathodic reaction that contributes the most to corrosion is H2CO3 ( ). The next

contributors are HzS ( ) and HS-'(blue line) equally. After that is H* (turquoise line). Water reduction
(light blue line), contributes the least to corrosion.

Mitigation Strategies

There are several mitigating solutions to this corrosion problem.

One is adding insulation to prevent temperature drops. The dew point is very close to the overhead gas
temperature so this may not be a suitable option. Adding heat to keep the temperature above the dew point is
usually considered along with insulation.

Changing the chemistry to change the partial oxidation and reduction processes is also an option.

Changing alloys could mitigate the corrosion problems as well.

We will explore the change of chemistry and change of alloys for this example.
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Adjusting the solution chemistry

The condensate pH is approximately 3.9. We can try to add a base to increase the pH. In this section, we will
add Diethanolamine to raise the pH to 7.5.

Single Point— Set pH Calculation

1. Click on the ‘Gas Condensate’ stream and go to the Add Calculation button and select Single Point
calculation or by selecting the Add Single Point icon in the Actions Pane.

Change the name to DEA using the <F2> key.

Add DEA in the inflows grid. (It should have changed to the formula name: HN(C2H40OH)2

Go to the Type of Calculation option and select Set pH

Change the Target pH to 7.5

Click on the drop-down arrow for the pH Base Titrant and select DEA (or HN(C2H40OH)2)

oghrwN

We have set up the calculation to adjust the amount of DEA to match the target value of pH=7.5.

Your screen should look like the image below.

| WY File Edit Streams Calculations Chemistry Tools  View Window Help
[E =y = PN | 1Mvasol2 Red w4t M| O REN
|| Mavigator - X
[ : A
Documentt
| Corrosion Rates oad* Description [£¥ Definition B Report LJ File Viewer
| 6“ Streams T f caloulat
- & CR of carbon steel | Yanatic LETE ~ vpe ol aledEten
o & CRusflow = Stream Parameters SetpH | | Specs..
. & Gas Condensate Stream Amount (mol) 1.00000e3
@ Gas Cond. Dew Paint Temperature (°C) 38.0000 Caloulate &
_____ A DEA Pressure (atm) 1.20000 SumEm
e Calculation Parameters
(=] Target pH 7.50000 Unit Set: Metric (mole fraction)
yse Sﬂng‘é Titrant No Automatic Chemistry Model
pH Acid Titrant HCL Agueous (H+ ion) Databanks:
pH Base Titrant HN(C2H40H)2 Agueous (H+ ion)
Using K-fit Polynomials
I i B oW (molege) T-span; 25.0 - 225.0
| H20 5.42000 P-span: 1.0 - 1500.0
| coz 77.4000 Set pH Calculation
Nz 0.0200000 38.0000 °C
|| Actions L - x 120000 atm
Actions s 166000 5 TargetpH  7.50000
! CHa 0.500000 Acid Titrant:
C2HS 0.0300000 Base Titrant: HN(C2H40H)2
C3HE 0.0300000 Calculation not done
| HN(C2H40H)2 00
Flot Template Manager L o« X
|
v
Input
5 Advanced Search Add az Stream Expart
ave
For Help, press F1 - - ) - @& NUM

7. Now, we are ready to perform the calculation. Click on the Calculate button or press the <F9> key

8. ltis time to save your file (File >Save as...) or using the save icon in the tool bar. You can save it under
the same file created in the previous example named Corrosion Rates.
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Analyzing the Results

1. Check the summary box to analyze the results.

Summary

Unit Set: Metric (mele fraction)

Automatic Chemistry Model
Agueous (H+ ion) Databanks
Agueous (H+ion
Using K-fit Polynomials
T-span: 25.0 - 225.0
P-zpan: 1.0 - 1500.0
Set pH Calculation
38.0000°C
1.20000 atm
cid Tirant: H
Total: 0.0 mole %
Base Titrant: HN(C2ZH40H)2
Total: _5.96844e-4 mole %

Phase Amounts
Aguecus  31.6062 mol
Vapor 939568.5 mol
Solid 0.0 mol

Aquecus Phase Properties
pH 7.50001
lonic Strength  0.0160370 mel'maol
Density 1.02643 g/ml

The pH is set to 7.5 and the inflow of DEA to the total gas is approximately 5.97e-4 mole%.

The DEA concentration in the condensing water and the amount remaining in the vapor phase can both be
viewed in the Report tab.

2. Click on the Report Tab and go to the Total and Phase Flows and Species Output tables

Total and Phase Flows {Amounts)

colurnn Filter Applisd: Only Non Zero Values

Total Agueous Vapor
mal mol mal
Mole (True) 1.00000e5 31.6062 99968.5
Mole (App) 1.00001e5 32.0477 99968.5
g a g
Mass 4.08064e6 642138 4.08000e6
L L L
Volume 2.11456e6 0.625619 2.11456e6

Species OQutput (True Species)

Row Filter Appiisd: Only Mon Zero Vsluzs

oolumn Filter Applied: Gnly Non Zero Values

Total Aqueous Vapor
mole % mole % mole %
CO2 77.3994 0.0416672 774239
H25 16.5999 0.0271211 16.6052
H20 5.41962 96.6827 5.30076
CH4 0.489999 1.37153e-5 0.500157
C2HG 0.03 9.08534e-7 0.0300094]
C3HE 0.03 7.06434e-7 0.0300094]
N2 0.02 2.56549e-7 0.0200063
NH2{C2H40H)2(+1) 5.02996e-4 1.58145
HCO3-1 3689%e-4 1.16718
C5H10HO04-1 6.67352e-5 0217474
H5-1 5.7612e-5 0182281
HN(C2H40H)2 2.51153e-5 0.0778779 5.01249e-7
C03-2 3.B6988e-6 0.0122441
52 3.93925e-9 1.24636e-5
‘OHA 6.55471e-10 2.07387e-6
H+1 247871e-11 7.8425e-8
Total (by phase) 100.0 100.0 100.0
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Recalculating the corrosion rate with DEA

We now can recalculate the corrosion rate with DEA in the stream. This represents some DEA entrained in the
vapor phase as the gas leaves the regenerator.

1. Copy ‘Gas Cond. Dew Point’ corrosion calculation, and paste it under the stream ‘Gas Condensate’

@n

mole%)

$ Streams

& CR of carbon steel
& CRusflow

£ & GasCondensate

& DEA

¢ Streams

& CRof carbon steel

& CRuvsflow

Bé
Do @ Gast Armange
Arrange > i dy DEA Cut
Cut Copy
Copy Paste
Paste o
Delete Rename
G Add As Stream

Change the name to Gas Cond. Dew Point DEA using the <F2> key
Add DEA to the inflows gird and give it the value computed in the set pH calculation

4. Leave the default alloy Carbon steel G10100 (generic) as the contact surface

Your screen should look like the image below.

O OLI Studio - [Corrosion Rates.oad

"l

B File Edit Streams Calculations Chemistry Toels View Window Help

- 8 %

Description Definition il General Corr. Rate [l Localized Corr. [l Polarization Cur| * | *

For Help, press F1

D= - TR | L1vasSolz Ret mesffft st S| S BEF Y
Navigator g o x
Document1 ‘ z
Corrosion Rates.0ad* |
6“ Streams
- # CR of carbon steel | Variable Value
G-d CRvsflow =~ Stream Parameters
- & GasCondensate Stream Amount (mol) 1.00000e5
@ Gas Cond. Dew Point (o] Temperature (*C) 38.0000
@ DEA L] Pressure (atm) 1.20000
i..[/ Gas Cond. Dew Point DEA - Calculation Parameters
Calculate Temperature
Flow Type Pipe Flow
Pipe Diameter (cm) 10.0000
Pipe Flow Velocity (m/s) 2.00000
Effect of FeCO3 / FeS Scales Include
< Inflows (mole %)
Hz0 541540
coz2 77.4000
LS roex Nz 0.0200000
GEITTE H25 16.6000
CH4 0.500000
C2HE 0.0300000
C3HB 0.0300000
HN(CZ2H40H)2 5.06844e-4
Fe 0.0
= Contact Surface
Plot Template Manager L o+ x
Carbon steel G10100 (generic)
Input
5 Advanced Search Add as Stream Expart
ave

- Range

Survey by

Single Paint Rate =

Thenby  [optional)

~

Specs.

WVary
Independzntly

Together

Calculate

Summary

Unit Set: Metric (mole fraction) ~

Automatic Chemistry Model
Agueous (H+ ion) Databanks:
Corrosion (AQ)
Agueous (H+ ion)
Redox selected
Using K-fit Polynomials
T-span: 25.0 - 225.0
P-span: 1.0 - 1500.0
Dew Point Calculation
1.20000 atm

Calculation not done

Single Point
No secondary survey selected

Polarizatien Curve Range
-2.0t0 2.0V (SHE)
Step size  0.01 W (SHE)

No. steps 400

Metal: Iron/Mild steel

@ NUM

9. Now, we are ready to perform the calculation. Click on the Calculate button or press the <F9> key

. (DEA =5.96844e-4

10. It is time to save your file (File >Save as...) or using the save icon in the tool bar. You can save it under
the same file created in the previous example named Corrosion Rates.
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Analyzing the Results

1. Click on the General Corr. Rate tab ( #ll General Corr. Rate ),

2. Click on the View Data button to see the results in tabulated form.

Temperature

Corrosion Rate pH

*C

mmiyr

1 33.5105

1.10650 | 7.59719

Notice that the corrosion rate has decreased from 0.7 mm/year to 0.48 mm year. The pH is 7.6, and it

remained similar to the target value of 7.5. Based on these results neutralizing the pH had a partial effect

on corrosion reduction.

Changing the Alloy

Since treating the acid gas with a base is probably not a good idea for metal hydroxides, perhaps we can
change the alloy. We will add a new corrosion rates calculation and test different alloys.

13%Cr Stainless Steel

1. Copy ‘Gas Cond. Dew Point DEA’ corrosion calculation, and paste it under the stream ‘Gas Condensate’

2. Change the name to Gas Cond. 13%Cr using the <F2> key.

Notice that in the inflows, copying and pasting does not bring the DEA and its composition to this corrosion
calculation. The reason why is because the DEA was added at the corrosion rate calculation level, and not

at the stream level.

3. Change the contact surface to 13%Cr stainless steel

Your screen should look like the image below.

D & B@ K| Lvasol? Red me sl s | MEE S EE NS
MNavigator o~ X
%
Document1 ‘ |
Corrasion Rates.oad” | Description &% Definition {lj General Corr. Rate [{l] Localized Corr. [{ll Polarization Cur * | *
&b Streams Survey by
& CR of carbon steel H (bl atac -~
G-& CRvsflow < Stream Parameters Single Point Rate = Specs..
H Stream Amount (mol) 1.00000e5
=-# Gas Condensate " (ol Thenby [optional]
B Gas Cond. Dew Point O Temperature ("C) 38.0000
-4 DEA @ Pressure (atm) 1.20000 Specs.
-l Gas Cand. Dew Point DEA & Calculation Parameters Vary
‘.. Gas Cond. %12Cr Calculate Temperature Independently
Flow Type Pipe Flow Together
Pipe Diameter (cm) 10.0000
Pipe Flow Velocity (mis) 2.00000 Caloulate
Thermal Aging Temperature (°C) 399.000 Surmmary
Thermal Aging Time (hr) 0.0
< Inflows (mole %) Unit Set: Metric (mole fraction)
Hz0 5.42000 Automatic Ch iry Model
“Actions e - x utomatic Chemistry Mode!
Actions coz 77.4000 Aqueous (H+ ion) Databanks:
N2 0.0200000 Corrosion (A0
Hos 16.6000 Aqueous (H+ ion)
- Redox selected
Cha 0.500000 Using K-fit Polynomials
C2HE 0.0300000 T-span: 25.0 - 225.0
caHe 2.0300000 P-span: 1.0 - 1500.0
Dew Point Calculation
Fe 00 120000 atm
Calculation not done
= Contact Surface
Plot Template Manager L +x
| | Fe(86.850)Cr(13.000)C(0.150) ¥ Single Point
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4. Now, we are ready to perform the calculation. Click on the Calculate button or press the <F9> key

5. ltis time to save your file (File >Save as...) or using the save icon in the tool bar. You can save it under
the same file created in the previous example named Corrosion Rates.

Analyzing the Results

i. Click on the Report tab to see the results. (You may need to use the €« » buttons to move the tabs and
find the Report tab).

ii. Go to the Calculated Rates table

il General Corr. Rate [l Localized Corr. (il Polarization Curve [l Depletion F‘E

Jump to: | Caleulation Summary w @ 8 Customize Export
Calculated Rates "
Corrosion Rate 0.0622463 mmiyr
Corrosion Potential -0.314266 V (SHE)

Repassivation Potential 2.0 V{SHE)
Corrosion Current Density 0.0566434| Alsg-m

The corrosion rate of 13%Cr is one order of magnitude lower when compared to the corrosion rate for
Carbon Steel, i.e. at 0.06 mm/year for 13%Cr vs 0.7 mm/year for Carbon Steel. This is consistent with the
use of 13% Cr to protect against CO2 corrosion.

iii. Click on the Polarization Curve tab (il Polarization Curve ),

iv. Click on the Variables button. This will open a new window.

bl Polarization Curve [ Report '] *

ﬂ E] Yiew Data Options

V. Remove the following variables by unchecking them. See image below. Then Click OK.

Select Data To Plot ? x

Survey Points & Reactions

Half-Reactions

Net Cument Density
[02 + 4H(+) = 2H20 - 4o
Peak Cument Density

Clear all reactions Select all reactions

Cance Povly e
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Vi.

The polarization curve (after some layout modifications) should look like the image below.

25 T T

Potential (' (SHE))

25 ! L ! L L ! L ! L ! L
% 7 % 7 % x % z % z % z %
a, Y ) |, ) |, ) Q, 9 CH N CY &
% > % B % % > O D % % % %
Current Density (Afsg-m)
13055 ={Felrix)=xe  —2H20=02+4H(+) + 42 ¥ Corrosion Potential

H2CO3 = 0.5H2 + HCO3(-) - & H20 = 0.5H2 + OHi-)- &

— HSION=05HZ=S(2)-e 02 + 4H(+) = 2H20 - de

H2Sag =0.5H2 + HS(-) - e

the option Alloy Layout Changes to modify the appearance of your plot.

The layout of the plot was changed for easy reading. To change layout, you can right click on any part of the plot and select

The corrosion potential of 13%Cr is -0.31 V vs SHE and the corresponding corrosion current icor=0.06 A/m?2.
The icorr for Carbon Steel was 0.61 A/m?, this means that 13%Cr is 10x more resistant to corrosion under the
same conditions.

Stainless Steel 304

1.

Copy ‘Gas Cond. Dew Point DEA’ corrosion calculation, and paste it under the stream ‘Gas Condensate’
2. Change the name to Gas Cond. SS304 using the <F2> key
3. Change the contact surface to Stainless Steel 304

Your screen should look like the image below.

4. Now, we are ready to perform the calculation. Click on the Calculate button or press the <F9> key
5.

6.‘ Streams
@& CR of carbon steel H Variable Value
& CRuvs flow = Stream Parameters
& Gas Condensate Stream Amount (mol) 1.00000eS
-B@ Gas Cond. Dew Point ©| Temperature (*C) 38.0000
@ DEA L] Pressure (atm) 1.20000
@ Gas Cond. Dew Point DEA = Calculation Parameters
@ Gas Cond. %13Cr Calculate Temperature
Flow Type Pipe Flow
Pipe Diameter (cm) 10.0000
Pipe Flow Velocity (m/s) 2.00000
Thermal Aging Temperature (*C) 399.000
Thermal Aging Time (hr) 0.0
= Inflows (mole %)
H20 5.42000
Bctions L coz 77 4000
o N2 00200000
H2S 16.6000
CH4 0.500000
C2HE 0.0200000
C3H8 0.0200000
Fe 0.0
Plot Template Manager g~ x = - Contact Surface
| Fe(741.930)Cr(15.000)Ni(3.000)C

Survey by

Single Paint Rate = Specs...

Thenby [optional)

Specs
WVary
Independently
Together
Calculate
Summary

Unit Set: Metric (mole fraction)

Automatic Chemistry Model
Agueous (H+ ion) Databanks:
Corrosion (AQ)
Agqueous (H+ ion)
Redox selected
Using K-fit Polynomials
T-span: 25.0 - 225.0
P-span: 1.0 - 1500.0
Dew Point Calculation
1.20000 atm

Calculation not done

Single Point

It is time to save your file (File >Save as...) or using the save icon in the tool bar. You can save it under

the same file created in the previous example named Corrosion Rates.
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Analyzing the Results

1. Click on the Report tab to see the results. (You may need to use the €4 » buttons to move the tabs and

find the Report tab).
2. Go to the Calculated Rates table

Corrosion Rate 3.57108e-3 mmiyr
Corrosion Potential -0.172583 V {SHE)
Repassivation Potential =2.0 V(SHE)
Corrosion Current Density 3.29499e.3 Alsg-m

The corrosion rate of 304 SS is now 0.0036 mm/year. This is a negligible value.

3. Click on the Polarization Curve tab (il Polarization Curve ),
4. Click on the Variables button. This will open a new window.

5. Remove the following variables by unchecking them. See image below. Then Click OK.

Select Data To Plot ? x
Survey Points & Reactions

Haff-Reactions

=02+ 2H(#) + 42
osion Potential

H20 = 0.5H2 + OH(-

H25aqg = 0.5H2 + HS(-) -e
Met Currert Density

Peak Curent Densty
1530400 = {Fe Cr.Ni}{c+) + xe

Clear all reactions Select all reactions

Apply Help

Potential (V/ (SHE))

Current Density (A/sg-m)

——13Cr 88 = {Fe,Cribes) + xe
H2C03 = 0.5H2 + HCO3i-) - &

2H20 = 02 + 4H(=) + 42
H20 = 0.5H2 + OH(-)- &
02+ 4H(+) = 2H20 - e

¥ Corrosion Potential

———H2Sag = 0.5H2 + HS(-) - ¢

— HSION=0SH2+S5(2)-e

The layout of the plot was changed for easy reading. To change layout, you can right click on any part of the plot and select
the option Alloy Layout Changes to modify the appearance of your plot.

The corrosion potential of SS304 is -0.17 V vs SHE and the corresponding corrosion current icor=3.3e-3 A/m2.
With this low corrosion current density, sour gas regeneration can be remedied using a higher-grade alloy such

as SS304.
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Section 9. Thermal Aging and Variations in Alloy Composition

9.1. Overview and Basic Terminology

Localized corrosion of engineering alloys is a complex function of metallurgical factors and environmental
conditions. Among metallurgical factors, effects of thermal instabilities are of interest for assessing the
performance and expected service life of industrial components fabricated from nominally corrosion-resistant
stainless steels and nickel-base alloys.

Fabrication processes such as heat treatment and welding are known to introduce microstructural changes that
may affect both the mechanical and corrosion performance of an alloy. In particular, thermal instability of
stainless steels and nickel-base alloys may lead to the formation of complex metal carbides of the type MsCx,
M7Cs, MeC, or M23Cs in which the metallic component M represents Cr, Mo, W, and Fe. The carbide is
chromium- or molybdenum-rich depending on the carbide type, which in turn depends on the alloy composition
and temperature. Also, various chromium-rich intermetallic phases can form in many alloys. Precipitation of
such phases may occur at temperatures ranging from 500 to 900 °C depending on alloy composition. Formation
of grain boundary carbides often results in the depletion of chromium and, possibly, molybdenum in the vicinity
of the grain boundary because of the slow diffusion of substitutional elements such as chromium relative to the
interstitial carbon.

Similarly, the corrosion resistance of welded components may be affected by the segregation of alloying
elements and precipitation of intermetallic phases, carbides or nitrides in the solidified weld and unmixed zones
as well as the precipitation of carbides and other phases in the heat-affected zone adjacent to the weld.

Sensitization of Fe-Ni-Cr-Mo alloys and its effects on intergranular attack and intergranular stress corrosion
cracking is the most directly observed effect of Cr depletion. It may result in intergranular attack and
intergranular stress corrosion cracking. Localized corrosion can be also affected by Cr and Mo depletion.

Corrosion Analyzer contains the following technology that can help address these issues:

e A grain boundary microchemistry model for predicting the chromium and molybdenum depletion in the
vicinity of grain boundaries as a result of carbide formation;

¢ An electrochemical model for calculating the repassivation potential of Fe-Ni-Cr-Mo-W alloys as a function
of alloy composition and environmental conditions including temperature and concentrations of aqueous
solution species;

e A procedure for calculating the observable repassivation potential that corresponds to macroscopic
localized corrosion by applying the electrochemical model to the depletion profiles and performing
suitable integration.

More details about this technology are described by Anderko et al. (2008), Tormoen et al. (2009), Anderko et
al. (2009), and Sridhar et al. (2009).

Alloy Chemistry

Simulations can be performed, in general, for alloys that belong to the Fe-Ni-Cr-Mo-W-N-C family (i.e., for
stainless steels and nickel-base alloys).

Depletion profiles in the vicinity of grain boundaries and depletion parameters can be obtained for austenitic
alloys (including stainless steels and Ni-base alloys). Also, the effect of Cr and Mo depletion on localized
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corrosion can be calculated. This effect can be examined using the repassivation potential, which provides a
threshold potential for the stabilization of localized corrosion (Anderko et al., 2009).

For other alloys from the Fe-Ni-Cr-Mo-W-N-C family, the repassivation potential can be calculated if the alloy
composition is known. This also includes experimental alloys and separate phases that may be formed as a
result of various forms of heat treatment (Sridhar et al., 2009).

Calculation types

Thermal aging is an additional phenomenon that can be simulated within the framework of corrosion kinetics.
All calculations types and, in particular, survey types, that are supported for corrosion kinetics are also
supported in conjunction with the study of thermal aging.

If it is desired to make calculations on a thermally aged sample, the thermal aging temperature and time need
to be specified in the Calc Parameters section in the Definition tab. The default values are 399 °C for the
thermal aging temperature and 0.0 hours for the thermal aging time. If either of these default values is used, no
thermal aging effects will be predicted. Thus, by default, Corrosion Analyzer performs calculations on samples
that have not been thermally aged.

Thermal Aging Temperature Survey

This calculation makes it possible to vary the thermal aging temperature within a certain range. A fixed value of
thermal aging time is assumed as specified by the user. Typically, the temperatures for which thermal aging
effects can be observed range from ~500 °C to ~900 °C, with the effects being most pronounced in the middle
of this range.

Thermal Aging Time Survey

This calculation can be used to examine the effect of aging time at a fixed thermal aging temperature.
Output Specific to Thermal Aging

The following output can be generated:

e  Chromium and molybdenum depletion profiles, i.e., the variation of Cr and Mo concentration within the
grain as a function of grain boundary.

e The depletion parameter, which provides compact information on the extent to which the depletion
process reduces the grain boundary concentration below a certain critical value of, which can be defined
by well-known criteria for maintaining passivity (e.g. x;,. = 0.11 or 0.12). This parameter can be calculated
as the area of the depletion profile below the threshold concentration x,., divided by bulk Cr
concentration, x2,:

1 (7
66 == | (xtr =30 @)z
Cr Y0

where z* is the distance from the grain boundary that corresponds to the threshold concentration x;,.

e The repassivation potential, which is a key parameter for determining whether localized corrosion can
occur, may be affected by thermal aging in a rather complex way.
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9.2. Thermal Aging and Variations in Alloy Composition

We will show examples of simulating the effects of thermal aging on Fe-Ni-Cr-Mo-W-C-N alloys (i.e., stainless
steels and nickel-base alloys). Specifically, we will show how to predict:

1. Chromium and molybdenum depletion profiles in the vicinity of grain boundaries, which result from heat
treatment of austenitic alloys;

2. Depletion parameters for sensitized austenitic alloys, which provide an indicator of whether the alloy is
susceptible to intergranular corrosion.

3. Effect of thermal aging on the repassivation potential of austenitic alloys, which provides a threshold
condition for localized corrosion (pitting or crevice corrosion).

4. The repassivation potential of alloys with compositional variations that may or may not result from thermal
aging. This facility can also be used for bulk alloys that are not in the database or to hypothetical or
experimental alloys as long as they belong to the Fe-Ni-Cr-Mo-W-C-N family. An example will be given for
a duplex alloy, either annealed or thermally treated.

Example 53: Thermal aging of alloy 600

We will be studying the behavior of thermally aged alloy 600 in a dilute aqueous solution of sodium chloride,
and will simulate how the time of thermal aging affects alloy 600 at a fixed thermal aging temperature of 700°C.

Starting the Simulation

Thermal Aging Calculation

Use the inputs and parameters from the table below to create the stream’s composition. Certain inputs, such
as the name style, units, etc. will require further adjustments, and will be described as necessary.

Thermal Aging Calculation

Calculation Settings Stream Composition and Conditions
Stream Name Thermal Aging Stream Amount | Calculated
Calculation Type Corrosion Rates Temperature 60 °C
Survey by Thermal Aging Time Pressure 1 atm
Name Style Display Name H20 Default — 55.5082 moles
Unit Set Metric, Batch, Moles NaCl 0.04 moles
Framework AQ

Add a new Stream
Click on the new Stream and press <F2> to change the name to Thermal Aging
Select the AQ thermodynamic Framework (selected by default)

Click on the Units Manager Icon and select Metric, Batch, Moles

o M 0 Dnd =

Click on the Names Manager Icon and select Display Name
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Enter the stream composition and conditions specified in the table above
Go to the Add Calculation button and select Corrosion Rates
Note: Even though the thermal aging simulation facilities do not predict corrosion rates per se, they belong
to the category of corrosion kinetics and, therefore, they are included in the Corrosion Rates section of the
Corrosion Analyzer.
Select the Survey by Thermal Aging Time
Change the name from Rates to Alloy 600 using the <F2> key or by right-mouse click on the object and
select rename

10. Select Alloy 600 from the Contact Surface grid

11. In the Calculation Parameters grid, change the default value for the Thermal Aging Temperature to
700°C.
Note that the default value for the Thermal Aging Temperature is 399 °C, which is a low value so that, in

the default case, no effects of thermal aging are being calculated.

Your screen should look like the image below.

& OU Studio - [Corrosion Rates.cad®] — O e
B File Edit Streams Calculations Chemistry Tools View Window Help - 8 X
D=l A 11vasSol2 Ret m:3lif 3wt | ME: GPEEHE &
Mavigator L o~ X
Corrosion Rates.oad |
&% Streams Description Definition i General Corr. Rate [l Localized Corr. il Polarization Curve [ Report * | *
& CRof carbon steel
‘ CR vs flow J Variable Value - Survey by
& Gas Condensate = Stream Parameters Thermal Aging Time Specs...
0 Localized Corrosion StreamAmuun-t (mol) 55.5482 Than by lantional]
=& Thermal Aging Temperature (*C) 60.0000
. Alloy 600 Pressure (atm) 1.00000 Specs..
e Calculation Parameters Yary
Flow Type Static Independently
| Thermal Aging Temperature (*C) 700.000 | Together
Thermal Aging Time (hr}
- Inflows (mol) Calculate &8
Water [ 55.5082 | 5
ummary
Sodium chloride 0.0400000
Actions L - x Hickel 0.0 Unit Set: Metric (moles) ~
I A i Chemistry Model
= Contact Surface Agueous (H+ ion) Databanks:
Alloy 600 Corrosion (AQ)
Agueous (H+ ion)
Redox selected
Using K-fit Pelynomials
T-zpan: 25.0 - 225.0
P-zpan: 1.0 - 1500.0
Isothermal Calculation
Plot Template Manager L - x 50.0000 *C 1.00000 atm
Calculation not done
A Thermal Aging Time survey:
Range 0.0to 10.0 hr
Input Step size 2.0 hr
Mo. steps S W
Advanced Search Add as Stream Export
Save
For Help, press F1 @ MNUM

12. Now we need to specify the Thermal Aging Time range. Click on the Specs button. This will open a new

window.
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13. Under the Survey Range tab, change the range for Thermal Aging Time from 0 to 22 hours with an
increment of 4.4 hours (of 5 steps).

Rates Calculation ? x
Category Survep Range
-Var, 1 - Theimal Aging Time )
Polaizaion e Themel g Tine Fange U
- Themal Aging

- Caloulation Type
Caloulation Options

Delete

(® Lingar O Log (O Paint List
End Points

Step Size

Increment ® }

Mumber Steps 5 (@]

Select one, the other is
calculated

Cancel Lipply Help

14. Under the Category section, select the Thermal Aging option.

Rates Calculation ? s

Category Thermal Aging
Yar. 1- Thermal Aging T

Erp Directly from Correlation: @ Mo (O Yes
tlloy Composiion Wi

Caleulation Opiions Fe [8.534 | crliga0s | Mi[E032 |
Mosw [0 | c oo | ufo |
Carbide Stoichiometry:
Fe [0 | w7 | wifo |
Mavw [0 | &3 | uo |
Carbids Thamochemisty: A 405190 | B[zm7es |
Cr Diffusion Coefficient: oo ‘4 4016e-006 ‘ [#] |-243000 |
Mo, W Diffusion Coefficient D [0 | afo |
Cr Sensilzation Threshold wt%:[11 | Grein Sizs: [123 |

Revert to Default

Concel Lpply Help

In this Thermal Aging Category, you can change all parameters that are necessary for calculating chromium

and (if applicable) molybdenum depletion profiles. You can change:

e The alloy composition (for example, to analyze the effect of a different carbon content);

e The stoichiometry of the carbide phase that may form at the grain boundary; the typical carbide
stoichiometry is M7Cs or M23Cs (where M = Cr, Mo) but can be adjusted

e The parameters that define the equilibrium constant for the formation of the carbide

e The diffusion coefficient of Cr and, if applicable, Mo

e The threshold concentration of Cr for sensitization. This threshold concentration is used for calculating the
depletion parameter.

e The average grain size, which affects the process of healing of chromium depletion as a function of time
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Also, you can indicate whether the repassivation potential (Erp) should be calculated directly from the correlation
developed by Anderko et al. (2008), which expresses Erp as a function of alloy composition or not. If it is not
calculated directly, then the repassivation potential is calculated first using the alloy-specific parameters for the
alloy of interest and only the decrement of Erp (i.€., Ep, thermally aged — Erp, bulk alloy) iS obtained from the correlation.
This decrement is then added to the alloy-specific Er, value. This option is set by default to “No” because this
maximizes the accuracy of calculations for alloys that are already in the database.

15. For now, we will accept the default settings. Click OK.

16. Now, we are ready to perform the calculation. Click on the Calculate button or press the <F9> key

17. It is time to save your file (File >Save as...) or using the save icon in the tool bar. You can save it under
the same file created in the previous section named Corrosion Rates.

Analyzing the Results

1. Click on the Depletion Profile tab (4Bl Depletion Profile)

buttons to move the tabs.

If you don’t see it in your screen, use the «»

[6¥ Definition Wl General Corr. Rate [}l Localized Corr. (il Polarization Curve [ Report |l Depletion Profile D
| a % 9 [=] | wiewData “ariables

N r s % - Thermal Aging Time=0.0hr 1
14 + T Weight % - Thermal Aging Time=4.40000hr ]
13 L Cr Weight % - Thermal Aging Time=2.20000hr ]
Cr Weight % - Thermal Aging Time=13.2000hr
Cr Weight % - Thermal Aging Time=17.8000hr ‘_
Cr Weight % - Thermal Aging Time=22.0000hr —
Mo+W Weight % - Thermal Aging Time=0.0hr ]
Mo+W Weight % - Thermal Aging Time=4.40000hr
Mo+W Weight % - Thermal Aging Time=8.80000hr
Mo+W Weight % - Thermal Aging Time=13.2000hr
Mo+W Weight % - Thermal Aging Time=17.6000hr
Mo+W Weight % - Thermal Aging Time=22.0000hr
Corrected Cr Weight % - Thermal Aging Time=0.0hr
r Corrected Cr Weight % - Thermal Aging Time=4 40000hr 1
-— Corrected Cr Weight % - Thermal Aging Time=8.80000hr —-
L Corrected Cr Weight % - Thermal Aging Time=13.2000hr ]

WVeight %

L 1 |1 ———Eorpected Cr \Weight % - Thefma) Aging Tipes178000hy )y v 0 v 0 1y
[P ol -~ A A A e, R 8, & PN S
D gy | B—aforsplern ey Wegnetiy Al Thes22 890, o, | S, Y, By % % %, &,
Corrected Mo+W Weight % - Thermal Aging Time=0.0hr
Corrected Mo+ WeighiGai Ao damoDiseaicd 000hr
Corrected Mo+W Weight % - Thermal Aging Time=3.80000hr

[ R - -]
T T T T
1

Note: Since alloy 600 does not contain any molybdenum, the molybdenum curves will always be equal to zero.

This plot will show the concentrations of chromium and molybdenum within a grain as a function of the distance

from the grain boundary (in um). You will see that, for each condition, there are four lines:

e Cr weight %: concentration of Cr in weight %

e Mo+W weight %: sum of the concentrations of molybdenum and tungsten in weight %

e Corrected Cr weight %: concentration of Cr corrected for beam scattering and related effects so that it
can be directly compared with experimental results. The procedure for calculating the correction is
described by Anderko et al. (2009).

e Corrected Mo+W weight %: sum of the concentrations of Mo and W corrected in the same way as those
for Cr.

| 307



Let's customize the plot

2. Click on the Options button. This will open a new window.

3. Since alloy 600 does not contain Mo or W, eliminate the Mo+W curves. To do this, go to the Category

section and select the Curves option

4. Highlight the Mo+W weight % curves by pressing the Shift key and the down key (Shift + |). After

highlighting these curves, check the Hidden button.

Customize Plot

Category Curves

- General

i Legend

e

Crweight % - Thermnal Aging Time=17. 6000kt
W iz Crw/eight % - Theimal Aging Time=22 0000k

Auto Legend Text
Auto Line Style Auta Line Weight Auta Color
——— ] [= J — -
[ &uta Symbol Auta Scaling Factor Hidden
T

Cancel Apply Help

5. After hiding the Mo+W weight % curves, do the same for the Corrected Mo+W weight % curves. Then

click OK.

The plot should look like the image below.

L e o e e L

1656

16.0 -
155 -
15.0 -
145 -
14.0
135
13.0
125
12.0
1.5
1.0

Weight %

Cr Weight % - Thermal Aging Time=0.0hr
Cr Weight % - Thermal Aging Time=4 40000hr
Cr Weight % - Thermal Aging Time=8.80000hr

Cr Weight % - Thermal Aging Time=13.2000hr
Cr Weight % - Thermal Aging Time=17 &000hr
Cr Weight % - Thermal Aging Time=22.0000hr

Corrected Cr Weight % - Thermal Aging Time=0.0hr
Corrected Cr Weight % - Thermal Aging Time=4.40000hr

Corrected Cr Weight % - Thermal Aging Time=8.20000hr
Corrected Cr Weight % - Thermal Aging Time=13.2000hr
Corrected Cr Weight % - Thermal Aging Time=17.6000hr

Corrected Cr Weight % - Thermal Aging Time=22.0000hr ]

Grain Boundary Distance

The legend of this plot was modified for clarity. The border style of the legend was modified by double clicking on the legend,
and selecting None as the Border Style
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Differences between Uncorrected and Corrected Depletion Profiles

Now, let’s focus on the differences between the uncorrected and corrected depletion profiles. To have a clear
picture of the difference between them, we will analyze the depletion profiles results obtained at 4.4 hours of
thermal aging.

6. Click on the Options button, and select the Curves category
7. Highlight all curves except the ones labeled as:

Cr Weight % - Thermal Aging Time = 4.40000 hr, and
Corrected Cr Weight % - Thermal Aging Time = 4.40000 hr

Check the Hidden box, then click OK.

Your plot should look that the image below.

17.0 [ LA L B L L B L B B B LY B B B L L BN EL A B B
16.5 - B
16.0 [ ]
156 [ ]
15.0 [ ]
1456 [ ]
14.0 [ ]
136 [ ]
13.0 L Cr Weight % - Thermal Aging Time=4.40000hr J

125 - Corrected Cr Weight % - Thermal Aging Time=4.40000hr ]
12.0 - -
15[ ]
10 [ ]
105 [ ]
100 F .
g5 [ ]
o f ]
o L -
so :
756 ]
7.0 .
b5 | B
5.0 Lo vy

Sp e Sy S by dn T B Op S G G S Ay B Gy S A %
O Y T Y T o b o D o D D o D o D o %P,

Weight %

Grain Boundary Distance

In the obtained plot, you can see the difference between the two curves for small distances from the grain
boundary (roughly below 30 um). The corrected concentration is much more rounded in the vicinity of the
minimum because instrumental measurement effects. At larger distances from the grain boundary, there is no
difference between the two curves.
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Effect of Cr depletion on corrosion

After analyzing the depletion profiles, let's focus on the effects of Cr depletion on corrosion. We will do it by
analyzing two parameters — the depletion parameter and the repassivation potential.

To have more meaningful results, let's expand the range of thermal aging time and reduce the interval for
calculations.

PoON-~

Your screen should look like the image below

5. Now, we are ready to perform the calculation. Click on the Calculate button or press the <F9> key

6.

Copy the Alloy 600 corrosion calculation, and then paste it under the Thermal Aging Stream
Rename the new calculation as Alloy 600 — Cr depletion
Go back to the Definition tab and click the Specs button

In the Var.1 Thermal Aging Time category, change the Survey Range as follows: Start=0 hours, End= 60
hours with an Increment= 1 hour. Then click OK.

{4 OU Studio - [Corrosion Rates.oad™] — m] e
B File Edit Streams Calculations Chemistry Tools View Window Help - & X
DEE| § & BN | 1vasSol2 Red mlfs ot ME: G BEE
Navigator Lo+ X
£

Corrosion Rates.oad* |

655 Streams
+-# CRof carbon steel
-& CRvsflow

-# Gas Condensate
-& Localized Corrosion
[

-
-
-

Thermal Aging

Allay 600

2
72l Alloy 600-Cr depletion

£ >

Actions L - X

Actions

Flot Template Manager g oax
Save

For Help, press F1

J Variable
=
Stream Amount (moly
Temperature ("C)
Pressure (atm)
=
Flow Type
Thermal Aging Temperature ("C)
Thermal Aging Time (hr)
=
Water
Sodium chioride

=
Alloy 800

Input

Advanced Search

Add as Streamn

Stream Parameters

Calculation Parameters

Inflows (mol)

Contact Surface

Export

Value

Static

55.5482
60.0000
1.00000

700.000

55.5082
0.0400000

-~

Survey by

Thermal &ging Time

Thenby [optional]

Wary
Independently

Together

Calculate &8

Summary

Description Definition ﬂ General Corr. Rate ﬂ Localized Corr. ﬂ Polarization Curve @ Report ﬂ D

Specs...

Specs.

Unit Set: Metric (moles)

Automatic Chemistry Model
Agueous (H+ ion) Databanks:
Corrosion (AQ)
Agueous (H+ ion)
Redox selected
Using K-fit Polynomials
T-span: 25.0 - 225.0
P-span: 1.0 - 1500.0
Isothermal Calculation
60.0000 °C 1.00000 atm

Calculation not done

Thermal Aging Time survey:
Range 0.0t 60.0 hr
Stepsize 1.0hr
No. steps 60

No secondary survey selected

@B

Thermal Aging Temperature: 700.000  w»
C

NUM

It is time to save your file (File >Save as...) or using the save icon in the tool bar. You can save it under
the same file created in the previous section named Corrosion Rates.
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Analyzing the Results

1. Click on the Localized Corr. tab ( ¥l Localized Corr.y By default, this tab will show a plot of the corrosion
potential and repassivation potential.

Description [£¥ Definition [ili General Corr. Rate {lli Localized Corr. il Polarization Curve (@ Report fB D * "
‘ a & |8 [F] | ViewData | Variables

20 . T T T T T T '

18 - ]
16 - ]
14 s Corrosion Potential [V (SHE)] ]
1§ [ —a— Repassivation Potential [\ (SHE)] 1
08 ]
06 ]
04 ]

02k p
0. phoidk

02+ 4
04 i
06 F i
08 F 4
A0 F i
42+ 4
A4 F 4
16 F 4
18 F i

20 L L L . L . .
z B ] F 9 % 0 % 2 % 92 0% %

Corrosion Potential & Repassivation Potential

P

Thermal Aging Time [hr]

Let's add a new parameter to the plot: The Depletion Parameter.

2. Click on the Variables button. This will open a new window.

3. Look for the Corrosion Values section, click on the ‘+’ icon, and select the Depletion Parameter option.
Click on the >> button that belongs the Y2 Axis. This action will place the new variable under the Y2 Axis.
Then click OK.

Select Data To Plot 7 X

Curves

[#- Survey Variables ~ X Pis
& St P: eters > ‘Thenﬂal Aging Time
toCalculation Results
I+ Cormosion Values
i~ Comosion Cument Density
i~ Comosion Rate
e —aa
- Additional Stream Parameters

Y1 Auis |
Repassivation Potential
Comosion Potential

- Scaling Tendencies Y2 Asis [
imum Pit Cumrent Density

Molecular Totals
-MBG Totals - Totals

MADVE Tobolee Aemmm

) e e [ [ e e - -

[ Use short names
Hide zero species 7 Muis
Plot data which is only within temperature range Select -

Cancel Apply Help
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The plot should look like the image below.

20 —— T T "~ T " T " T " T " T " T " T "t T T* 1T T ] 1.05e-06
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= 12r n —m— Depletion Parameter [cm] (v2) ] 8.50e-07 2
E 10 o " 1 5.00e-07 2
Z . { | 3
& sl | n 1 7.50e-07 3
< " n 1700007 2
g 06w ol o
e gal | - 6.50e-07 3
S 0 L] _ A =
3 02 L n 6.00e-07 z
2 e L | "".."..“...' se0 08 - 5.50e-07 S
m E w
£ " n 1 500007 =
@ 02 N n e
5 A 1450007 &
“C- 04 ._:rummumummnmnnhmwummumu 1 400007 &
c 14 <3
7 06 | .i% 1350007 &
= 1 =
g 08 . 1300007 3
@
8 1.0 ]r 2560007 &
A2 l'- { 200607 2
14 r .'.- 4 150807 ~

16 - " - 1.00e-07

4sb L. 1 5.00e-08

8 S— [ ] [ ] ] I - .*h! . 0002400

o < b B S S % % B B % % & & B

Thermal Aging Time [hr]

Itis clear that the depletion parameter reaches a maximum for aging time of about 10 hours. Since the depletion
parameter is a measure of the susceptibility of an alloy to intergranular corrosion, we can expect that the alloy
will be most susceptible to intergranular corrosion at intermediate aging times. When the depletion parameter
is zero, intergranular corrosion or intergranular stress corrosion cracking are unlikely. The decrease of the
depletion parameter as a function of time is a manifestation of the phenomenon of healing of Cr depletion.

The repassivation potential shows a minimum as a function of aging time (see the option View Data). This
indicates that the tendency of the alloy to undergo localized corrosion is enhanced as a result of thermal aging.
However, the effect of thermal aging on the repassivation potential of alloy 600 is small (cf. Tormoen et al.,
2009, Anderko et al., 2009). The repassivation potential shows a minimum at low aging times (ca. 1-2 hours).
Therefore, the susceptibility to localized corrosion is enhanced the most for these aging times. It is noteworthy
that the maximum in the depletion parameter does not coincide with the minimum in the repassivation potential.
This is due to the fact that intergranular corrosion (which is related to the depletion parameter) and localized
corrosion (which is controlled by the repassivation potential) are subject to different mechanisms. A general
discussion of these differences is given by Tormoen et al. (2008).

In general, the alloy will be susceptible to localized corrosion if the corrosion potential exceeds the repassivation
potential. In the above example, the corrosion potential is low because we have no oxidizing agents in the
system. Therefore, the alloy will not undergo localized corrosion at the conditions of this example. However, a
rise in the corrosion potential due to the presence of oxidizing agents may cause localized corrosion.
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Example 54: Thermal aging of alloy 825

Alloy 825 is appreciably different from alloy 600 because it contains molybdenum and, also, substantially more
chromium in addition to other alloying elements.

In this example, we will simulate how the temperature of thermal aging affects alloy 825 at a fixed thermal aging

time of 15 hours.

Starting the Simulation

Thermal Aging Calcu

lation

Use the inputs and parameters from the table below to create the stream’s composition. Certain inputs, such
as the name style, units, etc. will require further adjustments, and will be described as necessary.

Thermal Aging Calculation

Calculation Settings

Stream Composition and Conditions

Stream Name Thermal Aging Stream Amount | Calculated

Calculation Type Corrosion Rates Temperature 95 °C

Survey by Thermal Aging Temperature | Pressure 1 atm

Name Style Display Name H20 Default — 55.5082 moles
Unit Set Metric, Batch, Moles NaCl 2.846e-3 moles
Framework AQ

1. Under the Thermal Aging stream add a new calculation rate. Go to the Add Calculation button and select
Corrosion Rates or select the Add Corrosion Rates icon in the Actions panel

N

select rename

o0k w

Select the Survey by Thermal Aging Temperature option

Change the stream composition and conditions to the specified values in the table above
Select Alloy 825 from the Contact Surface grid
In the Calculation Parameters grid, change the default value for the Thermal Aging Time to 15 hours

Change the name from Rates to Alloy 825 using the <F2> key or by right-mouse click on the object and

Note that the default value for the Thermal Aging Temperature is O hours, which means that no thermal
aging is considered by default.

Your screen should look like the image below

Navigator g - =
Corrosion Rates. oad” | =
&8 Streams < Description Definition il General Corr. Rate il Localized Corr. [l Polarization Curve [ Report fill D/ * | *
& CR of carbon steel
- & CRvsflow J Variable Value ~
- & GasCondensate = Stream Parameters
=& Localized Corrosion Stream Amount {mol) 555111 |
=& Thermal Aging Temperature ("C) 95.0000
v Alloy 600 Pressure (atm) 1.00000
v-Egg Alloy 600-Cr depletion & Calculation Parameters
A Alloy 825 Flow Type Static
Thermal Aging Temperature (“C)
| Thermal Aging Time (hr) 15.0000 |
< > = Inflows (mol)
Water | 555082 |
SEITE B X Sodium chioride 2.84500¢-3 |
SIS | Nickel 0.0
— Contact Surface
Alloy 825

=

Survey by

Themal Aging Temp. Specs

Thenby [optional]
Specs...

Wary
Independentiy

Together

Calculate £

Summary

Unit Set: Metric (molez) N

Automatic Chemistry Model
Agueous (H+ ion) Databanks:

Corrosion (AQ)

Agqueous (H+ ion)
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18. Now we need to specify the Thermal Aging Temperature range. Click on the Specs button. This will open
a new window.

19. Under the Survey Range tab, change the range for Thermal Aging Temperature from 550 to 900 °C with
increments of 50 °C. We will keep the other parameters at their default values. Click OK.

Rates Calculation ? x

Category Survey Range
War. 1 - Thermal Aging Temmpe

Polarization Curve Themal Aging Temperature Fiange Unit

Thermal Aging Selected Range

Calculation Tupe E

Caloulation Dptions New
Delete

(@) Linear Cilog () Paint List

End Paints
Star
Step Size
eremert @ } Select one, the other is
Mumber Steps 7 o) calculated

Cancel Apply Help

20. We are now ready to perform the calculation. Click on the Calculate button or press the <F9> key
21. ltis time to save your file (File >Save as...) or using the save icon in the tool bar. You can save it under
the same file created in the previous section named Corrosion Rates.

Analyzing the results

1. Click on the Depletion Profile tab (ﬂ Depletion Profiley 1t yo; don't see it in your screen, use the <>
buttons to move the tabs.

Since alloy 825 contains Mo in addition to Cr, you will see the depletion profiles for both Cr and Mo.

il General Corr. Rate (i Localized Corr. [illl Polarization Curve [ Report [l Depletion Profile | File Viewerm
| AR =B

“Thermal Aging Temperature=550.000°C
CrWeight % - Thermal Aging Temperature=500.000°C 1

CrWeight % - Thermal Aging Temperature=850.000°C

CrWeight % - Thermal Aging Temperature=700.000°C

CrWeight % - Thermal Aging Temperature=750.000°C

CrWeight % - Thermal Aging Temperature=300.000°C

Z CrWeight % - Thermal Aging Temperature=850.000°C B

g ul CrWeight % - Thermal Aging Temperature=900.000°C ]
Mo=V Weight % - Thermal Aging Temperature=550.000°C

gl Mo+ W Weight % - Thermal Aging Temperature=500.000°C ]
Mo+ Weight % - Thermal Aging Temperature=550.000°C

[ Mo=V Weight % - Thermal Aging Temperature=700.000°C 4
Mo+W Weight % - Thermal Aging Temperature=750 000°C

5 Mo+ Weight % - Thermal Aging Temperature=800.000°C b

Mo+ Weight % - Thermal Aging Temperature=850.000°C
oo iegn - Thermal Agng Temperature-900.000°C ]
’ Lov [y o Corpecled,CriNgiht % - Theyma] Aging BSS0000°C 4 L | Ly L0, L
0 & |z < ! ; Aoy R S & 7
D gy | By—apoagesi ey sFghefy Adg Thpersipe-sig iy, 3, h, B, % % %, &,

Corrected Cr Weight % - Thermal Aging Temperature=650.000°C

Correctsd Cr Weight % CrasmBotaitrpistante700 000°C
Corrected Cr Weight % - Thermal Aging Temperature=750.000°C
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For clarity, let’'s customize the plot by removing the corrected depletion profiles and leaving only the uncorrected
(or directly calculated) ones.

Click on the Options button, and select the Curves category, highlight the Corrected curves and check the
hidden box. Then click OK.

Customize Plot ? *

Category Curves
General
Legend
¥ s

&

Curves

Auto Legend Test
Auta Line Style Auto Line Weight Auto Color
[——] [e——] -]
[ Auto Symbol Auta Scaling Factor
Nane ~ =

Cancel Apply Help

Your plot should look like the image below

E Cr VWeight % - Thermal Aging Temperature=550.000°C
7 Cr VWeight % - Thermal Aging Temperature=500.000°C
Cr Weight % - Thermal Aging Temperature=650.000°C
Cr Weight % - Thermal Aging Temperature=700.000°C

Cr Weight % - Thermal Aging Temperature=750.000°C

Cr Weight % - Thermal Aging Temperature=800.000°C

— Cr Weight % - Thermal Aging Temperature=850.000°C

=2 Cr Weight % - Thermal Aging Temperature=300.000°C
-E, 13 B Mo+W Weight % - Thermal Aging Temperature=550.000°C
§ 1 [ 1 Mo+ Weight % - Thermal Aging Temperature=500.000°C
L ] Mo+W Weight % - Thermal Aging Temperature=550.000°C
9| a Mo+W Weight % - Thermal Aging Temperature=700.000°C
F E Mo+W Weight % - Thermal Aging Temperature=750.000°C
[ 7 Mo+W Weight % - Thermal Aging Temperature=800.000°C
I 1 Mo+W Weight % - Thermal Aging Temperature=850.000°C
51 1 Mo+ Weight % - Thermal Aging Temperature=800.000°C
3 % -
1 1 1 1 1 1 1 1 1 1
& e - & sy A & &, Z
% % % B Y9 %, 9 9% @ %,

Grain Boundary Distance
The plot was modified by right clicking on it and selecting the option Allow Layout Changes. This option allows to move and

rearrange the plot and legend. Additionally, the color of the lines was changed for each temperature in order to distinguish the
temperature effect.
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As shown in the plot above, the depletion profile is very narrow at the lowest temperature, i.e., 550 °C. On the
other hand, it becomes flat at high temperatures and it has a high minimum. The high minimum value is
particularly important because it indicates that the local depletion of Cr and Mo is much less severe at high
temperatures (due to much faster diffusion of substitutional elements and subsequent healing).

It should be noted that the Mo profile qualitatively parallels the Cr profile but has somewhat different slopes
because of differences in diffusion coefficients of Cr and Mo.

Effect of Cr and Mo depletion on corrosion
To look at the effect of Cr and Mo depletion on corrosion

3. Click on the Localized Corr. tab ( il Localized Corr.) By default, this tab will show a plot of the corrosion
potential and repassivation potential.

2-0_'|'|'|'|'|'|-|'|'|-|'|'|'|-|'|'|'|'|

16 [ ]

14 [ ]
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08F o PP —,
06| e«

[]_4 __ —
02 [ ]
ook ]
0o —:
V4 & A A A A A A A
06 L ]
08k ]
40k ]
42 L ]
14k ]
16 E ]
18k ]
20L .

Repassivation Potential & Corrosion Potential

I 1 L 1 L I I 1 I 1 L 1 I 1 I 1 I 1 I 1 I L
P S A F, F G B B O
O R R R e S NI R A T A

Thermal Aging Temperature [°C]

Let's add a new parameter to the plot: The Depletion Parameter.

4. Click on the Variables button. This will open a new window.

Look for the Corrosion Values section, click on the ‘+’ icon, and select the Depletion Parameter option. Click
on the >> button that belongs the Y2 Axis. This action will place the new variable under the Y2 Axis. Then click
OK.
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It is evident that both the depletion parameter and repassivation potential show their extreme values at
intermediate temperatures of thermal aging. In the case of the depletion parameter, it is a maximum and, in the
case of the repassivation potential, it is a minimum. This is in agreement with experimental data (Anderko et
al., 2009). Non-zero values of the depletion parameter indicate the possibility of intergranular corrosion. A
depression in the repassivation potential indicates an increased tendency for localized corrosion.
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9.3. Thermal Aging and Localized Corrosion of Annealed and Thermally Aged
Duplex Alloy 2324

In the previous examples, we used the Corrosion Analyzer's capabilities to predict the Cr and Mo depletion
profiles for austenitic stainless steels and nickel-base alloys. However, we are not limited to such calculations.

We can also use the Corrosion Analyzer to predict the localized corrosion behavior of other alloys and other
phases, including those that are not stored in the database. This facility is based on a generalized correlation
for predicting the repassivation potential of Fe-Ni-Cr-Mo-W-N alloys as a function of alloy composition (Anderko
et al., 2008). This correlation can be applied to both bulk alloys that are not in the database and to phases that
may result from thermal aging.

In this section, we will go through two simulations:

o First, we will predict the tendency for localized corrosion for the duplex alloy 2324 in an aerated chloride
solution. Alloy 2324 (a.k.a. AlSI 329) is not in the database, so the repassivation potential will be calculated
from the generalized correlation (Anderko et al., 2008). The corrosion potential will be calculated for a
similar alloy because the corrosion potential does not differ much for many Fe-Cr-Ni-Mo alloys in the
passive state in neutral solutions.

e Second, we will predict the localized corrosion tendency for alloy 2324 after thermal aging. Thermal aging
of duplex steels in the temperature range of 900°C to 600°C leads to the formation of various phases - y,
o, M23Ce-type carbide, and secondary austenite (y2). The secondary austenite phase is primarily
responsible for the increased tendency of the alloy for localized corrosion. This is due to a very significant
depletion of chromium in the secondary austenite over relatively wide spatial areas (Sridhar et al., 2009).
Since the composition of the secondary austenite cannot be predicted at present, we will use experimental
microstructural data (Sridhar et al., 2009) in conjunction with the generalized correlation for the
repassivation potential.

Example 55: Prediction of Localized Corrosion for Alloy 2324 Before Thermal Aging in an
Aerated NaCl Solution

Starting the Simulation

Use the inputs and parameters from the table below to create the stream’s composition. Certain inputs, such
as the name style, units, etc. will require further adjustments, and will be described as necessary.

Thermal Aging Calculation

Calculation Settings Stream Composition and Conditions
Stream Name Thermal Aging — Alloy 2324 | Stream Amount | Calculated
Calculation Type Corrosion Rates Temperature 60 °C
Survey by Composition Pressure 1 atm
Name Style Display Name H20 Default — 55.5082 moles
Unit Set Metric, Batch, Moles NaCl 0 moles
Framework AQ 02 0.02 moles
N2 0.08 moles

Note: The oxygen and nitrogen have been added to simulate the presence of air
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Add a new Stream

Click on the new Stream and press <F2> to change the name to Thermal Aging — Alloy 2324
Select the AQ thermodynamic Framework (selected by default)

Click on the Units Manager Icon and select Metric, Batch, Moles

Click on the Names Manager Icon and select Display Name

Enter the stream composition and conditions specified in the table above
Go to the Add Calculation button and select Corrosion Rates

Select the Survey by Composition
Change the name from Rates to Alloy 2324 — before aging using the <F2> key or by right-mouse click
on the object and select rename

Since alloy 2324 is not available in the database, we will select stainless steel 316 as the contact surface. This
will ensure that the predicted corrosion potential is very similar to that for alloy 2324.

10. Select Stainless Steel 316 from the Contact Surface grid

Unlike in the previous examples, do not make any changes in the Calc Parameters section. We will not make
Cr depletion calculations; rather, we will be specifying the compositions of the phases.

Your screen should look like the image below.

Corrosion Rates.oad*

0‘5 Streams

- & CR of carbon steel

CRvs flow

Gas Condensate

Localized Corrosion
Thermal Aging

Thermal Aging -Alloy 2324
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TR I e W

-
'y
b
b
b

Actions L o+ x

Actions

Plot Template Manager L o+ x
Save

For Help, press F1
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B File Edit Streams Calculations Chemistry Tools View Window Help - & X
DEHE & =@ A | Llvasol2 Red metiE L s | MEF: G EE N

MNavigator L o~ X 3

Description Definition [l General Corr. Rate (il Localized Corr. [l Polarization Curve [ Report i1 * *

J Variable
=
Stream Amount (moly
Temperature (*C)
Pressure (atm)
=
Flow Type
Thermal Aging Temperature (*C)
Thermal Aging Time (hr)
=
Water

Sedium chioride

Stream Parameters

Calculation Parameters

Inflows (mol)

Oxygen
Nitrogen
Iron
= Contact Surface
Stainless steel 316 j
Input
Advanced Search Add as Stream Export

Value

Static

55.6082
60.0000
1.00000

359.000
0.0

55.5082
0.0
0.0200000
0.0300000
0.0

-~

Survey by
Composition -
Thenby  [optional]
Mone -

Wary
Independently

Together

Calculate @

Summary

Specs...

Spece..

Unit Set: Metric (moles)

Automatic Chemistry Model
Aqueous (H+ ion) Databanks:
Corrosion (AQ]
Agueous (H+ ion
Redox selected
Using K-fit Pelynemials
T-span: 25.0 - 225.0
P-span: 1.0 - 1500.0
lsothermal Calculation
60.0000 °C 1.00000 atm

Calculation not done

Composition survey:
No Inflow selected

No secondary survey selected
Thermal Aging Temperature: 399.000
°C

Thermal Aging Time: 0.0 hr

@8

v

NUM

We will be running a composition survey to see how the concentration of NaCl affects the propensity for
localized corrosion.
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11. We need to specify the NaCl concentration range. Click on the Specs button

12. Under the Component tab select Sodium Chloride

. This will open a new window.

Category

Compeosition Rates Calculation

- War. 1 - Composition
- Polarization Curve

- Themal Aging

- Calculation Type

.. Caloulation Options

Comporent  Survey Range
Component Inflows

[ Hide Related Inflovis e Inflow

Iron
Nitrogen
Oxpgen

‘wiater

Select a component inflove which will be vaiied over the specified range.

Cancel Apply Help

13. Click on the Survey Range tab and change the concentration range as follows: Start=0.001 moles, End=6
moles, and number of steps=20. Then, click on the Log radio button.

Category

Compaosition Rates Calculation

= War, 1 - Composition
- Polarization Curve
i Thermal Aging

- Caleculation Type

.. Caleulation Options

7 x
Component  Survey Range
Compuosition Range Urit
Selected Range
1.0e-4 to Mo
Delete

() Lingar @) Log ) Paint List
End Paints

Step Size

Select one, the other is
caloulated

Increment  0.233335 }

Nurmber Steps

Cancel Apply Help

14. Under the Category section, select the Thermal Aging option. The screen will be populated with default

parameters for type 316 stainless steel.

In the following steps we are going to enter the alloy 2324 composition and use the repassivation potential (Erp)
correlation (embedded in the software) to calculate the Eqp of the alloy. This is necessary because no
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parameters for alloy 2324 are stored in the databank and we have to rely exclusively on the correlation to predict
the repassivation potential.

15. First, click on the Yes button next to “Erp directly from correlation:”

16. Then, enter the composition of alloy 2324 by replacing the default values for alloy 316.

Enter the following composition of alloy 2324

Fe 67.245*
Cr 254
Ni 5.75
Mo+W 1.5
C 0.025
N 0.08

*which is the balance that includes many minor elements

The remaining parameters in the Thermal Aging screen can remain the same because we will not be using
them in this example (i.e., we will not be calculating any depletion profiles). After entering the values, the screen
should look as follows:

Compaosition Rates Calculation ? X

Category Themmal Aging
- War. 1 - Composition
i Polarization Curve

Erp Directly hiom Comelation: (Do (@) Yes

E:Eﬂ:{‘i:ﬁiﬁpa Alloy Composition wh: i

i Caleulation Dptions Fe |BT'245 ‘ Cr ‘25 4 | Nl|5.75 |
Mo+ [15 | c|oazs | w[oos |
Carbide Staichiometry:

Fe [0 | cifiame | wifo |

Mosw [3.28 | cfs G |
Carbide Themochemistry: & 41221 | & [aee |
Cr Difusion Coefficiert: DD [0.0D0TBB1S | @ [-289000 |
Mo, W Diffusion Cosfficient D0 [7.93e005 | 0 [-274000 |
Cr Sengitization Threshold wl2:|12 | Grain Size: ‘1[|I] ‘

Revert to Default

Cancel pply Help

17. Click OK to accept the changes
18. We are now ready to perform the calculation. Click on the Calculate button or press the <F9> key

19. It is time to save your file (File >Save as...) or using the save icon in the tool bar. You can save it under
the same file created in the previous section named Corrosion Rates.
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Analyzing the results

1. Click on the Localized Corr. tab ( Ml Localized Corr.) By default, this tab will show a plot of the corrosion
and repassivation potentials as a function of NaCl concentration. In the Y2 axis the Maximum Pit Current

Density is also plotted.

Description (&3 Definition [l General Corr. Rate [l Localized Corr. {ldl Polarization Curve (B Report 1| * "

1~ JHENIES [E | ViewData
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Logarithmic Scale

To visualize the results better, change the horizontal axis to a logarithmic scale.

2. Right-mouse click on the X Axis and select Logarithmic Scale

The plot should look like the image below.
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These results indicate that alloy 2324 is susceptible to localized corrosion in aerated solutions when the chloride
concentration exceeds ~0.3 molal. Above this concentration, the repassivation potential drops below the

corrosion potential and, therefore, localized corrosion can be stabilized at these conditions.
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Example 56: Prediction of Localized Corrosion for Alloy 2324 After Thermal Aging

Now, we will perform the same prediction of localized corrosion calculations for thermally aged alloy 2324. We
will run the same concentration survey as in the previous case so that we can compare the results for bulk alloy
2324 with those for a heat-treated sample.

Sridhar et al. (2009) found that after aging alloy 2205 at 700 °C for 24 hours, the formation of a chromium-
depleted secondary austenite phase is responsible for a much-increase tendency for localized corrosion. We
will use this experimental data to approximate the localized corrosion tendency of alloy 2324.

Starting the Simulation
1. Copy the Alloy 2324-before aging calculation and paste it under the Thermal Aging — Alloy 2324 stream

&4 Streams &} Streams

+ - CRof carbon steel + - CRof carbon steel
+£ CR vs flow +£ CRvs flow

4-& Gas Condensate -
+ - & Localized Corresion + :
- & Thermal Aging &

& Gas Condensate
- & Localized Corrosion
& Thermal Aging

2-d Thermal Aging -Alloy 232: - m =9 )
E07] Alloy 2324 -Rataienais o B Aloy 23 Arrange
Arrang
Cut
Cut Copy
Copy Paste

Paste
Delete

Delete Rename

Renar

2. Rename the calculation as Alloy 2324 — after aging by using the <F2> key or by right-mouse click on the
object and select rename

3. Click on the Specs button. This will open a new window.

4. Under the Category section, select the Thermal Aging option. The screen will be populated with default
parameters for type 316 stainless steel.

5. Click on the Yes button next to “Erp directly from correlation:” — because we will be running calculations for
a completely new phase

6. Then, enter the composition of the secondary austenite phase by replacing the default values for alloy 316.

Note: we are using experimental data obtained for alloy 2205 for illustration purposes). For more details
how these compositions were determined, see the paper of Sridhar et al. (2009).

Enter the following composition:

Fe 80.774*
Cr 12.512
Ni 5.134
Mo+W 1.399
Cc 0.017
N 0.164

*which is the balance that includes many minor elements
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The remaining parameters in the Thermal Aging screen can remain the same because we will not be using
them in this example (i.e., we will not be calculating any depletion profiles). After entering the values, the screen
should look like the image below.

Compeosition Rates Calculation

Category

- War. 1 - Composition
i-- Polarization Curve

- Themal Aging

- Caloulation Type

% Calculation Options

Thermal Aging

Eip Directly from Correlation: ()Mo @) es

Allay Coamposition wt:

Fe [20.774 | wlzmez | w5314 |
Moy [1.399 | ¢ lom? | wloed |
Carbide Stoichiometry:

Fe [0 | orf1am | nifo |
Mosw [126 | cle | nlo |
Carbide Thermochemistiy: 4 41221 [ES |
€1 Diftusion Coefficient: D0 [0.00016818_ | @ [-289000 |
Mo, W Diffusion Cosffisient D0 | 7.93¢-005 | 0 [-274000 |
Cr Sensitization Threshold WIZ:|12 | Grain Size: “\[I[I

Fievert to Default

Apply

Help

7. Click OK to accept the changes

8. We are now ready to perform the calculation. Click on the Calculate button or press the <F9> key
9.

It is time to save your file (File >Save as...) or using the save icon in the tool bar. You can save it under
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Analyzing the results

1. Click on the Localized Corr. tab ( Ml Localized Corr.) By default, this tab will show a plot of the corrosion
and repassivation potentials as a function of NaCl concentration. In the Y2 axis the Maximum Pit Current
Density is also plotted.

To visualize the results better, change the horizontal axis to a logarithmic scale.
2. Right-mouse click on the X Axis and select Logarithmic Scale

The plot should look like the image below.
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The obtained plot shows that the repassivation potential is much lower than that for bulk alloy 2324. Because
of the strong depression of the repassivation potential, the corrosion potential exceeds the repassivation
potential at chloride concentrations of ~0.0007 m. Thus, localized corrosion is predicted to be possible at
concentrations above 0.0007 m. This indicates a very strong increase in the propensity for localized corrosion
compared with bulk alloy 2324, for which the predicted threshold is ~0.3 m.

In general, you can use this facility to predict the repassivation potential for any alloys, including unknown and
experimental ones, as long as they belong to the Fe-Ni-Cr-Mo-W-N-C family.
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Section 10. Extreme Value Statistics (EVS)

10.1. Overview and Theoretical Foundation

Engineering systems may have a large number of pits and corroded areas of varying degree of severity. The
first perforation, whose time and location will be a matter of probability, may cause the failure of the construction.
Accordingly, the probability of such failure must be known as accurately as possible.

Extreme value statistics (EVS) is one of the most powerful statistical techniques that have been used
extensively to extrapolate damage (maximum pit depth) from small samples in the laboratory to larger area
samples in the field (see, for example, Eldridge G. 1957, Shibata T. et al. 1988, Kowaka et al. 1994). Thus, it
was shown (Shibata T. et al. 1988) that probability of failure of a construction, Py, i.e. the probability that at least
one pit reaches the critical dimension, d, (for example wall thickness) in the system with area S is described by
the equation:

Pf:l_EXp{_M} 1)

where location parameter, u, and scale parameter, a, are measured by using small samples with constant area,
s. Equation (1) is to extrapolate corrosion damage from a small reference area, such as a coupon to a larger
operation area, S. This is the classical use of Extreme Value Statistics.

Experimental studies demonstrate that both the shape and location parameters are time dependent. However,
those dependencies must be established empirically and since no theory contained within classical EVS is
available for the functional forms of u(t) and a(t), it is necessary to know answer (prediction) in advance for
predicting the damage at long times. This has proven to be a severe constrains of the applicability of classical
EVS.

This problem can be overcome by applying damage function analysis (DFA) method that considers propagation
of corrosion damage by drawing an analogy between the growth of a pit and the movement of a particle
(Engelhardt and Macdonald, 2004). In many cases DFA yields an analytical expression for u and a in terms of
time of the hyperbolic form:

_ _at —
U= and a = ast (2)

where a1, a2, and as are readily determined by calibration from short term data in order to predict damage over
the longer time. Namely, equations (2) are used now by OLI software for predicting damage in corroding
systems. It must be noted that a different (power) form of such dependencies has been used by Laycock et al.
1990.

Input and Output Specific to EVS

For applying this technique the user has to provide a set of experimental data (x;, i, si), i = 1,2,...,N, where xi is
the depth of the deepest pit over area s, of a metal exposed to corrosion attack. The separate area, si, could
be distinct coupons from a designed experiment or random samples at various times from different locations in
the system. Experiments must be performed for at least two different times.

The output of the code yields the probability of failure as a function of time for a large system with area S. The
code also allows the user to answers on several engineering questions, for example, what service life, t, will
have the pipe with the width, d, and length L in order to ensure acceptable performance (probability of failure,
Pr).
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Advantages and Disadvantages of EVS

The advantage of this approach is self-evident. The prediction of corrosion damage for long times will be done
by using experimental data for short times without requiring the explicit determination of any information about
the kinetic parameters of the system. However, such approach has evident disadvantages, as follows:

1. The results of the analysis cannot be transferred for predicting corrosion damage to other systems (for
example pipelines) due to the different technological and environmental conditions that generally exist.
The results cannot be used for predicting damage in the same system if technological and environmental
conditions change.

2. We can expect that when the depth of the pit increases some critical value, the nucleation of cracks can
occur. ltis clear that a purely statistical method cannot predict such a transition. This method also cannot

predict any catastrophic event.

3. This method cannot be used for design of new constriction, because it relies upon calibration upon a pre-
existing system.
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10.2. Extreme Value Statistics for Predicting Pitting Damage

We will show examples of applications of Extreme Value Statistics for predicting pitting damage. Specifically,
we will show how to predict:

1. The depth of the deepest pit in the engineering structure or laboratory systems as a function of time and
the surface area of the system

2. Probability of failure for a given penetration depth and the area of the system as a function of observation
time

3. Probability of failure for a given observation time and the area of the system as a function of penetration
depth

4. Probability of failure for a given penetration depth and observation time as a function of the area of the
system

Foundations of Extreme Value Statistics can be found in the following references: (Aziz, 1956, Kowaka et al.
1994, Laycock et al. 1990, Engelhardt and Macdonald, 2004).

Example 57: Corrosion of Aluminum Alloy in Tap Water

In this example, we will consider the classical data for pitting corrosion (Aziz, 1956). In this paper, we can find
particularly the experimental data for the maximum pit depths developed on Alcan 2S-O coupons with area
s=129 cm? immersed in Kingston tape water at 25 °C . The experimental data is summarized in the table below.

Maximum pit depth (in pm) developed on Alcan 2S-O coupons with immersed in Kingston tape water for different observation
times. Area of all coupons is s=129 cm?

Coupon # | One Week | One Month | Three Months | Six Month | One Year

7 days 30 days 90 days 180 days | 365 days
1 180 460 480 620 640
2 266 500 578 620 680
3 290 510 610 620 700
4 306 580 610 680 760
5 334 580 610 680 800
6 340 640 660 720 810
7 340 654 690 740 820
8 410 680 718 740 840
9 410 692 760 760 840
10 545 692 798 760 900

Calculating the Depth of the Deepest Pit
Starting the Simulation

1. Add a new EVS calculation. Select the Add EVS Calculation icon in the Actions Pane
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Actions

=] Add EVS Calculation

Add Brine Analysis

2. Click on the new EVS calculation and press <F2> to change the name to EVS-Aluminum samples. Notice
that the default calculation is the Pit Depth Prediction.

3. All samples have a constant area s = 129 cm?. Under the Calculation Parameters grid, enter 129 cm?for
the Surface Area and Default Value cells.

¢ OU Studio - [EVS.0ad]

L=y =]
Navigator
Documentt

L o+ x

EVS.oad

66‘ Streams

<

‘Us EVS-Aluminum samples

B File Edit Streams Calculations Chemistry Tools View Window Help

For Help, press F1

Actions L o~ X

Actions

Flot Template Manager § o+ x
Save

- X
- & x
7K Re s et | MBS % B E A
fy
Description &F Definition [l Plot [ Report
Description Pit Depth (pm) Area (sg-cm)
Calculation Parameters Pit Depth Frediction = | Specs...
Surface Area 128.000
= Experiment Start {day) 0 Calculate &8
Default Value 129.000
v Sample Group 01 (day) 7172.14 Summaty
EVS Calculation Type: Pit Depth
Prediction
Calculation Parameter(s):
Surface Area 129.000 sg-cm
Experiment Start: 01/01/2000
Range 0.0 to 3565.0 day
Step size 5.0 day
No. steps 73
Default Area Value:  129.000
AddGroup || @ Elapsed O Actual Time
@ NUM

There are experimental data sets for 5 different periods of time. This means that we need to enter 5 different

sample groups.

4. By default, Sample group 01 is created. Click on the = button to edit this field. This will open a new

window.

5. Change the title to One Week, enter the number 7 for the number of elapsed days, and check the box
‘Include for Calculation’. Then click OK.
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EVS Sample Group Info Editer ? X

Title:
| One Week

Elapsed: {day)

Induded for Calculation

Cancel

6. Enter the Pit Depth data (second column) obtained for 1 week

Description Pit Depth (pm) Area (sg-cm)
Calculation Parameters
Surface Area 128.000
= Experiment Start (day) [}
Default Value 125.000
ol One Week (day) 7.0
1 180.000 129.000
2 266.000 129.000
3 250.000 128.000
4 306.000 128.000
5 334.000 129.000
-] 340.000 129.000
T 340.000 128.000
8 410.000 129.000
9 410.000 129.000
10 545.000 128.000

Now we need to add 4 more groups.
7. Click on the Add Group button (located at the bottom of the window). This will open a new window.

8. Change the title to One Month, enter the number 30 for the number of elapsed days, and check the box
‘Include for Calculation’. Then click OK.

9. Enter the Pit Depth data (second column) obtained for 1 month.

10. Click on the Add Group button, and repeat the same procedure for one month, three months, six months
and one year.
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< Description & Definition §i§ Plot (& Report

Description Pit Depth (ym) Area (sqcm) | A

v One Manth (day) 30.0

1 460.000 129.000
2 500.000 129.000
3 510.000 129.000
4 580.000 129.000
5 580.000 129.000
6 £40.000 129.000
7 654.000 129.000
8 £80.000 129.000
s £92.000 129.000
10 £92.000 129.000

BuSE = | Three Months (day) 89.9999

1 430.000 129.000
2 578.000 129.000
3 £10.000 129.000
4 610.000 129.000
5 610.000 129.000
5 660.000 129.000
7 £90.000 129.000
8 718.000 129.000
9 760.000 129.000
10 788.000 129.000
< Six Months (day) 180.0

1 £20.000 129.000
2 620.000 129.000
3 620.000 129.000
4 660.000 129.000
5 660.000 129.000
5 720.000 129.000
7 740.000 129.000
8 740.000 129.000
9 760.000 129.000
10 760.000 129.000
< One Year (day) 385.0 .
1 £40.000 129.000
2 £80.000 129.000
3 700.000 129.000
4 760.000 129.000
5 800.000 120.000 |

AddGroup | @) Elapsed O Actual Time

Note the following:

e Here, for the description of different experiments we simply used the number of the corresponding row in
Table 1. However, this description can be done in an arbitrary form.

e For each group, the order of samples relative depth can be arbitrary (not necessary in ascending order as
in Table 1)

e If coupons have different areas each area must be specified in the column Area
¢ Radio button Elapsed means the time after corrosion attack is used in calculations and namely this time

is used usually in scientific publication. However, it is possible to use also Actual Time of the
experiments.

At this point, the experimental data has been entered. Now we need define the period of time for which we want
to do the prediction of failure due to pitting.

11. Click on the Specs button. This will open a new window.

12. Under the Survey Range tab, enter the range for Pit Depth Prediction as follows: Start=0 days, End=365
days, and number of steps=50. Then click OK
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EVS Calculation Options ? X
Survey Range

Pit Depth Prediction Range Unit:  [day
Selected Range

0.0to 365.0in 50 steps of 7.3

New

Delete

(®) Linear (O Log () Paint List
End Faints

Step Size

Increment | 730000 @] }
Mumber Stepz @

Select one, the other is
calculated

Cancel Aply Help

Before running the calculation, we are going to study two different cases:
l. The first case will include the experimental data for 1 week and 1 month — short term experiments

Il. The second case will include all the experimental data — long term experiments
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Predicting the Worst Pit Depth for 1 year of service life using short term experiments (Experimental Data for 1
week and 1 month)

13. Check the boxes for 1 week and 1 month only to include them into the calculations

Description Definition i Plot [E] Report

Description | PitDepth (um) | Area(sqcm) | a
Calculation Parameters
Surface Area | | 129.000
e Experiment Start (day) 1]
Default Value | | 129.000
o One Week (day) 7.0
1 180.000 129.000
2 266.000 129.000
3 280.000 129.000
4 306.000 129.000
5 334.000 129.000
§ 340.000 129.000
7 340.000 129.000
3 410.000 129.000
9 410.000 129.000
10 545.000 129.000
~[v One Month (day) 30.0
1 450.000 129.000
2 500.000 129.000
3 510.000 129.000
4 580.000 129.000
5 580.000 129.000
§ £40.000 129.000
7 £54.000 129.000
3 £30.000 129.000
9 £92.000 129.000
10 £92.000 129.000
<" Three Months (day) 89.9999
1 430.000 129.000
2 573.000 129.000
3 £10.000 129.000
4 £10.000 129.000
5 £10.000 129.000
§ 660.000 129.000
7 £90.000 129.000
3 718.000 129.000
9 760.000 129.000
10 795.000 129.000
<" Six Months (day) 180.0
1 £20.000 129.000 |,
(® Elapsed (D) Actual Time

14. We are now ready to perform the calculation. Click on the Calculate button or press the <F9> key

15. Itis time to save your file (File >Save as...) or using the save icon in the tool bar. Save this new file as
EVS calculations.
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Analyzing the results

16. Click on the Plot tab (il Plat). You will see a plot of the predicted mean value of the depth of the deepest

17.

pit, xm and the plots of values xm — 0 and xm + 0, where o is the standard deviation of xm.

It is important to note that only data for short term experiments (for 1 week and 1 month) are shown as
black circles in the plot. The additional data are shown as red diamonds, only for demonstrating the
accuracy of prediction.
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Click on the Report tab, and to the Calculation Results table.

The predicted depth of the deepest pit at 365 days is 610.43um < 825.373um < 1040.31um (based on the
short-term experimental data).

Predicting the Worst Pit Depth for 2 years of service life using long term experiments (all data sets)

18.

19.

20.

21.

22.

23.

The accuracy of prediction increases when additional group of experiments are included into consideration.
For this case we are going to add the experimental data for 3 months, 6 months and 1 year.

Go back to the Definition tab
Include (check) the experimental data for 3 months, 6 months and 1 year
Click on the Specs button. This will open a new window

Under the Survey Range tab, enter the range for Pit Depth Prediction as follows: Start=0 days, End=730
days, and number of steps=50. Then click OK

Then Click on the Calculate button or press the <F9> key
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Analyzing the results

24. Click on the Plot tab (il Plot).
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25. Click on the Report tab, and to the Calculation Results table.

The predicted depth of the deepest pit at 730 days (1 year) is 617.57 um < 780.873 um < 944.18 um.

Calculating Fail Probabilities

When doing engineering design, information regarding the probability of failure is of importance to consider.

The next set of calculations will involve calculating the Probability of Failure for a given:

e Penetration depth
e Observation time (life)

e Area of the system

it Depth Prediction: - Specs...

+*  Pit Depth Prediction
Fail Probability: Depth
B Fail Probability: Life

i Fail Probability: Area

FClrm o imdim e
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Fail Probability: Depth

Let’s start with the calculation of Probability of Failure for a given penetration depth and the area of the system
as a function of observation time.

We are going to answer the following question:
e Which thickness, d, does an aluminum pipe with the area of S= 1 m2 have to have in order to ensure
acceptable performance (probability of failure Ps< 5% at design service life, ts =5 years?
Starting the Simulation
1. Use the data enter in the example above. Change the Calculation Type to Fail Probability: Depth

2. Under the Calculation Parameters grid, enter 1 m2for the Surface Area and 5 years for the Service Life.
Change units by clicking on the blue hyperlinks.

3. Make sure all data sets are selected (checked)

Your screen should look like the image below.

B File Edit Streams Calculations Chemistry Tools View Window Help
O=HE 7N [ T b i M ?.} E " |
|
Mavigator L o~ X .
g’
| Documentt s
i EVS.oad Description Definition il Plot & Report
St I ]
e reams . Description Pit Depth (pm) IAreatsq-ml I ~
g EVS-Aluminum samples e n 3
By, EVS-Fail Probability e e Fail Probability: Depth Specs...
s Surface Area 1.00000
Service Life (yr) 5.00000 Calculate 48
= periment Start (yr) 1]
Default Value 0.0129000 SummEp ‘
~lv 2 TECEEEETL R EV'S Calculation Type: Failure
1 180.000 0.0125000 Probability - Critical Depth Based
2 266.000 0.0125000 |
Calculation Parameter(s): |
3 290.000 00125000 Surface Area  1.00000 sg-m
4 305.000 0.0125000 Service Life 5.00000 yr
5 334.000 0.0125000
Experiment Start: 01/01/2000
= 5 [ 340.000 0.0125000
7 340.000 0.0125000 Range 0.0 to 2000.0 pm
Actions P 8 410.000 0.0129000 Stepsize  10.0 ym
n No. steps 200
Actions 9 410.000 0.0129000 >
10 545.000 0.0125000 Default Area Value: 125.000
v|7 One Month (yr) 0.0821918 J
1 450.000 0.0125000
2 500.000 0.0125000
3 510.000 0.0125000
4 580.000 0.0125000
Plot Template Manager L - x 5 530,000 0.0129000
[ 540.000 0.0125000
7 §54.000 0.0125000
8 §80.000 0.0125000
9 §52.000 0.0125000
v
Add Group ® Elapzed (O Actual Time |
Save |
For Help, press F1 @ NUM
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4. We are now ready to perform the calculation. Click on the Calculate button or press the <F9> key

5. ltis time to save your file (File >Save as...) or using the save icon in the tool bar.

Analyzing the results

6. Click on the Plot tab (ﬂ Plot), You will see a plot of predicted probability of failure
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7. Click on the Report tab, and to the Calculation Results table.

We can conclude that the acceptable pipe wall width is reached at d > 1950 um.

Fail Probability: Life

Let’'s continue with the calculation of Probability of failure for a given service time (life) and the area of the
system as a function of penetration depth.

We are going to answer the following question:

e What service life, t, will have the aluminum pipe with the width, d=1850 um with area S=10 m?2 in order
to ensure acceptable performance i.e. probability of failure, Pi< 5 %?
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Starting the Simulation

1. Change the Calculation Type to Fail Probability: Life
2. Under the Calculation Parameters grid, enter 10 m? for the Surface Area and 1850 um for the Critical
Pit Depth. Change units by clicking on the blue hyperlinks (If needed).

For this calculation we need to specify the period of time at which we want to bound the calculation.
3. Click on the Specs button. This will open a new window.

4. Change the Service Life range as follows: Start=0 years, End=3 years and Increments=0.2 years. Then
click OK.

EVS Calculation Options ? *

Survey Range

Failure Probability - Service Life Based Unit: ICI

Selected Range

(@) Linear O Log (O Paint List
End Paints

Step Size
| t _D.2DDDDD
e ® } Select one, the other is
Humber Steps 15 O calculated

Cancel Apply Help

Your screen should look like the image below.

Description Definition ([iii Plot [ Report

Description Pit Depth (pm) Area (sg-m) ~
Calculation Parameters

Surface Area 10.0000
Critical Pit Depth 1850.00

[= Experiment Start (yr) 0 -
Default Value 0.0125000
¢|7 One Week (yr) 0.0191781 -
1 180.000 0.0128000
2z 286.000 0.0128000
3 280 000 0.0125000
4 306.000 0.0128000
s 334.000 0.0128000
[} 340.000 0.0125000
7 340.000 0.0125000
8 410.000 0.0128000
g 410.000 0.0128000
10 545 000 0.0125000
v|7 One Month (yr) 0.0821918 .
1 480.000 0.0128000
2 500.000 0.0125000
3 510.000 0.0128000
4 580.000 0.0128000
5 580.000 0.0125000
6 640.000 0.0129000
7 654.000 0.0128000
8 B80.000 0.0128000
9 692.000 0.0125000 -

AddGroup | @ Elapsed (O Actual Time
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5. We are now ready to perform the calculation. Click on the Calculate button or press the <F9> key

6. Itis time to save your file (File >Save as...) or using the save icon in the tool bar.

Analyzing the results

7. Click on the Plot tab (lilll Plot). You will see a plot of predicted probability of failure. We need to modify the
plot to see the results in more detail.
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8. Double click on the Y axis. This will open a new window.
9. Check the boxes Minimum and Maximum. Then click OK.
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The plot should look like the image below
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The maximum probability of failure seems to be at around 10%.

10. Click on the Report tab, and to the Calculation Results table.

We can conclude that the lifetime of this pipe before failing is <0.6 years.

Fail Probability: Area

Finally, let’s do the the calculation of Probability of failure for a given penetration depth and service time as a

function of the area of the system.

We are going to answer the following question:

e Whatarea, S, can have the aluminum pipe with the width, d=2000 um and service life t=5 years in order
to ensure acceptable performance i.e. probability of failure, Pr< 5 %?

Starting the Simulation

1. Change the Calculation Type to Fail Probability: Area

2. Under the Calculation Parameters grid, enter 2000 um for Critical Pit Depth and 5 years for the Service

Life. Change units by clicking on the blue hyperlinks (If needed).



For this calculation we need to specify the surface area range that we want to survey.

3. Click on the Specs button. This will open a new window.

4. Change the Surface Area range as follows: Start=0 sq-m, End=100 sq-m and Number of steps=50. Then

click OK.

EVS Calculation Options ? X

Survey Range

Failure Probability - Suface Area Based Urit:
Selected Range

0.0to 100.0in 50 steps of 2.0

New

Delete

(®) Linear O Log () Point List

End Paints

Step Size

Select one, the ather is
calculated

Increment | 200000 (@] }
®

Murmber Steps

Cancel Aoy Help

Your screen should look like the image below.

Description &¥ Definition i Plot (3 Report

Description | PitDepth (um) |  Area(sg-m)
Calculation Parameters

Critical Fit Depth [ 2000.00 |

Service Life (yr) | 5.00000
= Experiment Start {yr) (1] -
Default Value [ 0.0123000
TF One Week (yr) 0.0191781

1 180.000 0.0128000
2 266.000 0.0128000
3 290.000 0.0128000
4 306.000 0.0128000
5 334.000 0.0128000
6 340.000 0.0128000
7 340.000 0.0123000
8 410.000 0.0128000
9 410.000 0.0128000
10 545.000 0.0128000
[ One Month {yr) 0.0821918

1 450.000 0.0128000
2 500.000 0.0128000
3 510.000 0.0128000
4 580.000 0.0128000
5 580.000 0.0128000
8 640.000 0.0128000
7 654.000 0.0128000
8 680.000 0.0123000
9 692.000 0.0128000
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5. We are now ready to perform the calculation. Click on the Calculate button or press the <F9> key

6. Itis time to save your file (File >Save as...) or using the save icon in the tool bar.

Analyzing the results

7. Click on the Plot tab (il Plot). You will see a plot of predicted probability of failure. We need to modify the
plot to see the results in more detail.
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The maximum probability of failure seems to be at around 30%.
8. Click on the Report tab, and to the Calculation Results table.

We can conclude that acceptable performance is reached at <14 m2.
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Example 58: Failure Analysis due to Corrosion in Pipelines

In this example, we will show how in some cases reliable prediction of corrosion damage can be done by using

a very limited number of experimental points.

In the table below, you can see the results of direct measurements of the depth of the deepest pits in the pipeline
between Samara and Moscow [Zikerman, 1972].

Pit depths (mm) for pipeline between Samara and Moscow

Group1 | Group2 | Group 3 | Group4 | Group 5 Group 6 Group 7 Group 8

Sample | 1440 h 5040 h 5760 h 8959 h 12624 h 17688 h 28032 h 28272 h

1 0.1 14 1.7 1.9 2.1

2 0.49 1.95 21 2.08 2.25

3 0.3 1.6 1.8

4 0.4 1.6 1.65 1.88

5 0.9 1.57 2.1 2.21 2.4 2.4

6 0.3 1.2 14 14 1.55 1.71

Calculation the Depth of the Deepest Pit

Starting the Simulation
1. Add a new EVS calculation. Select the Add EVS Calculation icon in the Actions Pane
Actions |

Add Stream
[&l| &dd Mixer

=] Add EVS Calculation

Add Brine Analysis

2. Click on the new EVS calculation and press <F2> to change the name to EVS-Pipeline samples. Notice
that the default calculation is the Pit Depth Prediction.

3. Under the Calculation Parameters grid, enter 1 cm?for the Surface Area and Default Value cells.

Note: Because the area of the pipelines metal was not changed with time the information about this area
is not needed for extrapolation of corrosion damage in time.

4. Since the data is in hours, click on the blue hyperlink day and change it to hours (hr) (for both: The
Experiment Start and the Sample Group.
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Your screen should look like the image below:

& 0L Studio - [EVS.0ad*]

Fup EVS-Aluminum samples

4 EVS-Fail Probability Calculation Parameters
y -Fall Frobaoilr

- [m] x
B File Edit Streams Calculstions Chemistry Tools  View Window Help - 8 x
DEE| s BB R N e s o | RS R
Navigator L +x “
Document1
EVS.0ad* Description Definition il Plot [E] Report
‘-“ Streams Description Pit Depth (pm) Area (sg-cm)

Fit Depth Prediction = Specs...

v|7 Sample Group 01 (hr) 1.72174e5

R Surface Area 1.00000
- Biy EVS-Pipeline samples -
|V Experiment Start (hr) 1] . Calculate &8
Default Value 1.00000

Summary

EW'S Calculation Type: Fit Depth
Prediction

There are experimental data sets for 8 different periods of time. This means that we need to enter 8 different

sample groups.

5. By default, Sample group 01 is created. Click on the = button to edit this field. This will open a new

window.

6. Leave the default name as Sample Group 01, enter the number 1440 for the number of elapsed hours,

and check the box ‘Include for Calculation’

EVS Sample Group Info Editor

Title:

Elapsed: (hr)

1440.0

Induded for Calculation

Concel

7. Enter the Pit Depth data (second column) obtained for 1440 hours.

Description Definition i Plot & Report

Description
Calculation Parameters

Surface Area

e Experiment Start (hr) 1]
Default Value

v Sample Group 01 (hr) 1440.0
1 0.100000
3 0.300000
4 0.400000
5 0.5300000
[ 0.300000

Now we need to add 7 more groups.

Pit Depth (mm)| Area (sg-cm) |~

1.00000

]

1.0000
‘1.000#
1.00000
1.00000
1.00000
1.00000

8. Click on the Add Group button (located at the bottom of the window. This will open a new window.
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9. Leave the default name as Sample Group 02, enter the number 5040 for the number of elapsed hours,

and check the box ‘Include for Calculation’. Then click OK.

10. Enter the Pit Depth data (second column) obtained for 5040 hours.
11. Click on the Add Group button, and repeat the same procedure for 5760, 8959, 12624, 17688, 28032 and

28272 hours.

Once you have entered all the experimental data, your screen should look like the image below.

Make sure that all the groups are selected (checked) to be considered for the calculation.

- O X
Toels View Window Help - 0 X
e jme s M e s @ERS G R E N
By
Description Definition {1 Plot [l Report
Description Pit Depth (mm)| Area(sg-cm) |~
[<]w  Sample Group 01 (hr) 14400 Pit Depth Prediction v | Specs
1 0.100000 1.00000
3 0.300000 1.00000 Calcuate @
4 0.400000 1.00000
5 0.900000 1.00000 Sy
8 0.300000 1.00000 EWS Calculation Type: Pit Depth
Prediction
<[ Sample Group 02 (hr) 5040.0 ..
Calculation Parameter(s):
0450000 1.00000 Surface Area  1.00000 sg-cm
1.60000 1.00000
Experiment Start: 01/01/2000
= [w Sample Group 03 (hr) 5760.0 . Range 0.0 to 87600.0 hr
5 1.57000 1.00000 Step size 1752.0 hr
B 1.20000 1.00000 No.steps 50
Default Area Value: 1.00000
<[ Sample Group 04 (hr) 8959.0 .
1 1.40000 1.00000
2 1.95000 1.00000
3 1.80000 1.00000
4 1.60000 1.00000
5 2.10000 1.00000
3 1.40000 1.00000 5
v|7 Sample Group 05 (hr) 12624.0 -
1 1.70000 1.00000
z 2.10000 1.00000
4 1.65000 1.00000
5 221000 1.00000
6 1.40000 1.00000
<[ Sample Group 06 (hr) 17688.0 .
1 1.50000 1.00000
2 2.08000 1.00000
4 1.88000 1.00000
5 2.40000 1.00000
3 1.55000 1.00000
t|7 Sample Group 0F (hr) 28032.0
5 2.40000 1.00000
6 1.71000 1.00000
v|7 Sample Group 08 (hr) 28272.0 J W
Add Group (® Elapsed () Actual Time
@ NUM

At this point, the experimental data has been entered. Now we need define the period of time for which we want
to do the prediction of failure due to pitting.

12. Click on the Specs button. This will open a new window.
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13. Under the Survey Range tab, enter the range for Pit Depth Prediction as follows: Start=0 hours,
End=30000 hours, and Increment=2000 hours. Then click OK

EVS Calculation Options ? X
Survey Range

Pit Depth Prediction Range Unit:

Selected Range

0.0to 30000.0in 15 steps of 2000.0

New

® Linear O Log ) Point List
End Paints
Start
2
Step Size
et ® } Select one, the other is
Murnber Steps | 15 @) calculated

Cancel Apply Help

Before running the calculation, we are going to study two different cases:
l. The first case will include the experimental data from groups 01 to 05
Il. The second case will include all the experimental data from groups 01 to 08

Calculation including Groups 01 to 05

14. Check the boxes for Group 01 to 05

15. We are now ready to perform the calculation. Click on the Calculate button or press the <F9> key

16. ltis time to save your file (File >Save as...) or using the save icon in the tool bar. Save it under the same
file that we previously created as EVS calculations.

Analyzing the results

17. Click on the Plot tab (il Plot). You will see a plot of the predicted mean value of the depth of the deepest
pit, xm and the plots of values xm — 0 and xm + 0, where o is the standard deviation of xm.

5.0 T T T T T T T T

Maximum Pit Depth
i o Pit Depth + StdDev h
————— Pit Depth - StdDev
40 T
35| e ]
E e
=
< 30 -
: —
a1 —
=25} ) / g
£ . - .
2 R ) .
E 20t . ¢ g
s K . ¢
. ' s .
.
15+ s . MR 1

08 b o e .

0.0 & L L L L L L L L
o, o

Il 1 1 Il 1 1
G, Y, B B, B, B, g o, R, g, %, Y
Y % e Y T % % % % B % B % %

Senvice Life [hr(s)]

o
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As previously noted, only the points in black mean that were used for predicting propagation of corrosion
damage. The red diamonds mean that were not taken into account for the calculation and are shown only for
demonstrating the accuracy of prediction.

Calculation including Groups 01 to 08

18. Check the boxes for Group 01 to 08

19. We are now ready to perform the calculation. Click on the Calculate button or press the <F9> key

20. Itis time to save your file (File >Save as...) or using the save icon in the tool bar. Save it under the same
file that we previously created as EVS calculations.

Analyzing the results

21. Click on the Plot tab (il Plot),

36
34
32
3.0
238
26

Maximum Pit Depth
_____ Pit Depth + StdDev
----- Pit Depth - StdDev

12
1.0
08
0.6
04
02/
0.0 & 1 1 1 L L L L 1 L L 1 1 L L

9, "o, %, Y%, ‘o, b, % B, B, o, o, %, 6, W,
2 % B % B Y B Y B % B % b % B

Senvice Life [hris)]

B 24 (] — .
E 2.

£ 22 . _— .
g . . e .
o 20 . _— .

o138 - L] -

g —"s .
z 15 . . o
5 14 . .

= /

The plot above show how the predicted results improved with increasing number of subsequent inspections.

Note: The predictions can be substantially improved if they were obtained on the same part of the pipe where
conditions are approximately the same.

22. Click on the Report tab, and to the Calculation Results table.

You can see here that at 30,000 hours the maximum pit depth predicted is 1.55 um <2.54 um <3.53 um.
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Example 59: Predicting the Pit Depth with Insufficient Data

In some cases, the data that provided by the user may be insufficient for reliable prediction of corrosion damage.
The table below, shows experimental data (obtained from Laycock et al. 1990) for depths of the deepest pits
that were measured on 316L coupons (2 x 2 x 1/2 in) in a 10% ferric chloride solution at 50 °C.

Pit Depth Data for an area of s= 25.8 cm?, depth in um

Sample Grp 1 Grp 2 Grp3 Grp 4 Grp 5 Grp 6 Grp 7 Grp 8 Grp 9
40.5h | 14417 h | 21533 h | 2925h | 331.0h | 3785h | 453.25h | 477.0h | 528.0 h

1 775 1326 1036 912 1361 1613 2101 1722 1714

2 1176 1199 1173 1534 1641 2024 1798 1767

3 1496 1775

Calculation the Depth of the Deepest Pit
Starting the Simulation

1. Add a new EVS calculation. Select the Add EVS Calculation icon in the Actions Pane

Actions |

@ Add Streamn
Add Mixer

=] Add EVS Calculation

Add Brine Analysis

2. Click on the new EVS calculation and press <F2> to change the name to EVS-Insufficient Data. Notice
that the default calculation is the Pit Depth Prediction.

3. Under the Calculation Parameters grid, enter 25.8 cm?for the Surface Area and Default Value cells.

4. Since the data is in hours, click on the blue hyperlink day and change it to hours (hr) (for both: The
Experiment Start and the Sample Group.

Your screen should look like the image below:

¢ 0Ll Studio - [EVS.0ad*] - O X

B File Edit Streams Calculations Chemistry Tools View Window Help - 8 X

=2y = 78 Ree & | wse & B0 e dhEms | S RE &
Mavigator L o~ X .
g
Documentt s
EVS.oad"* Description Definition i Plot [ Report
ab
‘ ‘Stre;\TSSAI . | Description Pit Depth (pm) Area (sg-cm)
...... E%'ﬁ ) .lelem .SIEmp = Calculation Parameters Fit Depth Prediction Specs...
44 EVS-Fail Probability Surface Area 25.8000
£ Lo 5.
g EVS-Pipeline samples :
Ex| t Start (h o
i EVS-Insufficient data = S (hr) J Caloulate 4

Default Value

[~

25.8000

Summary

Sample Group 01 (hr) 972.0

EV'S Calculation Type: Pit Depth
Prediction
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There are experimental data sets for 9 different periods of time. This means that we need to enter 9 different
sample groups.

5. By default, Sample group 01 is created. Click on the = button to edit this field. This will open a new
window.

6. Leave the default name as Sample Group 01, enter the number 40.5 for the number of elapsed hours,
and check the box ‘Include for Calculation’

EVS Sample Group Info Editor ? s

Title:
| Sample Group 01

Elapsed: (hr)

Included for Calculation

Cancel

7. Enter the Pit Depth data (second column) obtained for 40.5 hours.
Now we need to add 8 more groups.

8. Click on the Add Group button (located at the bottom of the window. This will open a new window.

9. Leave the default name as Sample Group 02, enter the number 144.17 for the number of elapsed hours,
and check the box ‘Include for Calculation’. Then click OK.

10. Enter the Pit Depth data (second column) obtained for 144.17 hours.

11. Click on the Add Group button, and repeat the same procedure for the rest of the experimental data
(groups)

Once you have entered all the experimental data, your screen should look like the image below.

& oL Studio - [EVS.0ad] - o0
0 File Edit Streams Calculations Chemistry Tools View Window Help - 8x
DEHE| %8 7w e b e & B AT G EE &
Navigator PRIl s
Documentt i
EVSoad & Description & Definition §lj Plot [5] Report
o
W Streams Description Pit Depth (sm) | Area (sq.om)
£ Aluminum somples L Fit Depth Prediction v | Specs
W EVS-Fail Probability Surface Area 25,8000 . =
%y EVS-Pipeline samples
B, EVS-Insufficient data - Expe e () ° — Caloulate. @
Defaut Vaue 25.8000
Erd ‘Sample Group 01 (fr) 405 Starmep
! 775000 258000 EVS Caloulation Type: Pi Depth
Prediction
< Sample Group 02 (hr) 14447
- Calculation Parameter(s):
! 1326.00 258000 Surface Area 25,8000 sq-cm
2 1176.00 258000
Experiment Start 0170172000
[ ‘Sample Group 03 (r) 2533 Range 001087600 nr
1 212000 25.8000 Stepsize 1200
z 117300 255000
Defaut Area Value: 253000
v ‘Sample Group 04 (1) 295
1 512000 258000
z 117300 25,8000
v ‘Sample Group 05 (r) 310
== &0 1 135100 258000
) z 153400 258000 | |,
i Sample Group 06 (hr) 3785
1 1613.00 25,8000
2 184100 258000
S Sample Group 07 (fr) 525
1 2101.00 25,8000
B 202600 258000
S ‘Sample Group 08 (r) )
1 172200 258000
Plot Template Manager ¢ = x 3 79800 255000
B 149600 25800
S Sample Group 09 (hr) 5280
1 00 25,8000
AddGroup | @ Elapsed O Actual Time
Save
For Help, press F1 ] NUM
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At this point, the experimental data has been entered. Now we need define the period of time for which we want
to do the prediction of failure due to pitting.

12. Click on the Specs button. This will open a new window.

13. Under the Survey Range tab, enter the range for Pit Depth Prediction as follows: Start=0 hours, End=580
hours, and number of steps=50 hours. Then click OK

EVS Calculation Options ? X

Survey Range

Pit Depth Prediction Range Unit:

Selected Range

0.0to 580.0in 50 steps of 11.6

(®) Linear O Log () Point List
End Paints

Step Size

Increment 17,6000 (@] }
Murnber Steps ®

Select one, the other is
calculated

Cancel Aply Help

Before running the calculation, we are going to study two different cases:

l. The first case will include the experimental data from groups 01 to 03
1. The second case will include all the experimental data from groups 01 to 09

Calculation including Groups 01 to 03
14. Check the boxes for Group 01 to 03
15. We are now ready to perform the calculation. Click on the Calculate button or press the <F9> key

16. Itis time to save your file (File >Save as...) or using the save icon in the tool bar. Save it under the same
file that we previously created as EVS calculations.
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Analyzing the results

17. Click on the Plot tab ([l Plot).

2200 T T T T T T T T T T T T T T T T T T T T T T T T T T
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1:33 : Maximum Pit Depth . :
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Senvice Life [hris]]

We see that in this case the prediction cannot be considered satisfactory. The reason is that for the first, second,
and third observation times the observed mean value of deepest pit decreases. Obviously, such behavior of
maximum pit depth has no physical foundation. Generally speaking, such situation is the result of an insufficient
numbers of experiments (used coupons) for given observation times. Accordingly, we can expect that after
increasing the number of used coupons the situation can improve.

Calculation including Groups 01 to 09
18. Check the boxes for Group 01 to 09
19. We are now ready to perform the calculation. Click on the Calculate button or press the <F9> key

20. Itis time to save your file (File >Save as...) or using the save icon in the tool bar. Save it under the same
file that we previously created as EVS calculations.
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Analyzing the results

21. Click on the Plot tab (il Plot).
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The plot above show how the predicted results improved with increasing number of subsequent inspections.

The plot above also shows that the results of approximation of the full set of available experimental data from
Laycock et al. 1990) can be reasonably approximated by using EVS approach.

Additionally, these results show that insufficient number of coupons (measurements at given observation times)
can be compensated by increasing numbers of observation at different times.

22. Click on the Report tab, and to the Calculation Results table.

You can see here that at 580 hours the maximum pit depth predicted is 1309.93 pm < 1724.09 um <1724.09
pum.
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ScaleChem is a module within the OLI Studio. A separate license enables this module.

Why Use OLI Studio. : ScaleChem?

Scale problems arise when fluid, initially in equilibrium with its environment, is disturbed and becomes unstable.
The unstable fluid results in H20, COz2, and H2S partitioning across the water, oil, and gas phases, corrosion of
metal surfaces, and precipitation/dissolution of solids. OLI Studio: ScaleChem recognizes all three effects,
which are all important to the oil and gas production professional.

Precipitates form when mineral-forming elements increase the concentration of produced waters beyond
supersaturation, or the saturation point. The primary causes of supersaturation are pressure, temperature,
phase partitioning, and fluid mixing. OLI Studio. : ScaleChem quantifies the effects on mineral scale potential
while calculating the physical and chemical properties of fluid and gas phases. Industry professionals can use
the software’s calculations to help determine the best methods to deal with scaling situations.

OLI Studio: ScaleChem can be used to calculate scaling at one or more user specified temperatures and
pressures. Other calculation options include the ability to mix waters at user specified ratios to find compatible
waters, and the ability to saturate a water with respect to one or more solids to simulate reservoir conditions.

There are different types of inputs and calculations objects that can be used in OLI Studio: ScaleChem. A brief
definition of each type of calculation is given below.

Input Objects

There are three different types of input objects, also referred to as analysis types, in the OLI Studio: ScaleChem
software: Brine Analysis, Oil Analysis and Gas Analysis.

OLI Studio: ScaleChem refers to all waters and aqueous samples as brines. This option is
added by double clicking on the Add Brine Analysis. A brine can be a surface water, an
Add Brine injection water, a formation water, a production water or any other type of aqueous fluid you

can create. Brine compositions are entered in terms of ionic concentrations. In addition, the

Analysis ) X | o -
brine pH, total inorganic carbon and alkalinity can also be specified.

“ Add Oil Analysis allows you to enter an oil (non-aqueous phase). The oil sample may consist
Add Oil of pure component hydrocarbons (e.g., alkanes), distillation data, pseudocomponent or all
Analysis three.

‘lg:l’-“;' Add Gas Analysis allows you to enter any hydrocarbon mixture which may or may not contain

water, carbon dioxide or hydrogen sulfide. The default hydrocarbon is methane (CH4) but the
Add Gas . . .
Analysis hydrocarbon list may be expanded to include higher carbon numbers.
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Calculation Objects

There are five different types of calculations that can be carried out in OLI Studio: ScaleChem: Saturator,
Facilities, Scale Scenario, Scale Contour, and Mixing Water. A brief definition of each type of calculation is
given below.

ﬂ_

Add Saturator object combines fluids at the specified temperature and pressure and

Add saturates the combined phases with the selected minerals.
Saturator
:It Add Facilities mixes and separates fluids. It is used to simulate production operations.
Add Facilities
I‘i Add Scale Scenario object calculates the scaling of minerals from a fluid as temperature
Add Scale and pressure changes, e.g. at different production locations during production.
Scenario
©
Add Scale Contour object calculates the scaling of minerals from a fluid over a matrix of
Add Scale temperature and pressure. It creates a 2D contour plot visual.
Contour
“ v
. B Add Mixing Water object mixes two potentially incompatible brines together to identify at

Add Mixing what ratios the scale will form.
Water

In these chapter we will model a hypothetical field and learn how to use and set up each one of the objects
presented above.
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Section 11. Entering a Brine Analysis in OLI Studio: ScaleChem

11.1. Entering Data for a Brine Ana

lysis

To add a Brine Analysis, go to the toolbar menu and click on Streams > ScaleChem > Add Brine, or by

selecting the Add Brine Analysis icon in the Act

Streams Calculations Chemistry Tools View  Windo
Add Stream I‘ | e | gt

i Add New Analysis |

ScaleChem ¥ Add Qil
Add Gas
Add Brine

Analysis
-nnrile Mame: |Stre

You will see three different tabs for this analysis. The Description, Design and Report tab.

ions Pane.

Actions

@ Add Stream
Add Mixer

T Add Water Analysis

| Add EVS Calculation
1£) Add Brine Analysis|
Add Oil Analysis

P Add Gas Analysis
@ Add Saturator

L Add Scale Scenario
@Add Scale Contour
' Add Mixing Water
H: Add Facilities

The Brine Analysis open in the Design, which has 2 different sub-tabs: Data Entry and Reconcile, where we

need to enter the laboratory analysis information.

Description @ Report
= Variable | Value | Balanced
= |cations (mgiL) |
"é Na+1 0.0 0.0
3 K+1 0.0 0.0
Cas2 0.0 0.0
Mg+2 0.0 0.0
Lt
= Sr+2 0.0 0.0
s Bas2 0.0 0.0
o Fes2 0.0 0.0
|Ar|ions lmgfL}l
CH 0.0 0.0
sD4-2 0.0 0.0
HCO3-1 0.0 0.0
HE-1 0.0 0.0
C2H302-1 0.0 0.0
IHeutraIs Img:’L)l
co2 0.0 0.0
H25 0.0 0.0
5i02 0.0 0.0
B(OH)3 0.0 0.0

Entry Options
Units

maL
Display

Formula

[ show Mon-zero Only
Show Balanced Column

Template Manager

Standard

Save as...

Balance Options

Type

Dominant Ion
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We will start in the Data Entry (red) sub-tab. Here you enter the concentration of Cations, Anions, and Neutrals.
This sub-tab comes already prepopulated with some of the most common cations, anions, and neutrals species
found in laboratory water/brine analyses (by default the units are in mg/L). If your species is not present in the
prepopulated grid, simply click on the white grid and type the ion or neutral of interest. If it is a cation, type the
element followed by a plus (+) sign and the corresponding oxidation state, e.g. Cu+2. If it is an anion, type the
element followed by a minus (-) sign and the corresponding oxidation state, e.g. Br-1. If it is a neutral, simple

type the species either using the formula name or its name, as has been shown in the previous sections.

The Brine Analysis grid also contains search aids to find a specific cation, anion or neutral species. The first
search aid is the drop list located in each the cation, anion, and neutral grid sections. The list is alphabetic and

is activated using the drop-down arrow within the cell, after the first few letters of the ion is typed.

Description Design 5] Report

-

Data Entry

Reconcile

J Variable Value Balanced
Cations (mg/L)

Ha+1 0.0 0.0
K+1 0.0 0.0
Ca+2 0.0 0.0
Mg+2 0.0 0.0
Srs2 0.0 0.0
Ba+Z 0.0 0.0
Fe+2 0.0 0.0
Cu = |

Display Mame OLlI Name

# Cs+1 CSION

OLTCSIOM CSION

Wi v |

N Cul++) CUION

M Cu(+1) CUlON

SN Cnl+ 0 CHIOM
coz 0.0 0.0
H25 0.0 0.0
Si0z2 0.0 0.0
B(OH)3 0.0 0.0

Entry Options
Units
majL
Display
Formula

[ show Mon-zero Only
Show Balanced Column

Template Manager

Standard ~

Save as...

Balance Options
Type

Dominant Ion

If a name is misspelled or if the text is unrecognized, then a red X’ appears to the left of the name. This name
needs to be corrected or the row deleted before proceeding. To delete the row, simply select the wrong entry
(which will turn black) and hit the key <Delete>.

Neutrals (mgiL)

coz 0.0 0.0
H2g 0.0 0.0
502 0.0 0.0
B(OH)3 0.0 0.0
g o | 00 09
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The Reconcile sub-tab is used to define the measured properties of the brine. In this Reconcile sub-tab, we
will tell the software how to reconcile the brine.

Description Design [ Report

= Calculate Brine Properties Using:
E (®) Concentration Data Only Spece... Calculate i
m (O) Gas-Phase CO2 Content (male®s)
E (") Measured pH and Alkalinity [] Allow solids to form
(") Measured pH Only
@ (") Measured pH, Alkalinity, TIC
E Calculate Alkalinity
E J Properties Measured Calculated
Temperature (*C) 25.0000
Pressure (atm) 1.00000
pH 0.0
Alkalinity (mg HCO3/L) 0.0
Density (g/ml} 0.0
Elec Cond, specific (pmho/cm) 0.0
Total Dissolved Solids (mgiL) 0.0

Composition Adjustments
Charge Balance Unknown.

The first step, however, is to enter the brine measured properties and conditions. To do this we need to start in
the Properties | Measured | Calculated table.

J Properties Measured Calculated

Temperature (*C) 25.0000
Pressure (atm) 1.00000
pH 0.0
Alkalinity (mg HCO3/L) 0.0
Density (g/ml} 0.0
Elec Cond, specific (umho/cm) 0.0
Total Diszolved Solids (ma/'L) 0.0
Composition Adjustments
Charge Balance Unknown.

By default, the values of temperature, and pressure are 25°C and 1 atm. The cells indicate the
values that you need to enter if they were measured at the temperature and pressure specified, these are:
Measured pH, Measured Alkalinity 1%, Density, Specific Electrical Conductivity and Total Dissolved Solids (TDS).

You can always change the units of these properties by clicking on the units highlighted in blue. This action will
open the Units Manager Window.

10 This is generally a reliable value, unless solids have precipitated in the sample. Alkalinity is often but not always the same value as the
bicarbonate ion (HCO5’). OLI Studio: ScaleChem can reconcile on a measured alkalinity by adjusting the solution composition.
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If you don’'t have a measured property value, let's say for example, the Specific Electrical Conductivity, just
leave it blank.

The yellow cells, under the Calculated column, will contain calculated values by the software and will be shown
once the simulation is run.

When reviewing laboratory analysis of brine samples, it is quite common for the positive ions (cations) and the
negatively charged ions (anions) in solution to not balance. This may be due to the precision limits of the various
experimental procedures used to measure the ions - i.e. some ions may not have been analyzed. These
solutions must have a neutral charge. OLI Studio: ScaleChem will adjust/modify inflows in order to balance the
charges and make the solution neutral. This adjusting procedure is referred to as Reconciliation.

There are 5 different types of Reconciliation Options:

a) Concentration Data Only

b) Gas-phase CO2 content (mole%)
c) Measured pH and Alkalinity

d) Measured pH Only

e) Measured pH, Alkalinity, TIC

Additionally, there is the option to calculate the alkalinity value by checking the Calculate Alkalinity box.

Calculate Brine Properties Using:

(® Concentration Data Only Specs... Calculate &8

() Gas-Phase CO2 Content (mole%s)

(C) Measured pH and Alkalinity [ Allow solids to form
(") Measured pH Only

(") Measured pH, Alkalinity, TIC

Calculate Alkalinity

When the Reconciliation Option is selected, the software will calculate the properties of the brine

A more detailed description of each reconciliation option is given in Section 11.3. Reconciliation Options in the
Brine Analysis below.

11.2. Brine Analyses - Reporting Elements

Brine analysis data obtained from ICP measurements will contain concentrations for B, P, S, and Si. These
elements do not exist in the water, rather they exist as dissolved ions. If they are part of your analysis, then you
should convert them to the following before entering them into the Brine Analyses object.

Converting element concentration to species for Brine Analysis

ICP data Aqueous Species Formula to enter Formula weight multiplier

B, boron Boric Acid H3BO3 B (mg/l) x 5.72 = H3BO3 (mg/l)
Si, Silicon Silica Sio2 Si (mg/l) x 2.14 = Si0O2 (mg/l)

P, Phosphorus | Dihydrogen Phosphate | H2PO4-1 P (mg/l) x 3.13 = H2PO4 (mg/l)
S (mg/l) x 1.03 for HS-1 (mg/l

S, Sulfur Sulfate or Sulfide 181 or S04-2 or( o e

(cannot tell from total S only)
S (mg/l) x 3.0 for SO4-2 (mg/l)
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11.3. Reconciliation Options in the Brine Analysis - Definitions

When reconciling a Brine Analysis, there are five options for reconciliation:

1.

Concentration Data Only: The software will run an electroneutrality reconciliation only, and then compute
the water properties such as pH, density, etc., based on the entered concentration of neutral, cations, and
anions species. In the Concentration Data Only option you may allow the program to pick the species to
adjust for electroneutrality or you may manually choose the species to perform the adjustment. (See
electroneutrality options).

Gas-phase CO2 content (mole%): Frequently it is simpler and more stable to measure the gas-phase
CO2 that is separated from the brine at the sampling point. When matched with another measured variable,
usually alkalinity, the concentration of the carbonate species and the pH can be calculated. OLI Studio:
ScaleChem performs a COz2 gas fraction calculation by taking the Pco2 and the calculated alkalinity (based
on the water analysis data) to reconcile the system for pH and carbonate properties. The COz: is adjusted
to match a saturated gas composition.

Measured pH Only: Many brines analyses report a measured pH. This pH may or may not match the pH
calculated by the software. The cause may be an incomplete and/or inaccurate brine description. The
software will run both an electroneutrality and pH reconciliation. This type of reconciliation will match your
recorded pH. Additionally, the software will compute the water properties such as, density, electrical
conductivity, etc. The pH of the solution is automatically adjusted by the software by adding either HCI or
NaOH, or you may select your preferred acids and bases to adjust the pH.

Measured pH and Alkalinity: The purpose of the Measured pH and Alkalinity reconciliations is to match
the computed pH and alkalinity values with those you measured. The software will run an electroneutrality,
pH and alkalinity reconciliation. Additionally, the software will compute the water properties such as density,
electrical conductivity, etc. The pH of the solution is automatically adjusted by the software by adding either
HCI or NaOH or you may select your preferred acids and bases to adjust the pH. The Alkalinity is
automatically calculated by the software, using COz2 as the alkalinity titrant, H2SOa4 as the alkalinity pH titrant
and 4.5 as the alkalinity end point pH. You can also change a different alkalinity titrant if you prefer.

Measured pH, Alkalinity, TIC: The purpose of this reconciliation is to match the measured pH, alkalinity
and the total inorganic carbon (TIC). The software adjusts the acetate concentration (organic acids) to
match the target TIC. The TIC is adjusted by adding or removing acetic acid. The alkalinity is adjusted using
CO:2 as the alkalinity titrant, H2SO4 as the alkalinity pH titrant and 4.5 as the alkalinity end point pH. You
cannot however change the CO2 or acetic acid for the alkalinity adjustment. These are fixed by the
software. The target pH is obtained simultaneously by HCI or NaOH. You may select your preferred acids
and bases to adjust the pH instead of the default HCI and NaOH.

Additionally, there is the option to Calculate Alkalinity: []Calculate &kaliniy 1t js important to note, that this is only
an alkalinity calculation based on the concentration entered, it is not an alkalinity reconciliation.
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11.4. A Basic Brine Analysis

A brief introduction to the brine analysis tool will be shown in the example below. As we go through the example,
the basic definitions, functionalities and reporting for the Brine Analysis object will be shown.

Example 60: Basic Brine Analysis

In this example, we will input dissolved species concentrations and other measured properties into a Brine
Analysis object to model a hypothetical water sample. Will calculate the pH and scaling tendency of a brine
sample based upon its measured composition at 1 atm and 25 °C.

Starting the Simulation

Use the inputs and parameters from the table below to create the brine analysis. Certain inputs, such as the
name style, units, etc. will require further adjustments, and will be described as necessary.

Brine Analysis Composition
Cations (mgl/L) Anions (mg/L) Neutrals (mg/L) Measured Properties
Na+1 20400 Cl-1 37000 Cco2 150 pH 7.1
K+1 400 S0O4-2 2200 H2S 15 Alkalinity as HCO3-, mg/L 715
Ca+2 3800 HCO3-1 0
Mg+2 830 HS-1 0
Sr+2 15 C2H302-1 715
Ba+2 0.7
Fe+2 10

Setting the Water Analysis

1. Add a Brine Analysis. Go to the toolbar menu and click on Streams > ScaleChem > Add Brine, or by
selecting the Add Brine Analysis icon in the Actions Pane

Actions

Add Stream

& Add Mixer
Streams Calculations  Chemistry Tools  View  Windo mAddW'aterAnal)rsis

Add Stream l [ ikl | Add EVS Calculation
'
Add New Analysis ! = Add Brine Analysis
I Add Oil Analysis

ScaleChem > Add Ol | %2 Add Gas Analysis
m Add Gas L & Add Saturator
Marne: |Stre

Add Brine I-'_’Add Scale Scenario
Add Scale Contour
" Add Mixing Water
e Add Facilities

Lnalysis

~oncile

Click on the new Brine and press <F2> to change the name to Brine Analysis

Select the AQ thermodynamic Framework (default)

Click on the Names Manager Icon and select the Formula option (default)

Click on the Units Manager Icon, and select Metric, Concentration (default)

Under the Design Tab, enter the Cation, Anion, and Neutrals composition given in the table above.
our screen should look like the image below:

<OOsON
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Description Design [ Report

= [ | Variable Value

= Cations [mgi/L)

"!: Ma+1 20400.0

L

a K1 400.000
Ca+? 3800.00
Mg+2 830.000

% Sr+2 15.0000

S Bas2 0.700000

= Fes2 10.0000

Anions (mg/L)
CH 37000.0
504-2 2200.00
HCO3-1 720.000
H5-1 0.0
C2H302-1 0.0
Neutrals (mg/L)

coz 150.000
H25 15.0000
Si02 0.0
B(OH)3 0.0

Balanced

20400.0
400.000
3800.00
830.000
15.0000
0.700000
10.0000

38545.0
2200.00
720.000
0.0
0.0

150.000
15.0000
0.0
0.0

Entry Options

Units

mgL ~
Display

Formula ~

[]5how Mon-zero Only
Show Balanced Column

Template Manager

Standard W

Save as...

Summary

Unit Set: Metric (mass concentration)

Automatic Chemistry Model

Agueous (H+ ion) Databanks:
Agquecus (H+ion)

No Solid phase(s)

Using K-fit Polynomials
T-span: 25.0 - 225.0
P-zpan: 1.0 - 1500.0

Stream Parameters:
Temperature (*C}  25.0000
Pressure (atm) 1.00000

Stream amount (L) 1.00000

Balance Options

Type

Dominant Ion

Dominant Ion

Prorate Cation
Prorate Anion
Makeup Ton

Dominant lon Charge Balance
{eqiL):

Cation Charge, 1.15621

Anion Charge . -1.10124

Imbalance 0.0545756

lon{s) needed to balance (mag/L):

CH1.19458.049

Concentration Data Only.

Note: It is highly unusual for the data to be electrically neutral. Therefore, the software reconciles the sample
for electroneutrality. After entering each species concentrations, you will notice that the software shows a
yellow column named Balanced. The software balances charges according to the selected option and displays
this in the yellow column.

There are 4 different Balance Options:

1) Dominant lon: This is the default method. The largest counter ion is used to adjust the
electroneutrality. In our example,1949.049 mg/L of ClI-1 are added since there is an excess of positive

charge (see the above image).

2) Prorate Cations: All cations are adjusted up or down equally
3) Prorate Anions: All anions are adjusted up or down equally
4) Make-up lon: This option allows for a single ion species to be adjusted. User selects an ion to
increase or decrease.
5) Under the Design Tab, enter the Cation, Anion, and Neutrals composition given in the table above.

7. Select Dominant lon as balance option
8. Click on the Reconcile (vertical blue tab)
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Notice that there that five different types of reconciliation are available in in the upper left corner of the window

(see image below). Also, you can see the Calculate Alkalinity box ( ceat=akainty y ontion which allows you
to compute the alkalinity, based on the concentration entered.

9.

10.

Select the Concentration Data Only option. This option means that the software will compute the water
properties based on the current concentration of neutral, cations, and anions species. The calculation will

not use the measured pH, or the measured alkalinity entered (if any).

Enter the measured properties: pH = 7.1 and Alkalinity = 715 as mg HCO3/L

Description Design [ Report

Calculate Brine Properties Using:

I@ Concentration Data Only I
() Gas-Phase CO2 Content (mole%)

(") Measured pH and Alkalinity

Data Entry

(") Measured pH Only
() Measured pH, Alkalinity, TIC
Calculate Alkalinity

Specs...

[ Allow solids to form

Calculate &8

/ Reconcile

Properties Measured
Temperature ("C) 25.0000
Pressure (atm) 1.00000
pH 7.10000
Alkalinity (mg HCO3/L) 715.000
Density (g/ml) 0.0
Elec Cond, specific (pmhoi/cm) 0.0
Total Dissolved Scolids (mo/L) 0.0

Add Charge Balance (mg/l CH1)

Composition Adjustments

Calculated

Summary

Unit Set: Metric {mass concentration)

Automatic Chemistry Model

Aguecus (H+ ion) Databanks:
Aguecus (H+ion)

No Solid phase(s)

Using K-fit Polynomials
T-span: 25.0 - 225.0
P-zpan: 1.0 - 1500.0

Stream Parameters:
Temperature (*C}  25.0000
Prezsure (atm) 1.00000

Stream amount (L) 1.00000

Dominant lon Charge Balance
{eqiL):

Catien Charge  1.15821
Anion Charge . -1.10124
Imbalance 0.0545756

lon{s) needed to balance (mag/L):
Clk1 1949.049

Concentration Data Only.

11. Now, we are ready to perform the calculation. Click on the Calculate button or press the <F9> key

12. It is time to save your file (File >Save as...) or using the save icon in the tool bar. Create a new file and
name it: ScaleChem Analysis Calculations.
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Analyzing the Results

Once the calculation is done, the Calculated column displays the results obtained based on the concentrations
entered in the Data Entry tab. Notice that the calculated results are pH=6.22 and Alkalinity=669 mg HCO3-1/L
vs the measured values of pH=7.1 and Alkalinity=715 mg HCO3-1/L.

Summary

- Calculate Brine Properties Using:
Lﬁ (®) Concentration Data Only FreE Calculate @@ Unit Set: Metric (mass concentration)  #
m
= O GasPhase CO2 Content (mole%) Automatic Chemistry Model
(o (") Measured pH and Alkalinity [ allow solids to form Aquecus (H+ ion) Databanks:
() Measured pH Only Agueous (H+ ion)

No Solid phase(s)

Measured pH, Alkalinity, TIC
= O i Using K-fit Polynomials
2 Calculate Alkalinity T-span: 25.0 - 225.0
§ F-span: 1.0 - 1500.0
e J Properties Measured Calculated m P : -
Temperature (°C) 25.0000 ream Farameters:
: = 1 00000 Temperature (*C) |25.0000
ressure (atm) : Pressure (atm}  |1.00000
£ &l B2 Stream amount (L) 1.00000
Alkalinity (mg HCO2/L) 715.000 668.837
- Dominant lon Charge Balance
Density (o/ml) 0.0 1.04457 (eqiL):
Elec Cond, specific (umho/cm) 0.0 91767 6 Cation Charge,  1.15621
Total Dissolved Solids (mg/L) 0.0 MiA, ? Anion Charge | -1.10124
Composition Adjustments Imbalance 0.0545728
Add Charge Balance (I'I'Ig."L C|-1} 1948.05 Ionts] needed to balance tng'L]:

CH11945. 048

Concentration Data Only.
Phase Amounts:
Aguecus (g) 1044.97
Wapor (g) 0.0

Aqueous Phase Properties:

pH 822113
lonic Strength (mol/mol)| 0.0225505
Density (g/ml} 1.04457

Calc. elapsed time: 5.687 sec. (V]

Calculation complete

To the right you can see the results summarized in the Summary Box.

The top section contains the Stream Parameters information. In this example, the software performed the
calculation at 25 °C, 1 atm, and a total Stream amount of 1 L.

The Dominant lon Charge Balance section shows the type of balance that was used to reach electroneutrality,
which cation/anion was deficient, and how much of it was added.

The Phase amounts section shows the distribution of species in the different phases. This analysis contains
two phases: aqueous and vapor.

The Aqueous Phase Properties information shows the computed pH, ionic strength, and density of the
solution. It is important to note here that the measured pH is 7.1 and the computed pH is 6.22. The density of
this solution is 1.04497 g/ml. Remember, for this example the software used only the concentration of neutrals,
cations and anions in solution to do a reconciliation.
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1. Click on the Report tab, and scroll down to the Pre and Post Scaling Tendencies table.

Pre and Post Scaling Tendencies

Scale Mineral Pre-scaling Pre-index Post-scaling Post-index
BaS04 (Barite) 9.44533 0.975217 944533 0.975217
CaC03 (Calcite) 2.44082 0.387535 244082 0.387535
CasS04.2H20
(Gypsum) 0.938902 -0.02737498 0.933902 -0.0273798
Cas04 (Anhydrite) 0.740543 -0.130450 0.740543 -0.130450
FeCO3 (Siderite) 0.178450 -0.748484 0.178450 -0.748484
FeS (Pyrrhotite) 500.7849 2 69966 500.7849 2 69966
KCI (Sylvite) 6.72458e-4 -3.17233 6.72458e-4 -3.17233
e3 (Mackinawite) 8.54999 0.931965 8.549949 0.931965
MaCl (Halite) 0.0122161 -1.91307 0.0122161 -1.91307
SrC03 (Strontianite) 0.0290888 -1.53627 0.0290888 -1.53627
Sr304 (Celestine) 0.203964 -0.690447 0.203964 -0.690447

From this table, you can see that Barite, Calcite, Pyrrhotite and Mackinawite solids have been predicted to be

supersaturated.

For more detailed information about scaling tendencies you can go to Scaling section in page 174.

2. Scroll down to the Brine Composition table

Brine Composition

Cations Value (mgiL) Anions Value (mgiL) Neutrals Value (mgiL)
K(+1) 400.000 CI(-1) 389490 coz 158.990
Ma(+1) 20400.0 HCO3- (%) 707.535 H2s5 14.9948
Ba(+2) 0.700000 S504-2 2203.08

Ca(+2) 3800.00

Fe(+2) 10.0000

Mg(+2) 830.000

Sr(+2) 15.0000

This table shows the composition of the brine after the reconciliation (calculation) has taken place.
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Section 12. Entering a Gas Analysis in OLI Studio: ScaleChem

12.1. Entering Data for a Gas Analysis

To add a Gas Analysis, go to the toolbar menu and click on Streams > ScaleChem > Add Gas, or by selecting
the Add Gas Analysis icon in the Actions Pane.

Streams = Calculations Chemistry Tools  View  Windo
Add Stream l T i
Add New Analysis |
I ScaleChem > Add il
Add Gas
Analysis Add Brine

~ancile Mame: | Stre

Actions
Actions

@Add Stream

&) Add Mixer

Te Add Water Analysis
=] Add EVS Calculation
& Add Brine Analysis

& Add Oil Analysis
“g Add Gas Anal)rsisl
Add Saturator

I—i Add Scale Scenario
@Add Scale Contour
¢ Add Mixing Water
M Add Facilities

You will see four different tabs for this analysis. The Description, Design, Definition and Report tab.

The gas analysis opens in the Design tab, which has 2 different sub-tabs: Inflows and Reconcile, where we

need to enter the laboratory gas analysis information.

Description w Definition [l Report

w J Component Value Mormalized Entry Options

E Subtotal: 0.0/100.000 (mole %) | Subtotal: 100.000/100.000 (mole %) Units

EN [ no 0.0 0.0)  |mole % -
B oo e Display
| coz 0.0 0.0

o Formula ~

I | Hzs 0.0 0.0

[ = ] -3

o [v cHe 0.0 100.000|  []Show Non-zero Only

|l [ caze 00 T Show Normalized Column
| canis 0.0 o Template Manager
[ FCeHto 0.0 0.0
[ n-caHto 0.0 0.0| |Standard v
| Fosh2 0.0 £ Save as...
| csHiz 0.0 0.0
| ceHis 0.0 0.0

Normalize Options

Makeup w~

Group Manager

[Juse Groups Add

We will start in the Data Entry (red) sub-tab. Here you enter the concentration of a pure-component

hydrocarbon gas, in mole % units. The standard list of component extents to C6 alkanes.
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If there is a component that is not present in the prepopulated grid, simply click on the white grid and type the
species of interest, using the formula name or its name, as has been shown in the previous sections. Let’s say
for example, you want to add Isooctane. Type isooctane or i-C8H18 in the white cell to add it to the list.

There is also the option of using the drop-down arrow, that allows you to search for the specific components
you want to add.

-

o || Component Value Normalized Entry Options
E: Subtotal: 0.0100.000 (mole %) Subtotal: 100.000/100.000 (mole %) Units
E | HO 0.0 0.0 male % v
[v cHe 0.0 100000 pierjay
[ m2 0.0 0.0
K1) Formula ~
S|l | coz 0.0 0.0
§ [ His 0.0 0.0 [Jshow Mon-zera Only
& [ co2He 0.0 0.0 [ show Mormalized Column
[ came 0.0 00)  remplate Manager
[ ican10 0.0 0.0
[ n-cento 0.0 0.0 Standard v
[ icsHiz2 0.0 0.0 Save as...
| csHi2 0.0 0.0
[ ceH14 0.0 0.0
_m = 0.0 no| JHormalize Options
Display Name QLI Mame | | Makeup w
4 i-C4H10 ISOBUTANE Group Manager
#i-C5H12 IPENTAN [JUse Groups Add
L i-CEH18 MEPMTAN224
#112 10D2EL
SINIBA IBUTYLAMM
OLTIRFMTENE IRFMZERIE b

If a name is misspelled or if the text is unrecognized, then a red X’ appears to the left of the name. This name
needs to be corrected or the row deleted before proceeding. To delete the row, simply select the wrong entry
(which will turn black) and hit the key <Delete>.

Description Design Definition [ Report

w J Component Value Mormalized Entry Options
i"; Subtotal: 0.0/100.000 (mole %)| Subtotal: 100.000/100.000 (mole %) Units
= | H20 0.0 0.0 mole % w
[+ cH4 0.0 100000 gy
| w2 0.0 0.0
@ Formula ~
& | co2 0.0 0.0
§ r H25 0.0 0.0 [ 5how Mon-zero Only
& [ cone 0.0 0.0 Show Mormalized Caolumn
[ c3Hs 0.0 00| Template Manager
| icaHio 0.0 0.0
| ncanto 0.0 0.0 Standard w
| icsHi2 0.0 0.0 Save as...
| csHa2 0.0 0.0
| csH14 0.0 0.0
| icaHis 0.0 p.0| Mormalize Options
&3 Makeup ~
Group Manager
[(use Groups Add
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The Reconcile sub-tab is used to calculate the properties of the gas at the temperature and pressure conditions
specified. By default, the values of temperature, and pressure are 60 °F (15.56°C) and 14.7 psia (1 atm).

Component

Hz0
CH4

Reconcile

12.2. A Basic Gas Analysis

Normalized
Subtotal: 100.000/100.000 (mole %)

0.0
100.000

Calculate &

Condition

Conditions Value

|

1.00231

Temperature (*C)

Pressure (atm)

Show Mon-zero Only

A brief introduction to the gas analysis tool will be shown in the example below. As we go through the example,
the basic definitions, functionalities and reporting for the Gas Analysis object will be shown.

Example 61: Basic Gas Analysis

The Gas Analysis object provides a quick way to enter a pure-component hydrocarbon gas.

Setting the Gas Analysis

1. Add a Gas Analysis. Go to the toolbar menu and click on Streams > ScaleChem > Add Gas, or by

selecting the Add Brine Analysis icon in the Actions Pane

Streams = Calculations Chemistry Tools View Windo

MAdd Stream l [ i1

Add New Analysis |

I ScaleChem > Add Gil
Add Gas
Analysis Add Brine
Mame: | Stre

—oncile

Select the AQ thermodynamic Framework (default)

2 O

Actions

@Add Stream

[l Add Mixer

T Add Water Analysis
] Add EVS Calculation
E Add Brine Analysis

& Add Oil Analysis
F;Add Gas Analysis I

s Add Saturator
I—;’ Add Scale Scenario
Add Scale Contour
¢ Add Mixing Water
H Add Facilities

Click on the new Gas and press <F2> to change the name to Gas Analysis

Click on the Names Manager Icon and select the Formula option (default)
Click on the Units Manager Icon, and select Metric, Concentration (default)

Under the Inflows Tab, enter the gas composition given in the table below
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Gas Analysis Composition

Formula | Component Name | Mole %
H20 Water 1.80
N2 Nitrogen 3.00
CcO2 Carbon Dioxide 1.50
H2S Hydrogen Sulfide 0.50
CH4 Methane 65.5
C2H6 Ethane 14.0
C3H8 Propane 8.00
i-C4H10 | Isobutane 1.00
n-C4H10 | n-Butane 3.00
i-C5H12 | Isopentane 0.50
C5H12 n-Pentane 0.70
C6H14 n-Hexane 0.50

Your screen should look like the image below:

& Description Design [&¥ Definition [ Report

o || Component Value Normalized Entry Options
z) Subtotal: 100.000/100.000 (mole %) Subtotal: 100.000/100.000 (mole %) Units
= [ H2o 1.80000 1.80000 male % -
|— N2 3.00000 3.00000 Display
[ (=
o |— coz 1.50000 1.50000 Eormula -
o r H2S 0.500000 0.500000
c
S| v cne 65,5000 essopn| L Show Nen = only
; |— C2HE 14.0000 14.0000 Show Mormalized Column
|— C3H3 &.00000 8.00000 Template Manager
|— FC4H10 1.00000 1.00000
[ n-canto 3.00000 3.00000 Standard i
|— FCEH12 0.500000 0.500000 Srmar.
r C5H12 0.700000 0.700000
|— C8H14 0.500000 0.500000
Normalize Options
Makeup w
Group Manager
|:| Use Groups

Note: There are several options to the right of the data entered.

1) Entry options: Here you can select the prefer units, and display name. You also have the options to
show the non-zero values only — sometimes the composition of species is zero — and show normalized
(yellow) column — this option is useful when the values don’t add up to 100 mole%.

2) Template manager: Here you can select the standard (default) template or the extended template —
which includes hydrocarbons with longer chains. You can also create and save your own template for
future use.

3) Normalize options: When your analysis does not add up 100 mole% you can select between two
options: Make-up and Prorate. For the Make-up option, the default gas used is CH4.

7. Click on the Reconcile (vertical blue tab). The reconciliation calculation will be calculated at 15.556 C and
1.00231 atm (standard conditions).
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Description [&¥ Design Definition 53 Report

Component Normalized Reconciled Gas Calculate &8

Subtotal: 100.000/100.000 (mole %) Subtotal: 100.000/100.000 {mole %)

Conditi
H20 1.60000 1756e5| -onten
Nz 3.00000 300133 J Conditions Value
-0 s ss5
) coz 1.50000 1.50066 empernlROT| 16555
T Pres=ure (atmj) 1.00231
= H2s 0.500000 0.500221 !
§ CH4 B5.5000 £5.5200
o« C2HE 14.0000 14.0082
C3HE 800000 8.00355
HC4H1D 1.00000 1.00044
[+ Show Mon-zera Cnly

n-C4H10 3.00000 3.00133
FCSH12 0.500000 0.500222
C5H12 0.700000 0.700310
CEH14 0.500000 0.500222

8. Now, we are ready to perform the calculation. Click on the Calculate button or press the <F9> key

9. ltis time to save your file (File >Save as...) or using the save icon in the tool bar. Create a new file and
name it: ScaleChem Analysis Calculations.

Analyzing the Results

Once the calculation is done, the Reconciled Gas column displays the results at equilibrium conditions.

Description ¥ Design [E¥ Definition Report

Surnmeaty
= o Component Normalized Reconciled Gas Caculdte @ ]
5 Subtotal: 100.000/100.000 (mole %)|  Subtotal: 100.0001100.000 (mole %) Unit Set: Metric (mol fraction
E H20 1.80000 775645 |_Conditon
12 300000 3ouggs| (] Conitions | Vaue N auaous (he o) Oataben:
° =a T 20000 — Temperature (*C) 15.5556 Aquecus (H+ ion)
E s T 0.500221 Pressure (atm) 1.00231 i:;‘;r‘;,l;'f:‘ndwmﬁ:m
§ CH4. 655000 65.5290 T-span: 25.0 - 225.0
= c2H6 14.0000 14.0062 P-span: 1.0 - 1500.0
C3HB 8.00000 8.00355 Stream Parameters:
LCAH10 1.00000 100044 Temperature (*C) 15.5556
n-C4H10 3.00000 300133 Show Non-zero Crly Pressure (atm) |1.00231
iLC5H12 0.500000 0.500222 Wakeup Normalization: CH4.
CsHi12 0.700000 0.700310 5| | Equilibrium Calculation.
cBH14 0.500000 0.500222 Phase Amounts:
Aqueous (mol) |0.0443282
Vapor (mol} 99.9557
Solid (mol) 0.0
2nd Liquid (mol) 0.0

Aqueous Phase Properties:

pH 475177,
onic Strength (molimol)|3.20592-7,
Denstty (g/mi) 0.999257

Calc. elapsed time: 0.940 sec.

Calculation complete

To the right you can see the results summarized in the Summary Box.

The top section contains the Stream Parameters information. In this example, the software performed an
equilibrium calculation at 15.556°C and 1.00231 atm.

The Phase amounts section shows the distribution of species in the different phases. This analysis contains
two phases: aqueous and vapor.

The Aqueous Phase Properties information shows the computed pH, ionic strength, and density of the
solution.

3. Click on the Report tab. Here you will see a more complete representation of the results at equilibrium.
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Section 13. Entering an Oil Analysis in OLI Studio: ScaleChem
13.1. Entering Data for an Oil Analysis

To add an Oil Analysis, go to the toolbar menu and click on Streams > ScaleChem > Add QOil, or by selecting

the Add Oil Analysis icon in the Actions Pane.

Streams = Calculations Chemistry  Tools  View

Add Stream l
Add New Analysis |
I ScaleChem > Add il
Add Gas
Analysis Add Brine
-ancile Mame: | Stre

Actions

@Add Stream

&) Add Mixer

e Add Water Analysis
%] Add EVS Calculation

# Add Oil Analysis I

% Add Gas Analysis
& Add Saturator

L Add Scale Scenario
Add Scale Contour
" Add Mixing Water
H: Add Facilities

You will see four different tabs for this analysis. The Description, Design, Definition and Report tab.

The oil analysis opens in the Design tab, which has 4 different sub-tabs: Combined, Pseudocomponents,

Assay and Reconcile.

In the Combined (red) sub-tab, pure components (organic and inorganic) are entered. If there is a component
that is not present in the prepopulated grid, simply click on the white grid and type the species of interest, using
the formula name or its name, as has been shown in the previous sections. Let’s say for example, you want to
add Isooctane. Type isooctane or i-C8H18 in the white cell to add it to the list.

Also, you can use the show non-zero only option to hide all the zero values — since they are not needed.

(ﬁ Des:riptinn[% Report

‘Compaonent
n-C4H10
HCSH1Z
csH1z
C05H14
CTH18
FCEH18
n-CBH18
C9H20
C10HzZ2
C11H24
C12H26
C13H28
C14H30
C15H32
C16H34
C1TH38
C18H38
C19H40
C20H42
C21H44
C22H46
C23H48
C24Hs0
C25Hs2
C30HB2
C35H72
C40HB2

ponent:

Pseud

Assay

Reconcile

Normalized

Entry Options
Units

mole % ~
Display

Formula v
[]Show Non-zero Only
[7]15how Mormalized Calumn
Template Manager

Standard v

Save as5...

Normalize Options

Prorate v
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In the Pseudocomponents (blue) sub-tab, you can enter pseudocomponents. Here you need to provide the
molecular weight, NBP, SG, Thermodynamic Method and the mole% information.

J Component Molecular Weight Nomal Boiling Point (°C) Specific Gravity Thermo Method Value (mole %)

Combined

«Enter a name=

Pseudocomponents

In the Assay (red) sub-tab, distillation curves can be entered. The Assay screen contains three data entry grids:
Component, Entry Options and Distillation Data.

Component Grid

= i Compoment ol Distillation Data Grid
= <Enter a name=
o J Volume%: Temperature (°C)
B
L=
L&) Entry Options |
ASTM D36

@ API-8
[ =
a - A
5 0.00 | Spedfic Gravity
o
B
L=
o
o
= ™ A ~
- Display Assay Cuts
L
o -

Entry Options
i J Name Mole % Mol Wt. NBP (*C) Sp Gr Cr Temp (*C) Cr Pres (atm) Cr Vol (Limol) Acentric Factor
=T
-9

Component Grid: In the component grid you can name your assay. No more than 5 letters are allowed for the
name. The mole% instructs the software that the mole% entered represents the total hydrocarbon mass.

Entry Options Grid: In this grid there are four pieces of information that the user needs to fill out: The Assay
Type, the Thermo Method, Density and No. of Cuts.

There are four Assay types. These are experimental methods used to create distillation curves.

Entry Options

Type

ASTM D35
Thermo Methed  [pemM D150

Density | 34.00

e ASTM D86 runs at atmospheric pressures and is used for all oil types
e ASTM D1160 runs at vacuum pressure and is used for heavy oils

e ASTM D2887 runs on a gas chromatograph and is used for light oils
o TBP is the true boiling point curve
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There are also four methods for calculating thermodynamic properties, referred to as Thermo Method in the
software, and these are: API-8, API-5, Cavett and Lee-Kessler.

e The API-8 and API-5 are methods that use specific gravity to determine critical parameters.
e Cavett is a method to determine critical parameters using the API gravity
o Lee-Kessler is a method to determine critical parameters by using the Watson K

There are thee average bulk density options: Specific Gravity, API gravity and Watson K.

Spedfic Gravity

Mo. of Cuts

API Gravity
Watson K

o Specific Gravity (SG) is the ratio of the material density to water. OLI Studio: ScaleChem requires specific
gravity to be between 0.228 and 1.6.

e API Gravity is defined as API Gravity = (141.5/SG) — 131.5

e Watson K is a method that relates density to boiling point

A more detailed description of the different assay types, thermodynamic methods and density calculation
methods is found in the Basic Definitions for the Oil Analysis Tool section on pages 374-377.

Distillation Data Grid: In this section the distillation data is entered.
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And in the Reconcile tab, is where the equilibrium calculations are performed.

The Reconcile sub-tab is used to calculate the properties of the gas at the temperature and pressure conditions
specified. By default, the values of temperature, and pressure are 60 °F (15.56°C) and 14.7 psia (1 atm).

Description Design Definition [ Report

J Component Normalized Calculate &
Subtotal: 100.000/100.000 (mole %)

550 0 Condition

Che 100.000 J Conditions Value
e Temperature (*C) 15.555
E Pressure (atm) 1.00231
g
==

Show Mon-zero Only
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13.2. Basic Definitions for the Oil Analysis Tool

13.2.1. Hydrocarbon Petroleum Fractions

Frequently a hydrocarbon analysis is the only data available for entry into the software. This analysis is usually
a distillation curve where the volume distilled as a function of temperature of a petroleum fraction has been
analyzed. This information must be turned into a vapor, organic and aqueous component for use in the
simulator.

ASTM D86

Used for light and medium petroleum products and is carried out at atmospheric pressure. The results are
converted internally in the OLI model generator to a TBP (True Boiling Point Curve). This curve is then fit to a
spline to smooth the curve. The cuts are taken from the spline.

ASTM D1160

Used for heavier petroleum products and is often carried out under vacuum. Sometimes as low as 1 mm Hg.
The results are converted internally in the OLI model generator to a TBP (True Boiling Point Curve). This curve
is then fit to a spline to smooth the curve. The cuts are taken from the spline.

ASTM D2887

Uses gas chromatography to produce the distillation curve and is applicable to a wide range of petroleum
products. The results are always reported on a volume percent basis. The results are converted internally in
the OLI model generator to a TBP (True Boiling Point Curve). This curve is then fit to a spline to smooth the
curve. The cuts are taken from the spline

True Boiling Point (TBP)

These curves, in practice, are difficult to obtain. The other methods are usually used instead.

13.2.2. Thermodynamic Methods (pseudo-components and petroleum fractions)
The methods used within OLI to calculate the critical temperature and pressure are the API, Cavett and Lee-
Kesler methods.

API Method

Uses the specific gravity to estimate the critical parameters. The specific gravity, if not entered, can be estimated
from the API gravity or the Watson K. The boiling points are taken from the assay data. API version 5 (API-5)
and API version 8 (API-8) are currently supported.

The API method is selected by the user. Tc, Pc, and Vc are calculated as follows:
T, = 24.2787 x T 58848 x §G 0359

_3.12281p +9

Inf, = sz.31255(;2.3201

if T, < 1000 °F

374



Otherwise

InP, = 8.3634 0-566 (0 24244 + 2.2898 (0'11857 x 0.001 X T

e = o038 = e~ (% SG) SGZ) ' b

+ (1 4685 + 3.048 + 0'47127) X | 7 X T? (0 42019 + 1'6977)| 10 X T3
' SG SG? p b \% scz J|P b

Z.xXT.%x10.73
=" "
Fe
Where,
Tc = Critical temperature in Rankine
Pc = Critical pressure in psia
Zc = Critical compressibility factor

1
o
¢ 3.43 + 6.7p — 9 X A?

And

A 8.75 + 1.978(log T},) X T}
- 1.8

if T. < 536.67 R

If 536.67<Tc<593 R, the above result for A is multiplied by f:

536.67)0'38

=(T —
f (C TC_TIJ

If Tc>593 R,

A (0.98907 x SG)(A — 592.4439)\"°
B Mw

Cavett

This method uses the API gravity method to determine the critical properties. The API gravity, if not entered
can be estimated from the actual specific gravity or the Watson K. The boiling points for the pseudo-components
are taken from the assay.
If the Cavett method is chosen by the user, Tc, Pc and Vc are calculated as follows:

T, = 768.0712 + 1.7133693 x T, — 0.0010834 x T? — 0.008921258 X T}, X API + (3.8890584p — 7)

+ T2 x 5.309492p — 6 X TZ X API + 3.27116p — 8 x (T, X API)?

logP. = 2.829046 + 0.0009412 X T, — 3.047475p — 5 x TZ — 2.087611p — 5 x API x T, + 1.5184103p — 9 x T3
+1.1047809p — 8 x API X T? — 4.82716p — 8 x API? X T, + 1.3949619p — 10 x (API X T,)?
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Z.xT.x10.73
po==t_c "

c PC
Where,
Tc = Critical temperature in Rankine
Pc = Critical pressure in psia
Zc = Critical compressibility factor
1

7. =
€T 343+6.7p -9 x A2

And

j_ 875 +1.978(1ogTy) X T,

5 if T. < 536.67 R

If 536.67<Tc<593 R, the above result for A is multiplied by f:

536.67)%38
r=(r-5—7)

Tc - Tb
If Tc>593 R,
A (0.98907 x SG)(A — 592.4439)\*°
B MW
Lee-Kesler

This method uses the Watson K and the specific gravity (which can be estimated via the Watson K) to determine
the critical parameters.

If the Lee-Kesler method is selected by the user, Tc, Pc, and Vc are calculated as follows:

100,000

b

811
T, = 3417 + — + (04244 + 0.1174 56) X T, + (0.4669 — 3.2623 SG) +

Inp, = 8.3634 — 2220 (0 24244 + 2228 0'11857) X 0.001 X T,
e =¢ SG ' SG SG? ' b
+ (1 4685 + 3648 + 0'47127) X | 7 X T? (0 42019 + 1'6977)| 10 x T3
' SG SG? P p % s¢z )| b

y _ ZeXTex 1073

[ PC
Where,
Tc = Critical temperature in Rankine
Pc = Critical pressure in psia
Zc = Critical compressibility factor
1

Z. =
© T 343+6.7p—9 x A?
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And
A 875+ 1.978(logT,) X T,

1.8

if T. < 536.67 R

If 536.67<Tc<593 R, the above result for A is multiplied by f:

_(T 536.67)0'38
f=\T. =T,

If Tc>593 R,

A (0.98907 x SG)(A — 592.4439)\*°
B MW

13.2.3. Average Bulk Density

Specific Gravity

Unitless, relative to pure water (H20) at 15 °C which has a density of 1.0 g/mL

API Gravity

Degrees API (°API). This is calculated via the following equation:

141.5

API(60F) = (s. g.-(60F)

)— 131.5

where, SG is the specific gravity at 60 °F.

Watson K

The Watson K has no units but is calculated via:

‘- NBP'/3
“\ s6

where NBP is the normal Boiling point.
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13.3. A Basic Gas Analysis

A brief introduction to the gas analysis tool will be shown in the example below. As we go through the example,

the basic definitions, functionalities and reporting for the Gas Analysis object will be shown.

Example 62: Basic Gas Analysis

The Gas Analysis object provides a quick way to enter a pure-component hydrocarbon gas.

Setting the Gas Analysis

10. Add a Gas Analysis. Go to the toolbar menu and click on Streams > ScaleChem > Add Gas, or by
selecting the Add Brine Analysis icon in the Actions Pane

Streams Calculations  Chemistry Tools  View Windo

MAdld Stream l [Hiz it

Actions

@Add Stream

[ Add Mixer

W Add Water Analysis
=] Add EVS Calculation

Add New Analysis |

ScaleChemn 1] Add Oil
Add Gas

Analysis
-ancile Mame: |Stre

Add Brine

m Add Brine Analysis
& Add Oil Analysis
F;Add Gas Analysis I
s Add Saturator

l—;’ Add Scale Scenario
(% Add Scale Contour

' Add Mixing Water
M Add Facilities

11. Click on the new Gas and press <F2> to change the name to Gas Analysis
12. Select the AQ thermodynamic Framework (default)

13. Click on the Names Manager Icon and select the Formula option (default)
14. Click on the Units Manager Icon, and select Metric, Concentration (default)
15. Under the Inflows Tab, enter the gas composition given in the table below

Gas Analysis Composition
Formula | Component Name | Mole %
H20 Water 1.80
N2 Nitrogen 3.00
CO2 Carbon Dioxide 1.50
H2S Hydrogen Sulfide 0.50
CH4 Methane 65.5
C2H6 Ethane 14.0
C3H8 Propane 8.00
i-C4H10 | Isobutane 1.00
n-C4H10 | n-Butane 3.00
i-C5H12 | Isopentane 0.50
C5H12 n-Pentane 0.70
C6H14 n-Hexane 0.50
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Your screen should look like the image below:

Description Design [£¥ Definition [ Report

g B Compenent Value Normalized Entry Options

=] Subtotal: 100.000/100.000 (mole %) Subtotal: 100.000/100.000 (mole %) Units

E H20 1.80000 180000 |mole 9% -
N2 3.00000 300000 pigpiay

= coz 1.50000 (LS00 Formula ~

o H25 0.500000 0.500000

s CH4 65.5000 es.cogp| ] Show Non-zero Only

& 14.0000 14.0000 Show Mormalized Column

Cc3He 8.00000 8.00000
LC4H10 1.00000 1.00000
n-C4H10 3.00000 3.00000 Standard w5
-C5H12 0.500000 0.500000
CsH12 0.700000 0.700000
CEH14 0.500000 0.500000

Template Manager

Save as...

AT =TT
5]

Mormalize Options
Makeup ~

Group Manager
|:| Use Groups Add

Note: There are several options to the right of the data entered.

4) Entry options: Here you can select the prefer units, and display name. You also have the options to
show the non-zero values only — sometimes the composition of species is zero — and show normalized
(yellow) column — this option is useful when the values don’t add up to 100 mole%.

5) Template manager: Here you can select the standard (default) template or the extended template —

which includes hydrocarbons with longer chains. You can also create and save your own template for
future use.

6) Normalize options: When your analysis does not add up 100 mole% you can select between two
options: Make-up and Prorate. For the Make-up option, the default gas used is CH4.

16. Click on the Reconcile (vertical blue tab). The reconciliation calculation will be calculated at 15.556 C and
1.00231 atm (standard conditions).

Description Design Definition [E Report

g J Component Normalized Reconciled Gas Calculate &
o Subtotal: 100.000/100.000 (mole %) Subtotal: 100.000/100.000 (mole %)
E HZO 1.80000 1.75645 i)

2 3.00000 3.00133| ||  Conditions Value
P co2 1 50000 150086 Temperature ("C) 5.555
E Hos 0.500000 0.500221 Pressure (atm) 1.00231
§ CH4 655000 655290
2 C2HE 14.0000 14.0082

C3H8 8.00000 8.00355

i-C4H10 1.00000 1.00044

n-C4H10 3.00000 300133| 1 Shom Nenzera Only

i-CSH12 0.500000 0.500222

C5H12 0.700000 0.700310

CBH14 0.500000 0.500222
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17. Now, we are ready to perform the calculation. Click on the Calculate button or press the <F9> key

18. It is time to save your file (File >Save as...) or using the save icon in the tool bar. Create a new file and
name it: ScaleChem Analysis Calculations.

Analyzing the Results

Once the calculation is done, the Reconciled Gas column displays the results at equilibrium conditions.

& Description [&¥ Design [&¥ Definition [E Report

L

Reconcile Inflows
=
I
151

C3H8
C4aH10
n-C4H10
FCSH12
CSH12
CEH14

Component

Normalized

Subtotal: 100.000/100.000 (mole %)
1.80000

3.00000

1.50000

0.500000

65.5000

14.0000

8.00000

1.00000

3.00000

0.500000

0.700000

0.500000

Reconciled Gas Calculste @
Subtotal: 100.0001100.000 (mole %) —
175845| Conditon
300133 || Conditions Value
= Temperature (*C) 15.5556
500221 Pressure (atm} 1.00231
65.5290
14.0082
800355
1.00044
200133 Show Non-zero Only
0500222
0.700310
0500222

Summary

Unit Set. Metric (mole fraction

Automatic Chemistry Model
Aqueous (H+ on) Databanks:
Aqueous (H+ ion
Second Liquid phase
Using K-fit Polynomials.
T-span: 25.0 - 225.0
P-span: 1.0 - 1500.0
Stream Parameters:
Temperature (C)|15.5556
Pressure (atm) | 1.00231
Wakeup Normalization: CH4.
Equilibrium Calculation.
Phase Amounts:
Aqueous (mol) 0.0443282

Vapor (mol) 99.9557
Solid (mol) 0.0
2nd Liquid (mol) 0.0

Aqueous Phase Properties:

pH 475177,
lonic Strength (molimol)|3.20592¢-7.
Densty (g/mi) 0.999257

Calc. elapsed time: 0.940 sec.
Calculation complete:

To the right you can see the results summarized in the Summary Box.

The top section contains the Stream Parameters information. In this example, the software performed the

The Phase amounts section shows the distribution of species in the different phases. This analysis contains

two phases: aqueous and vapor.

The Aqueous Phase Properties information shows the computed pH, ionic strength, and density of the

solution.

4. Click on the Report tab.

Here you will see a more complete representation of the results at equilibrium.
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13.4. Putting together a complete calculation in ScaleChem

Now that we have defined some terms, we are now ready to begin entering the information required to run a
calculation. In this calculation we will be entering the concentrations of a single brine.

Task 1 — Create a Brine Analysis

In this tour we will show the main interface of a Brine Analysis, followed by an example of a brine (water analysis)
and calculate its scale tendency. Let’'s begin. Steps for the simulation will be given with bullet points.

Add Brine
Analysis

1. Add Brine Analysis from Actions Panel.

2. Click on the description Tab. If the Description tab is not currently displayed, click on the tab.

Tl
Description Design [E Report

I arme: |Brine |

The chemistry of the brine needs to be entered. This information includes concentrations, alkalinity, pH and
density. The table below describes the hypothetical water that we will create:

Brine Analysis

Na+1 36000 CI- 57000 Temperature 25C
K+1 300 S04-2 250 Pressure 1 atm
Ca2+ 600 H3CO3-1 600 pH 7.67
Mg2+ 150 Alkalinity 600
Sr+2 80 Density (mg/L) 1.064
Bat2 5 Total Dissolved Solids (mg/L) 96280

The screen should look like the image below

| Variable Value | Balanced | Entry Options
uE.; Cations (mg/L) Uniits
i e v
a - - Display
Cas2 600.000 | 600.000
T Mg=2 150.000 | 150.000 e -
% Sr+2 80.0000 | 80.0000 [ show Non-zero Only
s Bas2 5.00000 | 500000 []Show Balanced Column
; Fes2 0.0 0.0
Template Manager
Anions (mg/L) Standard v
ok 57000.0 | 570000
s0e2 250.000 | 250.000 save as...
[ HCO3-1 £00.000 | 600.000
HS-1 0.0 0.0 | Balance Options
C2H302-1 0.0 00|  Type
Dominant Ton v
Neutrals (ma/L)
coz 0.0 0.0
HZ5 0.0 0.0
sio2 0.0 0.0
B(OH)3 0.0 0.0
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3. Select Formula
Display

0.0 OLI Tag ~
Display Name

e Formula

0.0

You can display an easier-to-read table by showing only the species that have actual concentrations.

4. Select the Show non-zero only box

= J Variable Value Balanced Entry Options
= Cations (mgiL) Urits
w
‘E Na+1 35000.0 36116.0 — -
K+1 300.000 300.000
a al Display
Ca+2 500.000 §00.000
Mg+2 150.000 | 150.000 Frmes >
@
= Sr+2 80.0000 | 80.0000 Show Non-zero Only
c
o Ba+2 5.00000 5.00000 | Show Balanced Column
a
14

Template M,
Anions (mglL) = g

CH 57000.0 | 57000.0 Standard v
504-2 250.000 250.000
5
HCO31 600.000 | 600,000 ave as
Neutrals (mg/L) Balance Options
Type
Dominant Ion ~

Another thing to consider is which Balance Option to select.

Itis highly unusual for the data to be electrically neutral. Therefore, samples are reconciled for Electroneutrality.
After entering each species concentrations, you will notice that Balanced values show up in the column next to
values. The Column header says Balanced.

= J Variable Value l Balanced

E Cations (mg/L)

i} L

o Na+1 36000.0] 36116.0

= % !

g K+1 300.0004 300.000
Ca+2 500.000 §00.000
Mg+2 150.0004 150.000

@ L

o Sr+2 80.0000] 80.0000

§ Ba+2 5.000004 S5.00000

o L

o

Anions (mgiL)

CH1 s7000.0f 57000.0
504-2 250,000 250.000
HCO3-1 600.000) &00.000

Neutrals (mg/L)

When adding or removing ions to balance charge, the solute mass is altered. We must decide as to whether
we keep the mass of the solution constant (thereby adjusting the amount of water) or keeping the amount of
water constant and adjusting the solution mass.

382



Balance Options

Type

Daminant Ion -
Dominant Ion

Prorate Cation

Prorate Anion

Makeup Ion

5. Select Dominant lon balance option type.

You can review the Dominant lon Charge and lons needed to balance in the tables presented in the Summary
Box.

Summary

Unit Set: Metric (mass concentration)

Automatic Chemistry Model
Agqueous (H+ ion) Databanks:
Agueous (H+ ion)
No Solid phase(s)
Custom K-fit P-span
Stream Parameters:
Temperature (*C) |25.0000
Pressure (atm) 1.00000
Stream amount (L) 1.00000

minan arge
leq/L):

Cation Charge 1.61776
Anion Charge -1.62280
Imbalance -5.04367e-3

lon(s) needed to balance (ma/L):
Ma+1 115.954

Concentration Data Only.

The summary box shows additional detail about the brine’s chemistry and balance option. The stream

parameters table shows default values. The Dominant lon Charge Balance shows the total cations or anions,
and the total imbalance.

Now is time to enter the measured property data in the Reconcile Tab.

Select Concentration Data Only Option
Check the Calculate Alkalinity box

Enter the measured pH (7.67), density (1.064 g/mL) and TDS (96280 mg/L)
Leave the Allow solids to form unchecked.

© ® N

We will leave the Allow solids to form unchecked because generally the industry uses acid to preserve water
samples, which prevent solids to form. Acidified samples contain the unprecipitated ion concentration, which is

what we entered into the brine. In this step, we will eliminate solids because allowing solids to form would
change the brine’s composition significantly.
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~y

Calculate Brine Properties Using:

(®) Concentration Data Only Spers... Calculate &6

() Gas-Phase CO2 Content {moles)

(C) Measured pH and Alkalinity [ allow solids to form
(C) Measured pH Only

Calculate Alkalinity

| I Data Entry

Properties Measured Calculated
Temperature (*Ch 25.0000
" | Pressure (atm) 1.00000
ar 767000
Alkalinity (mg HCO3/L) 600.000
Density (o/ml} 1.06400
Elec Cond, specific (pmho/cm) 0.0
Total Dizzolved Solids (mg/L) 95220.0

Composition Adjustments

Add Charge Balance (mg/L Na+1)

10. Select the Calculate button or press the <F9> key

-

Calculate Brine Properties Using:

(®) Concentration Data Only Specs... Calculate i@

() Gas-Phase CO2 Content (mole%s)
(O Measured pH and Alkalinity [[] Alow solids to form
o (C) Measured pH Only

) T Data Entry

2 Calculate Alkalinity

‘g

§ J Properties Measured 1 Calculated

o Temperature ("C) 25.0000

o Pressure (atm) 1.00000)
pH 7.42804
Alkalinity (mg HCO3/L) 554 260
Density (g/ml} 1.06134
Elec Cond, specific (pmho/cm) 1.26085e5
Total Dissolved Solids (mo/L) 95090.6

Composition Adjustments Ll

Add Charge Balance (mg/L Na+1) 115.954

Once the calculation is done, the calculated column displays results based on the concentration that were
entered in the Data Entry Tab. The calculated results of note are pH=7.43 and 564.26 mg/L as HCO3 in total

alkalinity.

Experimental inaccuracies in sample measurement may, on occasion, result in a calculation that indicates that
solid is supersaturated. This can normally be ignored providing that the super saturation is not excessive.

Aqueous Phase Properties:

%pH 7.42804
lonic Strength (mol'mal) 0.0288607
Density (g/ml) 1.06134

Calc. elapsed time: 7.905 sec.

Calculation complete

The brine iz supersaturated with 3
solids:

BaS04 (Barite), CaCO3 (Calcite),
SrC0O3 (Strentianite)

Alkalinity: 564.260mg HCO3L

More details of the Brine composition can be found in the Report Tab.
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In the Report tab, scroll down to the Pre and Post Scaling Tendencies, where you will find the results of Scaling

Tendencies with Solids off.

17!

Description [£¥ Design @ Report L2 File Viewer
Jumpta: | Brine Analpsis Data ~ @ =N Customize Expart

Pre and Post Scaling Tendencies
Scale Mineral Pre-scaling Pre-index Post-scaling Post-index
BaC03 (Witherite) 7.09380e-4 -3.14912 7.09380e-4 -3.14912
BaS04 (Barite) §.22755 0.794317 5.22755 0.794317
Caco3 (Calcite) 6.35375 (0.803030 6.35375 0.803030
CasS04.2H20
(Gypsum) 0.0174237 -1.75886 0.0174237 -1.75886
CaS04 (Anhydrite) 0.0142718 -1.84552 0.0142718 -1.84552
KCI (Sylvite) 7.36476e-4 -3.13284 T.36476e-4 -3.13284
MaCl (Halite) 0.0324630 -1.48861 0.0324630 -1.48861
SrC0O3 (Strontianite) 238156 0.376861 238156 0.376861
5r504 (Celestine) 0123629 -0.907879 0.123629 -0.907879
Brine Composition
Cations Value {mag/L}) Anions Value {(maiL}) Neutrals Value {(mgiL)
K(+1) 300.000 Cl-1) 57000.0
Ma(+1) 36116.0 HCO3- () 600.000
Ba(+2) 5.00000 504-2 250.350
Cal+2) 600.000
Mg(+2) 150.000
Sr(+2) 20.0000

If we would have allowed solids to form, these concentrations would not be as close to the initial values.

Note: If scaling tendencies did not show up in the Report Tab, follow these steps:

(*) Thiz iz total system carbonate including dizelved COZ. THIS IS NOT ALKALINTY?T

11. Right click on the brine analysis icon
12. Select Calculation Options

2

Actions
Actions

T AddRsi
‘D
2 A P—

Mavigator L ~ X
: 7
16_Brine Analys
ams

Description

Arrange

Cut
Copy
Paste
Delete

Rename

Add As Stream
Clear Results

Clear Status

Calculation Options

>

T T TRaramntar
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13. Enable Pre-scaling Tendencies

Calculation Options - Brine-2 ? X

ScaleChem Calculation Options  ScaleChem Convergence

General Diagnostics
Show status dialog [C]Enable trace
Verbose

Optional Properties
Diffusivities and Mobilities

[ iffusivities Matrix
Viscosity
Electrical Conductivity
|:| Heat Capacity
Activities, Fugacities, and K-Values
[JGibbs Free Eb’gy
[ClEntropy
Thermal Conductivity
surface Tension
Interfacial Tension
Pre-scaling Tendendies e
Method
() Estimated (®) Rigorous

Cancel Apply Help

Task 2 — Create a Scaling Scenario

The next task is to calculate the brine scaling tendencies. Once the Brine Analysis data is entered and
the sample reconciled, we can begin the Scaling Scenario calculation.

1. Select Add Scale Scenario from Actions panel.

Actions o~ X%
Actions

Add Brine Add Oil Add Gas Add

Analysis Analysis Analysis Saturator

L

Add Scale

¥ooTt

Add Scale Add Mixing Add Facilities
Contour Water

Saturator
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Once we add a Scale Scenario object, the software opens to a new Design screen containing three
vertical tabs: Inlets, Conditions, and Solid. We will work in each of these sections to set up the
scaling calculation.

Description Design il Plot [Z Report 2 File Viewer

% J Type Name Flow
E =select=

w

c

£

%

=

o

L]

% Detail Info of Selected Inlet Name

= J Component Value (mallhr)

Inlet Tab

Type You can select the brine, gas or hydrocarbon of interest

Name Click in the Name field. As you position the cursor in the field, a Down Arrow will appear. You
can then select from a list of brines, gases or oils already entered into this OLI Studio:
ScaleChem document.

Flow Enter the flow rate for the gas, hydrocarbon or brine.

2. Click on the Description tab and rename the Scale Scenario as “ Brine Scale Scenario”.
3. Then click the Design tab.

Your screen should now look like image below.
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B File Edit Streamns Calculations Chemistry Tools View Window Help

=
=
M Bt _- Idle Eancel

Calculate @

[ calculate Akalinity

Summary

Unit Set: Scale Metric

Automatic Chemistry Model
Aqueous (H+ ion) Databanks:
Aquenus (H+ ion)
Custom K-ft P-span

4. Select the Inlets tab

Selected Solids:
No Solid Selected
Calculation not done

M=oy =] By @ T A | Aqva S0 Re s W o:E L #hE e | % B
Mavigator L o+ X l—i
Chapter 16_Brine Analysis*
¢ Streams Description ¥ Design il Plot (& Report L2 File Viewer
- lgb Brine-2
.| Brine Scale Sci}arin o J s = Flow
2
@
2
S
=
2
5
%)
% Detail Info of Selected Inlet Name
< B Component Value (mol/hr)
Actions L o+ X
Actions

Select the right corner of the first cell in the Type column then select Brine (bbl/day)

J Type Name

Whole Fluid '

Detail Info of Selected Inlet Name

Flow

Solid/ Conditions/lnlets

J Component

6. Select Brine from the drop-down menu in the Name column.

Value (mol'hr)

Description Design (il Plot [ Report L3 File Viewer

J Type Name
Brine

Inlets

=selects

Flow

~|

7. Enter 1400 (bbl/day) in the Flow Column. Please change units if necessary.

Conditions Tab

8. Select the Conditions Tab (vertical blue tab on the left-hand side of the Design screen)

At least one inlet should be selected.
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Description Design il Plot [ Report L3 File Viewer

I J Laocation Temperature (| Pressure (bar) | Drop Solid
= || [<Enter Location Name= |
w
=
]
=
£ 3
=]
(%]
=
& Auto Step Sort Zoom
Steps: | - | Go TP =Nl |

The Conditions section is where we enter points along the production scheme. The first column is Location.
We can use the dropdown menu in each row to select a location or type in our own location name.

9. Type in the following conditions or use the dropdown menu within the Location cells.

Scale Scenario Locations

Reservoir 125 275
Bottomhole 125 280
Downhole 115 190
Midwell 105 130
Wellhead 100 100
Choke 90 80
Separator 60 30

The diagram within the Conditions screen and the list of locations in the Summary box both show the locations
in the order that we entered. This screen has options for zooming, auto steps, sorting by temperature or
pressure, and dropping solids at particular conditions.
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Description ¥ Design il Plot & Report L File Viewer

w0 J Location Temperature (°C) Pressure (bar) Drop Solids
g Reservoir 125.000 275.000 O
i Bottom hole 125.000 280.000 D
Downhole 115.000 190.000 D
E Widwel 105.000 130.000 O
= Wellhead 100.000 100.000 O
=]
E Choke 50.0000 30.0000 O
o Separator 600000 30.0000 ]
=Enter Location Name>
o
& Auto Step Sort Zoom
steps:| 5 |[Go| [T ||P g @
~
Resenvoir E:‘“I“" Downhole Midwell ;
T:1250 . 1255 o T1150 o T:105.0
P275.0 Fos0g P:190.0 P:130.0
i /! / /]
Wellhead Choke. Separstor
T:100.0 o T:20.0 T:E0.0
F:100.0 F:20.0 F:20.0
f f +
v
< >

The graphical view clearly shows the five locations and their Temperature and pressure conditions.

Caloulate &

[ calculate Alkalinity

Summary

Unit Set: <Customs=

Automatic Chemistry Model
Agueous (H+ ion) Databanks:
Agqueous (H+ion)
Excluding 68 solid phases
Custom K-fit P-span
Inlets:
Brine (bbl'day) Brine| 1440.00

. Temperature Pressure
Locations

(°C) (bar)
Reservoir 125.000) 275.000
ﬁgﬁ“m 125.000  280.000
Downhole 115.000)  150.000
Midwell 105.000, 130.000
Wellhead 100.000)  100.000
Choke 50.0000, 80.0000
Separator 60.0000) 30.0000

Selected Solids:

BasS04 (Barite)
CaCO03 (Calcite)
CaS04.2H20 (Gypsum)
CaS04 (Anhydrite)
NaCl {Halite)
Sr504 (Celestine)

Calc. elapsed time: 4.653 sec

< >

The Drop Solids checkbox column at the very end of the grid is designed to help the users decide if they want

to carry forward solids from certain locations or not.
Solid Tab

10. Select the Solid Tab
11. Make sure that the solid button in the menu bar is selected.

aa e[ Solb [Re & [ < ¢ 8

12. Select the Standard checkbox

Solids Selection
arite)

CaCo3 (Caldte)
Cas04 (Anhydrite)
Cas04,2H20 {(Gypsum)
MaCl {Halite)

E 5r504 (Celesting)
-[Z] Expanded
-] Al

EEE

Solid TJ:onditions/lnlets

13. Press the Calculate button of select the <F9> key
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14. Select the Plot Tab

You can customize which curves are visible by selecting the Variables button.

Description [£¥ Design il Plot 5l Report L2 File Viewer

| a & & [8][§] [ vwom e

26 T T T
24 - '\’\k 1
22 - b
—&— CaC03 (Calcite) - Sol Pre-scaling tef cy [Pre-ST]
20 |- — 4 CaCO3 (Aragonits) - Sol Pre-scaling tendency —
2 18 —m— SrCO3 (Strontianite) - Sol Pre-scaling tendency [Pre-ST)]
g —4— BaS04 (Barite) - Sol Pre-scaling tendency [Pre-ST]
@
= 16 | MgCO3 (Magnesite) - Sol Pre-scaling tendency [Pre-ST) .
K
@
c 14 . 7
= l — —h— T
§ —
s 121 i
o
T 0 E
=
E
DD 8 % .
6| o Sa d
— — —8—  __m
———a
4k = 4
2 + e % n
0 ¥ 4 S—
(o)
Ta, %, %, %, %, 4 %,
) ) ) % %, o =N
I % 4 % %, 3
% %, % e ©
@

15. Select the View Data button

@ ::'q, ﬁm = [E] | Wiew Data Wariables Cptions

The View Data button shows the pre-scaling tendency at each location. We can copy the results of this table to
a program like Excel by selecting the top left cell then selecting <CtrI>+<C> on the keyboard.
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Task 3 — Create a Gas Analysis

1. Double click on the Add Gas Analysis object in the Actions Panel

At [ =
ACBons F
17
: s )
I I T B
Add Sream  Add Moer  Add Water Add EVS Add Braine
Arpbiin  Caleulsticn  Analys
|| F E G
Addd Ol Add Gas Add Add Szale Aadd Seale
Anatyin Andhin Saturatce Seerang Cortour
Y w4y
Add Meong Add Faclites  AddHC
Wiater Seturstor

This adds a Gas object to the Navigator panel.

2. Select the Description tab, then rename the object Gas Analysis.

MNavigator
Chapter 16_Brine Analysis*

ﬂ-‘x| &

6“ Streams

E’ Brine

: l:ﬂ Brine Scale Scenario
L..#2 Gas Analysis

Description Design Defin

Mame: |Eas Analysiz

Enter the following composition and values in the Inflows grid:

H20
N2
COo2
H2S
CH4
C2H6

The Inflows grid will look like one of the two below, depending on the Names view you select.

Water
Nitrogen
Carbon dioxide

Hydrogen sulfide

Methane
Ethane

Gas Analysis

1.80
3.00
1.50
0.50
65.5
14.0

C3H8
i-C4H10
n-C4H10
i-C5H12
n-C5H12
n-C6H14

Description ¥ Design [&%¥ Definition (& Report L3 File Viewer

Propane
Isobutane
n-Butane

Isopentane
n-Pentane
n-Hexane

o || Component Value Normalized Entry Options
_§ Subtotal: 100.0| Subtotal: 100.000i  Urits
E| [ Ho 1.80000 180000 | |mole % -
[ w2 3.00000 300000 | pigiay
[ coz2 150000 1.50000
2 Formula ~
o[ [ nes 0.500000 0.500000
S| v cne 855000 55000 |  Show Non-zero Only
4 -
3 [ cave 12.0000 14.0000 [+] Show Normalized Column
[ cans 8.00000 BO0DU0 | opite Manager
[ icanto 1.00000 1.00000
| ncenio 3.00000 3.00000 Standard o2
[ icemiz 0.500000 0.500000 Save s,
[ csHiz 0.700000 0.700000
[ ceH14 0.500000 0.500000
Makeup ~
Group Manager
[J use Groups Add

8.00
1.00
3.00
0.50
0.70
0.50
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This is the extent of the gas entry step. There are modifications that can be part of the gas analysis entry step
(in the Reconcile Tab), but in this case, they are not considered. Now that the gas is entered, the scale scenario
considered in Task-2 will be recomputed.

Description [&¥ Design [£§ Definition [ Report (3 File Viewer

Summary
o] Component Normalized | Reconciled Ga Calculate &8
E Subtotal: 10| Subtotal: 100.0 Unit Set: Metric (mole fraction)
E H20 1.80000 1.75645 o)
- Saturate With " - Automatic Chemistry Model
M2 3.00000 3.00133 alura ! one Agueous (H+ ion) Databanks:
Q coz 1.50000 1.50066 - Agueous (H+ ion)
3 = — —_— | conditions Value Second Liquid phase
= 7 = Temperature (*C} 5.555 Custom K-fit P-span
55 55
E £k 55 S0 G Pressure (atm} 1.00231 Stream Parameters:
C2He 14.0000 14.0082 Temperature (*C)|15.5556
S HIEEY LIEED Pressure (atm) |1.00231
-C4H10 1.00000 1.00044 -~
Show Non-zera Only llakeup Normalization: CH4.
e S0t UTTE Equilibrium Calculation.
C5H12 0.500000 0.500222 Phase Amounts:
CsH12 0.700000 0.700310 Aqueous (mol) |0.0843276
CEH14 0.500000 0.500222 o | [Vapor mon 99,9557
I} Solid (mal) 0.0
2nd Liguid (mol) 0.0
Aqueous Phase Properties:
pH 475178
Ionic Strength (molmol) 3.20591e-7
Density (g/ml} 0585257
Calc. elapsed time: 0.846 sec.
Calculation complete

Task 4 — Recalculate Scale Scenario with Gas
The gas analysis will be added to the Scale Scenario so that it is considered during the scale evaluation.

1. Select the Brine Scale Scenario icon in the navigator panel

b“ Streams
G- lgp Brine
i E{:Q'le Scale Scenario

&2 Gas Analysis

2. Select the Design Tab (horizontal tab) if not automatically sent there
3. Select the Inlets tab (vertical) if not automatically sent there
4. Inthe Type Column Add Gas

Type Name Flow
Brine (bbl'day) Brine 1400.00

5. In the Name column select Gas Analysis

N Type Name Flow
Brine (bblday) Brine 1400.00

Gas (std E3m3/day)

=select=

A

6. Enter a flowrate of 250 std E3m3/day in the flow cell

| 393



[} T Name Flow

% J Brine (bbl-'dy:re} Brine 1400.00
= Gas (std E3m3/day) Gasz Analysis 250.000
w |

7. Calculate (Press <F9>)
8. Select Plot Tab

</ Description [£¥ Design M Plot [ Report 3 File Viewer

\ a 2|2 [8][E [veroas mam

38

341 q
32 ~
sol 4 Bas04 (Barke) - Sol Pre-scaling tendency [Pre-5T] ]

—4— £aC03 (Calote) - Sol Pre-scaling tendency [Pre-5T]

28 @ CaC03 (Aragonite) - Sol Pre-scaling tendency [Pre-ST] ]
261 - SrCO3 (Strontiante) - Sol Pre-scaing tendency [Pre-ST] B ]
241 3r504 (Celesting) - Sol Pre-scaling tendency [Pre-ST] ]

Dominant Pre-scaling Tendencies

9. Select Variables button
10. Remove all the variables from the Y1 Axis and the Y2 axis by double-clicking on the variables (this
removes then from the list). Alternatively, highlight each variable and click on the double-arrow.

You will replace the existing variables with the calcite pre-scaling tendency.

11. Expand the Pre-scaling Tendencies button by clicking the + sign

12. Double-click on the CaCO3 (Calcite) variable to move it to the Y1 Axis
13. Expand the Additional Stream Parameters and add pH to the Y2 axis
14. Click OK

Select Data To Plot ? >

Curves

(- Thermodynamic Properties ~ X Aodis

=- P_re—scding Tendencies > Locations

i.. Dominant Pre-scaling Tendencies

i BaS04 (Barite) - Sol Pre-scaling tendency Y1 Aois |
i CaS04 (Anhydrite) - Sol Pre-scaling tendency
i Ca504 2H20 (Gypsum) Pre-scaling tendency
i NaCl {Halite) - Sol Pre-scaling tendency S
i 5r504 (Celestine) - Sol Pre-scaling tendency <<
- Pre-scaling Index
- Sealing Tendencies
- Sealing Index
- Aquecus
Vapor ¥2 Auis |
Second Liquid
Solid
Molecular Totals © 3

Solids
Standard ~

[ Use short names

Hide zero species Z Mxis
Plot data which is only within temperature range: _Select -
0K Cancel Apply Help
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If you are in the View Data view, then the table should be similar to the one below.

Locations

CaCo3
(Calcite)
- 5ol
Pre-sdali
ng
tendenc
¥

pH

Pre-sT

~lemen | fesra]—

Reservoir
Bottom hole
Downhole
Midwell
Wellhead
Choke
Separatoer

0.705312
0.694891
0.655192
0604657
0616784
0.500629

1.24448

561211
560661
567654
5.74056
5.79768
5.81369
6.14419

Calcite is sub-saturated (S<1) at all locations, except the separator.

15. Select the View plot button

The decreasing calcite saturation trend and the increasing pH is easier to see from the plot view.

Description Design @l Plot [Z] Report i File Viewer

[ZHENIES =) | ViewDala

WVariables

Optians

072 508

oo T A Jsos

0.68 - \ J 594
g 066 - +CEC03(Ca\uﬂe}}lﬂ@-sualingIendency[PrB—ST] q5.92
& ooss o (v2) S 1590
= 1588
= 0.62 . — _),_.\
5 060 ., 1 586
2 Y 584
5 058 A 5.
2 056 NS \ 4 Jss2
@ e i
S 054 e S 580 _
| - I
o N ;
2 050 - 1
048 & \ s
e sz
= 046 Js70
3 0.44 s 1568
G 042 1566
< 040 Jses

0B/E _ \. 1562

0.36 o 1560

0.34 L L L o L 5.58

'?% %, OD;,, 4’6 9, G’jo
%, S % g, % o %,
% b, % 4 % G
=]

Task 5 — Creating a Saturator Object

You will use the Saturator object to set the reservoir minerals at equilibrium with the produced fluid. It is
reasonable, in some cases, to saturate the produced fluid with common evaporite and secondary minerals like
CaCO03, CaS04.H20, FeCO3, and NaCl. This is based on the assumption that as the reservoir fluid flows
through the rock pores, there is sufficient time to interact with the surface minerals. This is based on a second
assumption that the vertical column of liquid and gas are in complete equilibrium and that the saturating minerals
are distributed throughout the reservoir matrix, such that complete water-mineral contact is possible.
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In this case we are going to simulate a particular oil & gas well: ABC. This well produces from calcite-cemented
sandstone. Barite is also present in minor quantities in the rock matrix. You will, therefore, create a reservoir
called ABC Reservoir and saturate the Brine (previously calculated) with calcite and barite. You will then

recalculate the Brine Scale Scenario.

1. Add a Saturator Object

Actions g =X
Actions Ll\\g
] e sl _— m
Add Stream  Add Mixer  Add Water Add EVS Add Brine
Analysis Calculation  Analysis
w | F |
Add Gil Add Gas Add Add Scale  Add Scale
Analysis Analysis Saturator Scenario Contour
AT 4 &
s wE
Add Mixing  Add Facilities  Add HC
Water Saturator
2. Select the Description Tab to rename the Object Reservoir
Mavigator pL o+ X
X N -
Chapter 16_Scale SCEH%IO with £
& Streams by Description Design [ Report 03 F
£-Tgb Brine
[ - Reconciled-Brine-1 -
i @ . Narne: |F|eserv0|r | D
l:@ Brine Scale Scenario
% Gas Analysis
.3 Reservoir
3. Select the Design Tab
Description Design [ Report 3 File Yiewer
-
‘E J Type Name Flow Calculate @
= -
£ Dl calculate Aksliity
Summary
=
°
w0 Unit Set: Scale Metric
Automatic Chemistry Model
Agueous (H+ ion) Databanks
Aguecus (H+ ion)
Custom K-fit P-zpan
] Conditions Value At least one inlet should be selected
Temperature (*C) for Resenvoir
Pressure (bar} Selected Solids:
Calculation not done
Detall Info of Selected Inlet Name
J Component Value (mol/hr)

The Saturator has two vertical tabs: Inlets and Solid.

In the Inlets Tab the Fluids are entered in the top grid and the Conditions are entered in the bottom grid.

Solids are selected and saturated in the Solid Tab.

4. Enter the Brine calculated in Task 1
5. Enter the Gas calculated in Task 3
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6. Enter the Reservoir conditions: 125 C and 275 bar in the conditions section.

Description & Design [ Report I File Viewer

i
it J Type Name Flow Calculate
c! a/day)
= Brine (m3/day) Brine 200.000 [ Calculate Akiinity
Gas (sid E3m3/day) Gas Analysis 250.000
- <selects Summaty
s
w Unit Set: Scale Metric
Automatic Chemistry Model
Agqueous (H+ ion) Databanks:
Agueous (H+ ion)
Second Liguid phase
J Conditions Value Excluding 83 solid phases
Temperature (*C) 125.000 Custom K-fit P-span
Pressure (bar) 275.000 Inlets:
Brine (m3/day) Brine|200.000
Detal Info of Selected Inlet Name Gas (std 825 250000
¥ E3m3/day) Analysis
J Component Value (mole %)
Warning: no solid selected for
Reservoir,
Selected Solids:
> Calculation not done

The Saturator’s calculate button is yellow. This is because solids have not been selected yet. A warning also
appears in the summary box. A yellow button is allowable, and a calculation may continue; it is merely a warning
that the case is incomplete.

7. Select the Solid Tab (vertical tab)
8. Select the Standard checkbox

This last step instructs the software to allow the selected solids to precipitate — to include solid-liquid equilibrium
equation in the calculation. It does not instruct the software to saturate these solids. Rather, if the phase is
supersaturated, then it will precipitate. It is in the lower section that saturated solids are chosen.

This section contains two columns. The first (Solid) is the mineral to be saturated, and the second (inflow) is
the cation and anion to be adjusted. If, for example, Barite is subsaturated in the existing fluid, then Ba+2 and
S04-2 are added. The amount of each added is stoichiometrically equivalent; one Ba+2 with one SO4-2, which
maintains charge balance. If, for example, (again) Calcite is supersaturated, then equal mole amounts of Ca+2
and CO3-2 will be removed from the fluid. This inflow will be positive if the solid is subsaturated in the existing
fluid, or it will be negative if the solid is supersaturated.

9. Use the Solid drop-down menus to select BaSO4 (Barite) and CaCO3 (Calcite) as solids to saturate
10. Use the Inflow drop-down menu to select BaSO4 and CaCO3 as solids to saturate (it should have been
selected automatically).

Reservoir Mineral Saturation Section

J Mineral to saturate Inflow to vary
BaS04 (Barite) Bas04
CaC03 (Calcite) CaCo3 -
<Select Solid= 4%

At this point, the Calculate button is green indicating that the specifications are complete.

11. Calculate (or press the <F9> key)
12. Click the Report tab
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The Saturator Report tab contains several tables: Saturation Details, Inlet Summary, Stream/Phase Properties,
Pre and Post Scaling Tendencies, Brine Composition, Gas Composition, and if selected an inlet summary.

e Scroll down to the Pre and Post Scaling Tendencies Table

Pre and Post Scaling Tendencies

Formula Mineral Excess Solute Excess Solute Pre-Scale Pre-Scale Post-Scale Post-Scale
mg/L 1b/1000bbl s, ST s1, Index s, ST sl, Index
CaS04.2H20 Gypsum 0.0 0.0 0.0179366 174626 0.0179365 174626
5504 Celesting 0.0 0.0 0148191 -0.829178 0.148191 -0.829178
SrCo3 Strontianite 0209852 -0.678087 0209852 -0.678087
Bag04 Barite 2 6465865 02764486 1.00000 18253486 1.00000 0.0
Caso4 Anhydrite 0.0 0.0 0.0934633 -1.02936 0.0934633 -1.02936
Caco3 Calcite 11349565 3.97806e-6 1.00000 -4.51593e-8 1.00000 0.0
MaiOH)2 Brucite T 49848084 -3.30235 49847904 -3.30235
NaC| Halite 0.0 0.0 0.0245553 -1.60985 00245553 -1.60985
Kel Syhite 21438204 -3.66881 21438264 -3.66881

Excess solute or Max Scale: The solids amount forming at equilibrium.

Pre-Scale: The saturation ratio before solids precipitate.

Post-Scale: The saturation ratic AFTER solids precipitate (if solids are selected),

S, 5T - Saturation, Scale Tendency: The ratio of the concentration (activity) to its solubility (S=1).
Sl- Scale Index: Log(S).

The Max scale column shows that trace amounts of BaSO4 and CaCO3 are present in the water. These
exceedingly small values (in the parts-per-trillion range) are the specifications or targets for the calculation. The
software sets these target solid concentrations and then adjusts up or down, the BaSO4 and CaCO3 inflows
until it reaches these targets. These part-per-trillion values may look arbitrary, but in fact the values are
equivalent to 1e-10 moles of solid/kg water.

Notice also, that the pre-scale tendency for BaSO4 and CaCQO3 are set to 1.0, by saturation definition. That is,
these are not calculated, they are defined. The remaining scale tendencies are computed.

Task 6 — Recalculate the Scale Scenario with the Saturated Reservoir

Considerable time is spent creating what is hoped to be a more representative brine. The Brine is reconciled
for charge balance, and where needed, alkalinity and pH; the gas is saturated with water as needed (though
not done in this case), and lastly the fluids are set to equilibrium with important reservoir minerals. It is only after
these steps are complete, and that there is confidence that the assumptions and calculations are representative
of the process, that a final scaling calculation is run.

The Reservoir calculation contains the representative fluid. It is, therefore, the output of this calculation that
will be used in all subsequent calculations. To access this output, a new Type of fluid, Whole Fluid is defined.
The Whole Fluid type represents 100% of the contents of a previous calculation, regardless of phase.

You will use the Whole Fluid from the Reservoir to rerun the scaling calculations.

Select Brine Scale Scenario in the Navigator Pane and rename it Reservoir Scale Scenario
Select the Design tab

In the Inlets tab in the Type column delete the Brine and Gas from the Type column

Add Whole Fluid

In the Name column select Reservoir

In the Flow column select <Automatic>

ook wN -~
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Description Design {l Plot (3 Report CF File Viewer

] J Type Name Flow
= Whaole Fluid (m3/day) | Reservoir
- <select=

Note: The Whole Fluid type refers to all the phases within the fluid. The Automatic option takes the final flow
rate phase of the separator and automatically enters this as the flow rate in the Scale Scenario calculation.

7. Go to the Solid tab and make sure that the Standard box is checked

Solids Selection

Bas04 (Barite)

CaCo3 (Caldte)
Cas04 (Anhydrite)
CaS04. 2H20 (Gypsum)
MaCl (Halite)

5r504 (Celestine)

Inlets

Conditions

8. Calculate (Press <F9>)
9. Select Plot tab and select View Plot

Description [£¥ Design il Plot 5l Report L2 File Viewer

‘ a & & (= | ViewData Wariables Optiohs

24 T T T
22 / .
20+ —#—BaS504 (Barite] - Sol Pre-scaling tendency [Pre-5T] T

4 CaCO3 (Calcite) - Sol Pre-scaling tendency [Pre-ST] [}

w 1T _m CaCO03 (Aragonite) - Sol Pre-scaling tendency [Pre-ST] 7

@

g 16 —4— SrCO3 (Strontianite} - Sol Pre-scaling tendency [Pre-ST]
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The Saturator is a tool for normalizing the thermodynamics of a reservoir system. The purpose of this calculation
is to apply the constraint of solid-liquid equilibrium on a system to create a specific compositional starting point.

The basis of this calculation is that water in the pores of a rock matrix is at equilibrium with the mineral surface.
Some questions to consider are whether it is reasonable to assume that a reservoir gas, oil, water, and rock
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are in equilibrium. Furthermore, we should also consider over what vertical and radial distance we can make
this claim.

Regardless of the inconsistencies, the industry widely accepts this approach. It is up to the analyst to decide if
the Saturator produces a more representative fluid than the original data.

Task 7 — Add a Contour Diagram

An alternative to the Scale Scenario calculation is the Contour Diagram. The conditions defined in the Scale
Scenario are specific to production locations, and generally no more than ten are entered. By comparison, the
conditions defined in the Contour Diagram are a range of temperatures and pressures. The object then
computes a matrix of temperature and pressure conditions and creates a presentation-quality contour diagram.

1. Add Scale Contour
2. Rename the Object Contour Reservoir

Mavigator g % =
Chapter 16_Scale Scenario with E|
&F Streams Description Design [l Plot &
—E’ Brine
@ Reconciled-Brine
+l:¢ Reservoir Scale Scenario
o #p Gas Analysis
+? Reservoir
_.[f@ Contour Reservair

Mame; ||:Dntour Reservair |

Drescription

Select the Design Tab

Select the Inlets (vertical) tab

Select the bottom right corner of the 1st cell in the Inlet grid and choose Whole Fluid
Select Reservoir in the 2nd column

Keep the <Automatic> flow rate option in the 3rd column

No ok

Description Design [l Plot L3 File Viewer

Type M Name Flow
‘Whole Fluid (m2/day) Reservoir <Automatic= j
<select=

Inlets

8. Click Conditions (vertical) tab

The minimum and maximum conditions are at the Separator 60C, 30 bar and Reservoir 125C, 275 bar. These
are the start and end range of the study. To create a reasonable number of calculations (~300) and to keep the
matrix somewhat symmetric, we will use increments of 2 C and 10 bar.

9. Change the Start to 60

10. Change the End to 125

11. Select the Increment radio button

12. Enter 5 as the increment

13. Uncheck the Log box (if it is checked)
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14. In the Pressure Range box, change the Start to 30

15. Change the End to 275

16. Select the Increment radio button (uncheck the Log box first)
17. Change the Increment to 10

@
Description &¥ Design il Prot LF File Viewer

Temperature Range

[ieg o v
End (O Number Steps 13

Conditions Inlets

Pressure Range

[ieg bar v
=
= Start 30.0 (®) Increment 10.0
End 275.0 (O Number Steps 25

This produces a matrix of 13 temperature and 15 pressure steps. This produces a 14x16 matrix, or 224
calculations.

Temperature Pressure

Units C bar
Start 60.00 1.01325
Stop 125.00 101325
Step Size 5.0, 0.60795
Mo. Steps 13.0 15.0
Calculations 224

10. Select the Solid Tab

11. Check the Standard box

12. Calculate. The calculation should take less than 10 min to be complete
13. When calculation is done, go to the Plot tab

& Description &¥ Design @l Plot 3 File Viewer

‘ a a4 . ViewData || Variables Optiors

270 =100

250

230

210

190

40.0

170

150

Total Solid Concentration [mgsL]

Pressure [bar]

130

110

P
o
o
&

%

Temperature [°C]
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The default plot is the total solids forming. The color scale represents a different numerical range. The red cells
indicate heavier solid precipitation, and the faint purple-white in the center and left of the screen indicate that
little to no scale forms. The upper right corner is the Reservoir conditions (125C and 275 bar). The lower left
represents Separator conditions (60C and 30 bar). At both points, minimal solids are computed to form. The
fluid traveling through the piping traverses this plot as temperature and pressure decreases. Layering
production conditions (e.g., early to late life) over this plot provides an indication as to whether production will
be at risk now or in the future. For example, if the pressure decline is significant (e.g., 60 bar), then the fluid will
be unstable at the higher temperatures (bottom of well).
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13.5. Overview of Brine, Gas and Oils and Introducing Mixer, and Saturator
Objects

Other calculation options include the ability to mix waters at user specified ratios to find compatible waters, and
the ability to saturate a water with respect to one or more solids to simulate reservoir conditions.

This chapter will cover the same calculation objects using fewer instructions and will introduce Mixing, Saturator
and Facility Calculations. Its purpose is to reinforce what was learned in the previous chapter and to promote
the anticipating of next steps when using the interface.

Task 1 — Add a Brine

1. Add a Brine Analysis from the Action Panel
2. Rename the Brine in the Description Tab, and name it WTXWTR

Mavigator PR
Documenti* | bl
6,:“ Streams Description Design [

Name: [wTAwTR

Drescription

West Texas Water Supply

3. Go to the Design Tab and enter the following composition in the Data Entry (vertical) tab:

Name: WTXWTR
Type of water: Aquifer Water
Comment: West Texas Water Supply
Species Concentration
Na* 3074 mg/L
Ca*? 910 mg/L
Mg*2 249 mg/L
Fe*? 0.77 mg/L
CI 4474 mg/L
S04 2960 mg/L
HCOs 439 mg/L
HS-! 146.2 mg/L

Check the Show non-zero Only box (under Entry Options)

Go to the Reconcile (vertical) tab

Select the measured pH and alkalinity Option

Enter the following conditions (change units if necessary)

e To change units just click on the hyperlink next to the variable that you want to change.

Temperature (2F)
Pressure (ps

No ok

-
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7

Temperature
Pressure

pH

Alkalinity end Point pH
Titration pH

Density

Description Design [ Report L File Viewer

77TF

14.7 psia

7.98

439 mg/L as HCO3-
4.5

(will be estimated)

Data Entry

Calculate Brine Properties Using:
() Concentration Data Only
(O Gas-Phase CO2 Content (mole3t)
(®) Measured pH and Alkalinity

(O Measured pH Only

Calculate Alkalinity

Specs... Calculate &

[ Allow solids to form

Summary

Unit Set: <Custom:

Automatic Chemistry Model
Agueous (H+io atabanks:
Agueous (H+ion)

No Solid phase(s)

Custom K-fit P-span

Stream Parameters:

Reconcile
[

Added titrant (mg/L)
Add Charge Balance (mg/L CH1)

Properties Measured
Temperature (°F} 77.0000
Pressure (psia) 14.7000
pH 7.98000
Alkalinity (mg HCO/L)
Alkalinity End Point pH 4.50000
Density (g/ml) 0.0
Elec Cond, specific (pmho/cm) 0.0
Total Dissolved Solids (mo/L) 0.0

Composition Adjustments

Calculated
alculate Temperature (°F) |77.0000

Pressure (psia) | 14.7000

Stream amount (L} 1.00000
Dominant lon Charge Balance
(eq/L):

Cation Charge| 0.19953%

Anion Charge | -0.199435
Imbalance 2.02957e-4

lon(s) needed to balance (maiL):
CH1/7.185

Measured pH and Alkalinity.

8. Click the Calculate Button

Task 2 — Add a Second Brine

1. Add a Brine Analysis

2. Enter the composition given below in the Data Entry (vertical) Tab

Description ¥ Design B Report Z File Viewer

= | Variable Value
= Cations (mgiL)
F Na+1 20400.0
= =] 402.000
a
Cas2 3300.00
Mgz 829.000
= 2 15.2000
s Bas2 0.70000
o Fes2 9.50000
Anions [mg/L)
CH 37000.0
5042 2200.00
HCO3-1 0.0
B(OH)&-1 400000
HS1 0.0
C2H302-1 715.000
Neutrals (mg/L)
coz 0.0
H2s 0.0

Balance | »  Entry Options
Units
20400.0 mall -
402.000 >
Display
3800.00
229,000 Formula ~
15.2000 ] 5how Mon-zero Only
0.70000 [ show Balanced Column
9.50000
Template Manager
Standard v
38034.7
220000 Save as...
0.0
4.00000 Balance Options
oo Type
715000 Dominant Ion v
oo
00| .
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3. Go to Reconcile tab
4. Select pH and Alkalinity calculation type, and enter the information provided in the figure below.

Description Design [Z] Report L3 File Viewer

- Calculate Brine Properties Using:
E () Concentration Data Only Specs..., Calculate &8
z (C) Gas-Phase CO2 Content (mole%t)
=] (®) Measured pH and Alkalinity [ Allow salids ta form
(C) Measured pH Only

2 Calculate Alkalinity
2
§ J Properties Measured Calculated
o Temperature (*C) 25.0000

Pressure (atm) 1.00000

pH 7.10000

Alkalinity {mg HCO/L) 715.000

Alkalinity End Point pH 4.50000

Oensty (5

Elec Cond, specific (pmhofcm) 0.0

Total Dizszolved Solids (mg/L) 0.0

Composition Adjustments
Added titrant (mg/L)
Add Charge Balance (mg/L CH1)

5. Click the Calculate button

Task 3 — Add a Gas

1. From the Actions Panel click on Add Gas Analysis
Input the name in the Description tab. Name it LightHC

Navigator L s X

LS
Document?* | ®
& Streams Description % Design
- Tgh WTXWTR
2 LightHC Name: |LightHC
I’\\5 Description
’—

w

Go to the Design Tab and enter the following composition in the Inflows (vertical) tab
4. Enter the following composition:

Component Composition

Carbon dioxide (CO2) 10 mole %
Water (H20) 15 mole %
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Description Design Definition (5] Report LI File Viewer

Raconcila/ Inflows

Component Value | Normalized
Subtotal: | Subtotal: 10

H20 15.0000 15.0000
N2 0.0 0.0
coz2 10.0000 10.0000
H23 0.0 0.0
v CH4 0.0 75.0000
C2HE 0.0 0.0
C3H2 0.0 0.0
C4H10 0.0 0.0
n-C4H10 0.0 0.0
FCEH12 0.0 0.0
CSH12 0.0 0.0
CBH14 0.0 0.0

Entry Options
Units

male % w
Display

Formula v

[ shaow Mon-zero Only
Show Normalized Column

Template Manager

Standard ~

Save as...

Mermalize Options

Makeup w

Group Manager
[ use Groups Add

OLI Studio: ScaleChem will assume that all of the hydrocarbon gas is methane (CH4). So, in this case the

software normalizes the gas adding 75 mole% of CH4.

5. Go to the Reconcile (vertical) Tab

@-’

Component Normali| Reconcile
Subtota Subtotal:
Hz0 15.0000 | 1.75794
coz 10.0000 | 11.5567
CH4 75.0000 | 866854

Condition

Calculate &8 |

Conditions Value
Temperature (*C) 15.5556
Pressure (atm) 1.00231

Show Mon-zero Only

6. Leave the default conditions for Temperature and Pressure

7. Calculate
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Task 4 — Add an Oil

1. From the Actions Panel click Add Oil Analysis.
2. Enter the name in the Description Tab. Name it O/L-1

Mavigator
Document1*

3
X

&
|

3. Go to the Design tab
a. This tab is divided into:

i

ii.
iii.
iv.

Combined Tab: Here pure components (organic and inorganic) are entered.

Pseudocomponent Tab
Assay Tab: Here distillation curves are entered.

Reconcile Tab

Description Design (& Report |

Name: |OIL-1

Description

For this example, we will enter pure component and pseudocomponent data.

4. Go to the Combine

d tab

5. Enter the following composition:

Methane (CH4) 20.53mole %
Hexane (C6H14) 8.595mole %
CO2 6.09mole %

Note: You will have to scroll down to find the CO2 entry.

[
Description &¥ Design | (E Repont | L3 File Viewer
Summary
| Component Value | Hormalized Entry Options

b Inflows Subtota Subtotal: 100.0|  Urits Unit Set- Metric (mole fraction)

E CHe 205300 8 2990 z Automatic Chemistry Model

8 Display AQ (H+ ion} Databanks:

o5 .
S el P
coz 6.03000 17.2938 Second Liguid phase

E ow Mon-zero Only Custom K-fit P-span

§ Show Normalized Column Stream Parameters:

= Temperature (*C)|15.0000

o Template Manager Pressure (atm) | 1.00000

o

A Standard il Prorate Mormalization.

“-. Normalized Summary (mole %):
nfows: 100000

e Pseudecomponents: 0.0

= -

E Normalize Options Assay L
Equilibrium Calculation.

=

o

=

o

o

@

i3
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6. Go to the Pseudocomponent tab

Description [&¥ Design & Report LI File Viewer

= J c Molecular gD.Tal Specific Thermo Value

£ omponent| .y ight Po?;t";,gq Gravity | Method | (mole %)

B

15
7. Add the following pseudocomponents:

PC1 98.43 100.21 API 27.57
PC2 170.34 216.32 API 29.35
PC3 282.55 343.78 API 719
PC4 506.0 645.00 API 0.68

The completed input looks like this:

Nomal

Molecular s Specific Thermo Value
Boil
J Component| =\ iont Po?;t":?ﬂ Gravity | Method | (mole %)

PC1 92.4300 100.210 APL2 27.5700
pC2 170.340 216.320 APLE 29.3500
PC3 282.550 343.780 APLE 7.18000
PC4 506.000 645.000 APLE 0.680000
<Enter a na

8. Go to the Reconcile (vertical) tab
Here you will see how well the pseudocomponent will predict the phase behavior of the hydrocarbon
sample.

9. In the Condition option (below calculate button) enter T=204 F and P=1 atm.
10. Click on the Add boiling point curve (red square shown)
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Description Design Report 3 File Viewer

Summary
| Component Normalized Calculate &
E Inflows Subtotal: 35.2132/ di Unit Set: <Customs=
o || R og| Condten Automatic Chemistry Model
. 2
& CH4 205290 | Saturate With Ho T Agueous (H+ ion) Databanks:
coii14 6.59457 = Aqueous (H+ ion)
| o 508370 J Conditions Value Second Liguid phase
g Temperature (*F) 204.000 Custom K-fit P-span
o Pressure (psia) 14.6960 Stream Parameters:
- :
= Pseudocompo | Subtotal: 64.7568/ Temperature (*F)|204.000
o PC1 27.5688 Pressure (psia) |14.6550
c
pc2 s [] Show Non-zero Crily Prorate Normalization.
PC3 7.18564 > " .
Bolling-Point-Ear Normalized Summary (mole %):
P4 0.679966 - - Infiows: 35.2132
E Add boiing point curve Pseudocomponents:|64.7868
£ Assay: 0.0
Equilibrium Calculation.
2 N
‘T
E
]
[}
@
==

11. A new calculation appears in the navigation panel below OIL1 Object.

12.

13.

14.

15.

5“ Streams

%3

This is a survey by Pressure. Click on the specs button and specify the conditions below. Change

pressure units if necessary.

Survey by

Prassure -

Thenby [optional)

Nane - Specs...
Enter a pressure range:
Start 200 psia
End 2000 psia
Decrement 100 psia

Click the Calculate button.

Click on the plot tab, you will see the following graph: You could adjust the parameters by clicking on

curves.
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Pressure [psia]

If the curve does not meet expectations, you will have to adjust the mole percentages or the pseudocomponent
properties. This is a manual iterative approach. You can see the actual data by clicking the View data button.

Vapor Fraction
Pressure | (Vapor/inflow
[mol])
psia maole %

1 200.000 278711

2 300.000 231877

) 400.000 19.4550

4 500.000 16.0216

5 500.000 126532

6 700.000 9.26672

7 200.000 5.80919

8 500.000 2.24433
9 1000.00
10 1100.00
11 1200.00
12 1300.00
13 1400.00
14 1500.00
15 1600.00
16 1700.00
17 1800.00
18 1800.00
19 2000.00

Frequently the hydrocarbon is saturated with water. We will simulate this part.

16. Go back to OIL-1 in the Action panel

6“ Streamns
2. T WTXWTR
2145 LightHC
= N OIL-1

2. 45 Boiling

17. Click on the Design tab
18. Click on the Saturate with drop down. Select H20
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Description Design (3 Report UJ File Viewer
J Component Normalized Calculate &g

Inflows
H20
CH4
CEH14
coz

Combined

PC1
PC2
PC3
PC4

Pseudocom:

Assay

Reconcile

Subtotal: 35.2132/
0.0

20.5290

8.50457

6.08570

Pseudocompo | Subtotal: 64.7868/

27.5686
293485
7.18564
0.679966

Condition
| saturate with | |

|| conditic ¥_MNone }

Temperature | [ H20

Pressure (psia

Show Mon-zero Only

Bailing Paint Curve

Add bailing point curve

19. In the Conditions option use T= 77 F and 14.7 psia.

Note: The software requires an initial "Guess" for the concentration of the water.

20. Click on the Calculate button.

When done, the software will create a Reconciled OIL-1 in the Navigator pane.

The Brine, Gas and Oil that we already calculated will be used for the upcoming Mixer, Saturator and Facilities

Calculations.

Task 5 — Adding a Mixer Calculation

The Mixer calculation determines if two waters (brines) can be mixed. Frequently the mixing of two waters will
cause precipitates to form which were not present in original brines. This can lead to the plugging of a formation
when an injection water is mixed with the natural fluids in the formation.

1. From the Actions Panel, click on the Add Mixing Water logo.

AT 4
4

Add Mixing
Water

2. After double clicking the logo, you will the object in the Navigation Panel.

Navigator
Documentt

AT
)

Chapter 18-Calculations overview*

Description [£¥ Design

& Streams

- T WTXWTR

- LightHC
&g OIL-1

-z Scenario

™ MixingWater-1
- Tgb SSC-Brine

N

Mame: |Mikingw ater-1

Description
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Click on the Design tab to enter more information.

Select your Brines, Gas and Oil s as shown in the figure below. Enter the indicated brine flow rate of 1000

bbl/day, gas flow of 230 stdMft3/day and oil flow of 7 bbl/day.

Note: To change units on brine, oil and gas, click on the hyperlinked (blue) units inside of the bracket

next to Inlets First Brine, Second Brine etc. This is under the column heading Type.

Description Design @ Plot | E Report | L2 File vi

Inlets

First Brink (bbliday)
Second Brine (BEbliday)

Gas (=td E3m3/day)
Oil (bbliday)

«select=

wditions

WTXWTR
SSC_Brine
Light-HC
OlL-1

This should pop the following window up. Click on Inlets tab and change the units.

Inlets tab looks like below. Changing units on Brine:

-

Edit Units - Mixing Water-1

? | |

| Composition I Parameters I Corrosiorklnhtﬂ

Batch System (@ Flowing System

Variable Units
Brine Quantity
il Quantity bblday
Gas Quantity std Mft3/day
Whole Fluid Cluantity m3/day
QK ] ’ Cancel ] [ Help

The final Mixer with inflows entered should look like the image below:
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Type Name Flow
First Brine (bbliday) WTXWTR 1000.00
Second Brine (bbliday) SSC-Brine
Gas (std Mft3/day) LightHC 230.000
E 0il (bbliday) olL-1 7.00000
= =select=
[ =
L=
[
=2 J Conditions Value
[=]
w Temperature (°F) 100.000
Pressure (psia) 200.000
Detail Info of Selected Inlet Mame
J Component Value (mgiL)

Calculate €@

[ calculate Alkalinity

Summary

Unit Set: <Customs= ~

Automatic Chemistry Model
Agquecus (H+ ion) Databanks:
Agueous (H+ ion)
Second Liguid phase
Excluding 116 solid phases
Custom K-fit P-span

® Inlets:
Brine (bbliday) | WTXWTR
X . s5C- 1000.00
Brine (bblday) Brine

Gas (std .

Wf3/day) LightHC 230.000
il (bbliday) OIL-1/7.00000
Brine Ratio:

WTXWTR SSC-Brine

1.00000 0.0

0.800000 | 0200000
0.500000 | 0.400000
0.400000 | 0.600000
0200000 | 0.800000

5. Go to the Conditions tab.

In this example, we are mixing the brines at 100 F and 200 psia. The first brine specified (WTXWTR) is
the one we compare to when evaluating the ratios. In this case we start out with all brine WTXWTR and
none of the SSC_Brine and end up with none of brine WTXWTR and all of the SSC_Brine.

6. Leave the default values

Select Type

Ratio -

Total flow: 1000.00 bbl/day

Steps: 5 Auto Step

7. Go to the Solid tab

Enter Values
B WTXWTR SSC_Brine
1.00000 0.0
0.800000 0.200000
0.600000 0.400000
0.400000 0.600000
0.200000 0.800000
0.0 1.00000

For this calculation we are only selecting a few of the possible solids.

(BaSO4, CaCO3, CaS04.2H20, NaCl).

Mark a check box next to desired solids
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Description Design

Solids Selection

=-[7] standard

----- BaSO4 (Barite)

----- CaCo3 (Caldte)

----- [ caso4 (anhydrite)

----- Ca504.2H20 (Gypsum)
----- [[] Feco3 (siderite)

----- [[] Fes (Pyrrhotite)
----- MaCl (Halite)

----- ] srso4 (Celestine)
#-[Z] Expanded

- Al

/Enlid 1Condition5/|nlets

8. Click on the Calculate button.

9. Click on the Plot tab.

9-0 [ T T T T T T T T T T T T T T T T T T T T
85
8.0 F
75 [
70F
6.5
6.0 b—
55 [
50 F
45l _
4-0 '_ \\‘ -

—#— FeS5 (Pyrrhotite) - Sol Pre-scaling tendency [Pre-5T]

35 —a—BaS04 (Barite) - Sol Pre-scaling tendency [Pre-5T] ]

30r —m— CaS04.2H20 (Gypsum) Pre-scaling tendency [Pre-5T] T

25 —4— CaS04 (Anhydrite) - Sol Pre-scaling tendency [Pre-5T] ]

Dominant Pre-scaling Tendencies

20 __ = CaC03 (Calcite) - Sol Pre-scaling tendency [Pre-5T] 7]

15 B

1.0 L J
] — ——— 3§

05 - B
po vy ey e
o, 0, 0 0 0,0, 0_ 0 0, 0 0 0 0 0, 0 0, 0O O 7

To study the effects better go to the variables button and eliminate other solids precipitated by the << arrow.
Keep only one solid (in this case BaSO4). The ratio is relative to the first brine specified. This means at a ratio
of 0.0 (all the first brine and none of the second) we have no BaSO4 scaling. As we add the second brine, the
amount of BaSO4 increases. These waters are perhaps incompatible.
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066 L / —#— BaS04 (Barite) - Sol Pre-scaling index [Pre-S1]

BaS04 (Barite) - Sol Pre-scaling index [Pre-Sl]
f=]
[=3]
&
T
\
1

S5C-Brine Ratio

Task 5 — Adding a Saturator Calculation

Water and gas samples at the surface are not necessarily representative of conditions in the reservoir. The
processing of the samples may involve significant changes in the chemistry.

The Saturate option (often referred to as "Saturate at reservoir conditions") allows the user to "Back-calculate”
the conditions downhole.

1. Select Add Saturator from the Actions Panel.

ﬂ_

Add
Saturator

2. Rename the object in the descriptions tab. Name it Saturator-1

MNavigator L o+ x =
Document1
Chapter 18-Calculations overview* Description Des
6“ Streams
+@ WTXWTR Mame: |5 aturator-1
-5 LightHC
21 OlL-1
+|=¢ Scenario Description
+"¢? MixingWater-1 I
- lyb SSC-Brine
.3 Saturator-1

3. Go to Design tab
4. And go to Inlets (vertical) tab

We will select objects that we have already defined.
5. Enter a Brine flow of 1000 bbl/day
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6. Enter a Gas flow of 230 std Mft3/day
7. Enter T=77 F and P=14.7 psia

= '

2|

k1

4
|4m
£5

r -H)

8. Set these units as custom units for all new objects in Units manager.

Units Manager - Saturator-1 ? X

Units Manager

<Custom = ~

ooz |
e

OK Cancel Apply Help

The window should look like the image below.

Type Name Flow
Brine (bbliday) SSC-Brine 1000.00
Gas (Mft3/day) LightHC 230.000

<select> b

Inlets

Salid

J Conditions Value

Temperature (*F} 77.0000

Pressure (p=ia) 147000

Detail Info of Selected Inlet Name
J Component Value (mole %)

9. Go to Solid (vertical) tab
10. Check the Standard box

We need to select solids inflow to vary for Saturator1. Under the table Select Inflows to Vary, choose the solid
to vary from the dropdown list.

11. Select BaSO4 (solid) and hit enter. Automatically the inflow to vary BaSO4 will appear.
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& Description Design & Report L2 File Viewer

Solid Selection (check solids allowed to form)

w
=
= Standard
BasSO4 (Barite)
CaCo3 (Caldite)
= Ca504 (Anhydrite)
u'?; Ca504.2H20 (Gypsum)

FeCO3 (Siderite)
MaCl (Halite)
Sr504 (Celestineg)
% @-[£] Expanded

- Al

Reservoir Mineral Saturation Section

J Mineral to saturate Inflow to vary
BaS04 (Barite) BaS04
<Select Solid>

To study the Saturator-1 (Brine and Gas mix) at various locations we need to add a Scaling Scenario object.

For Help, press F1

& OLIStudioTest - [Chapter 18-Calculations overview'] - o x
7 File Edit Streams Colculations Chemistry Tools View Window Help - &x
e Cancel
b=l B R N2 | Rqvaso 2 Re [ sl MEE S
Navigator & - %
Documentt =
Chapter 18-Calculations overview* | | & Description &¥ Design ({lll Plot [ Repont L3 File Viewer
&# Streams.
Tt woawT z ] Type Em o] Caloulte @
D LightHc = -
4 OlL-1 o [ calauiate Alkalinity
L2 Scenarie
%% MixingWater-1 R SEmED
b SSC-Brine = Unit Set: Scale Metric
3 Saturator-1 2
5 Automatie Chemistry Model
% Aqueous (H+ ion) Databanks:
Agueous (H+ion)
o mon h Custom K-fit P-span
2| Detai Info of Selected Inlet Name At least one inlet should be selected
Actions 3
Component Value (molihr) Selected Solids:
~
[ (ﬁ";’ == [ No Sold Selected
AddBrine  Add Ol AddGas Add Caleulation not done
Anclysis  Analysis  Analysis  Saturator
A4
k- @ R
AddScale| AddScale  Add Mixing Add Facilities
Scenario | Contour  Water
v
Plot Template Manager L
Save
&
3
5
@ NUM

12. Name the new Scale Scenario as Saturator-1 Scale Scenario under the Description tab.

Mavigator 5
Document1

Chapter 18-Calculations overview™

6“ Streams

Teb WTXWTR

%3 LightHC

4 OIL-1

le# Scenario

"% MixingWater-1

E S5C-Brine

S Saturator-1

Saturator-1 Scale Scenaric

4
Description Design

Mamne: |Saturator1 Scale Scenarid

Deszcription
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13. Go to the Design Tab
14. Under the Inlets (vertical) tab, select Brine under the Type column
15. Make sure to select Saturator-1, as is shown in the picture below:

Description Design [jli Plot B Report & File Viewer

Type Name Flow
Brine

<select=

Saturator-1 [AQ]

v
—

Flow will be automatically controlled. Locations can be input under the Conditions tab.
16. Go to Conditions (vertical) tab, and enter the information provided in the figure below:

Description Design i Plot [ Report L3 File Viewer

™ J Location Temp (*F) F (psia) Drop Solids

g Surface 77.0000 14.7000 O

i Choke 101.000 71.7600 O

Midwell 126.200 128.820 D

g Wellhead 150.800 185.880 O

= Downhole 175.400 242,940 O

-E Stock tank 200.000 300.000 D

o <Enter Location Name=

=

g Auto Step Sort Zoom

Steps: ° GO T||P s, @

L\\) Surface Choke Midwell ‘Wellhead
T77.0 B T:101.0 P T:126.2 = T:150.2
F14.7 F71.8 F:128.8 F185.9

!

Downhole Stmcx
T:175.4 . _ETE
poans T:200.0
o P:300.0
< >

17. Go to Solid tab and check the Standard box
18. Click the Calculate Button
19. Go to Plot tab
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After the calculation is complete, the plot for scale scenario shows that other solids are appearing.
20. Go to the Report tab, and look for Pre and Post Scaling Tendencies
Pre and Post Scaling Tendencies
Formula Mineral Excess Solute Excess Solute Pre-Scale Pre-Scale Post-5Scale Post-Scale
malL Ib/1000bbl 5 5T I, Index 5 5T &1, Index
Cas04.2H20 Gypsum 0.0 0.0 09258262 -0.0323294 0.925262 -0.0323294
FeCO3 Siderite 0.0 0.0 0.114350 -0.941763 0.114350 -0.941763
31504 Celestine 0.0 0.0 0203747 -0.690908 0.203747 -0.690908
31C03 Strontianite 0.0120451 -1.91908 0.0120481 -1.91908
BaS04 Barite 0.0 0.0 1.00000 -2.23307e-11 1.00000 0.0
CaSo4 Anhydrite 0.0 0.0 0731753 -0.135635 0731753 -0.135635
Caco3 Calcite 0.0 0.0 1.00000 -1.46285e-11 1.00000 0.0
MaCl Halite 0.0 0.0 0.0121174 -1.91659 0.0121174 -1.91659
KCl Sylvite 6.71059e-4 -317324 6.7105%9e-4 -3.17324

Excess solute or Max Scale: The solids amount forming at equilibrium

Pre-Scale: The saturation ratio before solide precipitate.

Post-Scale: The saturation ratio AFTER =olids precipitate (if solids are selected).

S, ST - Saturation, Scale Tendency: The ratio of the concentration (activity) to its Solubility (S=1).

Sl - Scale Index: Log(S).
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13.6. Introducing the Facilities Object

This section presents a new calculation object: Facilities. The Facilities is a simplified process simulator; it mixes
and separates. OLI Studio: ScaleChem has the ability to link together several individual calculations to create
a flow sheet facility. An example of a facility calculation is shown in the figure below.

Water Supply
3,000 bwpd ——
Field 1 77F, 30 psia
11,000 bwpd  =—
100 F, 100 psia 5,000 bbl
> \Sb-klonsng%( » Suction =—
Field 2 Tank
12650|§)01 g\g’pd_ — Skim Tank Discharge
» 125 psia 110 F, 100 psia 90 F, 30 psia

It is a simple process in which two field brines mix in a skim tank. The discharge from this tank then mixes with
a water supply in a discharge tank. Below are the compositions and conditions of the inlet fluids.

Na+ 38209 27078 3074
Ca+2 6600 4480 910
Mg+2 1531 1191 249
Fe+2 120 6.6 0.77
Cl-1 73150 51134 4474
S04-2 2453 1840 2960
HCO3- 421 677 439
HS-1 244 146.2 0
Temperature 100 F 125 F 77F
Pressure 1Q0 12.5 30 psia
psia psia
pH 6.97 7.53 7.98
Alkalinity (As HCO3 mg/L) 421 677 439
Alkalinity End Point pH 4.5 45 45

Follow the steps below:

1. Open a new Window for Simulation

2. Create the above brines: Field 1, Field 2 and Water Supply

3. Use the Add Brine Analysis object as you have done before to create them.

The Data Entry Windows should look like this:
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Description (¥ Design [ Report L File Viewer

o

Description ¥ Design [ Report d File Viewer

")

& Description [&¥ Design [F Report LI File Viewer

> Variable | value | Balanced | = Variable Value Balanced | A
E Cations (mg/L) z K1 00 0.0
W)
= Na+1 38200.0 383704 = Cas2 448000 | 448000
E K+1 0.0 0.0 5 Mg+2 1191.00 1191.00
Cas2 660000  6600.00 sz N 00 00
1g=2 153100 1531.00 3 Bas2 00 0.0
3 sre2 00 00 3 Fe-z 550000 660000
g Bas2 0.0 0.0 s
5 =
= Fe=2 120.000 120.000 4 Anions (mg/L)
cH 511340 | 512579
Anions (mgiL) 5042 1840.00 1840.00
[ox] 731500 731500 feos 677000 | R0
s042 245300 2453.00 fs 146200 146200
C2H302-1 0.0 0.0
HCO3-1 21000 421000
Ha-1 244000 244000
Neutrals (mg/L)
C2H202-1 00 0.0
coz 0.0 0.0
H2s 0.0 0.0
Neutrals (mg/L) e o =
coz 0.0 oo BOH 0.0 0.0
Hes 0.0 0.0
v
sio2 0.0 0.0

4. Reconcile these three brines for measured pH and alkalinity.
5. Make sure that the Allow solids to form box is uncheck at the bottom of the reconciliation options for all

the brines.

by

= Variable Value Balanced
= K+1 0.0 0.0
= Ca2 910000 |  910.000
] Mg+2 245000 |  243.000
5r+2 0.0 0.0
Bas2 0.0 0.0
Tg Fes2 0.770000 |  0.770000
8 [
o= Anions (mgiL)
cH 447400 | 463791
504-2 2060.00 |  2960.00
HCO3-1 439000 | 433.000
Hs-1 0.0 0.0
C2H302-1 0.0 0.0
Neutrals (mg/L)
coz2 0.0 0.0
H25 0.0 0.0
sio2 0.0 0.0
B(OH)3 0.0 0.0

- I
T Calculate Brine Properties Using:
s (O Concentration Data Only Specs... Calculate @8 |
E Gas-Phase CO2 Content {mole®s)
=] (®) Measured pH and Alkalinity

[ Allow solids to form I

) Measured pH Only
Calculate Alkalinity

Properties Measured Calculated
Temperature (*F) 100.000
Pressure (psia) 100.000
pH 6.97000 6.97000
Alkalinity (mg HCO3/L) 421.000 420.9%0
Alkalinity End Point pH 4.50000
Density (g/ml} A 1.07666
Elec Cond, specific (umho/cm) 0.0 1.84804e5
Total Dissolved Solids (ma/L) 0.0 1.22617e5
Composition Adjustments
Added titrant (mg/L) HCI 227.307
Add carbonate (mg/l CO2) -235.440
Add Charge Balance (mg/L Na+1) 161.374

6. Select Add Facilities from the Action Panel.

+,

Add Facilities

7. Go to the Description Tab and rename the object as Facilities-1
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Description ‘@ Design |ﬂ F‘Inll & Report | _d File Viewer|

Mame:  Faciliies-1|

Description

Date: | 62172016 [+]

The facilities calculation is based upon transferring information between calculations through nodes. These
nodes can be thought of as pseudo brines and gases. These pseudo brines are not stored as individual brine
rather they are used internally in the calculation. The concentration and flow rates for these nodes can be

viewed in the output.

8. Go to the Design tab

9. Go to the Inflow Specs (vertical tab)

Within Inflow Specs, we can add Nodes via Node input options. There will be one default node added.

10. Double click on the node name (where it says: Node 1) and type "Skim Tank".

e

Description Design @ PIotl@ Repunlg File Viewer|

Inflow Specs

Solid

e
.

=

4 I

m

Node Input
i Z
Current Node: Skim Tank [Clorop Solids oom
(o) &
Add Delete a
Conditions T
Temperature ("C) 150
Pressure (bar) 1.01325
..... Type Name Flow

<select=

Calculate @

[T Calculate Alkalinity

Surmmary

Unit Set: Scale Metric

Automatic Chemistry Model
AL (H+ ion) Databanks:
Public
Custom K-fit P-span

Hode(s):
Skim Tank: No inlet

Selected Solids:
No Solid Selected.

Calculation not done

Some node(s) do not have inlet.

11. Enter the name, description, conditions, and streams for the Skim Tank shown in the table below:

Field 1
Field 2
Water Supply
Skim Tank
Suction Tank

11000 bbl/day
6000 bbl/day
3000 bbl/day
5000 bbl/day
5000 bbl/day

100
125
77
110
90

100
125
30
100
30
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12. Make sure to select drop solids checkbox at the Skim Tank node.

When complete, your screen should look like this.

] ~
4]
@
-3
W
2
-]
=
£
v
£ >
w
Node Input
= Current Mode: Skim Tank oom
S e Alkalinity &,
5 Add | | Delete @
Q
J Conditions Value

Temperature (°F) 110.0
-1_§ Pressure (psia) 100.0
w

Type Name Flow

Brine (bbl'day) Field 1 11000.0

Brine (bblday) Field 2 5000.00

«sglect=

The output of this calculation will go to the next node.

Next, enter the information for the second node, Suction Tank. We will select the output brine of the Skim tank,
which is a brine from node. The temperature and pressure as well as the flow of the brine are calculated.

13. Click on the Add button to add a second Node
14. Change the name of the node to Suction Tank
15. Change the conditions of this node to 90 F and 30 psia.

When complete your screen should look like the image below:

Description Design i Plot [El Report Ui File Viewer

—
—=
=

¥ Skim
Tank

Solidaonditions Inflow Specs

£ >
Node Input
i Z
Current Node: Suction Tank E Drop Solids oom
Calculate Alkalinity Q
Add Delete @
J Conditions Value
Temperature (°F) 50.0
Prezsure (peia) I’\\S 30.0
J Type Name Flow
<gelects

When a brine is calculated in a facilities calculation, we have the option of allowing any produced solids to be
considered (that is they traveled along with the brine) or to eliminate them as they precipitate out. We will
eliminate the solids in this case. The orange downward arrow from Skim Tank indicate dropped solids.

We are also adding the Water Supply to this tank.
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16. In the Type column and first row select Brine from. In the Name column select Skim Tank. The Flow is
calculated (since it comes from the Skim Tank).

17. In the Type column and second row select Brine. In the Name column select Water Supply. Enter 3000
bbl/day in the Flow column.

When complete the screen should look like the image below.

i
] -
1]
Q@
(-3 —
v -
g Skim Sucticn
= Tank Tank
=
W
w
5|l ¢ % ¥
S| MNode Input
i il
S | Name: Suction Tank [ orop Salids oom
o [ calculate Alkalinity g @
Add Delete
- J Conditions Value
E Temperature (°F} S0.0
Pressure (psia) 300
J Type Name Flow
Brine from (bbl'day) Skim Tank Calculated
Brine (bbliday) Water Supphy 3000.00
=select=

18. Click on the Calculate button, or press <Ctrl+F9>
19. Go to the Report tab, and check for the Pre-scaling Tendencies and Scaling Tendencies
20. See the Results

Pre-Scaling Tendencies

Column Filter Applied: Values * 1.0=—4
Tempersture Filter Applied: Active TRangs Only.

CaCO3 . CaS04.2H20 CaS04 L Fe{OH)2
WILIE (Aragonite) | C3CO3(Calcitel 6 pcum) (Anhydritey  |FECO3 (Siderite)) o inite)
Temp Range °C Invalid Invalid Invalid Invalid Invalid Invalid
Skim Tank 520710 5.91186 1.24207 1.39847 0.165109 34877504
Suction Tank 4 83533 986145 1.18226 1.09089 0.147451 1.58132e-4
Fes MgC03.3H20 MgCO3 Mg({OH)2 MgS04.TH20
Nodes Fe$ (Pyrrhotite) {Mackinawite) | (Nesquehonite) (Magnesite) {Brucite) (Epsomite)
Temp Range °C Invalid Invalid Invalid Invalid Invalid Invalid
Skim Tank 419583 906.834 4 47209e-3 9.15709e-3 1.05810e-3 1.11430e-3
Suction Tank 415521 781107 3.37396e-3 474809e-3 3.15204e-4 1.21290e-3

Based on these results, it is clear to see that the software predicts the formation of several solids in this process.
Solids with a Pre-Scaling Tendency > 1 are predicted to form.
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Adiabatic, 215, 223

Alkalinity, 387, 395, 451, 452

Alloy Chemistry, 316

Anions, 391

API Gravity, 386

Aragonite, 59

Assay, 382, 383

ASTM, 382

ASTM D1160, 382

ASTM D2887, 382

Average Bulk Density, 386

Brines, 387, 401, 429, 430, 433, 441, 442, 443, 457
Bubble Point, 25

Calcium Carbonate, 59

Calculation Types, 317

Cascading Mixers, 220

Cavett, 201, 383

CO:2 Fraction in Gas, 387

Composition Point, 26

Composition Survey, 218, 340

Contour Plot, 159, 163, 486, 490
Corrosion, 256, 261, 266, 316, 317, 329, 339, 350, 367
density, 201, 386, 390, 394, 396, 421, 461

Depletion Parameters, 316

Depletion Profile, 317, 336

Dew Point, 26, 47, 457

Dolomite, 67

Dominant lons, 393

Electroneutrality, 191, 421

Entropy, 513

Equation of State, 15

Equilibrium Constant, 108, 111, 388

Extreme Value Statistics
EVS, 348, 350

Facility Calculation, 441

Gases, 391, 401, 407, 430, 443, 457

Heat Capacity, 513

hydrocarbon, 426

Hydrocarbon, 407

Isenthalpic, 25

Isochoric, 26

Isothermal, 25, 37, 225

Lee-Kesler, 384

Make Up lon, 393

Mixed Solvent Electrolyte
MSE, 15

Mixer, 220, 222, 225, 227, 429, 433, 513
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Oxidation, 248, 249, 252, 253, 255

Passivation, 257, 261, 262, 266

Petroleum Fractions, 209

pH, 26, 33, 37, 56, 119, 120, 121, 128, 131, 132, 133,
136, 137, 218, 219, 224, 226, 227, 233, 255, 257, 263,
265, 268, 270, 272, 387, 390, 391, 394, 395, 396, 421,
441,442, 448, 451, 452, 453, 456, 501, 502, 503, 513

Pit Depth, 348, 350, 377

Precipitation Point, 26

Pressure Survey, 141, 159, 486

Proration Cation, 393

Pseudo-components, 383

Reaction Kinetics, 97

Redox, 252

Reduction, 241, 248, 255, 268, 270

Report Tab, 454, 515

Saturate Calculations, 435

Scaling Tendencies

ST, 459

Scaling Tendency, 176, 387

Selective Redox, 252
Single Point Calculation, 513
Soave Redlich Kwong

SRK, 15
Solubility Product

KSP, 387, 388
Speciation, 132, 216, 451, 453, 454, 459
Stability Diagram, 258
Temperature Survey, 121, 468, 515, 529
Thermal Aging Temperature Survey, 317
Thermal Aging Time Survey, 317
Thermodynamic Framework, 111, 220
Tree View, 120, 132, 225
True Boiling Point

TBP, 382
Vapor Amount, 26
Vapor Fraction, 26

Watson K, 382, 383, 384, 386
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